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TRIALS

No mattes what trials came auy way.

Qad will sce us thveugh cach day.

It anly we'll put eux tust in Him.

The light of FHis love uill nevex dim.

Dan't cvey think that He's [argatten yeu,

Jts just, sametime, we need test ox tua.

Fax, we'll nevex fe able to hielp cur brathey.

I wee've nevex been tested, ane way ex another.
Newer ask the Losd fax an easy vead.

But anly fox stxength ta cavry youn load.

Fax thvough yaus sovvoues, you will find.

Ghe Lovd i with yau.

He's laving and Find.

(nd when youx trials have all gene auay.
“J'uc bicen thexe, tea,” is what you can say.
Fav, thexe'll be times when someene you meet.
Will praise Qod te walk in the steps of your fect.
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SYLLABUS

SOFTWARE APPLICATIONS IN CIVIL ENGINEERING
LT P
- ~ 8

Rationale: Computer applications plays a very vital fole in present day life. more so. in the professional life of enginces

In order to enable the stidents use the computers effectively in problem solving, this course offers apphcations of variou

computer softwares in Civil Engineering

Learning Outcomes
After undergoing the subject, students will be ablc to:
o Draw 2D drawings on AutoCAD viz. plan, scction and elevation of a residential building.

e Usc various Civil Engincering softwarc.

DETAILED CONTENTS

PRACTICAL EXERCISES

1. Introduction and use of AutoCAD for making 2D Drawings and develop plan. section and elevation of
a residential building.

2. Demonstration of various Civil Engincering softwares like STAAD-Pro/RevitMS Project Primavera
Project Planner, Auto CIVIL or any other equivalent software.

Note:

(i) Polytechnics may use any other software available with them for performing these exercises.

(ii) If the above softwares are not available in the institution, demonstration of the above said software
should be arranged outside the institute.
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THINK ABOUT IT )
Take up one idea. Make that one idea your fife--think of it, dream of it, ive on that idea. Let tfic
brain, muscles, werves, every part gf your {ra:fy, Et'fuff gf that idea, and just leave every other
idea alone. This is the way to success
— Swami Vivekananda

Try not to become a_person of success, but rather try to become a_person of value.
— Albert Einstein

§1.1. U= (Introduction)

I H G HE H T ) G W 6 € e fa 9 s qe f2ie 9 ve-ue el
0 < T AR 1w T A O, W S F AW g © T el weged q fafae e
& FH @ AgA G A F e 8@ g A software available 2 I civil engineering ¥ Exet
fau'fl'iﬂa'i-"lmm%mcivilcnginsedngaﬁmaﬁ Tiezagd & = 7 =7 7@ 2
gFm W # fofaw wifd g0 Swam fe 99 9 & Siea® €1 9 JRET construction projects
# 9ga I ¥ 94 civil engineering F T subdisciplines & fF Structural design, Surveying. Geo-
tech engineering, Environmental engineering, Construction planning ¥ 37 ®iwaas &1 syam f&a1
W €1 4% 39 civil engineering ¥ BT ¥, 3W: STF T softwares § IR T FRY T softwares
fafawt Sofifras &1 379 daily duties FvH % 7eg 94 €1 Tl fafae i@ # yqw §9 9 g5
Hiwaad ® g & W @ R

(i) 3= ¥ AutoCAD (AutoCAD for Drafting)

AutoCAD (Autodesk's Computer Aided Design) T SAEITGH computer-aided fesza R gigen
software application §1 §8 Autodesk &R1 fofe 3it f9fTd (marketed) 8 1, AutoCAD Teeh &R
fexmt 1980 4 ww ‘Sl ¥9' w9 ¥ v A Wb FRE (Intemal graphics controllers)
% WY micro computer W ¥l TET 1l AutoCAD &1 fmiv wfcdrsrnsy % drafting 3 documentation
% fAu Autodesk BT fawfaa o a1 §1 WRa & @ @9 Structural design consultancies (¥R
fesrs wreler ) it ol ¥ 5@ WiveTmR @ IWEm W g 1 AutoCAD 3D version 3D modelline
% fa o available §1 )
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(i) STAAD Pro for Design and Analysls (Structural Deslgning Program)
T UF structure F designing 3 analysis ¥ @ 3R ¢, @ Bentley fIRM W STAAD Pro wy
T software &, W P 8% % FE professionals T use fm IwN $1 STAAD Pro &1, H2, wwg),
TgETA 3R cold-formed-steel 3 T fomEa ¥ fog weamem AR professionals T vew) weig
21 T software TR building structures 8 & culvents, petrochemizal plants, T (tunnels), Y&
(Bridges), WETH (piles) feams & v W oot professionals TRI use fawm smn 1 yas
e T, advanced features, fluent data collaboration F ®N T T popular §311 t
STAAD T STAAD Pro TF W= (S99 (Structural analysis) AR femmgn ¥ o O s
Y R IWM fFW ST AN WS ¢ 9 fF g9 §9 ¥ 1997 % Rescarch Engincers International &R
fasfya frmi T @ TR STEM X3 ¥ o TR R ST F ATRe €1 9mY w1 F R program
= ST F prior knowledge ETEF T R
e STAAD Pro @& structural design oriented program & f& user interactive interface T FEwmM
3 user ST TE FEA S F@ W @ o

o a1 faf9= structures T8 structural conﬁgunnionﬂﬂ modelling designing & nnnlysis%ﬂ use
= <1 "= B

« STAAD Pro i 53 fadimard §—Model
Seismic/Dynamic analysis, 3l

ion, model verification, secondary analysis,

STAAD Pro Software & Advantages
o Manual calculation F1 SFETTal TEIl
« T T | Saiea fe=ET ¥ SUGE (concrete, steel, aluminjum FEIT)!
 Results accurate €13 €, shear force, bending moment 30 W1 TVA structures & ¥4l beams
ﬂTcoiumns%ﬁE“Tﬁztm—n"f%I
e Structure 3 FER w1 Hv4l
« {551 9 ¥¥R ¥ load ¥ designing ¥YF H9iq dead load, live load, wind load, snow load, area
load, floor load 3micl
AutoCAD # STAAD  design import X &1 €1
o TEE ¥ TE W T WA beam ¥ WEX TWHYHI HRA F design T favawo fmn =
T 2l

(iif) PRIMAVERA for Construction Management

Primavera G standard project management software tool & Sl ffSi= industries S f construction,
oil and gas, manufacturing, energy, =1 SR (IT or Information technology) ¥ use far < &1
Civil engineering % &% ¥ project planning T3 management % fT Primavera 91 use fiFa1 e 31 9%
use T ¥ FIE] 5TGTH € € T4 project activities F forecasting F time resources T cost management
W focus T €1 991 Terdal 4 employee responsibility, schedule creation, parison reports 3R
i 3= F update 79 W T4 2

Primavera T& f501 4151 (Construction planning) 3R o Giwam (scheduling software) 2
=% B4 planning 37 scheduling professionals F T 9F =9 | s S g use R o €1

fifreey golifoafin 0 wqan afiesad 3

MS office @ MS project Sl U project management software 1 Primavors v, enterprise project
portfolio management soltware 1 i project management, callaboration, control eapabilities it
#, afhe e oy At S Oracte SHESAD s FRI ystem & 0 wga (otegrane) A1 2)

(Iv) MS Projoct
MS project U project management ¥ dare e vt woftware # 9 project @1 planning. tracking
9 management W merTm e €

(v) REVIT Structure for Bullding Information Modolling

Building lnformation modelling W21 T an ai AT (innovation) WA v o e
R W fofrastructure projects T GG T #1 BIM (Building Information Modelling) 2% intelligent
D model snefea wfwa ¥, @ Architeeture, Engineering 30 Construction (AEC) professionals 71
aifirw YTETn A A (Plan), hﬁm (Design), fento (Construction) sfe g (Buildings) aa1 1{1‘(""5!
TR W WA WO W e siwifE (Insight st 3@ (ool ser aad #

(vl) ETABS for Design and Analysis

ETAB A ETABS @1 full form Extended Three Dimensional Analysis of Building System #iwm
software F) e A FRE building 7 structure T structural analysis @1 91 7@w #1 weE @
software civil engineering W use 81 ®, (@ a1 At 1 it s s e s 1 ETAB ®) e
R/ Fgefiren T (Multistorey buildings) 1 fagénm wal fasmga ) fea o mem §1 59 sofiware
fefd modelling tools T templates, code bused load prescriptions, analysis methods and sojution
techniques ) I ¥ G use FH structures & designing @ modelling % 1 T #

ETABS FRAl & W0 FRAMV (Structural analysis) 31 FSse & a0 altimate integrated
Wi &1 ¢ qul & Friew arfEaT $iR frm @ wite A W Aw T ETABS unmatched 3D
object 3R modelling MR visualization tool Y& M 1

®W (Advantages)
¢ Graphic Input and Modifications
e Creation of 3D model
* Easy and quick
Editing of model is very easy.
Accurate drawings using snap command
Quick creation of objects by a click of mouse (for beam, column, slab, wall ele.)
Easy navigation through multiple views of windows.

(vii) SAP 2000 or Structural Analysis Program 2000:

~ SAP 2000 TSN & fasme o farverm & T Sueed U o W 1w wrees wu
¥ ‘ﬁ.m IR fmA @R SAP 2000 ¥ wEwEa simple A advanced 2D T 3D structures &1
practical 91 intuitive object base modelling environment &R model, analyse, design @9 optimize
e o e & Forerd SR ShRat e @ streamlined 8 SR §1 SAP2000 § New model 7 5
QY& T F 7 cemplates 1 freg =W 06 §1 SAP2000 § fbE waR F HEA F fem
parametric templates I § 31 simple beams, 3D Trusses, 3D frames, storage, vessels, staircase,
dam structure T pipes T
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(vill) MS EXCEL . .

Microsoft Excel, microsoft. &1 fawfa cpreadsheet R T caleulation, graphing 1001, pivey
tables 9 visual basic FHE macro programmimg language % [N A l?l ue @ Wi i‘; "‘m
oF agt SOF F9 A WGR W T A spreadvheet ¢, vk ffaer golfaftn N R2n W, ity
favarym ok feama fam o w&@ R1 Spreadsheets N values F tables W rows 3491 column ¥ wg
syafoms few T &, FaAa) fF basic T compley anthmetic operations A functions B mathematically

manipulate f&F I wFA L]

(ix) Arc GIS for Surveying

Arc GIS Smfers g Wonel (Geographical Information System) A WA U AR
thematic maps 7 A wEE B 1 Are GIS data collect FT Y'ﬂ 3 manage FA ‘?q professional
maps T T3, traditional 3 advanced spatial fagerm F R‘g it arafas arEsl ® T 0 h
TF FA~4 ITA software ﬁl

Arc GIS Organisations ¥ TF software platform & o weman A spatial data B create, manage,
share T analyse f& s 21 TR server components, mobile & desktop applications, developer tools
fz 1 2
(x) 3DS Max for Modelling

3DS-Max TF animation software & fSE1 ITAM visuals generate T & fory fovan sman &1 ¢
modelling 3 rendering software & 1 T8 ¥ @ interior design 3R visual graphics ¥ faw wm
form T 1 97 WRAR Autodesk 2R fawlEd fba man &

(xi) MX Road for Road Design and Analysis

MX Road UF TI9eamt & 1 Bentley Systems BRI faafod fan w1 &1 g svdm Ug festeA o
f&@ I #1 MX Road WR9R& F@wis (conventional workflows) ®1 3D modelling technology d
combine FTF design F1 quality F improve FTdl ]

There are many software available which are used in Civil Engineering. Due to the Technological
Revolution, the number of software serving Civil Engineering needs are increasing manifold. Software
used by Civil Engineers all around the world. These softwares are very much useful in Construction
projects. Almost every field of civil engineering like Transportaiion Enginecring, Structural Design,
Surveying, Geo-tech Engineering, Environmental Engineering, Construction Planning, uses softwares
in one way or other.

o AutoCAD for Drafting

AutoCAD is one of the basic software for drafting and documentation of the construction projects
which is developed by Autodesk. It is used in almost all structural design consultancies and firms
especially in India. AutoCAD 3D version is also available for 3D Modelling.

* STAAD PRO for Design and Analysis

When it comes 10 designing and analysis of a structure, Bentley System’s STAAD PRO is one such
software which is opted by many professionals in construction field. STAAD Pro is used for steel,
concrete, timber, aluminum, and cold-formed steel design of virtually any structure including culverts,
petrochemical plants, tunnels, bridges, piles, and much more through its flexible modeling environment,
advanced features. and fluent data collaboration.

fufary ehfanfrn 4 wpen dfzamd §

o PRIMAVERA and M3 Projoct for Construction Management
Primavera and MS project are construction Planning and Scheduling software. Primavera is opted
by almost grater than 75 percent of all planning and sheduling professionals. Primaverais an enterprise
project portfolio management sofiware. It indludes project management, collabaratian, and contraol
capabilities, and integrates with other enterprise software such as Oracle and SAP's ERP systems
MS project for Project Management: MS project is especially developed for project management
and is a useful software application for planning, tracking and conteolling a project.

e REVIT Structure for Building Information Modeling

Bullding Information modelling or BIM is one of the modern greatest innovation helping big
infrastructure projects. BIM (Building Information Modeling) is an intelligent 31 model-based process
that gives architecture, engineering, and construction (AEC) professionals the insight and tools to
more efficiently plan, design, construct, and manage buildings and infrastructure.

o ETABS for Design and Analysis

ETABS or Extended Three Dimensonal Analysis of Building System is a software package for the
structural analysis and design of buildings. ETABS offers unmatched 3D object based modeling and
visualization tools, blazingly fast linear and nonlinear analytical power, saphisticated and comprehensive
design capabilities for a wide range of materials, and insightful graphic displays, reports, and schemaric
drawings that allow users to quickly and easily decipher and understand analysis and design results.

e SAP 2000

SAP2000 is also a software for design and analysis of structures. It is also used in many structural
firms. SAP2000 has a wide selection of templates for quickly starting a new model. SAP2000 includes
parametric templates for the following types of structures: Simple Beams, 3D Trusses, 3D Frames,
Storage Vessels, Dam Structures, and Pipes.

o MS EXCEL

Microsoft Excel is a spreadsheet developed by Microsoft. MS excel is an ideal choice for not only
accounts work but also for various fields of Engineering Professionals. It is used calculation, graphing
tools, pivot tables, and a macro programming language called Visual Basic for Applications. It has
been a very widely applied spreadsheet for these platforms. It is widely used in Civil Engineering for
Data collection, Surveys, Analysis and Design.
e ArcGIS for Surveying

ArcGIS is a softaware used in Geographical Information System. It is helpful in creating Thematic
Maps. ArcGIS helps to collect and manage data, create professional maps, perform traditional and
advanced spatial analysis. and solve real problems.
e 3DS Max for Modelling

3DS Max developed by Autodesk is an animation software which is used to generate visuals. 3DS
Max is modelling and rendering software which is mainly used for interior design and visual graphics.
¢ MX Road for Road Design and Analysis

MX Road is a software developed by Bentley Systems which is used in Road design. MXROAD
combines 3D modelling technology with traditional workflows to improve design qualiry.
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s 1. fofm gt w2 o fmn ww £

| FAT—Engineenng in the term apphed to the profession in which o knowledpe of the mathematica)

| and natural sciences ganed by study, expenence and practice in applied o the efficient wse of (e
matenals and forces of nature ¥ engineening T ZEARMA & A7 A am madn fam g wm
U, 3EYA A WANT F WA [OWTE fEm = ¢ am o A wgfa v a amn o ampla;
Yo 4 L& fFm = 71 Civil engincenng in the design and constructon of public works such uy
dams, bndge

constructy

roads. canals, railways. airports ete, e, the apphcation of planming, desipning,

mantaning and operating infrastructures while protecung the public and envirommental

| health and improving existing infrastructures

| we= 2. fafam it ¥ w9 FT TqQ Softwares & AW WAHA|
TET—AutoCAD, Rivet, STAAD Pro, MS Excel. MS Project #fzi
T 3. AutoCAD #11 #?
TH—AutoCAD TF FTETTF computer-aided FZATA 35 SR oftware application # 70
Avtodesh. 27 fFFTTa @7 faA (marketed) 91 T8, AutoCAD Weell @m famem 940 11 v
T OY F ER R wRTe S0 T (aFF (Intemal graphics controllers) % A4 micro
computer T == TE DI

AutoCAD fam <fs=13h & w=sm (drafting) = TFEA (Documentation) fav ow 77
=EET 2 R UF 7 7R Autodesk 3T 3R o 21w B A A (Structural design
consultancies) ( Tr==rE fz=e ’1‘777:':37) s owdl A AT F: I foEm = R ?,
AutoCAD 3D version 3D modeling F 70 1 available 1

agfaeE a9
| T¥9 1. Which software is used for drafting purposes (Drafting ﬁﬁ Tqa software Cack: 8 7))
(a) AutoCAD (h) MS Excel
(c) STAAD Pro (d) PRIMAVERA
¥ 2. HEWIZ software B F1 87 (Which are of these is a spreadsheet)?
(a) AutoCAD (h) MS Excel
fc) STAAD Pro (d) PRIMAVERA
¥ 3. Construction, planning and scheduling software —
(a) PRIMAVERA (b) MS Project
(c) Both (a) and (b) (d) NOTA
¥ 4. Building information modelling %‘rj T software:
(a) AutoCAD (h) PRIMAVERA
i fc) STAAD Pro (d) REVIT Structure

frfinm tHbofin 0 g wfed 7

w5, Are GIS waltware (R0 use form wrm §—
(hy Maodelling
(¢) Spread sheet (dy Drafting
WA 6. 3DS Max software faford uwe fom arm §—
(hy Modelling
(c) Spread sheet (d) Drafiing
o 7, Excel window % Dottom o wm wrz v &7
() Title bar
(¢) Waorksheet tubs

(n) Surveylng
(n) Surveylng

() Formula har
(d) Name box
o 8, Clvil engineering i A roftware:
(1) AutoCAD (h) STAAD Pro
(¢) Revit Structure (d) T wd |

v 9. Busic rectangular bullding blocks of a spread sheet are called:

(n) Cells (h) Molecules
(¢) Atomy (d) Nucleus |

§1.2. TWPRT Aot Ryl AT

woagEL U Teagleen foarn 0t fafver v o shom % g wr e ) f¥ w8 Ty o
FHAT B

“A computer is an electronic device that can perform a variety of operations in accordance with a
set of instructions called prograrm.”

A W, FP 7 2R G ) A A 0 A D access (TE TN) A4 process fEm
A THA B TR A Aid) e aa Information T % TR #, TR process B TEA £, A
A results A1 777 %7 A1 #1 A7 computer F1 Data processor F T A Use f&m 7w #1

i, o F A Data A0 Information T T 2R M fE en 50 ATE e v
TN A=A B Data A0 Information 71 ¥ £7

Data—3%z1 @1 add Raw fucts A41 Figures 71 #1 &-Rajeev, 1983, ~159, 723.6, Sunaina,
‘B’ #fE Data #1 Dats B Process % Information TA 30 1 TwA #1

“The raw facts and figures are called data. "

Information—%121 %1 Process HT1 % a7 3 99 0 §, 061 G290 @ Information FHA
f amh Meaningful Data Zflﬂh‘ Data T f feft 7 faeft =g T Nﬂqﬂi !7!, Information FRETAT
1z Rajeev was born in 1983, 7% Y% Information &1 Rajeey got *B' grade in Mathematics
ax & Information %1 Rajeey nnd Sunalna live In Gornkhpur 7% ft & Information )

“Information is what we got after processing the data e, Meaningful data is known as information,
Data are aggregated and swmmarized in varions meaningful ways to fornt information. ™
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3@: WA § 39 A% FOF @ f& Computer & Inpuit | 3 fem ST R, AT data AW Output W 5
e T g T lnfnrmuhunﬁl A W B F T, @ data F AN fFE Saed W m A e e
(raw material) F TE TAH A £ 41 Information 1 37 factory § AR 311 T I (Product) )
q® A TF4 € Dota F Information ¥ FZ& F1 9661 Information Processing Cycle FHeem f{,
FYe, WAE @ 3MEEYE (Input. Process and Outpul) —FIoRT 1 Input, Process 91 Outpuy
s vt W FE AR M F S A S s € e R W el fame, g
IS T eI A TR A4 AT A N FE E—
(i) = @i fF 39 S =9 Decorate T (W FOA1) T 81 ST Market W Flowers,
posters 91 Decorative items (WA qWE) = '(! AT FTH Room F Decorate F ] 7
98 Input, Process A1 A8 F41 §02 Input F 319 § 6 39 =1 w07 98 ©, 9 o o
Ecize R ESaC 2. YT FT E=R Decorate F1 Fl T3 Process F1 319 'E-’ fs arsa o F1-
w0 59 T, T 79 TR A Process § 9@ Decorative SIHA T F fofdl AT ST
T TR T A | OQuiput T 319 % fF 9Rom (Result) 391 537 1 fF 59 3939 ¥ Result
% 3TTH Decorate 41 &31 room |

(ii) ¥ TF 37 IR 4 ¢ A A w9 B 9 1 el  SAR 0 H
M TR T THTH FAQ WAl T 37 T % T Input T €2 Process T & a9 Output
1 82
Input— T 39 T2 WE =1 39 7 55 qH H el
Process— 39 WiE &1 29 T Go&t HER @HI
Result—3T0F 9 1 FHYE TG

(iii) Toam we—am =i fE o9 o fird @ F W[ w1 9 €1 3 She R firem
3 IHY AW | TR Y2 Process § F™IYE F-F1 22

T ST A TE W € fEdl w9 w0 T o0 9 SavEs & 9% Input FEd €, I Actual
Work 31aiq anafas w1 f&a1 9 € 37 Process &4 € a4 Sl Final result e 21 €, 38 AR FEd
R 3, T 9@ S Work T § @1 T Input-Process-Output Cycle 8 Short # IPO %% H&d €
foraf=m Tt &1 Cor'npulcr‘ﬁ T TFR w1 F:A %I TR W HTa %, erec ol Processing STl % aq

APER FeH A B

A T
(i) What is data?
(ii) What is information?
(ili) What is process?
(iv) Which of the following statement is true—
(a) Data is processed to get information.
(b) Information is processed to get data.

(v) The full name of CPU is woeenriinsnnns
(vi) 32 & processing FTH WA T & AW T€ information NTER processing & Tord &
Eacild

fafrm et @ wpe wezasd 9

[T ¥ FrfET T2 (Functional Components of a Computer) :

S fF st AT 2T R FwE AT wE #T 7 INPUT-PROCESS-OUTPUT CYCLE #1
Follow 1 &, 3. FO[27 H 1% Input unit T 2, Processing F74 79 Central Processing Unit 1 CPU
1 & W Output FF 7 Output Unit 711 #1 #7; Computer T block diagram 73 1.1 % 7= )
Input data 741 Processing 7 T Intermediate data 512 T Storage 77 Fo7Z T Memory 711 #1

Central
Input ¢ Output
(Keyboard | —» Pmumslsmg —|  (Monitor,
mouse elc.) © ;;J ) Pnnter ete )

Main
memory

a7 1.1—Block diagram of a Computer

e iz (Input Unit)—F7J2L 1 Data input #7F £ FE Input Devices FIZ 3 Auached
ot £ S Keyboard, mouse. magnetic ink character reader (MICR), optical mark reader (OMR).optical
character reader (OCR), Joystick #nfe &1 faf=t &1 # FW27 § Data input 774 79 Use f71 = i

FT[E IR 7 Hel user § TG W FI €, Afew F9H 7 forms (FF) B Conven T T 2.
S fif FE BT B S FHI TE A1 A w5l a7e A 9 e % w542 59 Binary W (FEA
1 wa1 0 Ft W) FeRET machine language i %1 Sl ¥ €1 WA € 3 TEAA € 5747 ON/OFF 71 High/
low a1 1 i 0 Sl 3W: user @ Ww SAYE &1 Binary language ¥ Convert %1 Input unit F1 &
ot <t 21

“An Input unit takes the input from the user and converts it into binary form so that it can be
understood by the computer.”

34, FTYA &I TI9E W & 941 Instructions &3 9 & @91 39 instructions F1 follow FTd TE T
FTR BRI data F processing F I &1 ITER: AR 3 FLR F w1 5 59 6 F add F,
W 59 6 data & 991 add TF instruction € UH &, e 39T F7FR ShE T Rajeev Print FL11 i@
‘Rajeev* data & 7o ‘iz 1" Print Instruction! 37 39 43 78 Farsd fe fvoei @0 § 5 7 example
#3 consider Y &, SWH data T €, 941 instruction T &

ﬁ'E_?I‘ wafgT q;ﬁrz (Central Processing Unit)—Central processing unit @ CPU F7=Z&T =1
control center aizrhm feAm B &1 9% computer £l guide. direct 991 govern Il HEGR 5
AR F Y Fgd A T TG o =T F @i CPU FFGE & Brain FE WA € fag w6l =9
1 Decision making power (Frofar <01 =1 erman) 76 €6 A A 3 w1 1Q T ] FEGT N THF
step o user BRI f28 T instruction @ program F & follow HTal & qE |l FUIG user BT 24 9 S
(Fri) & arqem & o &1 fT instruction 3 programs & CPU $ 78 & T&a 37 e 39=
FI g O @ T 1 o FON € I IAF fA SR computer F instructions T &M A program
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7331 ¥I1 computer ® fA7 8 propramms computer 1 9§ d  fo computer ATA TFHA #)
2. e A AT v W Awar) v A computer language W TEA § qm programs fTE Ty
7,k s oz ® R W wem TEd Y CpUE @ Components B & =1 fer Fafsr=y vhawry Eac]
#—Control unit T CU 2 Arthmetic logic unit (3491 ALU)

ufrofrs am @AE g2 (Arithmetic and Logic Unit is ALU)— Arithmetic operations
Ay TR Operations T plus, minus, mulbply 39 dividel 381 TR Logical operations sfy
AHF operanony FE TFE F qvm w FR w@ a9 operations HT AND, OR, NOTI TS F
ALU Arithmetic 3 logic 770 &1 57, 7 ¥ fa# data W logic T Arithmetic operations %1 9 #
M A7 datas memory A ALU 8 591 7m0 & @fF ALU required operation #1 perform FF results F
Eukesd memaory 0z zm P

T WA Jogical operations A Comparision < , >, = =, <=, >=, < > 1% operations ¥ 121§
Memory R ALU B &30 711 7 A7 logic operation F1 result 51 % True/False, 21 1/0F form § ¥
t memaory 7 w3 fra w2

2 332 (Control Unit or CU—F=/ unit (3mt Frsm 3o¥) #9et & daa 7
information ¥ interpretation flow 39 manipulation F1 control & guide HTA i Iﬁﬂ'ii[w I frg
sequence (F78) B F0 F7 £, f#% 7 =0 F F0 €, §93 509 €, 7 79 monitoring control unit
&7 7 #1 ALU B %1 7 9 CU 351 Control signals 591 1 38t wam0 program exccution
F T control unit program F F instructions F1 one by one (TH-TF FTF) execute FTA 21

AT F77 | ALU 371 CU 1 single 99 W Integrate %% fean € aan 9 fam (=147 ICs)
Micro processors 7 "Zl"f'l {uP) FrE %l

FIZTYZ Y2 (Output Unit)—F2T A 13292 W 5731 ¥ F¢ 2Meeqe feamim (i Aeege
) W T A Anached (F2) 764 €1 CPUH o1 76l SMSZYE electronic binary form 3 T
# form 7 77 form # conven F1 T ¥ € 91 user BT STEHT | WO W1 FH i Characters,
graphical, audio visual 1121 7% ¥ Output Unit 8111 fa1 =@ €1 Output Unit 3 ISeXwl §—VDU
(Visual Display unit) 71 Monitor, Printer, Plotter, Coder, Speech Synthesizer 3IfGI

0l (Memory)—F™7z % =1, YW 3 Information ® =W FQ ¥ FOR H AR
Semiconductor memory 7T % 771 7€ data F1 Binary form Hi @18 1 3% 0% form § =R &6 81
Binary digits 71 short @ bits F¥1 ST 1 UF bit 1 store F ¥ T flip flop 1 use B & (Fig. 1.2)
flip flop 1 electronic circuit 191 21 5; bit 1 A4 T & 141 01 Flip flop % group # register &l
0 £1 8 but TG byte FEAT £ AT 4 bit F TGE nibble FEAM 21 Bits F TYE word T &
'ﬂﬂh 1 register [ UF word store 1 %1 afz word size 4 bit % E'ice memory T 4 bit F 512 word store
F3 F) g # @ AT F size TN 512 x 4 bits) 2 HHR B W B AN uh qgriAen ARG
(Multistoreyed Building) ¥ 7R 7R 7%a 1 fama 94 floor ¥ 4 7 8 FW & w1 TH =% Floors €1

For example: If the memory size is specified as 1024 x 8 bits, this means that word size is 8 bits and the
memorty is capable of storing 1024 words, each of bit size 8.

fafi st 3 wpey w11
W zer0
71 one storo
s om@/ wm #
ik [ o @
input
K I A I O A O

(a) Symbol of fiip flop (Mip flop in an electronic (b) Aregister s a group of flip flops which sicre
clrcult which can use on binary digit (bit) l.e. a sot of bits called a binary word
1or0 "

last
location

1023 1]0]1[1i1|1|o]0

(c) Asemiconductor memory is a group of registers and its size is specified as rumber of binary words i can
store for example this memory can store 1024 x 8 bits ( means 1024 worc's of word size 8 sach)

fa# 1.2—Memory organisation in a Comput

313%#1‘ qT WA (Hardware and Software) :

AT (Hardware)—%PZeX & ¢ 92% Components f37%1 Z@1 am =9 (Touch) f= =1 T%a
2, Hardware F&eTd € #19fq Hardware represents the physical and tangible components of the computer
that can be seen and touched. In short, we can say that the electronic, electrical and mechanical equipments
that make a computer is called hardware 3187q Input devices, output devices. CPU, Floppy disc, Hard
disc TR T TN FTX QLA F 4o 7 A 2

ERETEH (Peripherals)—F = F s § T3 external hardware units 5 keyboard. mouse,
speakers, printers, monitors & peripherals FEH €1 ¥8 components software % T8 et
Calculations %% i, data &1 organise F1 § 791 gL computers § communication 773 § ReTaF 71 #1

WFATT (Software)—FFd Fw ¥ fag wumdi =1 TR W FIXR F software FEA T ie.

software represents the set of programs that govern the operation of a computer system and make the
hardware run.

WA i B fR W e d—
(i) Operating system
(ii) Language Processors
(iii) Application software
TR w99 —Without software, o computer will be of no use. Do you agree? @y fam

Software & computer hardware &t & Q!ﬂ w ffr @ i, ¥ e ww HE R
N I wewa 87
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aigifen fasm (Operating System)
sicfen frem s Fhm 8 9 f6 user T hardware & WOT Interface (1@ Torv)

w wrd ¥
v eperating svstem is a program which acts as an interface between a

wrer andd the hardware”
HA operating wystem B fam ey A ad o and F W T@ T e

yifgtfen finem w0271 1 UE nrErg w2 § @ fe Rae pal % 3= e W
faymm mrd s T E A g ¢ —wEam, siifin fawm,
et e (a3 ) FIHRT N Basic computing wmutcc\"{ﬂﬁ F.

apphication program rontines AT users mm|ml itions problems solve w1 i 1.3—Operating
10 compuiter resourves T utize fam s & am ammifen fm?fi application gy tem®s role In
program & hardware F use B control 87 coordinate ® W €1 FH @ T TG Computer System
® % user AR "l‘l‘l‘\""“" program un Fa T " A Ta WA B oA F F UEER & 3T
=i ufiod B owemfaa ©R§ PTEET @ ®ie @ coordinate T W1 T operating system B8R fFm
A 1 operating system T F TERR W uscable ( TRIE F A) T € 3W: operating
system W T3 program € 9 & hardware #1 uscable T R An operating system may also be defined
as st of programs that controls the computer. Some examples of operating systems are MSDOS, MS
Windows. UNIN, VMS. Chicago cle.
ST A oA T @ s fem e aeege w0 e d—
(1) Provide the INMTUCHONS 1o prepare user interface 3191 user W1 computer & W& interaction
(menE ) werd WA ¢ fF & IR user computer ¥ communicate X (typed commands T
@ Graphical symbols ZT0)t
(i1) Loads necessary programs into the computer memory which are required for proper computer
functioning 391 computer F1 start F13 F =T 7 WA program S & computer  functioning
% ferd smmems € €, SR sqien fawm g s W
(iii) Coordinates how programs work with CPU, keyboard. mouse, printer and other hardware as
well as with other sofiware. 87 programs @ computer hardware T4l 37 Software % =
e wafea w
(iv) Manages the way in which the information is stored on and retrieved from the disks 4fq
disk?? 51 TRNFTI W disk B I Q@ F F T management FI
Operating System F¥ YR & T ] Single user OS TF user F support HT €, multiuser OS T
users ® support F4 &1 Batch processing OS jobs of batches 314fq groups 1 process HT #
Multiprocessing OS T CPU’s 1 & W9 Handle T 11 HeM €11 81

ﬁW T (Language Processors):

W YW 59 Programs 1 high level language HLL's ¥ faaa & ==iifs & languages ¥ code
(coding BEGH i el @ s 1 m fama) w=n S{EIH@H A T él e FER Fad machine
language S & binury 3197 | 90 0 % w9 A €6 & T € 8@ FORT High level language 378 C,
C++, Java 507z 1 fered st @ fl wew W 4 @@ Som machine language B 45H faa Sam1 9%

fif e & g w13

S S0 FE L binary form B #7001 2 (anguage processors 7 21 Language processors T273:
@ wE & T E—Assemblers, € “ompilers 991 anterpreters

(1) Fwrgerd |Lumpllcrs)-—rump.lcn ar M 713 2 M fF High level language program Eal
machine I.mg_lmycm A convert 74 # A7 T High l.mguug: program & 1 TF # A0 8 Convert ¢
) & am IR errors A report 1 24 #1 24 crrors F1 HHE correct F 7 2, Am T3F A AW T
compile fFa1 FmT #1 S T crrors TAIH F1 A # 61 77 GO F UF object program Binary 71 s ]
T € TR A memory Ll Compiler F1 remove fFm =1 7w 21

(h) xﬂﬁﬂ' (Interpreter)—Interpreter 1 high level language F1 machine language T Convent
T # f T line by line conversion a1 21 7z f7 line § F1¢ error fem 2 gd T reporting T4l
2, @9 WA T crror F correct FA 71 IAF AR @ AA A F conversion T E1

(iii) @W (Assembler)—Assemblers Assembly language programs #1 machine language &
convert ST €l Assembly language program RHA: mlcroprocessors? fog e = % A4 English
like letters /@@ Mnemonics (FHIFE) 21 971 &, F form § &4 21

A Compiler checks the entire program written by user and if it is free from eror and mistakes then
produces a complele program in Machine language known as object program. But if it founds some
error in program then it does not execute the single statement of the program. So compiler translare
whole program in Machine language before it starts execution.

Interpreters translates one statement at a time (i.e. line by line) and if it is error free then executes
that statement. This continues till the last statement in the program has been translated and executed.
Thus Interpreter translates and executes the statement before it goes to next statement. When it found
some error in statement it will immediately stop the execution of the program.

Error finding is much easier in Interpreter because it checks and executes each statement at a time.
So wherever it fine some error it will stop the execution. Where Compiler first check all the statement
for error and provide lists of all the errors in the program.

Interpreter take more time for the execution of a program compared to Coripilers because it translates
and executes each statement one by one.

UEHIHYA WA (Application Software) :

mﬁmpmgmmsmmﬁm%ﬁ}ﬁ?ﬁ?ﬁmmaﬁm operation
ot w1

"“An application software is a set of programs necessary to carry out operations for specific
applications.”

a7d: Weldw application % AT 31@M Software i €1 SeEm: library management ¥ software F1
Hotel management & e use T8 f&@ <M & @9 Hotel management % software 3 library
manngcmentﬁw‘ fer use &l a1 S T | 3 WAF application % requirements F = § = Ei!
software engineers 371 mquimmenzs% STTHR 39 particular application %ﬁ application software design
W 2

THFIA AR 1 Feae aiigd &9 1 Foa g—

Customized Application Software—-3€ user F requirement F TTAR tailor-made software 2t
Rl 3: user BWI specify ¢ T requirements g qU 21 . 7 fe {H\I user F work place
W directly install T fFar 1 werm =l € W ¢ 5 TR user F requirements & user R



&3 &% particular customize application software develope fFm o 2, & = @ oam new user %
requirements F 3ET T oftware fit T F23 8
General Application Software—f%1 ¥4 %1 74 9 general requirements (FT=1 sTavaFasi)
F v & 757 T general application software design fF9 T € AR T users use T T §)
7, BF a7 @, §F 7 S = Customized Application Software 75 General application softwars
> &7 39 7 o= B £ 3 o9 a1 59 TS Ve A9 readvmade TS @ §iT ¢ a9 ot vy

15T GFY 74 F9w a9 T3 [RE F 53R 9L e § T readvmade garments TF 3 user
7 general requirements ¥ 97 T IEFT 7S S8 B 7 9 SeET &7

Gl

4

Some important examples of Applications Software—

(i1) Financial accounting
(iv) Medical field

(v1) Billing software etc.

faer

(i) sTET faem =@ €W £ TS vow e = oen 87
(ii) Compiler & Interpreter ¥ =T F=T BT 87

(iii) Compiler & Assembler § &1 3= g1 27

(iv) 7= ¥ Hardware 91 Software Bifzd-

(1) Inventory Control
(ii1) Railway reservation
(v) Results preparation

(a) Memory (b) Motherboard (c) Power Supply
(d) Windows (e) Compiler () Assembler
(g) Interpreter (h) MS-Office (i) MS-DOS

() Mouse (k) Keyboard (I) Printer

(m) Monitor (n) C-program (0) Unix

(p) Linux (q) CPU (r) Joystick

(s) Visual Basic (t) Java (u) Fortran

(v) BASIC (w) HTML (x) Modem

(¥) Pen drive (z) Hard Disk Drive (HDD)
) = & & ¥F-w sw smg i—
(a) Computer High level language &l ¥e Q&
(h) Compiler T TAT Hardware device gAfs High level language ¥ fr@ wa program
F machine level binary language & change & a1 &1
(c) MS-office T& application software g1
(d) DOS CUI operating system & S&f& Windows GUI operating system g1

Eﬂqa'f @t Strength TAT Weaknesses (Strength and Weaknesses of a Computer) :
fsmn, feomefm e v @ i & woog o i faon v
m&aﬁiﬁaﬁm;ﬁmw%wmm%—
1 ?ﬂzﬁspew)—mﬁﬁmmmﬁa@mméumﬁmwwm
W @ instructions excute FX T4 8l

fafaa i § wpE wieaaE 1S

(ify 353 TR &HER (High Storage Capacity) —FT72 F memory T 778 F1 space #aE
HTF Information store F1 1 TF41 21 i
(iii) f@vasfaa (Reliability)—%952 %1 %17 M boredom 7 ¥ #1 % Human beings &
=@ reliable (9 favaadia) &m #)
(iv) URYREAT (Accurncy)—FF7[21 FNTF accuracy ¥ F1f F1 T ¥
(v) TR (Versality)—F™[z7 #rwasien @13 #1 Hazardous environment ( FATATE A0
& Human beings ¥ fet mwa 81 7w €, F99924 instal F76 w0 fam sn F=m #) FEE
graphic audio, visual 3¢ information ®1 % provide F¥ TFa B
FOEH F T A AN T F AES FgE F F9 FEd 0 § HH—
(i) Lack of decision making power.
(i) Zero IQ
@ FEH ¥ T @ decision (Ff7) &7 %1 e Edt € 991 T @1 3721 73 A9 1Q (FegT) T
21 e A FW TR AU BR A TR step B W 3% T4 TEA1 B1 3: WA 7 HOGI T 9EY A9
Wﬂﬁ%fﬁmﬂmmﬁm%m%ﬁﬁﬁﬁﬁmﬁ 1Q 71 decision making
power’lﬁ @ | e, programs & W 3:‘“112‘\‘1 1 instructions <41 Al £ a9 =z F =4 =
Wi ?1 A TR FRI Programming languages €, 31 fF TF software engineer 31 S vz £ 39
languages ¥ Data types, statements, syntax 39 579 e &l 97, 79 @& 31 & A9 $wH 5@ g ag
A o Freped | Fid wd wa | T Iangunge?ﬂ@e{i‘{ SMTHT proper syneax (fFH 9 Frg=t
W1 1 grammar (4T ST ) IAH syntax FEET ) FaFeTd i vgd € FFF 393 52 program
ferr % ot |l 5t error R, W compiler SHH! TE A TR (AW ervor T W) I program run
T/ I IR

ﬂgﬂﬂ'{' e Aiveaa] (Hardware and Software) :

ST B I TW 96 A confusion WA € fF SR TSR a9 WA T ¥ SR 21 9rF 4,
FR F TN F IgH HEIR § 76 TH ¥ 40 fF 7R F o T wew 59 9w § #) s
TR AT F IR IFH T F TR G-I F 06 $0 96 @ 9w, w56 TwR SRaw F
FR T EETR N TF WR F T F wun @ 2, g warg) w1 a=w ¥ faw s ok 9% swm
@ 8

HeEa w1 A Fvget fIRA & physical components & § ot st WRfET g W
Torar s &1

“Hardware refers to the physical components of a computer system (electronic or electrical) which
are used for processing data.”

AEEAT A WA §EEVTH (IRTH) T UE complete set AN & W R W g1 v
W § i it weraer ¥ et fH problem FY solve FaT #1

“A software or a program can be defined as complete set of written instructions by the programmer
which enables the computer to obtain the solution of a problem (with or without data). Software is a
general term that is used to describe any single program or group of programs. ™
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[IFET F WS (Types of Software) :
i o wEm R weRE 1 FeeRed B O software F qEEm: d7 AfE A fawf
frm = T E—
(1) fr=m TiezEm (System Software)
(i) T WwEA (Utility Software)

faem wieeda (System Software)

frprzn iwedT B 4% @ W, languages A9 documentation ¥ ¥ S fF FPoET F fmim
(manufacturer) 810 T fFm AW €1 TE W user B FEER | communicate FH H TETHA T
¥ AW T &R ST SRS W wnie FOTEA € TR software  FW A Had mmpulcr'@ﬁt use AT
WEE T WA ¢, AeF TR F TEam SE (resources of the hardware) F Wl T 2argds
(eMicicnt) M TN &1 = 1 fen Wigeaa & W €1 § i S # permanently stored B
2 fF 7§99 programmer (G user) F FE Hrwe 7 (mundane tasks) @ T e € afew
resource utilization % improvement f +f FEEw w1 €

T AT F A user §W ST application software develop fFa1 W1 v @ €1 fawen
AT F1fF particular computer F o specifically ff@ S #1 37:, fa W proper modification
F, T TR SR U WA R 9 wSE @ e

TwiteyA wireaat (Application Software)

TSV AT i S T S S € S fF user W 9 specific functions F perform F
¥ Y= fh w217 s Freifa task G 39 develop Rl i &1 F A Aifordt ¥ fawnfoa fermn
o T E—

(i) Specific or Customised Program 19 & S < i firell ferdiy i 2 ford wmt € eeevm:

ST AR FHEM F marksheet T 7Y FE FmW feran €, 4 Indian Railways T reservation
#q feren T ¥ = fFE Businessman # inventory control ¥ fEr@1 man s swf) A
w1 e a5 ¢ 5 53 Tmm W) foee user afed w1 w1 ol W wwa €
(ii) Standard Application Sofiware 387 F& W9 1 S f ready to use T & aa1 g TN F
common problems T serve T iﬁ ferd M %1 9% standard software B § 991 379 users
T T T B € TIROR: pay roll packages, accounting packages, traffic control, Educational
softwares, Library Management Softwares k|
afz 3 & TR A A W § fF g Software I Libraries T catalogue @M, Books

issue 1 data maintain F73 ¥q H99E PN 3, F1E M institute T Library 87 38 A H
Tie TEA €1 o, W & fF 9w specific @ customised software f&Ht fo@iT user it wmnf=rd
FTA €, FF Standard Application Software T 2171 user sf=m e gl

(i) General Application Software or Programs &1 Al 39 S 4 € S fw mEhe § manuals F
MY TGS TeA B 77 softwares F users F1 T TEA AUF T2 TR €1 IIE0E: MS word,
MS Exel, Computer Games Software, DMBS (Database Management System) packages ECl
foxpro 32| Af2 HMTH work processing STME F1 & FA & T MS Word use I &4 €,
spread sheet use FCH % @ Excel use F T & 3ol

(i) TR Feadt (Application Soflware)

—

i —

foafre geifrafn 4 v At 17

AR AiozdaT (Utllity Software)

AT wiweda aw Application Soflware 7 System Software BRt 2 9 fF 7@ program F
developement 1 STHT W A A1 21 32vma:, fFe T 71 logarithm M square root 37712 1
O R T S A STECTR fF Application Software ¥ development F HRA Ug FEAl €1 THI
W™ Utility Program SHeetl 21 Utility Software #1 data transfer 79 ( #4Iq tape-to-tape, tape-to-disk.
card-to-tape T tape-to-printer ctc.) ¥ faa 1 7 #1 371 GEAAA T F7 sormerge TAA F
TR & records F sorting. files # merging, files 1 updating 37 F1 W TEA 21

Windows :

Operating System & &1 I ¥ §—Kemel 797 Shell. Kemel ¥ hardware & interact 57 £ Fa(®
shell T user ¥ interact &Tdl €1 Shell TF command interpreter € =1 user & command W4 F3d : &
I interpretation (3¢ FIHIEFT) FTa1 € 991 H ATAT action 7 21 user AT computer 7= H 73
SR Interact T4 &, S Interface Tl A €1 9% user E keyboard 97 2159 %1% commands =
Wi € 1 9€ CUI Mgl character user interface Fe@ml ¢ #8 DOS! 3@ user mouse click B
commands ¥ € & ¥ GUI 4 graphical user interface FEaal % &7 % windows,

“GUI (Graphical User Interface) based operating system have shells that offer Graphical elements
for interaction betwen computer hardware and user.”

Windows % =R & eyl A freaq e—
o Windows XPU% GUI based 3ifqifen faeem &, a1 398 fafit=t Windows T multiple applications
TF W9 run T €
o 3 el T Window open T4 W HWA 36 €, fT@ W icons display € ¥, desktop FEel
2
Window T& rectangular area #, 5 81 application a1 document 41 dialog & F=ifea € €1
Icon TF graphical ¥ (symbol) €1 & S fFE window element (file, folder A shortcut) &
represent (RT) HIAT ?
Operating System %I computer Ft memory # load T booting HEwldl %l
Windows XP is a GUI based operating system. In windows operating system, multiple applications
can be simultaneously run in different windows.
o In Windows XP, the screen upon which icons, windows, etc. are displayed is known as desktop.
® A window is a rectangular area pertaining to an application or a document or a dialog.
e An icon (3Tg%)is a graphic symbol that represents a window element like file, folder or
shortcut.

o Loading up of operating system files into the computer’s memory is called booting up (gfem).

e We can cxplore your computer through Start button & Taskbar, My Computer and window
Explorer. The Taskbar is a bar, which is usually at the bottom of the screen. The Start button is
located at taskbar. By clicking at Start button, Start menu appears wherefrom you can start
programs, open documents, customize your system, get help, search for items on your computer
and more. My Computer is uscful for viewing the contents of a single folder or drive. Windows
Explorer is another way of seeing what is on your computer. Windows explorer shows the
computer’ contents as a hiczarchy.
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o A folder (TPEL) o location i which you can store (iles and other folders
o Tocreate nonew folder, Pile New Folder commands are elicked i My Computer window,
To find files or folders, Start Find Files or Polder commands are clicked.

To move i file, the file 1con or name e firstly selected, then Edit Cut commands are clicked,
Then the destinntion folder s opened in n My Computer window and there Fdit Copy command
15 chicked Then the destination folder i opened in a My Computer window, and there it
PPaste commands are clicked

To create a shoncut to a file, firstly select the file or folder, whosw shorteul is 10 be creted,
Then drag the file icon through nght mouse button 1o desired location where shorteut iu to be
placed. And then select Create Shorteut(s)

To shut down the computer (P22 %) W2-EA W #7), Start Turn OfT Computer commnndy
are clicked.

2 gfwdl (Input Devices) :
T A &) Input T 7 W A Inpun i wrend #1 fafie inpun i e e

¥ Keyboard:

o e & w nm b (faa 14

¢ W2 Keyboard 7 key L3l press Fa tm ey
electronic signal U1 310 £ 9 bit patiemn (1 74 0
W) N conven V1 W £

s Keyhoards #1 ASCII (America Standard Code for
Information Interchange) 1 7 fam amm

* Keyboards 7 =g, arardfzas am v Yo
7 keys o £

o A T Keyboards QWERTY Keyboards #100 # F5F0 &-bit 1 code w4t 256 whpzf K
fat e Bo o) TR FW e Keys 7 A9l W SQWERTY" B )

o Setof typewriter—like keys that enables you to enter data into computer and other devices,

o Standard layout of leticrs, numbers, and puctuation Is known as 4 QWERTY keyboard because the
Sirst six keys on the top row of letters spell QWERTY.

¢ Keys typically found on computer keyboards are:

o Alphanumerle keys: The letters and monbers on the keyboard,

 Punctuntion keyw: The comma, pertod, semicolon, and simitlar keys.

o Spectal keys: This inclides the function keys, control keys, arrow keys, caps lock key, and so on,

¥ Mouse:

o Wrn vw e fomen £ (73 1.4) a9 Screen % Pointer 31 control T B
* T UE palm size device B (7 o i Tmew i o)

o T Ball w1 7 v £

o W W A e g g W vl 2w wa o Seroll wheel Bl 81

-

fux 1. 4—m)-uné e wram

frfrer eotfnfin 8 s atwzaned 19

o 50 Mowse 00 Pl mue wt gove fea s & av pall ol wedl & (0 pointes W scecen ™ move
e 1 e apthons 70 seloc (a1 B

o 000 kelect B shogle click, sty M welect a4 open Wt i’.'[ double chick A7 Window #1
move W i'.il dragy operitlon 1 /fat famn s R

o Optical motse LED lght @1 73 220 & W4l Laser mowse Laser @wa ar qar it b

o A polnting device that detects two-dimenstonal motton relative 1o a surfuce

o Motlon Is translated into the motlon of a polnter on o display, which allows a smooth control of the
sraphical wser intesface,

o Controls the motienr of a pointer in two dimensions in a grophical user interface (GUI)

o Turns meventents of the hanel baclward and forward, left and right into equivalent electronic signals
that b tusn are wsed 1o move the potnter.

o felative movemems of the mouse on the surface are applied to the position of the pownter on the
sereen, which signals the point where actlons of the user take place, so that the hand movements are
repllcated iy the pointer,

o Comrols the movement of the cursor or poluter on a display screen.

o A small object you can roll along a hard, flat surface,

o Name derived from its shape, which looks a bit like a mouse, its connecting wire can be imagined 10
be the mouse's 1ail,

o As the mouse s moved , the poluter on the display screen moves in the same direction

o Mcchanlenl: Has a rblier or metal batl on its underside that can roll in all directions. Mechanical
sensors within the mouwse desect the divection the ball is rotling and move the screen pointer accordingly.

o Optomechanienls Same as a mechanical mowse, bt uses optical sensors to detec: motion of the
ball,

e Optical: Uses a laser 1o detect the mouse's movement, have no meehanical moving perrts, respond
maore quickly and precisely but they are more expensive,

» Tracker Ball:

* UL UE upside down mouse (S5 monse 7 37 TR A
7 ) (firg 1.5)

o TN ball @ rotate R smn $ S@fE mouse W W fom TEW
£

o 6w S dm f

DO 2] video games, Loptops senfe 3t 7 faan wmm t

& Apointtug device consisting of a ball held by a soc ket containing 2
setsons to deteer a rotation of the ball about nwo axes-like an
upsice-down mowse with an cxposed protruding ball, fam 1,537 o

o User rolls the batl with the thumb, fingers, or the palm of the hand to move o pointer.

> Joystick:

b U UE pointing device & (RT3 1,6)1

T video games 7 71 faan s




0 ffve AT ¥ RREE ST
SO & TR Robots  control 70 39 I8 frn wma &

An inpur device consisting of a stick that pivots on a base and
reports its angle or direction 1o the device it is controlling.

Similar to a mouse, except that with a mouse the cursor stops
moving as soon as you stop moving the mouse.

The pointer continues moving in the direction the joystick is
pointing.

To siop the pointer, joystick must be returned to its upright
position.

Used mostly for computer games, but also for CAD/CAM systems
and other applications.

» Touch Screen:

Tax 1.6—wfafes
o 7% T U8 WER F) Screen ¥ & I @l ¥ wft WA (Touch sensitive) Bt 21

o T Screen W Option Select &1 ¥g Iw fFaT ST 2

o Touch Screen, ATM. Mobilephone. restaurents s ¥ = gt &

A computer display screen that is also an input device.

o Screens are sensifive to pressure; a user interacts with the computer by touching pictures or words on
the screen.

Aninput device normally layered on the top of an electronic visual display of an information processing
system.

3

Touchscreen technology makes it possible to interact with a computer system using direct touch of
the electronic display instead of using a traditional keyboard and mouse.

Types of touch screen technology are: Resistive: coated with a thin metallic electrically conductive
and resistive layer that causes a change in the electrical current which is registered as a touch event
and sent to the controller for processing. Surface wave: uses ultrasonic waves that pass over the
touch screen panel. Capacitive: coated with a material that stores electrical charges.

» Light Pen:

o Hﬁ\?ﬁfm @ Architect (@) g1 47 fFa1 Sen &1 390 TF Light sensitive (S ¥ i
THAETHA) cell T IR G € TR FER Screen A position indicate T ST 21

o THH operate 4 ¥ pen H screen A touch FAN T B

* TEH! CAD (¥R TR festid) srpwdnii ¥ 9 f&a S 21

Aninput device that utilizes a light-sensitive detector to select objec:s on a display screen.

Sllmrlar to a mouse, except that with a light pen you can move the pointer and select objects on the
display screen by directly pointing 10 the objects with the pen.

A light sensitive input device used in conjunction with a computer's CRT display.

Aflow_s the user ro palir'u to displayed objects or draw on the screen in a similar way to a touchscreen
but with greater positional accuracy. ’

» Bar Code Reader:

* Bar code el T #1 U AvR € € (Fa 1.7(a)) o) Sirer fm-fir 8t 21 98 7% 3R W
Printed g1 21

fufrer vohfrafon § w21

o Bar code reader bar code H I F decode w1 ¢ (Fra 1.7(b)1

I

(b) W &T

(n) U I B3

fax 1.7
o TE T SAFC AT T TS T & A bar code image H THTHT AT Tt B
Bar code F light detector 54 T 1 eM H@ 2l
Bar code ® Libraries, Books, S, Speed post G 3rrl it # 7w fma wma 1
Barcode is an optical machine-readable representation of data relating to the object to which it is
attached(a small image of lines (bars) and spaces that is affixed to retail store items, identification
cards, and postal mail(speed posts and registerd posis eic.) 1o identifv a particular product number
orlocation). A barcode reader is an electronic device that can read and outpu printed barcodes to
a computer.
Consists of a light source, a lens and a light sensor translating optical impulses into electrical ones.
e Barcode readers contain decoder circuitry analyzing the barcode’s image data provided by the
sensor and sending the barcode’s content to the scanner's ontput port.
o A hand-held or stationary input device used to capture and read information contained in a bar
code.
e Consists of a scanner, a decoder and a cable used to connect the reader with a computer.

» Scanner:

o T text A picture F scan T 3 I RN T & TR TR computer F store A S THI

e Scanner fafirt 5@ & 31 # R fF Hand-held scanner, flat-bed scanner 31

Scanner is a device that captures images from photographic prints, posters, magazine pages. and
similar sources for computer editing and display.

Come in hand-held, feed-in, and flatbed types and for scanning black-and-white only. or color.

o Very high resolution scanners are used for scanning for high-resolution printing

o Lower resolution scaniers are sufficient for capturing images for computer display.

Optical Character Reader (OCR):

o Optical character recognition data ) input ¥ H T o faf 2 @Y scanner % WY-TY TF
fI9 software FT use FT@ & Wt i scanned image M ASCII code ¥ viafda & a1 &1

® 39 text A word processing software &R edit it foFm W wEW § =R ksscol picture 1 TE treat
T fra ST S text F E treat A ST R

o OCR & @M §—data entry IR & T B, peak loads ! handle T, Human readable ST
g



22 fafem GeifEfn A Wieeaw WM

OMR (Optical Mark Reader):

o OMR sheets & T & 3193 F16 G T A SUFR Tgfameda ST a1 Tl ¥ way yg,

frw W & am w5 faeey O TR B N W A e W e 9 @

Optical mark readers 31 marks (F11 f193) 1 sense 3 &) ¢ AU W ER TR checking 1 s

]

o T AN E IE ¢ T T2 99 W data T Landling 4 time, 4 cost W AW J € W &

Magnetic Ink Character Reader (MICR):

» MICR documents 1 directly Wg4 &1 &l T@dl & {573 characlers fiW Yor #t gemly wm)
(special magnetic ink) (Iron oxide based ink) g1 @ ™ @1 Kl

e TT scanning system cheques & processing %ﬂ Sfe foed g 1950's A faefam i mam

¢ 38 f=% § 9% # Bank. branch. account number 31T magnetic ink & printed i

o Costly. €11 €1 Very large scale applications ¥q @ S9g% &Rl 21

* I security

"

Microphone:

o 7 waf fard w1 Sgd ford ¥ e e gl
fefsrea &m:
» T froed =1 fefoea w9 & F9a axa 2

§1.3. AREBYS ?{ﬁiﬁ" (Output Devices) :
Tﬁmmmﬁhﬁhﬁmgﬁﬂmﬁﬂﬁm%nﬁfwmgﬁﬁ
v

Qutput Devices

— Monitor

Non
Impact Laser Printer
— Printer Printers
Inkjet Printer
—= Plotters

Impact Printers
Dot Matrix Printer
Character Printers

—— Spcakers

fafrm HEifehn ¥ sgm weaes 23

» afftet:

o TAH VDU (Video Display Unit) W %1 S €I

o THH WeTdd A results F screen W 2 = FFAT 21

o Monitors F1 size 38% diagonal (fa&vi) BT specify f#41 ¥/ 2 24iq 21 inch screen %7 diagonal
21 inch T 1 Emi

o Screen % Resolutions screen T pixels F1 He g fifa &6 21 @izt =1 fzes =791 dots §
fieret =1 B €, 9E dots picture clements 1 pixels T2 £)

. gisplay %4 CRT (Cathode Ray Tube) screen a1 LCD (Liquid Crystal Display ) screen X471 i =i

|

» firex

X F 510 fFH document F printout 814 g WA 341 @1 €1 Printout 31 document F1 hard
copy off S ST 81 Printer €1 ¥R % €A %—lmpacx printers 9 non-impact printers. Impact printers
paper W print ¥4 Y94 paper 1 T A & ValH non-impact printer. T =1 touch T =4I Dot
matrix printers (DMP) Daisy wheel printers @ Character printers impact printer %t Eok ok decod
inkjet 9 laser printers non-impact printers %1 9191 # & 1

2 fefem fwed (DMPs) :

o 3GY pins %! TR 4 ink ¥ coat &4 T4 ribbon T SR 1 Sl €, 7% ink ribbon & paper | TFHE
B W % 99 character paper T print € S €1

o 12 %t carbon copies ¥ & 1 Tl €1

o FH o

o Poor quality, very slow, very noisy, less resolution.

o R fie dva T

g&we fiied (Inkjet Printers) :

o Y paper T ink ¥ droplets (T ) F spray (fogam) == e fom wm &1

* T path Y=HE ©IZH F10 direct fha 1 g1 §1

o F AR F B & feed FFT I A printer head M TS (back and forth) W Fwa & foms T
T flﬁ ki droplets S spray S %I $ droplets F1 diameter ¥ F T (human hmrs)@ i
w5 B R

o TEH AFN, 300-600 dpi F image, office T8 home use ¥F T

¢ Slower than laser printers, more cartridge cost.

@ filed (Laser Printers) :
o e Sgfaml (static electricity) ¥ fa@m W smnft

o Laser ¥ WO & TR W positive charge I a1 I 8, @M fR paper W T (toner T ink
powder) F1 spray 1 a1 1 Ink F3@ T fawae @ 7@l positive charge 1 &1
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. T T 3 A fr e (35 oirwm 2 ¥ fRR), T resolution (6001200 dpi)
o ¥ F T2 Y woling ¥ T §E

o TET, carhon copies TR T8 § I wFA

o A printer (55 1.8 ) is a device thar accepts text and graphic output from a computer and transfers
the imformanon 10 paper, wswally 1o standand size sheets of paper.

fax 1.8 fi

® An exemal device that communicates with another digital device to print what a user sees on a

screen.

o Use small pixels to transfer an image from the system to another surface.

o A e ripheral which makes a persistent human readable representation of graphics or text on paper or
similar physical media.

e Laser prinier rapidly produces high gualiry text and graphics.

e Laser printers employ a xerographic printing process

¢ Inkjet printers operate by propeiling variably sized droplets of liquid ink onto almost any sized page.

¢ They are the most common type of computer printer used by consumers. printer is a piece of hardware
for a computer.

® Allows the user to print items on paper, such as letters and pictures.

> Wied (Plotters) :

. ;Tzﬁ%q:a?m;ﬁzi;g % Sl 37 T R drawings, images T graphics 31 hard copy

. Pl?nm?gmtﬁfﬁf—gﬂ?ﬁ?{(mﬁﬂaﬁmlaﬁngdmm‘l’{ mount fF W }), e AT
R (T TR F1 horizontal surface W fix FFm < 2), Teufa

> Wiwd (Speakers) :

* Speakers 3T signals 1 S signals ¥ F7a¢ 1 &)

o Frozd FEH A weEd 4 @ 3 i play FR 31

o S\!er;o speakers % <1 <770 ¥ ¥—Left channel 741 Right channel, f@ sound i arefass Wi
T =l

‘-E:-."‘? i

fofrar shfEfn # oy w25

$14. A4t @ wrifwTr (Classification of Memory) :
A w wllao frv t—

Memory

Internal memory or External memory or

Primary memory or Secondary memory or
Main memory Auxilliary memory

| o Magnetic —

Media ——= Hard Disk
RAM (Random
Access Memory) ‘——= PenDnive
t———= Opucal =
Meda [P
ROM (Read v
Only Memory) — DVD

' Blu-ray

o Computer memory is any physical device capable of storing information temporarily or pe rmanenily.
It is used to store data and instructions. Computer memory is the storage space in computer where
data is to be processed and instructions required for processing are stored. The memory is divided
into large number of small parts called cells. Memory is primarily of three types:

Q Cache Memory
Q Primary Memory/Main Memory
Q Secondary Memory

Cache Memory: Cache memory is a very high speed semiconductor memory which can speed up CPU.

It acts as a buffer benveen the CPU and main memory. It is used to hold those parts of data and

program which are most frequently used by CPU. The parts of data and programs are transferred from

disk to cache memory by operating system, from where CPU can access them.

o Faster than main memory.

Consumes less access time as compared to main memory.

Stores the program that can be executed within a short period of time.

Stores data for temporary use.

Has limited capacity.

Very expensive.

Primary Memory (Main Memory): Primary memory holds only those data and instructions on which
computer is currently working. It has limited capaciry and data is lost when power is swirched off. It is
generally made up of semiconductor device. It is divided into two subcategories RAM and ROM.

o Semi-onductor memories.

e Usually volatile, Data lost in case power is switched off.

o Working memory of the computer,Faster than secondary memories.
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Secondary Memory: [t ix slower than main memory. These are used for stoving dat/Informatigy,
permanently. CPU direct!y does not access these memories instead they are accessed via input-o,

! Pul-¢ nipy
routines. Contents of secondary memories are first transferred 10 main memory, and then CPU ¢qy
access it
¢ Known as backup memon
* Non-volanle. Data permanently stored even if power is switched off.

* Used for storage of data in a computer.

e Slower than priman memories

» loternal Memory:

« FRTEm AT =n R

* T built-in memory Tt ¥, 79 T 2T A manipulate fFm @ )

* T A IR T IR E—RAM 79 ROM

» RAM:

¢ Processing ¥ 9T dats F1 temporanily (8% T7 ¥ ) store T §1

o 7 9 cell T randomly access {5 =1 w7 R

* T volatile memary ¥ § S power ¥ switch off T B data lost 8 S #1
> ROM:

. nmwra 52 (f73 & w9 %) ¥ ¥ 9w 55 data user BRI 390 78 foran 1w
* T F 3R F 593 ROM B s =R = e W #

* ROM i wored 71 ¥ o7 s ¥ # & operating system &1 load €FM1

* ROM TF non-volatile memory ¥ S power % off €14 W Wi data lost 781 Bl

* Computer 31 stan 777 73 2% 0% fadw 2w W @13 & fawa ROM-BIOS firw w1 w1 € (ROM
= Read Only Memory, BIOS = Basic Input/output system)

Exernal Memory :

* T9F1 secondary memory T auxilliary memory ¥ F& I 21

* T T T E 22 I permanently store T F w1 A4 ¢ qw primary memory ® % cost ¥l €
4!

* Hard disk. Pen drive, CD ROMs, DVD's, Memory sticks, Blu ray 8% 3280 ¢

> T &= (Hard Disk) :

* TF Deskiop computer & T §1

* T %E A planers T € A% T @ platters F A sides ¥ store FF W 1

s o o g ¢ aw n gEww wd @ S o

® TF traces T sectors A fawifod g6

futem $Aydtn 0 wqad adaeaad - 27

Storape capacity A0GD A 150 Q0 @ wrd) §1

Hard disk ix a datet storage deviee wsed for storimg and eetrieving digital infosmation using one or

more vt vapidiy rotating disks called platteny coated with magnetic material

Platters ae panred witlymagnetiv heads arcanged on a moving actuater acn, which read and write
duati 1o the platicr surfuces

A hard sk s puant of heod disk deive that stoves and provides celatively quick aecess to lurge
oot of data onan eledctromagnetically charged susface or set of surfoces

Medern computers ispically come swith a hard disk that comtaing gigabytes of storage

» CD-ROM :

o g B (e W falea form W @ fam s 2

o ¥ BT W laser heam B rend [ 5mm ?l

o FEA cupucity 650 MDY T B &)

g@ W 719 @ fm s

CD-ROMs are stamped by the vendor, and then cannot he erased and filled with new data

To read a CD, a CD-ROM player is needed,
Suitable for large stovage capacity information like large software applicattons that support color,
graphics, sound, and video.

» DVD:
® & T& optical storage device 2 form @) i W e T fa o e @ ann g EE W) (ast access

fan s
o FEN fARE w22 SR photons, videos, files, games T store fadl m wwd #1

» Blu-ray (IF[-"(‘) '

o ST 2@ A read ® write T B blue-violet laser T use frm amm # (wavelengih 405 nanometer),
frers WM sEER A Blue-ray WS

T WRA W CD A DVD ® e A wga sifirw gl

Blu-ray f&w% ) yeama i 94 &% Industries 3 standards T q0 & &G 0 companies 3 ey
BDA (Blu-ray disc Association) W) e @l

Blut-ruy A & A1 A Blue % T W Bl T use Fferd fm amm & @i nDA ¥ rademark
TN register TN e o aen doni % W W irademark % ¥ N register T wIW M T
TAT A 25 G W W & .

Biu-ray is an oprical disc format designed to display high definition video and store large amounts
of dea.

Successor 1o DVD.
Adigital optival disc data storage format designed to supersede the DVD format capable of storing

high-defintion and ultva high-definition video resolution.
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An HD-DVD format that uses a 405 nanomerer-wa elength blue-violet laser technology, in contrast
0 the 650nm-n avelength red laser technology used in traditional DVD formats.

Rewritable Blu-rav disc. with a data transfer rate of 36 Mbps, can hold up to 27 GB of data on a
single-sided single layer disc.

The Blu-ray format was developed jointly by Sony, Samsung, Sharp. Matsushita, Pioneer and Philips,
Mistubishi, Thomson. LG Electronics and Hitachi.

» Pen Drive (7 31%39) :
e TE U removable T91 rewritable mcmory% £l pcng? FEFR A
¥ (Ff3 1.9 7)1
e @4 & small circuit board ¥ € &1 fF plastic, rubber 91 metal
case BRI JU&a T 2
« 3T# access F74 g computer & USB Port (Universal Serial Port)
 insert fEm =@ 21
Pen drives %% GB sizes ¥ 37ered £
Apendrive. or a USB flash drive, is a portable data-storage device.
now the most popular data-storage devices among consumers being small in size, lightweight and
handy and can be easilv carried from place to place.
Currently available pen drives with storage capacities ranging from 8GB and 32GB can be used to
store graphics-heavy documents. photos, music files and video clips.
e 1 register fF51 memory FT address store T % 1 39 resistor F memory pointer &gl
Ekd

§1.5. gfeT (Booting) :

Wa FE F W ON #1 9dt # 9 T user 81 use F 78 #9% €% ¥ 99 75 intemal processes
(3R ¥hFaIs) F TETI 21 T8 process boot process 91 PC F1 booting FE@ #1 aT&e # “boot”
¥ bootstrap 7 T FWE AW A T WM TF T R “Pull yourself up by your
bootstraps™ 31917 1 el T 1 w2 F T F1 @@ F (to improve your situation without any

gclp from others) & T2 21 Boot a1 PC & Basic Input Output System (BIOS) 21 frdfya =71 =
1

oz 19—t gma

anic Input Output System 31 BIOS U& software 211 € St & TF flash memory chip T stored

1 PC & BIOS motherboard by embedded €1 21 Boot process #1 Frdfi X3 & WH-aa BIOS PC

¥ Hardware 991 § configuration interface 9l Y& %t 21 Boot process % THY e T2 M1 €—

o Power Button % ON € W PC %1 power supply W54 €1 9T & a1 et 1€ 9a7 371 U2 a5
S vEw e 2

* PC T power-on self test (POST) perform %l #1 POST BIOS & &iet 0% ot T F0aget

!TI'!!TF 3'1?“‘6 =M hardware failures 1 check &1 €1 POST signals % Y47 @F single beep TE AT

FA & & 7 7o 3% 7% & (A Allis well) T beep sequence T¢ oI I £ 5

R S T N

ot EEEET 2 vTm Seees 29

hardware # 3 TETE £ 3 PC repair P53 79 beeps T = § T T T w4 £ FE =
W 7zF w1 T F A

PC 3T boot process 1 fF3771 monitor @ djnplayf??:?ﬂé"!ﬁfimos?fr-‘f"w Processor
i fafagama (specifications), instal F5% 31 5 RAM 37 5791, 740 detect 31 77 T2 (devices).
BIOS drive ¥ 774 sector (boot disk) 7% TE3 799 = ¥= A 7

BIOS 72 A58 7 2 % boot disk & T3 sector T boot loader (T bootstrap lozder)
=8 71 3% boot loader F1 memory § load T #1 Boot loader 7% 7721 T5= 7 £ T F
¥ operating system 57 221 7 launch ¥73 25 designed 77 21

4% 99z oie §9 § 7 = £, BIOS F9 w6 32 &% 31 %09 29 £ 7 1% operating system
= mcmory’:f load T I 7 241 21

= Boot loader 31T =7 T = %W %, =% PC ¥ F37 operating system #1 =% 2
37 OS user interaction 27 ¥37 ¥ =7 £ T users HT commands TF T Fow TS
T 2

G
%=

&

2
Exs

praicnl

. Computers ¥ ¥=iod €4 § civil enginesring ¥ &3 ¥ #7-771 57002 39 €7

Civil TR § 5997 o7 % 39 AT softwares ¥ 57 SR

. STz F €6 87 T 69 Information ¥4 i €7

=Tz #1 Block TAWT %% T TREEEI
TETT T AW § w F e 87
Mmm—fﬁ%m%ﬁﬁ%?

faft Inpwt 7 FEeRe el F9E4I

. What do you mean by data and information?
. Explain the different functional blocks of 2 compater.

‘What is operating system? What are its functions?

. What are compilers, interpreters and assemblers?
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(AutoCAD)

2|

THINK ABOUT IT

“Keep your cyes on the stars, and your fect on the ground. '
—Theodore Roosevelt

§ 2.1. Introduction

AutoCAD software Autodesk BT Inunch T 74T software 1 AutoCAD software 3 WETaT
drawings S 3THF | draw T9T interpret {61 51 W §1 FR ‘I& ¥ Drawings Tt mini drafter
& WEEa | S I G A T time consuming T W Wiwan ot qor drawings ¥ @yitaR
O it @gA FYEE & A A AutoCAD software T R commands 3 T R drawings
T T T modify T FG AW 8 T & FRE FRO AutoCAD FT ITERT T T TR
o s 1

AutoCAD is a commercial computer-aided designing and drafiin g software application. The
AuwtoCAD software is launched by Autodesk. This software is mainly developed initially for the drawing
as previously the drawings was done manually using mini-drafter, therefore was very time consuming
and making modifications was very difficult. In order 10 execute the drawings on the field, one must be
able to read the drawings. AutoCAD makes it casier to draw and interpret the drawings. AutoCAD is
a tool in which we can draw and modify any nype of drawings using different commans such as line,
rectangle, construction line eic. In AutoCAD we can do two dimensional as well as three dimensional
drawings. AutoCAD allows you to draw and edit 2D and 3D design more quickly and easily. The files
can be saved in the cloud and can be accessed any where and any time. This AutoCAD tool is very user
friendly because we can do modify very easily and copy the drawings ‘n’ number of times such that the
original drawing can be retained as it is in the same warking window, this helps in keeping both old
and revised drawings.

Important: AutoCAD F file format .dwg €11 &1 /|

Advantages of AutoCAD (AutoCAD & wI¥)
* AutoCAD TSFTER #1 Productivity Tl g 1

(AutoCAD improves the productivity of the designer to visualize the product and its component,
parts and reduces the time required in synthesizing, analyzing and documentin g the design).

30

Atz 31

o AutoCAD & FT§T & Rayetew wrerm & aar e A faww w ww 2
(AutoCAD system permits a more detailed engineering analysis and a larger mumber of design

alternatives can he investigated).

AutoCAD & ¥ / drnwings et §¥ &, 378 wreateror gan €, a7 #ga¥ documentation
dva yor ¢ aen Rt it @w gy )

(The use of AutoCAD system provides better engineering drawings, more standardization in the
drawings and better documentation of the design as well as few drawing errors and legibility)

&=t components i design FT3 ¥ AutoCAD T T& Engineering Drafting tool Fwad
g v §1

(AoCAD is an engineering drafling tool used for designing various components, while minimizing
human errors).

AutoCAD T} fayiamail & &0 Gt designs &1 plan T Twa §, map FT Ta&d & aan
3D Max, Maya, 791 31T design Automation tools & WG use FT THA 1

(AutoCAD's enable its users to plan out architeciural spaces. map them out and can be used
simultancously with 3D Max, Maya and other design/animation tools when the need arises.
AutoCAD supports the use of DWG and DXF files which can be exported from its interface to
those of ather advanced CAD applications to aid animation projects).

AutoCAD vs Manual Drawings

o WAEA A 3TWH (AutoCAD is casier to understand and is user- friendly)l

« ff, e W time consuming (much faster than manual drawings. So, its less time consuming)!

o 3fUF accuratey FH errors (It is more accurate, so, errors are reduced)!

e Back up T WM TR W TR A WA (Creating backups easier, hence no problem of
storage)|

e E-transmit option &R drawing ! fava & faFet +ft W A A FE0 WA (E-transmit option in
AutoCAD, enables the user to transfer the document easily to the client in any part of the world)!

e Drawing ' update 78 modify T WA (Updation and modification is much easier)!

§ 2.2. LAUNCHING AutoCAD

Choose the AutoCAD icon from the desktop and double click.

% 2.1—AutoCAD Icon
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Coordinate System

faadt fg @ positions @l specify T THA AW Cartesian T Polar coordinates T use T
HAR (x. y) T (r, 0)F FAH specily T TF B

When specifving positions vou can use Cariesian or Polar Coordinates. Cartesian coordinates gy,
simply a x value, a comma, and a ¥ value (1e x, ¥) form, for example: (80, 60). Polar coordinares are

a Distance followed by a £ symbol and an angle. for example: (100 £ 20). Angles are measured j
degrees, with 0" = East and 90° = North. Any of these numbers can have decimal values.

Graphical User Interface

QUICKACCESS  MENUBAR
TOOLBAR
APPLICATION

MENU

fa= 2.2—AuteCAD FIGUI

o The Graphical User Interface (GUI) of AutoCAD contains the Quick Access Toolbar, Title Bar,
Ribbon, Status Bar, UCS icon. application menu, workspace etc.

* Application Menu: T95 open, save, print 3% command €4 & (Application Menu contains
basic commands pertaining to the drawing as a whole, such as Open, Save, Print, and Export)!
Quick A_\cccss Tololbar: Quick access toolbar § 39 ST use T4 arell commands F ER R RS
@ |4 € (Quick Access Toolbar is a customizable area of the interface where you can add
your favourite or mostly used commands)|

Title Bar: Project 1 title ¥ AutoCAD 1 version title bar # 5@ %@ £ (Title bar contains
the title of the project and the version of AutoCAD used)!

Ribbon: Rihlnu.n Title ba % A # 21 Menus 9 toolbars F TM W Ribbon F1 use FF
commands ®1 95 # exceute BN I FFA } (Ribbon is below the title bar. The menus and
toolbars have been replaced with the ribbon, which helps you to find the commands quickly)!

Drawing Area: Drawing area # drawings %1 draw a1 < £ (Drawing Area covers maximum
space on the interface. All the drawings are drawn in this area)|

Aawz 33

Command Bar: T8 51 commands type #7753 7 7 w7 # 1 commands 31 41 273 7
(Command Bar is a palette where you can type in commands and view history of the commands)1
View Cube: T BT 35 view 741 UCS 1 change 7 7FA # (View Cube 15 in the upper
right, from which you can chunge the view and UCS. Just below that 1s the NavBar that gives
you controls for zooming, panning, orbiting, and more)!

UCS Ieon: UCS A4 User Coordinate System 31 f AR TIGET orientation T 1 5T
current coordinate system % AR AT drawing F orientate % TFA ¥ (UCS Icon User
Coordinate Svstem is in the lower left hand corner which tell you the general orientation. UCS
helps to orientate the drawing with respect to the current co-ordinate system and in particular, to
know where the co-ordinate system origin is located)!

Status Bar: Status bar ¥ %7 W@yl THEd %4 ¥ scheduling mode of new tasks 3772 271
w1 wFd T (Status Bar displays some important details like the scheduling mode of new tasks
(manual or automatic))!

AutoCAD S5 full form Autodesk's Computer Aided Design %, UF drafting 341 designing
software 2, T Autodesk company B faafaa fFan M AutoCAD T Wiel software # 441
fF I% coordinate system T work Hdl €, #@: T survey. drawing A1 drafting 3 use T =
21 AutoCAD #) Ger™dl | 1Y 2D 91 3D design &1 %4 ¢ 9491 T Civil. Mechanical, Electrical
Engineers ?q A IYEM €l 21 T Ferdal A layout, building plan. mechanical parts iz =
design T draw a1 <1 ke 21

Autodesk Company who develop a software named AutoCAD, stands for Autodesk's Computer aided
design. It's a drafting and designing software. There are several software for drafting and designing
available in market, Out of them The AutoCAD is best, because it Works on co-ordinate system that
help's in survey drawing and drafting.

AutoCAD is used for 2D and 3D design, mostly for Civil. Mechanical, Interior & Architecture
domain. You can design and draw layout, building plan. mechanical par etc.

AutoCAD & 3rgwam
o Asan Architectural planning tool (Architectural planning tool & &9 #)1
o As an Engineering drafting tool (Engineering drafting tool FEY )
o As a Graphic design tool (Graphic design tool & &9 A)I
o In the fashion industry (Fashion Industry )
o Asan industrial design tool (Industrial design tool F w0 )|

AutoCAD 2019 & 3uerer it fagiward (New Features &t AutoCAD 2019)

¢ PDF import o External file references
o Object selection ® Textto Miext

® User interface e Share design views

» High-resolution monitor support e AutoCAD mobile app
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§ 23. THA (Worksapce):

Waorkspace i {1 menns, toolbars, paleties ufe w1 e [ﬂ il '”"] i fevh Illull'uun
yEr E € Workspace W ribbon toolbar ) display e @ qaan R, 914 sk apecitic control panely
W distinet paletie TR0 1A workspace A awitching W) gl ) aae Hid atalq am
ST & W workspace 3 G TR & W fer wowmd ol o0 W ) AwoCAD i
2D Drafting and Annotation, 3D modelling, 3 Basic task based workspace 81l §1

Workspace provides us a platform for carrving out onr work with definite sets of Menus, toolbary,
palettes, which are displaved as per the work space selected. A workspace may alvo display the ribbioy
toolbar; it iy a distinct palette with taks specific comol panels, By using Ribbon, the commandy can he
executed quickly one can casly switch benveen workspaces,

The Welcome Screen

AutoCAD 2019 version i AwtoCAD open T W welcome sereen fm & & 5l AnoCAD @)
S A start fan e A § AN st LEARN T CREATE TABS 9 #1 CREATI
TAR % st i fawen €10 §—GET STARTED, RECENT DOCUMENTS 991 GIT CONNIiC “TED,
GET STARTED @i W& A fresh new drawing page 91E0 1 W &, a1 folder ) Browse H
faoel draw & files T 50 open R 0 FEW #1 Recent document 18T BIE T8 work 40 T8 files
AF T AFA T Get conneet T web access MG FT 740 Notificution B4R W W Wit 8)

In create tab, we will have three columms on apening AwtoCAD, we see a welcome sereen, luving
LEARN and CREATE tabs. “Ger Started” it is for starting a fresh new drawing page, or we cant work
upon onr previously draven file by browsing the folder, **Recent document™ provides instant aceesy (o the

Sile that we lastly worked upon in AutoCAD, And “Get connected” provides ws web aceesy to Autodesk
and also shows us notifications regarding AntoCAD,

Stort Drawing

ferx 2.3—Crente Tul

WDkn 14

Coordinate Bystom with Line Command

AntoCAD T mlteaen Convdinnte system €0 sienfta @an d, fraldl dia s ma g,y oen
0 om0 sug e (o (vl 0, 0, 00wt Gred & aen vl e ged @l cman gependicntas
WA A el convdinste 3ty alt fGen o sl |gd e an s A cooedinate 953 e §)

Our AutoCAD page Iy bised on graphical coordingte system that comstimtes thiee andy 924 v
These theee axds starts fromea potnt ovigbn (0,0, 0) one o the vertical divection, ne st boi contol and the Iuy.l
pumlh-l to the paye. Moving fooward in any of the avecincreases the valie of the coonlinate in that savis

We can dranv ustng any of the theee comdinates system

Abrolute Coordinnte 8yntem (X, Y)
Absolute coordinnto nystem 1Y B0 e gue O 8, ot g ko 791 yecom dinntes 80 e @ @
wlt ym Al
Absalute coordinare system (s used when we know the precive distance of cooordinae anid
yecoordinate from the origin,
\ sgh Rd R, 76 AnoCAD W Line command 8 0 S0 ave 0 fines diaw w0 ad &
(fr4 2.3 R~
Commund 1.
Speelty first polnt: 0,0
Speetly next polnt or [Undo]: 20, 0
Speetly next polnt or [Undol: 20, 4

o Speelly noxt polnt o [Close/Undo]: 16,4

o Spectly noxt polnt or [Close/Undo]: 16, 10 @

o Speelly next polnt o [Close/Undol: 12,10 o .

o Speclly noxt polnt or [Close/Undo]: 12, 14 - Btart pint 1 4

o Speelly next polot or [Close/Unda|: 8, 14 =i T-, n,‘, — (20, m 2

| e

&
B RETE
fug ut wa

Spectly next point or [Close/Undo]: 8§, 10
Speelly next point or [Cloxe/Undol: 4, 10

firzt 2,d—=1xample of Absolute Coardinnte System

Speelfy next polat or [Close/Undo]: 4, 4
Spectly noxt polnt or [Close/Undo]: 0, 4
Spectly next polnt or [Close/Undo]: €

Relatlve Roctangular Coordinato System (@X, Y)

7 coordinate system @6 une (e i s wn mane g a1 e 10 # amlg Neat point 43
{trsey polnt EARIIL wpecity il 1 Relative rectangalan coondingte system R e 1R wgaa
W& AegErons; 4, 0w ok @ Gy [y fag d s o Aald 0 oadd ol am

Relathve Rectangirlar coordimate system iy ised when we have a relative distance, ie | distance of
the Het polnt witl respect (o previons drawn point @ sxmbol Is wsed for velative rectangidar coordinate
system,
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Evample (See Fig 24 lf _7F

o Commnnd: | o

o Spevity tise poimt ek any point

o Spevity neat pomtan [Undo] @d, 0 b

o Specity nent pomtor [Undas] @i, -4 8
N e Start point

e Spovity neat pomt o [Close/Undo]: @6, 0

o Speaity neat poimt o [Clise/Undo]; @00, o Ky

o Speviy neat poant o [Close/Undo) €010,0 6

e Spevity next pomt o [Close/Undo): @0, 6 J

o Specify et pomt o [Close/Undo]. @ <6, 0 l ] |

o Spectly ne ‘ ; , e e Tt 10 |
Specity et pont o [Close/Unda]s @00, o

w2 5—Example of Relative Rectangular
Coordlinnte System

Spevity peat pomt o [Close/Undo]: @6, 0
Specity neat pont o [Close/Undo]: 600, <2
Spavify neat point or [Close/Undo]: @4, 0
Spavify nent pomt ot [Clase/Undo): ©

Relative Polar Coordinate System (@ distance < angle)

Relative polar coordinate system % use fan wmn § o fyost ﬂ!§ W {ﬁ T Wi
W AR specitied B &1 9% w0 wgt W R & R (counter clockwise) specify R smn
@ W relative & five 7 WY wor 7 wgE R W )

Relanve polar coordinate svstem i used witen we have a relative distance and angle of a point to
draw with reapent o the previous poins. The use of angle is compulsory in this nmnl’im;lr system which
ts measwrad in counter clockwise direction, taking towards the right. ’

Evample: (See Fig 2.5)

Command: 1

Specify fint pomnt: Pick any point
Spevtfy next point or [Undo): @ 200
Specity next point or [Undol: <60

e Specify next pomnt or [Undo): @ 2060
e Speciny nent pount or [Close/Undo]: @ 20<0
® Specify next paint ar [Close/Undo]: @20<120 Start point
e Spocify ment paent of [Clase/Undo]: @ 2060 Rt
fig L S

Spevify next pamnt o [Close/Undo]: @ 20<180
Spectfy next point of [Close/Unda]: ¢ 20<120
Spectfy newt point or [Clase/Unda). @ 20<240
Spevily newt point o [Close/Undo): @ 20<180
Spevily next peint or [Close/Undo]: @20« -60
Spevily next pount or |Close/Undo): €

T8 2.6—Relative Polar Coordinate System

Zoom T Extents

3 AutoCAD page R drawing 1 ZOOM IN T ZOOM OUT & ¥q mouse SCROLL Bar T use
T command bar W Z type TTH enter press FX1

sferds 37

Use the mouse scroll bar to ZOOM IN ZOOM OUT the drawing created on AutoCAD page, in case
scroll does not support then type z in command bar and press enter to zoom.

I created dravving have unexpected size then zoom it and extend afier.

o Command: 7
o Zoomt [All Center Dynamic Extents Previous Scale Windew Object]: E

I fawTa (Avallable Options):

Al
Conter

Dynamic

Extents :
Provious :

Scale

Window :

Object
REGEN :

1t is used 1o only for gird limits (7@ Gird limits ¥ w@a & A ]

It is used as center point and a magnification value or a height. (Center point a5
magnification value A 3 Tq YR F R )

Rectangular view box @1 use FTh zoom T 1 View box ITH view T represent Fa
2 Roram) fif 19 shrink (FAEA1) W enlarge (FFT) & 7Ha & 01 drawing ¥ across
move THA 'E-' (Pans and zeoms using a reclangular view box. The view box represents
your view, which you can shrink or enlarge and move a round the drawing. Positioning and
sizing the view box pans or zooms to fill the viewport with the view inside the view box)!
It is used to zoom all objects (R objects I zoom F FG)I

Zooms ta display the previous view. You can restore up (o ten previous views ({72 view
2 display F ¥ zoom FTA 1 370 FTT TH views T H restore F7F4 (31

It is used to zoom scale like two times, three times (& zoom scale FEig 2 T, 3
e ¥ use T EN

Zooms to display an area by rectangle window (el area F rectangular window 3
display 9 zoom % ¥Q)!

It is used to zoom select object (Select object F1 zoom FH ¥

% zoom in T4T zoom out 3 FET A work F& $T & REGEN command F1 use &1

<t & (1t is generaliy used during zoom in and zoom out of AutoCAD pages. it’s not working
properiy, Or when you move the page it refrain to move, Or when you create circle and

want to view by zoam in it appear like polygon)!

Circle before use Circle after use

REGEN command REGEN command

(8) REGEN command # T sefffdcircle () REGEN command ¥ reg WA arde

" 2.7—REGEN command
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agfaweda wA
(i) AutoCAD software f&® company 0 fasfaa fear wn?
(@ AutoCAD (b} AutoSoft
(c) Autodesk (d) AutoMac
(ii) AutoCAD software ! Fet use foFT = 3 -
(a) Architectural Planning (b) Engineering Drafting

(c) Graphic Design (d) Jq0ad st

§ 2.4. AutoCAD ¥ fafX ZFW Ta1 FATH (Tools and Command of AutoCAD)

DRAW TOOLS:
LINE COMMAND:

Contiguous line segment Lo iﬂ ¥9 command &1 use foa amn &1 T segment U line
object EHT ¢ fA&Y separately edit foar o1 wwar 1

Create a series of contiguous line segments. Each segment is a line object that can be edited
separately.

Command: L
Specify first point: Pick any point
Specify next point: 8

(Give Direction then specity distance)
Specify next point or [Undo]: 3

Specify next point or [Close/Undo): 8
Specify next point or [Close/Undo): 6
Specify next point or [Close/Undo]: 2
Specify next point or [Close/Undo]: 4
Specify next point or [Close/Undo]: 6
Specify next point or [Close/Undo]: 6
Specify next point or [Close/Undo]: 8

F0Ez 39
« Specify next point or [Close/Undo]: 6
. Spccify next point or [Close/Undo): §
o Specify next point or [Close/Undo]: 3
o Specify next point or [Close/Undo]: 3
o Specify next point or [Close/Undo): 2
fe————80 ——

T T 20+
60| €0 T
[ !

l €0
T ——ep—si _|_
30
Je——s50——+ T
T 'L 30
20 1
o
f———s0——
fax 2.9 Line drawing

PLINE:

PLINE ﬂ'ﬂ'ﬁ[ Polyline command line command &1 @18 R &g 3OH TTe F@r {lﬁ end
point ﬁspecifymmel TT TF object T tﬁﬁwﬁdiﬂ'cren!segmmts o wEat &
Polyline o segment ! Fifeq width & 91 ¥ § T4 polyline F start T end ¥ -
T width i & 1w 81

Command Pline means polyline and created in the same way as line created but this command
requires first and second endpoinis. It is an object bur may have different segmenrs. In polyline. each
segment can be given required width and can be also given different width to the siart and end of the
polyline.

* Ribbon: Home Tab » Draw Panel » Pline (Polyline)

¢ Command: PL

* Insett  Annciate  Parametric . 30 Tock

: e ¢%e Move - S T £
/ ) 9 7 ® - . ¢ls Move - () Rotate Tom _~
il — '
G-

® Copy. - d\ Mimor™ ‘gl Fitet 4 qf-_
W - Bswech F)Scle TAmy - g
X L4 Medify ~ S

Line Povyflne Circle  RArc
4 - »

I3 2.10—Pline Tool Icon
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Specify first point: 3,3

PLINE Specify nent point or [Are Halfwidth Length Undo Width]: 6, 6
PLINE Specify next point or [Are Halfwidth Length Undo Width]: 6

(give nght side direcon then enter value)

PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 3
(gve down side direction then erter valued

PLINE Spevify next point or [Are Close Ha'fwidth Length Undo Width]: 6
(give nght side direction then enter value)

.

.

e

PLINE Specify nent point or [Are Close Halfwidth Length Undo Width]: 9
(gve up side direction then enter value)

PLINE Speuify next point or [Are Close Halfwidth Length Undo Width]: 3
(give left side direction then enter value)

PLINE Specify next point or [Are Close Halfwidth Length Undo Width): 3
(@ive up side direction then enter value)

PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 9
{(give left side direction then enter value)

PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 4.2
(g1ve down side direction then enter value)

PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 7.8
(give left side direction then enter value)

PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: C

(C far close iine)
je——o90—+
42 }‘_’ l
b 30
90
Stant
Pont

T

©
le— 60 ——PC/

a3 211—Phine drawing

PLINE Specify next poirt or [Are Close Halfwidih Length Undo Width]: @6 < 45

PLINE OPTIONS:
e Arc
Iis used to create Arc (Arc ™M1 71 37 413 2

Puk sarmel
frArd -

Pick first
point

\

i 2.12—Arc Option of PLINE,

o Halfwidth

It is used to change the line width. But it is two directional (line width change 74 271

x

T

3 2.13—Haltwidth Option of PLINY,

s Length

It is used to create a line with same direction (8T direction 274 line 2774 F71 T4
¢ Undo

faa step F1 undo F 27 (to reverse a step)!

o Width
It s used to change the line width (line width change 73 27)1

agfrmedta ava
(i) AutoCAD ¥ f&a#t Workspaces a1 £¥ft §7
(@) 2 (h) 3
(c) 4 d) 5
(i) AutoCAD %! T9H AT %A release fHar m217
(a) December 1982 (h) December 1985
(¢) December 1986 (d) January 1990
(iil) AutoCAD drawing file T extension 271 ¥ 7
(a) .DWG (h) .ACTD

(c) ..CD (d) .ABC

#rake 41
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XLINE:

mmmmmﬂﬁ&ﬁma‘mmtﬁw%:dmhg 7 constroction referencs
fam o TEA b

It is a command which is used to draw lines of infonite length and wied to crecte construction ling,
reference line and for trimming boundanies.

« Ribbon: Home Tab > Draw Panel > Xline

« Command: XL )

o Specify 2 point or [Hor Ver Ang Bisect Offset]: Use one of the points fixing methods or enter an

option
« Specify through point: Pick through point
: - -
Hor : Creates 2 horizontal xline passing throogh 2 selected point (F57 9% 5 pass 573
T horizontal xline 77 3 7)1

Ver : Creates 2 Vertica! xline pessing through 2 selected point (F773 43 T poss 575
T venical xline TR 795 7)1

Ang : Creates 2 xline at 2 specified angle (ﬁ?‘-:’dm?xﬁm?ﬁ?ﬁ%’vpl

Bisact : T command TF xline 773 575 £ 3 selected angle vertex 3 pess 5 £ 7w
T H7E A T WA B T F R #) 4 e o | =7 £ (It creatss
2 xline that passes through a selecied angle veriex and bisects the angle between the
two lines)!

Offset Distance : 773 selected object T xline F1 offset (Z) specify T73 T28  (Specifies the

distance the xline is offset from the selected object)!
TEfaEeaa T
Prmcﬂiapalﬂuiﬂ!ﬁ?ﬁkmuu!ﬁm?ﬁf?

(a) Ctrdl 4+ 0 (b) Ctri+1
[fe) Ctri+2 (d) Crl+3
SPLINE:

Spline Command smooth curves 77 27 use %1 @t § 94T T curve &3 77 points & pass
wth f1
It ir @ command for making smooth curves and can be constructed along specific points.
¢ Ribbon: Home Tab > Draw Panel > Spline
¢ Command: SPL
SPLINE Specify first point or [Method Knots Object]: pick point 1
Specify Enter next point or [start Tangency oLerance]: pick point 2
Specify Enter next point or [end Tangency tolerance Undol: pick point 3
Specify Enter neat point or [end Tangency toLerance Undo Close]: pick point 4
Specify Enter next pount or [end Tangency toLerance Undo Close]: pick point 5
* Specify Enter next point or [end Tangency wlerance Undo Close]: pick point 6

oSpef:f.‘}EU

. 5':'-3.':‘ Enfer

. S—::::n y Erter pett prent ox [224 Tx

o Spectfy Enter res pent or [exd

i-

e Specify Enter next poent or feod T

£exl grest or | e::{ Tapeacy 'rf_f:m,.

olcamce ’_'.-

25 2.14—Spiize Drawize

Avzilable Options (79 &==9):

Method: Used to creetz Fit 2=d CV splime (Fe % CV Spizze

/\7\

‘rfr("m

(‘.-g:

B

s Umde -
W _emmce nan U

=

57 2.15—Merhod Option of SpEae Com—ud!

Knots: Used to creatz knots (Koo

.——._7’?—.:?-:“

—/ \ / \b"\
: N/

53 2.16—Kneots Option of Spline Command

ﬂ“'

Fgfaecad T
(i) Scale command 3 type T acess I I w541 §2
(@ § M C
(c) SC (d) SCL
(ii) fr § & 9 T AntoCAD ST Keyboard shorteut 78 §2
(a) Alt+F4 (b) Ctri+ P
(c) Ctrl+ F4 id) Alt+B
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CIRCLE:
¥ command XRT cirde 3W= fFT I t

) . . " " o
It is @ commazad By whioh we can male @ cin te. There are many wavs l\" creute Cindde. One is by

5 5 -
specineng the nadii and sevoed by pecifving Diameter. Besides this 2 poing, 3 point, and fan tan roding,

« Ribbon: Home Tab » Draw Bancl » Cirele
» Command: C

o Spevify center point for cincle or (SR T (tan tan radias)]: Biek a point

o Spevify mds of arcle o [Duameter]: 1S
Ceater pont

9 2.17—Drawing Circle by Specifying Radius

Circle Diameter
e Command: C
o Specify center point for circle or [3P/ 2P/ Tar (tan tan
o Specity radius of circle or [Diameter]: D

o Specify diameter of circle: 25

radius)]: Specify a point

97 2.18—Drawing Circle by Specifying Diameter

3P (Three point)

Draws a circle based on three points on the
circumference m‘lﬁﬁl Fad @ ﬁﬁ faforea =&
circle draw FTT

¢ Command: C

® Specify center point for circle or [3P/2P/Ttr (tan
tan radius)]: 3P

* Specify first point on circle: Specify a point (1)

 Specify second point on circle: Specify a point (2)

¢ Specify third point on circle: Specify a point (3)

First P1
point
Second
point
P2
Third
P3 point

fa 2.19—Drawing Circle by 3 Point Method

ke 48

2P (Two polint)

=mE ¥ end points B vty FTF circle draw FT3 (Draws a circke hased 0a two endpaonts oo
the diameter)!
Command: C
Spevity center pount for circle of [3P22PTer (tan tan radies)) 2P
Spevify first end pointof circle's diameter: Specify a pont
Specify second ead potat of curcle’s duameter: Specify a point

3

P2

¥ 220—Drawing a Circle by Specifying the End Points of the Diameter

TTR (Tangent, Tangent, Radius)

A objects A radius tangent specify TTF circle draw T (Draws a circke with & specited radius
tangent to two objects)!

e Command: C
Specity center point for circle or [3P/2P/Tr (tan tan radws)|: T
Specify point on object for first tangent of circle: Select a line
o Specify point on object for second tangent of circle: Sclect a line
e Specify radius of circle < current >: Enter radius

P1

P2

4% 2.21—Drawing Circle by Specifying ttr

TgfamwiE W

() AutoCAD & Rectangle draw T RY command:

(a) R (b) RE
(¢©) RET (d) REC
(i) AutoCAD ¥ Osnap feature T automatically activate &3 ¥F key:
(a) F1 ) F2
(c) F3 (d) F4
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mmand:
AR(;::omm:md 210 are (SM9) I 7 W 1 Arc 3 point 3 2 point B TR 1 3 point Arc §
angle, endpoint, start point. combination of centers, chord length, direction values T radius & specify
e 1 wEa &1
o Ribbon: Home Tab » Draw Panel » Arc
¢ Command: A

Annctste.  Parametric:™s 30 Tools . Visualize -~ View Manage  Output A4,

o Mm..»e_ ) Retate _~/+ Tim - 7 A ' 1 1) i.
[} RIS - . Az . B .
Line Pohfine Circle S Copy - A\MW.* a ml-21 ">’ . Text Dimension { 1
T R piied &) Scale Amy - St i T
Draw ~ Modify ¥ “Annctatien v
arctool
&% 2.22—The Are Tool 2
* Specify start point of arc or [Center]: Pick 1 point
* Specify second point of arc or [Center/End]: Pick 2 point
¢ Specify end point of arc: Pick 3 point Sa .

Various Types of Arc (Arc & fafi= wam) 9 223 Drawing an Arc

“-"_——

« 3-Polint Arc:

o Start, Center, End

 Start, Center, Angle

o Start, Center, Length

2
3
/ 1
End point
iz 2.25—Arc 3-point
End point
2 2

e 2.26—Specifying Start, Center, End

3. Specify angle (F1m)

2 1

a7 2.27—Specifying Start, Center, Angle

-

T 2.28—Specifying Start, Center, Length

AINET 47



« Start. End, Angle

5 229 Specifying Start. End. Angle

|

« Start, End, Direction

~

3
f3 2.30—Specifying Start. End, Direction

« Start. End, Radius

£ 100 ]
2 '1

fir 2.31—Specifying Start, End, Radios

— | ]
2 N 2

Mid point

« Center, Start, End

7 232—Specifying Center, Start, End

« Center, Start, Angle

z

57 231 Specifying Center, Start. Azgle

« Start, Center, Length

=57 49

N
\}
_S
Z %
s Continue
Mode .
FglaEead XeA
(i) AutoCAD drawing file ¥q extension—
(a) .DWG (b) DWT
(c) .DWF (d) DXF
(i) AutoCAD drawing %1 save &1 €3 shortcut—
(a) Ctrl A (b) Ctrd X
(c) CirlV (d) CtrlS
(i) AutoCAD template file & extension—
(a) .DWF (b) .DXF
(c) .DWT id) .DWF
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RECTANGLE:
¥ command I rectangle 30 &8 I3 &1
It is a command by which vee can make a rectangle.
¢ Ribbon: Home Tab » Draw Panel » Rectangle
e Command: REC

S

M a=0ta = oae

[eLIGTl Insert -« Project, . Schematic

oY=

Line Polyline Circle Arc |[_] Rectangle

Draw ~ O Polygon

&= 2.36—Rectangle Tool

® Specify first comer point or [Chamfer/Elevation/FilleUThickness/Width]: Pick 1 point
e Specify other comer point or |Area/Dimensions/Rotation]: Pick 2 Point

g;

Rectangle

T fag

74

N2

fax 2.37—Rectangle

IuEre fawew (Available Option):

¢ Area: Rectangle &1 @3%w specify &T&H rectangle 3@ &A1 &1 |Waar 2
By specifving the area of the rectangle
¢ Command: REC
¢ Specifly first comer point or IChamfer/Elevaliuanillelf]'hickncss/Wid[h]: Pick 1 point
* Specify other corner point or [Area/Dimensions/Rotation]: A
* Enter area of rectangle in current units: 400
¢ Calculate rectangle dimensions based on [Length/Width]: L
* Enter rectangle length: 40

ke &)

1 Lengih A0

The aren of
Rectangle is specifiod

farw 2.8—Specifylng Rectangle Area

Dimonslons: Rectangle ® wmanf -t whert specify won tectangle TE G 2 (Creates o
rectangle by using length and width values)!

e Command: REC

» Specily first comner point or [Chamfed/Blevation/Fillet/ Thicknes/Width) Pick 1 point

» Specify other corner point or [Arca/Dimensions/Rotation|:

o Specify length tor rectangles: 30

o Specity width for rectangles: 20

¢ Specify other corner point or [Are/Dimensions/Rotation: Pick 2 point

Length = 30 7 I —— Oimention of

¥ tectangle
aro specified
f
Widn « 201
&
faw 2.39—Specifylng Rectaogle Dimensions 2

Rotatlon: Rotation angle specify T rectangle 3= 0
®F (Creates u rectangle at a specified rotation angle)l

e Command: REC ‘

* Specify other corner point or [Arca/Dimension/Rotation]: R
® Specify rotation angle or [Pick point]: 45

® Specify other corner point or [ Area/Dimension/Rotation]: D
® Specify length for rectangles: 30

® Specify width for rectangles: 20

* Specify other corner point or [Arca/Dimensions/Rotation):

Pick 2 point fam 240 —Specifylng Rectangle
Rotation
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Lrai:c o il R

() Drawing units window = open A ﬁﬁ command—

(n) UNIT (b) UNI
(¢) UN d) U
POLYGON:

Polygon command R/ Polygon T fet w1 w2 €1 AutoCAD ¥ &0 ¥ &% #iy closeq
sides (14T triangle) | HFT 1024 sides 7% & polygon I &5 71 W &1 Polygon clr,
@ inseribe T circumscribe THT A F&w 1 ]

O Q

(a) Inscribed (b) Circumscribed
Polygon Polygon

% 2.41—Inscribed and Circumscribed Polygon

. 1t is a command by which we can create a plane figure having at least three straight sides and angl

Triangle, rectangle and pentagon or polvgon having desired number of sides can be created throu; ItSl; N
m/nmnnnf. In AutoCAD we can construct a polygon having minimum of three closed sides and maiimuu
of 1024 sides. There are two 1ypes of polvgon i.e. inscribed in a circle or circumscribed around a cin:lzl

Line Polyline Circle Arc

Pobsn,
Palygon Icon
fa= 2.42—Polygon Tool :

* Command: POL

* Inscribed in the Circle: 39 foafa & p ircle 3 aieT @
’ olygon circle & el &1 ¢ o
# circumference (uftfr) W A 2 UM T deticentoirels

stiFe 53

The polygon lies inside the circle with its vertices on the circumjference.

o Polygon enter number of sides: 10

o Specify center of polygon or [Edge]: Specify a center point

o Enter an option [Inscribed in circle/Circumscribed about circle]: I

o Specify radius of circle: 20

Gircumscribed about Circle: W&t feaf & polygon cirele % #TgT BT #, ;@i circle polygon
=1 W sides % mid points T touch FTA LA cross HTAT {1

Polygon constructed such that circles lies within it and its circumference passes by touching the
midpoints of all the vertices of polygon.

¢ Command: POL

o Polygon enter number of sides: 10

o Specify center of polygon or [Edge]: Specify a center point
Enter an option [Inscribed in circle/Circumscribed about circle]: C

(i) Zoom command ®q shortcut-

o Specify radius of circle: 20

(a) Z (b) A
(c) C d D
ELLIPSE:

¥¥ command T ellipse type arc (SR 9m) draw F AT #1 UES & g TEet axis
& location 74T length &Y specify 3 & s 8 point ellipse ¥ center # THL A (second
axis) & end point @ distance T fix HTA 4]

It is a command to draw an Elliptical type arc. The first two points determine the location and length
of the first axis whereas the third point fixes the distance from the center of the ellipse 1o the end point

of the second axis.
Ribbon: Home Tab > Draw Panel > ELLIPSE

Command: EL
e

Line Pehtine Cucle  Aichy

&S
Ellipse tool icon

fas 2.43—Ellipse Tool
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« Specify axis endpoint of ellipse or [Are/Center]: Pick 1 point
» Specify another endpoint of the axis: 20 (Give direction then enter value)
o Specify the distance to other axis or [Rotation]: 20

20

13
¥ ﬁai

fa= 2.44—Drawing an Ellipse

Iueee fa=wew (Avallable Options):

* Arc: T8 first axis dimension specify WX, ff second axis dimension specify HY, R stan
angle T end cycle specify F (Specify first axis dimension, then specify second axis
dimension. Then specify start angle and end angle)

* Center: Specify center point of ellipse (ellipse F1 center point specify )

HATCH:

¥/ command F1 WETEAT ¥ section viewing %ﬁ, lines I~ Ft W ¥ qon famit object &
area fill far v & ot 6 @ TR objects @ rem @)

Hatch command is used to create lines for section viewing and filling of an area of an object so that
it is distinguished from other objects.

* Ribbon: Home Tab » Draw Panel » Hatch

* Command: H

* Give the command *H* enter, a ribbon toolbar will appear.
¢ Click “Hatch Pattern™ and select the type of pattern.

. Ell(‘k on pick points and select an area that is required to be hatched. Only a closed area can be
atched.

¢ In the ribbon toolbar, give the scale of the pattern and properties like color and background color.

/ Pick auter area

C Hatched Section

a7 2.45—Use of Hatch

agfadedta w91
() Tt ¥ ¥ = @ property THt object 3 property T&l gF—

(a) Elevation (b) Measure
(c) Line weight (d) Hyperlink
GRADIENT:

Gradient command % ERT gradient type of fill 3= Tar ST § ¥afq two color types of
fillings 3= f&d @ &1

* Ribbon: Home Tab > Draw Panel » Gradient

* Command: GD

¢ Give the command ‘GD’ and press enter. A ribbon toolbar will appear.

® Select the gradient pattern from *Hatch pattern” option.

o Give the required color, such as a single or a pair of two color.

¢ Click ‘Pick Point’ to select a point in a closed area.

agfasedia WA

(i) Gradient Command T shortcut—

(@) G (b) G
(¢) GN (d) GRA
BOUNDARY:

Boundary command &R enclosed aren (3% &%) 3= fevar smar #1
Boundary command is used to create a region in an enclosed area.
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« Ribbon: Home Tab » Draw Pancl > Boundary

¢ Command: BO

« On giving command *BO" enter. a boundary creation tab appears.

« Click the option of *pick points’, then select an enclosed point in an enclosed area that you neey
to make a boundary.

e Then enter.

RAY:

nyCummandWmﬁgﬂﬁﬁﬁ?ﬂimmllnedmwﬁmﬁgmwobjm
m&?ﬁiﬂmkmnm%miuwmmmil

It is a command to create a line starting from @ point to infinity in one direction which can furthe,
be used as a reference for crearing other objects.

« Ribbon: Home Tab » Draw Panel » Ray

e Command: RAY

* Pick Start Point

e Pick through point.

TEfaseda Wv
(i) Ray command is used to draw a line from a point to—
(a) Second point (b) Infinity
{c) Another line (d) Another object

POINT:

Point zm HETTAT | point object IT I A1 ¥&a §1 FER ¥ point F 3D location specily
ETS o= ¢, Object =t snap & F&a €, Current elevation 3& TF1 # (I z-axis 3 neglect
B

) We use point to create point object. With the help of this command we specify the 3D location fora
point, snap object, view current elevation (if we neglect the z axis.)

e Ribbon: Home Tab > Draw Panel » Point

¢ Command: PO

+ Pick Point

T 2.46—Point T W&

DIVIDE:

Divide command line, arc, circle, polyline ¥ points @1 place (Ffe®) T IR FiGA line
segment ¥ fawiiva w1 & &1

starre 57

The divide command places a point along the line, are, circle, polvline dividing it into the required
number of segments.
« Ribbon: Home Tab > Draw Panel » Divide

» Command: DIV
e Select object to divide: Select abject

Select object
o

=

12.0000 J

e 2.47(n)—Use of Divide Tool

o Enter the number of segments or [Blocks]: 6

2 fiF O tne TUT
G A fe @

X o :
In—z.ooooiz.oooo 2.0000 { 2.0000 {— 20000—-'-—20000A|
i

i 12,0000

T4 2.47(b)—Use of Divide

MEASURE:
afg ¥ f&H line polyline, arc, AT circle ﬁ' specified STATTEH H=TH (specified regular
intervals) TT points TTA &A1 &8} ¥ @ measure command T use T U S TR R
When we want to locate points ar specific required intervals along the line, polyline, arc or circle

we can use the measure command.
o Ribbon; Home Tab > Dmw Panel » Measure

REGION:
Region command object & set H region object ¥ convert HT 2 {1 Region TE 2D area

ﬁmtaﬁagobjemmmﬁmt(ﬁﬁﬁ:m,unc.mcimrewkm:nohjmm‘t.\nﬂ'

waad fwar s ww )1
The region command, converts a set of objects info @ region object. Region is a 2D area made by

different objects like arc. or line or circle. It is used to convert 2D to 3D object.
o Ribbon: Home Tab » Draw Pancl > Region

* Command: REG
o Select object: Select first object and second object then Enter.
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WIPEOUT:

A command R N rEvawm ugt qar ohject W hideout fEm o wEm t STEﬂTl
an w1 9 Bounded lines (3R f& polygon, rectangle, trinngle 3 WY W 'ﬁ" sit Cross
section area B T Wipeount aren wl editing %n turn on W4T plotting i'{[ turn off Ty m
wEm §

It isused ro hideout an object The object can be of any cross-section arca made by bounded sidey
suchas polvgon, rectangle, triangle, ete. The wipe-out area can be TURN ON for editing and TURNOR Y
for plotting

* Ribbon: Home Tab » Draw Panel » Wipeout

o Command: WIP

Draw Wipeout tool icon

fow 2.48(n)}—Wipeout Tool Icon
* Specify first point or [Frames/Polyline]: Pick 1 point
¢ Specify next point: Pick 2 point
* Specify next point or (Undo]: Pick 3 point
* Specify next point or [Undo/Close): Pick 4 point
* Specify next point or [Undo/Close): C

Before 2 Aftor

Y- AE A G-I F T
T 2.48(1)—Use of Wipeout
3D POLYLINE:

3D polyline straight line segments &1 connected sef i
s s gement BYT & S % single object ¥
¥ o= foem  wwm &) Fle otk

Az 59
30 polyline non-coplanar B Feh #, f&=] @ arc segments ®Y Include T w7 7w #1

A JD polyline is a connected sequence of straight line segments created as a single object. 30D
polylines can be non-coplanar but they cannot include are segments.

o Ribhon: Home Tab » Draw Pancl » 3D Polyline

o Command: 3DPOLY

o Specify start point of polyline: Pick 1 point

« Specify end point of line or [Undol: Pick 2 point

o Specily end point of line or [Undo]: Pick 3 point

e Specify end point of line or [Close Undo): Pick 4 point

<>y
%

s 2.49—3D Polyline T w@m

HELIX:

Helix command & gRY spring EATAT ST ¥1 B0 7T base radius, top radius, height T&1
turns (3rerfR W H T specily FCH B 31

Helix command creates a spring by specifying base radius. top radius. height as well as the number
of turns of the helix.

¢ Ribbon: Home Tab » Draw Panel > Helix

o Command: HELIX

Ta 2.50—Helix Tool

® Specify center point of base: Pick 1 point
® Specify base radius or [Diameter]: 30
® Specify top radius or [Diameter]: 12
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(on)
o Specify helix height or [Axis endpoint Turns Tuen height IWist]: T (T for turns)
(on)
« Enter the number of tuins: 12
{or)

« Specify helix height or [Axis endpoint Turns Tum height 1Wist]: 20
REVISION CLOUD:

¥ command ! TEA R revision cloud % arcn W highlight T o &1 o revision
cloud W A A B urc W series Liuil {

It is @ command to highlight the area of the revision cloud. 1t is a series of are formed 1o creage o
reviston cloud

o Ribbon: Home Tab > Draw Panel » Revision Cloud

¢ Command: REVCLOUD

SOLID:
¥ command W FETAT | 2d filled polygon draw T SmM 1]

It is a command to create 2D filled polvgons.
Command: SO
FILL:

¥€ command wt wgrEA & hatch, 2D solids, wide polylines IfE objects u filling Y control
famar @ #1 6T object ®Y referesh HTA B repenernte command T use forar s 4 @y o
mode command & FTER §% ON mode ¥ filling = 2@ w5 §, 79T OFF mode # 3 four 7w $1
This command is used 10 control the filling of an object such as hatch, DD solids and wide polylines.

It is a "mode” command by which we can view the filling through ON mode and no filling of objects
through off mode.

« Command: FILL
* FILL enter mode {ON/OFF): Enter option

3 ON: Fill mode W ON 13 T U solid object display T 1 3D object T filling I visible EE
% extrusion dircction viewing direction & parallel (WA B i) a@n hidden lines suppressed
Té ¥ afen

By lumin{r the fill fnodc ON, the complete solid object is displayed. For the filling of a 3D object
to be visible, its extrusion direction must be parallel to the current viewing direction, and hidden lines

must not be suppressed,
mn::i H‘.| modf ® OFF mﬁ %A ohject T outlines display TRl #1 Fill mode 1 change
X f:““"g :’h.leﬂ wfem B #1 Fill mode sevting BT line weights 1 dieplay omfa e vy 81

mi ;

y turning the fill mode off, only the outlines of objects are displayed. Changing Fill mode affects

existing abjects after o ving 0 i i
AR i, ifter the drawing is regenerated. The display of line weights is not affected by the fill

Az 61
§ 2.5 MODIFY TOOLS

MOVE Command:
Move commuand TT use WO WA object i select W 7 ZAFT hase point select FTH zaF!
required position T4 dircetlon 9T move % w1

St | commind we seleet an object, its base point and move it to the required position
andl dircetion.

o Ribhon: Home Tab » Modify Panel » Move

o Commind: M

o Seleet object

o Specify base point or [Displacement]): Pick base point

o Specify second point or <usc the first point as displacement>: Give direction then 50

COPY:

afy w fal abject W UE @ Al M T A f @ OF A object &1 draw ®T& copy
command T 3 copy FT ww #, foradt am 7@t Tl Ut use i whi

This conmane can be used to make mudtiple copies of an object. When we need the same object at
more than one place, we draw an object once and then use the command ‘copy” to copy this object so
that it can be pasted at other places.

« Ribhon: Home Tab » Modify Panel » Copy

s Command: CO

o Sclect object

o Specify base point or [Displacement/mode]: Specify a base

o Specify second point or (Array]: Pick first point

o Specify second point or [Array): Plck second point

o Specify second point or [Array]: Give dircction then 20

STRETCH Command:

Streteh command 1 FEEA A T drawing % fadt portion @ (frs1 & drawing & {!ﬁ‘
parts @ connection =l ﬁl’!ﬁ fRl) move & e ¢ Em & f& Blocks, Hatch patterns 791 Text
entitles @ stretch it fora w0 AT

Streteh command allows us tomove a portion of a drawing without distorting their connections with
othier parts of the drawing. But we cannot stretch Blocks, Haich patterns, or Text entities.

« Ribhon: Home Tab » Modify Pancl » Stretch

s Command: §

* Sclect object

& Specify base point of [Displacement]: Pick first point
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ROTATE:
Rotate command &1 use &Td 89 object & fEdt anis & |G inclination (g&ma) 2 uwn 2

By using the rotate command, we can give mchnation 1o an object from an axis,

e Ribbon: Home Tab » Modify Panel » Rotate

e Command: RO

® Select object then

Specify base point: Pick point
Specify rotation angle or |Copy/Reference]: 60

MIRROR:
Mirror command FT use FT& g9 fast objcct FT reflection T&Ht axis & AT Iu= T
wER g

We use the mirror command to create a reflection of a designated objected about a specified axis.

Ribbon: Home Tab » Modify Panel > Mirror
Command: MI

Select object

Specify first point of mirror line: Pick first point
Specify secand point of mirror line: Pick second point
Erase source object? [Yes/No): N

SCALE:
Scale command F use FX& T object & size THE FUE F alter FT THE £

By using scale command. we can alter the size of an object proportionally.

TRIM:

Ribbon: Home Tab » Modify Panel » Scale

Command: SC

Select object then

Specify base point: Pick base point

Specify scale factor or [Copy/Reference]: R (R enter for reference)
Specify reference length: 1

Specify new length or [Point]: 2

Trim command &1 use F¥& g7 fodt object &I portion (S fs specified edge &1 cross
FAR) erase FT WHT §1
We use trim command to erase a prorion of the selected object that crosses specified edge.
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o Ribbon: Home Tab > Modify Panel » Trim

o Command: TR

3D Tooks « Visushre
4 4 Move (' Rotate - Trim_

¥ 2.51—Trim tool

e Select object or <select all>: Select reference object then
¢ Trim [Fence/Crossing/Project/eRase/Edge/Undo): Select trim object

EXTEND:

Extend command T use &% line, arc, polyline i ETE QT W Wet &, Wi 9 feEr
specified boundary edge | meet FH w

By using the extend command, we can elongate or say lengthen a line, orc or polyline to meet a
specified boundary edge.

¢ Ribbon: Home Tab » Modify Panel > Extend

e Command: EX

* Select object or <select all>: Select reference object

¢ Extend [Fence/Crossing/Project/Edge/Undo]: Select Extend object

FILLET:

Two lines, ares, circles TT polylines F vertices & 77 et fiffe fivwr =1 9w &=y g
Fillet command &7 use f&mam =man 1

We use the fillet command when need to construct an arc of specified radius benveen nwo lines, arcs.
circles or vertices of polylines.

¢ Ribbon: Home Tab » Modify Panel > Fillet

* Command: F

* Select first object or [Undo/Polyline/Radius/Trim/Multipie]: R (R for fillet radius)

* Specify fillet radius: 6

¢ Select first object or [Undo/Polyline/Radius/Trim/Multiple]: Select first

¢ Select second object or shift-select to apply comer or [Radius]: Select second object
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Select first object /

Select second object

o T objeey
& W ISy

'l

After Using Fillet Command

fav 252

Before Using Fillet Commands

CHAMFER:

Chamfer & angled line connection €T §1 Chamfer command T use FT& two lines §
intersection W angled connection 3= fear T R

A chamfer is an angled line connection. Hence, by using chamfer command we can ereate an angleg
connection at the intersection of two lines.
Ribbon: Home Tab » Modify Panel > Chamfer
Command: CHA
Sclect first object or [Undo/Polyline/Distance/Angle/mEthod/Multiple]: D (D enter for Distance)
Specify chamfer length on the first line: 3
Specify chamfer length on the first line : 6
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple): Select first object
Select second line or shifi-select to apply comer or [Distance/Angle/Method]: Scleet second

object
Chamfer %

Select second object

Select first object

Before using Chamfer command After using Chamfer Command

fax 253
BLEND CURVES: '
e & 2 lines A curves T AT WER 2 @ & Blend curves & use FTd 81 TAA selected
object % W& spline create § @A &, spline w7 shape specified points W depend TaT &, FAH
selected ohject Tt length unchanged &t 1

7] v o 100 I}
i W ht’"} we need to join two lines or curves, we use blend curves. This command creates a spline
nween 1 u' selected object, shape of the spline depends upon specified points while the length of the
selected object remuins unchanged.

#FE 65

» Ribben: Home Tab » Modify Pancl » Chamfer

« Command: BLEND
View  Manage ™ Outpt Addiine  Autedes) W5, Exptess Tooks | B P%
A Fe ' & YW T -
f ()55 10 P I e
Pos /,_ Layes (i “
W Propenies 2y £, My =5 B

5 tion =. g Layers = .
"

Blend tool icon

e 2.54—Blend Tool

o Select first object or [CONtinuity]: Select first object
o Select second object: Select second object

——

Select first object

Select second object

(a) Before using Blend Command

v Blending of object

(b) After using Blend Command

fas 2.55—Blend Command &1 Use

ARRAY:
Continuous manner # qar Fifed @0 F rectangular, polar, circular 91 37 selected path

% objects W serics & R Array command FT use e s #1
We use array command for creating a series of object in a continuous manner and the require number

of rectangular, polar, circular or any selecied path.
o Ribbon: Home Tab » Modify Panel > Array
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By using the n]]'m (*m‘mnmr(l, we can create a new line, polyline, and arc or circle parallel 1o the
objectand al a specified distance from it,

Ribbon: Hoie Tab » Modify Panel » Offset

Aymarmatre

o3 Mave. - () Route

8% Copy A\ punor
R Srexch @ Saie

AL LR

Home  intert & e Pasmerri

g .,_:J_- O /1/‘ :

Line Polyline . Circle  Asc

. Draw ~ ¢

D rai-ingl

U MepllID Yecfinne)

fa% 2.56—Array Tool
Offset ool icon

EXPLODE:
Explode command F&¥ block, hatch pattern, 9T dimension &1 3% constituent Te&i § war fi 2.58—0fTset Tool
polylines 1 series of straight line ¥ break &¢ &d1 &1 & objects ® properties FT modify %t
=T w5 £ LENGTHEN:
Lengtben T Tt object Eq| WB' qT ares & included angle £ change f&ar =1 g

Explode command breaks a block. katch pattern or dimension into its constituent entities and polyline

into a series of straight iines. Bv using explode. we can also modify the properties of a particular object #1 37 changes S final length, increment 4T angle FETH specify Te&ar s 1 Lengthen =t

TRIM a1 EXTEND & fa&ed & &0 ¥ use T w1 7wam &1

« Ribbon: Home Tzb > Modify Panel > Explode LENGTHEN changes the length of an object and the included angle of arcs. We can specify changes
as the final length, an increment or angle. LENGTHEN can be used as an alternative tool in place of

x CommrartX TRIM or EXTEND.
EREELISS - L « Ribbon: Home Tab > Modify Panel > Lengthen
e ‘ A

in block, exc.

Polylne  Circle

24 Draw ~

Expiode tool icon

o 2.57—Explode Tool
OFFSET

Oftset command 7 use 7% T8 f52H object 3 2 " .
T object & parallel ¥ aa fiffe i Iyline
- it j pa g0 TT T4 line, poly]

fax 2.59—Lengthen Tool
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ALIGN:

Align command 1 use T fian & s et object W M Tt ohJect & yone )
keecl ol d :m:f{w source point TR ohject * s q afirw ﬂlg Wl definition polnt oo,
arg firg & points R align WA ti

We use Align command when we need o keep an ohject in scale with another object ie. It yyey

for aligning one or more point of an object called source point with the points of other object cafley

definition point.
« Ribbon: Home Tab > Modify Panel > Align

¢ Command: AL
BREAK:
Break command % TETEA A line, arc T circle & fAw W @Y erase T N www g
IT7ET T lines T arcs F split (STETT-IACRT FI) oot o wewar 1 WA lines 3 WY Toy
ferer 33 gap IS F1 & @ §¥9 command ® use fm amm §1

By using break command, we can erase part of the line, arc or a circle or 1o splititinto nvo lines or
arcs. Normally, we use it for creating a gap berween lines for wrifing text.

« Ribbon: Home Tab > Modify Panel > Align

« Command: BR

s Select object

o Specify second break point or [First point]: F

o Specify first break point: Pick first point

o Specify second break: Pick second point

‘f" Break

........... e --_-7____

ween fag ferda farg
First point Second point

fam 2.60—Use of break command

JOIN:
JOIN command %1 use %T% U ¥ plane % 2t fiigail #1 attach favay o wwan 81

By wsine fof
¥ using join command, we can attach two object lying in the same plane.
* Ribbon: Home Tab > Modify Panel > Align

DELETE DUPLICATE OBJECT:

UT command dupllcalc 1 overla
1 pping lines nre: |lﬂ|)‘""l'i .
! S il' s a1 S 'i‘. lzll ﬁ a ;
o "lﬂl’Pl g lines 91 cvlllli:lll)us lines lﬁ' continue Hﬂiﬁ t|

Wihe Y

Thiv commanid cemoves diplivate on averlapging Moves, e ol podilisies o s piibdises fiiilally
averlapping ot Contlgnomy enes

o Qitbont Home Tab = Maodity Panel = Deleto Duplivate Object

o Commnndi OVERKILL
DRAW ORDER:

AutoCAD W TVE avertapplog abjects @) display &0 @1 wn fralfin e iy s feee
et @ AT (@6 DIRAWORDER conmunnd, TEXT TOVRONT command 781 HATCH 1O

BDACK conmminl,
Several options are avatlable that control the ander i which averlapgring objec i ne disphiyid In

addition 10 the DRAWORDER commund, the TENTTOFRONT comuind Batiges all test, dimeniions
or leaders in a dvnving in front of ather objects, and the ATCHIORBACK commind sendv ol hai b
objects behind ather ohfech,

gelact Objocts: Specifica the objects for which vou want to change the disw viler

Above Object: Moves the selected object above the spectfied veferenie objeciy

Under Object: Moves the selevted objecrs belone the spectfied 1eference abjedi

Moves the selected objeciy the top of the order of aljeciy i the digwing

Front:
Back: Moves the selected objects o the bottom of the order of objects in the diawing

o Ribhon: Home Tab > Maodify Panel » Dirivw Opeder

s Commund: DR
BLOCKS:

el abject @1 seloct W AAT Insertlon polnt R WU commund T Wlock S0 firn a1
wra § wen T WA save e v wrean 14w Wlocka design center toallar 7E ol praletten
N save 0§

1t iy used 1o erealv
by the name of itself. The

o Ribbont Home Tab > Modify Fanel > Wlocks

o Commundd:

a black by selecting that object el ghvbng 00 an dsertion proint anial theii save 1t
o blocks are saved in the design centre toolbar and the toul paleties

uglteredla W

() Commund B A wen Fwr ol o
(n) Blocks
(¢) Lines

() DR command e gl el B
() Drawling colour
(¢) Draw order

() Objecta
(ly Are

(h) Drawlng deslgn
() Draw style

(I For deleting dupliente ohjecty which commund cin hie used
() Overklll

(n) Del
(¢) Froase () Al of these
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(iv) Which command convert discrete object in polyline—

(n) Union

(b) Subtrac

(¢) Join (d) Polyline

(v) ¥ offset command BT &7 create & & qH=—
(n) Vertical straight (b) Concentric circles
(¢) Three parallel lines (d) Parallel arcs

§ 2.6. ANNOTATION

TEXT:

Text command single line text ™= kot %ﬁ use &1 WA &1 FWR ¥ line text object define
ol SR & f &9 modify (SWIfEE) T relocate (THEmUm) FT 7w £

Itis a command 10 create a single-line text object. It is also used to define different line text objects
which we can madify. relocate.

e Ribbon: Annotation Tab > Text » Single Line Text
e Command: DT

MULTILINE TEXT:

Multiline text command &1 HeTaaT § AFURHAL TR text objects & fF Rrawg sw= vl
WS &1 79 39 command &1 Wew™ar Htext F appearance, boundaries, columns Ft format
o 3 5w &

Itisused to creatc multiline 1ext objects such as paragraphs. It can also be modified, relocate. Using
this command, we can format 1ext appearance, boundaries and columns.

* Ribbon: Annotation Tab > Text > Multiline Text
¢ Command: MT
TEXT STYLE:
Text & style change & ®Y Text style command use 3 SR 21
Itis used to change text style like text height, text font.
¢ Ribbon: Annotation Tab » Text Text » Style
DIMENSIONING:
¥ command %} HETA | current viewport draw {1 T WEAT 2, Current text style change

&4 < 7T &, recently created object T undo AT ST WEHAT &, anfz)

Itis a command witly the help of which we can draw the current viewport, change current text style,
undo the recemtly created objects, etc.

e Command: DIM and DIM 1

sz 71
gratvfm B & T Wi
Di foning mode ¢ J equivalents

Di foning mode C d Equivalent C:
ALIGNED DIMALIGNED
ANGULAR DIMANGULAR
BASELINE DIMBASELINE
CENTER DIMCONTINUE
CONTINUE DIMDIAMETER
gloAnTEErrETT DIMEDIT Home
HORIZONTAL DIMLINEAR Honzontal
LEADER LEADER
106 DIMIOGGED
NEWTEXT DIMEDIT New
OBLIQUE DIMEDIT Oblique
ORDINATE DIMORDINATE
OVERRIDE DIMOVERRIDE
RADIUS DIMRADIUS
RESTORE -DIMSTYLE Restore
ROTATED DIMLINEAR Rotated
g?.:"rsus -DIMSTYLE Status
i DIMTEDIT
TROTATE DIMEDIT Rotate
UPDATE -DIMSTYLE Apply
VARIABLES _DIMSTYLE Variables
VERTICAL DIMLINEAR Vertical

LINEAR:

Linear command &I vertical (Eﬁi'ftﬂ'). @fat (horizontal) T rotated dimension line @t

linear dimensions S I <1 Wt §1 o . - o
We use linear command, to create a linear dimensions with a vertical, horizontal, or ro

dimension line.

« Ribbon: Annotation Tab > Dimensions Panel > Linear

e Command: DIMLIN . )
o Pick first point and Pick second point then give direction and click.

ALIGNED: ] ‘
¥4 command &1 RErEAT R aligned position # lincar dimensio
It is @ command to create a linear dimensions in alig

¢ Ribbon: Annotation Tab » Dimens

¢ Command: DIMALI

ned position.

jons Panel > Aligned

ns I FT AT FEHA &
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ANGULAR:
38 conumand F TG & object T angle W S FHA 21
It is a command (o measure Angle of object.

« Command: DIMANG

ARC LENGTH:
29 command 1 FETEAT | simple arc T polyline arc it T measure T A TR ¢
It is a command 1o mcasure the length of a simple arc or polyline are.
« Ribhon: Annotation tab > Dimensions panel > Arc length
¢ Command: DIMARC

RADIUS:

Radius command 3 TETEA § ST g€ 41 90 &t B & w0 w5 @ qwa @, gy
dimension text @1 display Tear w1 7w &1

Radius comriand is used 1o measure the radins of a selected circle or arc and display the dimensioy
rext having a radiug symbol in front of it.

« Ribbon: Annotation Tab » Dimensions Panel » Radius

e Command: DIMRAD

DIAMETER:

It is a command to measure the diameter of the selected circle or arc, display the dimension text with
diameter symbol in front of it and can relocate the resulting diameter dimension.

« Ribbon: Annotation Tab > Dimensions Panel > Diameter

« Command: DIMDIA

RADIUS DIMENSION:

T% command AR object H FHwaT H WU & TN dimension text % WA radius symbol
@1 display T g1

This command measure the radius of the selected object and displays a radius symbol with dimension
text.

* Ribbon: Annotation Tab > Dimensions Panel » Jogged

» Command: DIMJOGGED

CONTINUE:

uz' command ot wrafra ¥@ia (linear), angular (Fof4) A1 ordinate dimension & @
extension line (fam m T FY I (4
It is a command 10 creare an ¢

xtension liy i , s
ordinate dimension, 1e automatically from the last selected linear, angular or

* Ribbon: Annotate Tab > Dimensions Panel »

Continue
* Command: DIMCONT

aAtzEs 73
BASELINE:

e ® @ selected dimension & angular, lincar T ordinate dimension WA FHIA
s i 4 command Y use fEm wmw #)

It is a command 1o create angular, linear and ordinate diniension from the baseline or the selecred
dimension.
o Ribhon: Annotate Tab » Dimensions Panel » Bascline

o Command: DIMBASE

CENTRE MARK:

falt circle 0 are ¥ center point mark % ¥ §9 command &1 use 1 AR 21
It is a command 1o create a centre point in a circle or are.

« Ribbon: Annotate Tab > Centrelines > Center Mark

Center
Mark

et 2.61—Use of Center Mark

CENTRE LINE:
fmt line ¥ Centerline create T ¢ $9 command T use far smar #1
It is a command 1o create a centreline in a line.
« Ribbon: Annotate Tab > Centrelines > Center Line

Center

line
- ‘g'g

First line

Second line

& 2.62—Use of Center Line

INSPECTION DIMENSION:

Drawing & dimension T inspect HIE il

It is @ command to inspect the dimension given in the drawing so as to maintain the standard of
the dimensics.

¢ Ribbon: Annotate Tab > Dimensions Panel > Inspect

¢ Command: DIMINSPECT
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A etk AAGCAD X017 Drawing) dwy

gt O

A bl (T A e +advd
. Anid \

path d 19 1 %7
Wites R o | Center Centering
1w QRN ) | Mark |

Tt »

Certes ey
Inspection ool icon

fat 2.63—Inspection Tool

DIMENSION BREAK:
¥W command W1 TETGA A dimensions T extension lines Wt hireak T restore f&RTT 511 e
R, mfﬁ?“mﬁlﬂﬁ W cross w E1

It iy a command to brcak or restore the dimension or extension lines when they cross each other,

e Commund: DIMBREAK

el T

B

Mot T v ’ 163 f P
T ' 0 020 : : d e o

Tewt »
] b + n ' Conterhines

Inspection tool icon

fa¥ 2.64—DBreak Dimension Tool
Select 50 %0
dimension
40
am
far¥ 2.65—Use of Break Dim

DIMENSION SPACE:

Linear W angular dimenston &
Wi, W spacing A distance A1 adjust & iﬂ T command

Itis a command to adj cing or dis ¢ between linear or mensiol
to adjust the spacin 1 8
Iy istance between lin i
ar or angular dimensions.
¢ Ribbon: Annotate Tab » Dimensions anel » .

. Adj
P ¢ Command: DIMSPACE ljust Space
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oo MacdAD 211 Drawteny) dusy
¢ Pl Aty < o Micame gk %
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T Lnwar ¢t pice H1C

Demernion

Po fkne
1l e Tt R I g
e 007000 f v

Tert = - .

(U Diriension

o Coverany J

Dimension space
tool icon
e 2.66—Dimension Space Tool

DIM STYLE:

af ¥ dimension 1 style 91 & G §, 990 drawing § ¥YF dimensions T control
w1 aTgd § & DIMSTYLE command %1 use F 2

When we need to change the dimension setting and have control over the dimension used in the
drawing, we use ‘DIM Style’. By using this command we can create dimension styles and specify the
format of dimensions quickly for example text height, arrow size and precision etc.

« Ribbon: Annotate Tab > Dimensions Panel > Dimension Style

e Command: D

QLEADER:

Leader annotation 3= &1 ¥ QLEADER &7 use fam s 1

We use QLeader to create leader annotation. By its help we can set location of set multiline text
annotation and specify leader format.

o Command: LE
Applications:

e Set the location where leaders attach to multiline text annotation

o Specify leader annotation and annotation format

e Constrain the angle of the first and second leader segments.

o Limit the number of leader points

LEADER:
Leader command & TEEAT A line 3T =% 39 annotation T & feature R/ connect

fira ST &1 WE specified point & lender line segment 1 draw T FEAT 81

It is a command to create a line that can be connected to a feature by annotation. It alse draws a

leader line segment 1o the point specified.

TABLE:
& empty table (FF rows T@I columns (3rafy dfal Fa To) I %11 %) Total command

T use T4 T AT § T ¥ data T tabular form I show T aTER Bl

It is @ command to create several rows aud colunms irt an enipry table. We use table when we want

to show the data input in tabular form.
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« Ribbon: Home Tab > Annotation Panel » Tables
¢ Command: TB

SMART DIMENSION:
Smart dimensioning automatically creates appropriate notes based on type of objeet You seleg

araf smart dimensioning ¥ 3MTEH T select e Tfa ohject & WA & MR 0T automatical
(=A:) ITGE dimension notes I FH ST TE B

F Tgfasedia W9

How many units arc available in AutoCAD?

(@) 3 b 4
Ilcl s (h 6
LIST:

afz ¥ falt object F propertis JEAT AR & F F List command HT use HTW §1 7y
sclected object T type (cirele, arc, block 3, colour, & (axis), thickness, end points Eﬁfmﬁl
Z-nxis A clevation Mg &1 FHER 2t #1

Listis ingquiry command which lists the distance between any hwo selected points in our command bar,

ANGLE:
¥® Command F1 WETAAT | points, circle, aren T & 7L angle (F01) T4 &6 s §)

VOLUME:
ol aftaied object F volume ®1 TURT FT1 BY volume command T use Twam wmm #1

We use voline command, to compute volume of a defined object.

AREA:

FNE! HETAA object T1 shape T aren A fFaT I FFam 31

We use the command area to calculate the arca of an object or shape. Using this connnand, we can
calculate the area of the object such as circle or by selecting the varions points of a given object efe.

Tfaseda w9
Which command is used to create multiple view ports in the layout:
(n) EATTEDIT (b) VPORTS
(c) REC (b) GMAIL

§ 2.7. PARAMETRIC
PARAMETRIC DRAWINGS:

5rm"l’nmmq:lrif: drawing 8% @&1% & fA8R constraints AT restrictions & 3= designing al
%1 Geometrical constraints objects T UH F@E A relationship Y control &1 &,

dimensional constraints objects &1 distance, length, angle, radius values &1 control & 81

Atrdz 77

Parametric drawing is atechnology which is wsed for designing with constrainis, that are associations
and restrictions applied 1 2D geometry, The two types of constraims are (1) Geometrical constraints,
which control the velationships of objects with respect to each other and (i) Dimensional constraints
that control the distance, length, angle, and radins values of object.

Constraints are divided into three sections:

» Geometric constraints

o Dimensional constraints

o Manage

o Ribbon: Parametric
Geometric Constraints: Constrains a object based on geometric propertics: Vertical. horizontal, etc.

Geometric constraints geometric objects F1 FEA T #1 I2ETW: A2 FE symmetric drawing &
qun e W T drawing # FT change TN ed & @ a% symmetric T T8 FOF7, T4 B symmetry
) T T ¥4 T symmetric contraints apply F % 9@ I object T select FA ¢ fomh 7
symmetry AT T e 2

Dimensional Constraints: Dimensional Constraints an object based on a set length or radius.

Dimensional constaraints & €5 37 objects # changes 1 A € o W &9 already F1 7 9 ¢

How to MANAGE CONSTRAINTS:

Mnanage section % aiwia §9 Parameters manager F use H& Bt used constraints H
excel sheet TiaTet WY & T4 delete constraints &l use FT&H FEMGA constraints I remove
= wa g

In ‘manage’ section, we can perform fwo operations, we can uise ‘parameters manager' lo generate
excel sheets of all the constraints used and “delete constraints * to remove unnecessary constrainis.

wfamedtd 99
Which command is allows to use the Dynamic input command:
(a) F9 (b) F10
(¢) F11 (by F12

§ 2.8. SETTING AND OPTION

INFER CONSTRAINT:

ag command T&df geometr;
apply T 3t R

It a helping type of tool for applying geome
olbjects.

INFER CONSTRAINT command autor:

y ! create T edit T3 W geometrical constraints 1 T
trical constraints while creating and editing geometrical

wtically applics constraints benveen the object or points
h ' e )
associated with object snaps and the object we are creating or t'dlflrlg. A U"‘I'O(' ONSTRAIN 'mnummd.
constrainis are applicd only if the objects meel the constraint conditions. With Infer Ce mu.rmml-s turned
on, to infer geometric constraint we specify the object snap while creating geometry. The n_h_;m-u not
supported are: Apparent Intersection. and Quadrant, Extension, Intersection. Constraints which cannot

be implied are: Smooth, Synmetric, Equal, Concentric, Fix, Collinear.
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GRID and SNAP: o

Stralght line %7 pattern 7 % Zat wm cross w7k o aT :, Grids wyema §, Snap
command cursor movement 1 specified interval ¥ restrict kb

The grid is a pattern of straight lines that crosses over cach other, forming square._ In AutoCAry Itiy
infinite in the given waorkspace Grid helps us in aligning abyects and visualizing the distanceg b"""nl
them Horzontal lines are called mmor grid lines and vertical lines called major grid lines, Snap mad,
limits the movement of the croschairs sinee it 18 defined With tnap mode on, the cursor wnfl_fn”,m, o
invisible rectangular grid Snap 1¢ helpful tn specifying precise points w ith the arrow keys Ror a5
independent to each other but we use them simultaneously too

+ Ribbon: Status bar » Gnd or Snap

OSNAP:
Osnap %} ETE # 3 point T pick FTA FAT specific abject location T snap FT w3 §,
“OSNAP™ means object snap. The Object Snaps are drawing tool that help us in drawing accuraely,
Osnap specifies us to snap onta a particular point location while picking a point,

POLAR:

AutoCAD ¥ Polar %1 A7d WTH=TA: Angle (F757 Fom | & #1 Polar tracking commang
fafée ®uif 9T tracking vectors 3= wTA &1 Polar snapping command & specific angles Ty
snapping Bt § (specified distance 97)1 Polar &1 opposite ortho mode g LA cursor
(crosshalr) 1 90" 3 Tora! UT restrict (#ifom) & 21

Polar is a helping 1vpe of 1ol wsed 1o define an angle and to draw using angles. It selting containg
two types of angles: Increment angle is the angle that is shown in the drawing as a multiple of it, b
additional angle we take mare than one and they can be easily seen in the drawing,
ORTHO:
¥ setting % I cursor movement % #ret dfawt v meafery feen # whfea frm s wwar )
It is a senting by which cursor movement is consirained to vertical and horizontal direction only,
OTRACK:
Itis a command that hover over the reference point until the Otrack box appears. Otrack point can
be changed whenever needed.
LWT:
¥4 command &} WERAA A line segment % pixels B decrease increase f&war <1 W §
(3rate, vzrm ar wgrar @ wa )
I1is a command used 1o increase and decrease the pixels of the line segment,
DYN:
T status bar ¥ TF setting Bt & i cursor & firme command interface %1 %74 FTd! §
forerd fi6 drafting aren T focus forar m W)

It is a serting in the status bar which acts as a command interface near the cursor so as to keep the
Jocus in the drafting area.

ap (Quick Propartias):

Ohject 1 properties ¥ cnlonr, layer, finetype. contrn 1. eantes 5. eirmymfersnes, ar=.
diameter, radins &1 oheerve FT3 T T command 37 aee G5 W

It is uted tn observe the properties of the reguived ahjers auch as ralar layer, linempe. crore ©
centre v, Circumference. area. diameter. radius

COLOUR:
7% U% display toal 1 T92% TAA T ased slements =7 75 77 T distinguished ST A7
wFa

It is display type of tacl which is used in interface dements 5 fhar the dlemenrs used can Er
distinguished from one anather.

STEERING WHEELS:

% U navigation wheel ¥ FT5 1D 7 30 F 37 7 drawing T e T =R 41 Zeam
T image T WG FIF ZAT I TAAT §1 Rewlnd mast racont view FT rastare FTTo=A L pANT
current view repasition T T T3 §, Orhit 217 current view 3 75 fied pivet paine ( 55 ) =
T A HEA S

Itis a navigation wheel to have a watch on the drawing puade in 20 or 30

o Command: Wheel

UNITS:
a7 f ¥5 T work start FR ¥, A onits I set F7F 77 anits 3 qse =5 §)
When we start our new work we siart by sersi y
work. When we give the command for uniz. the Drawing Un
divided into length, angle. insertion scale sections.

LINEAR UNITS:
The default unit for length is decimal. The AutoCAD 2015 provides five difarsnr finear anit opes
as shown below:

Unit Type 15Drawing | 1500 Drawing | Explanatien
Units 1

Decimal 1.5000 | 15000000 ST units or metrc umts

Scientific 1.3000E « 00 | 1.5000E-m3 Decimal value rased 1o
l sorme power

Engineering 0-1.5000" | 125" cooa” Fe=t and decimal mches

Architectural w-14" | 12574y Feet and fractenal mehes

Fractional 1% | 1500 | Whote nambers aad
| fracucns

ANGULAR UNITS:
The default angular unit is also decimal. There are five different angular anits provided 10 us iz the
units dialog box are shown below:
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{ '—ﬂl!‘n—lt"l'_\ pe j:'.-__* A ngular Units | 1500 Drawing Explanation
Devimal m—_‘v:\_ | 12500 180000 Metric or S1umits
LI'\m'?\m 'VL.‘E‘;';'_— j 1ROJO07 Degrees, Minutes and Seconds
t;m‘!«— i l;\l»; 200000 400 grads = 360 degrees
’T&ndmm 0 218r 3142 2 P radhans = 360 degrees
l Surveyor N 77430°0°1 w Compass bearings
LAYERS:

It is a command having large space where all types of object are placed, and the basic designing i
done on it. On starting AutoCAD default layer is only shown which is set current. The object defineg is
only seen on the laver. the layer itself is not seen. Layer is invisible matter.

« Ribbon: Home Tab > Laycrs Panel > Layer Properties Manager

e Menu: Format » Layer

¢ Command: LA

¢ Choose: Format, Layer.

¢ Type: LAYER at the command prompt.

Or
e Pick: The layers icon from the Layer Control box on the object properties toolbar.

New Creates new layers.

2 Lists layers. with states. colors and linetypes.

Make Creates a new layer and makes it current.

Set Sets current layer.

ON Turns on specified layers.

OFF Tums off specified layers.

Color Assigns color to specified layers.

Ltype Assigns linetype to specified layers.

Freeze Completely ignores layers during regeneration.

Thaw Unfreezes specified layers Ltype.

Lock Makes a layer read only preventing entities from being

Edited but available visual reference and osnap functions.

Unlock Places a layer in read write mode and available for edits.
Plot Turns a layer On for plotting
No Plot Tums a layer Off for plotting

LWeight Controls the line weight for each layer.

Changing the Layer of an Object
# Click Once on the object to change
. IS:Ier:l the desired layer from the Layer Control Box, AutoCAD will move the object to the new
ayer.

atikz 81

PURGE:
Drawing o & unused named ftems remove w73 %‘1 purge command %1 use f&m @ £
Purgeisa command for removing unised named items Jroma drawing. It can remave block definition,

Javers. dimen sion style, linetypes. empty text objects and tex siyle,

o Menu: Application Menu » Drawing Utilitics » Purge
« Command: PU

EriEcaaic® ol
The default grid spacing in both X and Y direction is—
(@) 5 (h) 10
() 15 (b) 20

3D Modeling and View:
Box: Box TF 3D object T 21 FHH length o brezdth F1 X-Y plane W draw 27 == %
qm height Z-axis T Create #1 Wl & (A solid box can be created by a box command. Box is 2
3D object. Its length and breadth can be drawn on X and Y plane and its height create on Z axis)i
Cylinder: Cylinder F1 31 FT1 ¥ T9H radius T3 height T F@l £ (To create cylinder we
must specify radius and height. After creating circle on X and Y plane, give height on Z axis)l

¢ Ribbon: Home Tab > Modeling » Cylinder.
Helix: Helix command # spring draw 41 51 T % (Helix command creates 2 spring. Firstly
give base radius, top radius and height as well as number of tumns to draw a of helix)!

s Ribbon: Home Tab > Draw > Helix.
Cone: Cone command B ¥F draw FR @0 21 39% fog =991 fo=n 7@ =90 specify
%) & € (Cone command is used to create circular cone. To create cone specify radius and then
specify height of cone)l
Torus: Torus command ERT @ T Radius T4 thickness F1 tube draw 1 1 T=41 & (Torus
command is used to create tube for this we have to specify radius of circular tube and its thickness)!

s Ribbon: Home Tab > Modeling » Torus.
Pyramid: Pyramid i cone ¥ W @ % fFg 799 Base circular T ¥FE edged FrE
Pyramid command EM F9 ¥ FH &4 9 HuFa9 32 edges T Pyramid draw F = =
2 (Pyramid is just like cone, but cone has a circular base while pyramid has a polygonal base, it
has at least three edges and can up to maximum 32 edges)!

* Ribbon: Home Tab > Modeling > Pyramid.
Sphere: Sphere TF 3D Circular solid &1 %1 Center 3 radius specify F= sphere command
BT sphere draw a7 <1 W&al & (Sphere command creates a sphere. A circle is 2D object while
sphere is a circular shape solid 3D object and created by giving center and radius)l

« Ribbon: Home Tab > Modcling » Wedge.
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Polysolid: Polysolid Command polyline #1 w1 8 &1 5 Polysolid T solid 3D object §
ol Thickness & 39 9 specify #1 S & (Polysolid command use just like polyline
polysolid is a 3D object so we also have to specify thickness and height. It is used to Create '“.
or simple piane (surface)! n
Extrude: Fi ebject ¥ 37 T T extrude command F use fFa1 9T # (Extrude com

is used to increase the height of object like line, circle. rectangle, arc, spline etc. By incrcasing hr:_and
we can convert 2D objects into 3D)! 1eht
Loft: 31 = @ F % 2D objects T single 3D oblect A convert FA ¥ loft command use 3
@ ? (Loft command is used to convert two or more than two 2D objects into single 3D ob;
Loft command works on any 2D object which is built upon any 3rd object by selecting simulmneo{;t
both the object and then convert in single 3D Object)t ’
Revolve: 2D object F1 fF# axis R §74 W 5 T 3D object 1 3@ & ¥ T commang
31. use @ S % (Revolve command is use to convert a 2D object into 3D by revolving thy
object on one of any axis with respect to two distinguish points of that axes)!

Sweep: fF5 2D object T T 2D object T sweep & 3D object ¥ convert T W =
mmm use ¥ A & (Sweep command is used to convert into 3D object by sweeping anyone
2D object to another 2D object)!

TEfaseia T

To divide the object into segment having predefined length, we use—
(a) Measure (b) Chamfer
(¢) SC (b) REC

§ 2.9. 3D MODIFY TOOLS

:%M;ve:mobjm 1 }-W&i‘lﬁﬁ el 9 ¥ along rotate FW ¥ T command use H
n;e § (3[; m‘;:ncon:mmd 1s use (0 move an object along any of the three axes. To do that select
: ob;ea.km rst scect 3D move object and you will found all three axes appear, then move the
object g the desired axes by clicking on that axes and provide move distance manually)!
;%R;tate:fi‘w object ¥ 3.9 § & fawt 31 ¥ along rowate FA ¥ T command use
g (3D fotate command is use to rotate an object along any of the three axes)!
Jnmﬁm object F1 ¥ axis ¥ along scale FH ¥ & command use F TA B
command is used 10 scale an object along any of three !
W o darmonn g any axes. You can change scale according
3D Mirror: %5 object =1 Wifda (mi
v o | 2 (mm)mﬁ%ﬁﬂ?mmmduscﬁmg'ﬂ
Z-axis F along 9 object T mimror ¥ T 2
30 : 3D i i
i N'I'Brnes amray cft;ﬂ;;mz is usfd ;;:h create multiple copy of an object simultaneously along
(Three R f& object F ol i
we fem = wEm 3) along copies I FA ¥ 7@ command F
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subtract: Overlapping 3D object F intersected part cut FH ¥ T8 command use B A #
(Subtract command is used to cut the intersected part of the overlapping 3D object)!

unlon: T8 command F! FEP | 1 3D objects join 71 merge f£7 31 TFA % (Union command
usc to joint OF METEE (WO or more than two 3D objects)!

Intersect: R intersecting 3D object F intersecting part F FrEzF I UM cur T 9 Intersect
command use F1 % (Intersect command is use to cut the rest part (i.e. remaininz part) of two
3D object who is intersecting each other)l °

Slice: T8 command % ZT TF 3D object F cut FF isolated part I remove FFA W THA
2 (Slice command is use to cut a 3D object, and remove the isolated par)l

agfaweda ww
(i) How many grip points does a circle have?
(@) 2 ® 3
© 4 ®) 5
(i) Youapply a property called thickness to a standard AutoCAD circle: What type of AutoCAD
object will you have now?

(a) Surface Model (Polygon mesh) (b) Cylinder
(c) PLINE (b) Sphere.
FRY4E ZeW (§87 ¥) (SUMMARY OF AUTOCAD TOOLS):
DRAWING TOOLS:
Open (Command) | fei existing file ®) open XA ¥ Application menu — Open
(Opens an existing file)
Units (Command) | 2% 319 unit type (Architectural or Decimal), | Application menu — Utilities

Angle Display format 39 (decimal degree) — Drawing setup
it precision of unit set HT TR &

(Allows you to set the unit type (Architectural
or Decimal), angle display format (degrees-
minutes- seconds, or decimal degrees), and
precision of the units, controls the precision
and display formats of coordinates, distances

and angles.)
([:)lmcnsion Style Drawing style #1 create T3 781 modify -
IMSTYLE ;
command) = %ﬁ

(Creates and modifies dimension styles. A
dimension style is a named collection of
"4 dimension settings that control the appearance
of dimensions. You create dimensions styles
to specify the format of dimensions quickly
and to ensure that dimensions confirm to

~—_[standand2).



84 fofem sorfrafen § WiwEm SFTFAM

'Eoﬁ?’f

Limits (Command) !Dmmng F1 Imaginary boundary check ®1
@ W ¢ 5 T drawing boundaries ¥
ar 7R @1 /2 afe limit checking ON
E A drawing P unit F aeC 7@ H
<1 T
(Changes the imaginary boundaries of the
drawing. and controls whether drawing
can be made outside of the boundaries. If
Limit-checking is ON. drawing cannot be
done outside of limuts. The limits command
<ets an invisible rectangular boundary in the
drawing area or viewport. It limits the grid
display and points locations, we are required
1o specify the coordinates of opposile corners
of the rectangular window.)

TE lower left comer @e upper right
sct & 1 Command bar T Iim'L
a.m its i
(It sets lower .Icl_‘l comer and uppey .
corner. Type limits on the commang bary

Properties Existing objects &1 properties 1 control
Eaeii(l
(Controls properties of existing object)

Properties T select T right click Bl
object T faf\= properties display §
Eicuill

(Select properties and right click,
various properties of the object will b

|
displayed.) [

Line 2 specified points F d9= straight line draw

Eashail

(Used to draw straight line, between two
specified points. You can invoke the LINE
command by choosing the LINE tool by
entering LINE or L at the command prompt,
you will have to specify the starting point of
the line by clicking mouse then you will be
prompted to specify the second point. You
can terminate the LINE command by pressing
ENTER. ESC or SPACE BAR.)

command & finish T Ec] '%'I

.

.

« Command Line T 99 Llypcﬁ
Enter | l
* Ribbon T Line icon R click I

IR o option T 3G Line
Drawm%mmﬁlmil
AutoCAD TR & point specily T
% fow wem, ﬁ(ﬁ W click X 3T mouse
1 move HY, AUTOCAD 3@ #Tw
3TN point FA ¥ frAT F¥M AUTOCAD
g T T qoa@ wm, fF A point I
specify @t W@ A% T4 Enter TOH

At command line just type L and press
enter.

On the toolbar click on the line icon.

Construction Line

/|

fﬁﬂiﬁ -‘ﬂ Angle R R page W line Draw
+ &)

(Draws a line to full page at any angle.
Construction lines also known as XLINES
are temporary line entities that can be used as

Command linc T CL type X 3T Enter
<@ @,
Ribbon T construction line 3 feon
T click )
At

references when creating or positioning other
o_hjcc(s or line work. Construction IirTes are
either circles or straight lines that extent to
infinity in both directions).

enter.

On the tool bar click on the constructio?

]

|

d line type CL and P"-'“J

!

line icon, |

——

i
Multilin

(MIJNI

AN

% |
3 Command)

Polyline

o

wurdy o1 TE & i ) gl a) (e won,
ot G W wmAr 1A 6 ong via aw by
(Allows you to draw one 1o six lines parallel
1o each other, by specilying the distances
between the lines. Mutliline tool i a cyclic
command that allows building parallel
segnents pereeived by program as a single
object.)
3 U Open Aren W UE closed Polyline
crente W WEA E 6 lines, ares sl
circles 3 BT enclosed B, Polyline 71
widih o T AR ¢ a1 curved path
follow & Wrd

SR TRl start 991 end point % )
amayrral TRR B A PR finst point
choose T AR W sclect 70 S0 &1
(Polyline means many lincs. To draw
a polyline you need to invoke PLINE
commuand, specily the start point and follow
the prompts. Creates a closed polyline of
u specified boundary by picking an open
area within an arca enclosed by lines, arcs
or circles, Unlike the standard line they can
have width and they can follow curved path.
To draw polyline you need o give start and
cend point).

aade 85

o Command line T “ml" type ®01

+ On command hie type “ml’

1 Polyline sepment @t sl wdvpr
favife wem &y

U 0 previous segment undo 71 a8

W Polyline scpments %1 vivgrd fauffen
o f)

I sets the hall-width of the polyline
sepments

« 1) Undoes previous segment

o W sets the width of polyline segments

=)

Splinc

.

TEH BRI A curve TN THD 1w W
SR different points @ (specify) fafém
B ¢ e ) fag s A e A
curve Tt S FHA B

(You can draw a curve.

You need to specify the different points and
curve passing through all the points will be
drawn.)

Command linc 9 spline type w1

On command line type spline

Polygon

O

THA MY sides F HEA specify HE
polygon draw T A ® (for example, if
you specify four sides, a quadrilateral can be
draw, if you specily five sides, pentagon will
be draw, if you specify six sides, hexagon
will be drawn, il you specify seven sides,
heptagon will be drawn ctc.)

(Draws regular polygons with a specilicd
number of sides. Polygons are polyline

entities)

« B UF edge (fFAT1) % end points
W FAE polygon T ATFR i
Rotation fafére wwam &

C Polygon & =M 31 U g7 k2l
circumscribe A 4]

o | UF polygon A circle B inscribe

wrm




I .

C

* E Specifies size and wotating of
Dy,

by picking endpoints of One Ed"’”‘
Circumscribes polygon arg "
circle.i.c cin‘lclm(,,“‘idcnu i
and touches all the \'cni.)”""
polygon. cen g
Inscribes polygon within g ¢
circle lies inside the poly
touches the midpoint of )| 1
of polygon.

0 a”d-

T T8 TF arc (M) draw F ERA £
Arc T 29 default faf & F3 f7 select
frd wm ¢, o @ fag arc F end point
(o o) BR ¢ ot T wm A fag
FTH locus W F fimd B0 ¢ Arc TR,
A 3= fafrh @1 SEA 98 i e 7| |

E

L
fafée fmm s ¢, fama 314 € Stant point,
End point 91 Included angle. « R
(Draws an arc. The default method of
drawing arcs is selecting three points (so- | * S
called “3 pont arc”). which are the two [+ A
endpoints of the arc and some other point |, ~
along its locus. Other methods of drawing an
arc can be specificd by three letters, suchas | * P
SEA. which means "Start Point. End Point,
and included angle.) e E
e L
= R
*S

* A Included angle il
+ C Arc &1 centre pointl
« D Arc

F tangent line diregy;
angle "

Arc &I end point

Arc & 2R ﬁ%ﬁf'&pasggﬁw
Chord ® Length

Radius

Arc T start point

is the included angle

is the center point of arc

is the direction angle of a line tangen
to the arc

is the endpoint of ar

is the length of chord passing through
both endpoints of the arc

is the radius
is the start point of the arc

‘ll'l:k-,‘c i

e “dc‘

|

Circle command &R =t ¥ &R 1 circle
T W GEA 81 Circle T9H 3 Default
method § WE centre point T radius W
@ point specify & @ FR radius 91| o
dimension F1 type FTF circle draw foFa
I FEA E OHF circle draw F F 37
% methods i ¥, fre w1 5w aemm
F W TR &

Circle

3P

« 2P Diameter %l opposite ends W

@l points specify S circle
fifée = g1

e points pick FF IAF pass
¥ AR circle specify R S
il

A 550 F1 Dimentions # %
I8 F Dimensions € 1 T
&

* TTR BR13 Lines, Arc 1 circle fd

TE circle tangent T A4T radius
¥ dimension Enter T circle
T specify Frar w1 w21

#aEz 87

(Draws a circle of any size. The default
method is to specifly a center point and
specify a point on the radius or type the radius
dimension, but other methens can be selected
For example. specify center and the diameter
D, by specifying two diametrical end (2p),
specify three points on the circumference
(3P), specify radius targent to two objects

(TTR)).

]
BT circle 1 radius enter F7777 |
ez Rl |

bid Specifies circle by picking two ‘
points on the diameter [

* RET

draws circle by specifying three |
points on the crcumference

. 3p

Allows entering the diameter |
dimension instead of radius

dimension

Specifies circle by picking

two lines, arcs or circles for |
the circlz ic he Langent 1o, and |
entering the dimension of the |
radius {
* <RET> Enters radius of circle (the |

default) |

Rectangle

i

3GH M Rectangle Draw F Hd ¢ 2T
rectangle option 1 select ¥ TFA &,
Autocad 19H first corner e %73 & fou
THM, ‘Specify the first comer’, fFH fag
T click Y fFT AutoCAD #T98 opposite
comer Y&, Y & THY point TR T,
aei T forrs w0
(Draws a rectangle. You can select rectangle,
AutoCAD will ask you to *specify the first
comner’, click on a point. AutoCAD will ask
you to ‘specify the opposite comer’, click
on another point. You can draw rectangle by
specify two opposite comers of the rectangle
or by specifying the area and the size of any
one side or by specifying the dimensions of

Command line W A 37 7% 77 Area 31 |

Rectangle 919 #71 #1 ¥ 37 Area enter |

F0 A 51 length T4 T Command |

line T D & Z778 rectangle #1 length 71

width T&1 J771 4 23 Dimensions =1

rectangle W@ ZPTI

¢ *A’ on command line will give you
rectangle of specified area. When you
enter area it will ask you specify the
length.

« 'D’ on command line will give rectangle
with specified dimensions. AutoCAD will
ask you specify the length and width.

the 1 le.)

Ellipses

S

39 command T use ellipse 1 draw T3
2 e = &1 Ellipse & ve A fag
18 1 location T4 length Fuife Fd &1
e fig Ellipse & %% 7 g oW F
sifim famg 3 = F) G0 (Distance) Fsif
=@ &
(The ellipse command is used to draw elIip;c.

« C g Ellipse &1 centre point specify
fem = 7= &1

« R EW Ellipse F eccentricity (35534
specify = 1wl 1

« C allows specification of Center point of
ellipse rather than first axis endpoint

+ R allows specification of eccentricity
in place of length of second

The first two points d the .' c
and length of the first axis and the third point
determines the distance between the center of

axis.

the cllipse and the end peint of the other axis.)
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[ox

- ]
Donut e sy e AW A = fadifca
F0F filled nngs draw T ekl

(Draws filled nings with speaified side
and outade diameters: The donut command
creates a filled crele or a wide nng A donut
consists of twa are polslimes thatee joined
end to end w create a arcular sheet The
width of the polvhines s determined by the
specifying mside and outside diameter. I
you specify inside diameter of 0, the donut
15 a filled aircle.)

MODIFYING TOOLS

« Menu A Donut option £ selegy I
"

« 7% 3R inner diameter ¥ fem

A faffe ™

o 3 TE TR outer dameter ¥ hf"i
*Q ¥ fy wem )

« Sclect donut option from meny

« Specify the inner diameter,

+ Next specify the outer diameter.

Erase

4

78 command F1 RETTAI A T selected entity
Eo] drawing AW R

(Erases sclected ennty trom the drawing. To
erase an object choose erase tool from the
maodify panel.)

3 keybord W E type X am 3 g
object 3T delete FT 9EA &, 37 7y n

(Type E on the kevboard and selecy the
desired object and delete it.)

Copy

smq 21 fa{EE Base pont falg @
Displacememt f3f 1 ITM T select
object F1 copy draw F1 w8

(Draws a copy of selected objects using
two methods namely base point method and
displacement method. On invoking this tool.
you need to select the object and then specify
the base point. Then, you need to specify the
second point. where the copied object has to
be placed. You can continue specifying the
second point. for creating multiple copies.)

Multiple object 1 3T M ¥ zm
T R

(Drawing & S similar object F AN #
2 3 % Doors. windows 3z %1 7y
91 ¥ fau «E ar copy command
A R A EA 2)

(M Allows multiple copies to be made of
an object in drawing which have similar
object occurring many times such as doors
window will have to be drawn a number of
times, and hence, COPY command can be
used. in such cases)

Mirror

i

User ZM specify F1 TR axis & AR &
7 Entity #1 mirror image Lendaie Gk
(Reflects or makes mirror image of existing
or designated entities about a user specified

axis. The objects can be mirrored at any
angle.)

Keyboard T MI type F{ 31t 8 object
1 MY mirror FTN &R &, T T
(Type M1 on the keyboard and select the
object you want to mirror)

Offset

T F line, polyline, arc A circle TN #
S enity F AR 3N Friif@ g0 w
(Creates a new line, polyline, arc or circle

parallel to the entity and at a specified
distance from it.)

<number> specifies offset distance 3&f
<number> T specify FTdl Tl

T 3991 through %1 T & 319 € point
specify & TFq ¢ faad fF offset line,
polyline, Arc @I circle &1 pass FTHI #

(T i.e.. Through allows specification of
a point through which the offset lin¢.

polyline, arc or circle is to pass)

Move

e

waFT 89

TF BT AT UF AP (parallel with the
snap rotation) A7 TATFT pattern 4 ¥ 7%
1A objects F w1 ofn o mw H
(Makes multiple copres of selected obyects in
arectangular (parallel with the snap rotation)
or circular pattern. Then, each resulting
object can be manipulated independently )

‘Amymmmm:mfwim.yt!
IR ¥ svm w fadr wv (A |
l pattern F1 T F 7 AucCAD 3’!'-"1!
Rows (Honzontal) 37 Columns (Vernical) |
i?h amm % oz |
| €The operation of array depends on type of :
| array you specify In case of rectangular :
pattern. AutoCAD will ask for the |
number of rows (Horizontal) and colurnns [

(Vertical :

Designated entities F1 791 3% qize 2
orientation # 3 A A7 present location
Q faHl other location W =M F1d #
(Moves designated entities from their current
any other location without changing their
orientation and size.)

« Keyboard T M type FT5 object ¥
select 71 move 7 TFA 21

+ (Type M on the keyboard and then select
the ohject you want to move)

& WA g @M fFA central rotation
point & T ATF object F rotate F¥ TFA
21 (Rotates the object around a specified
central rotation point.)

+ Rotate F 7 object 1 select 77 f77
31 rowation T # TTE base point
= =0

A T TE

Select the objects to rotate, after that
specify the base point about which you
want the rotation to occur

Specify the angle through which you E
want the rotation should occur. |

Stretch

Drawing % 3 it & 1T 3197 connection
ﬁmtﬁﬁ@mawing%ﬁﬁﬁﬁ
move FA T FAA T & FAlH 39
block, hatch pattern A% text entities 1
stretch TE F T

(The stretch command is used to stretch the
portion of the object partially enclosed by the
polygon selection or window selection. The
objects selected cannot be stretched. These
objects can be moved such as ellipses. blocks
and circles. Allows moving & portion of 3
drawing while retaining their connections to
other parts of the drawing. Note that Blocks.
Hatch patterns, or Text entities, cannot be
stretched)

+ Object 3 o1 T g1 ¥73 T ¥4 |
ma |

« Crossing window a1 Polygon ¥1 3|
object F1 cross T Fel faa =m
stretch FT TEd

+ SYF Base point T stretch amount
specify FX ®I FERTFA TR 2

« Allows lengthening or shortens the

object.

Crossing window or polygon must cToss

the objects you want to stretch.

+ You need to enter the base point and
amount of stretch.
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| Lengthening

| yerm Z7dm obyects ) lenpth ® ¥ W
won w & fam e

{This command 1« used for ancreasing of
decreasing the length of speaified objects)

Keyboard WU Len type %1 qeq ™
object T select F Fol sm 5 won
¢ s fam

+ Type len on the keyboand and then g)
the object you want to len

Rthen
<horten) and by how much. o

Tl aTF g AR cunting edge T cross
FT A ecnunes T erase FI T TFA #i
(The TRIM toal 15 used 1f vou need (o remove
the unwanted and extending edge Erases
a portion of selected entities crossing the
“cutung edge” specified by you. These edges
can be lines, polyline, aircles, ellipses, rays,
splines etc.)

AutoCAD sl cuting edge % fpm

@

* UF T cutting edge F select wy *
mwmaﬂnbjmé:mm
foil 3y e Tw

+ 3TUE BT selected object ¥ mam,

AutoCAD will ask you for culting edge

and then for the object that you wap to

getnd off. The unwanted portion wil| be
crased.

Extend

UF specified boundary 1 T w4 & faQ
TF line, arc AT polyline F T F 77
wF4 21

(Extends the length of a hine, are, or polyline
to meet a specified boundary. The extend
tool may be considered as the opposite of
tnm tool )

Extend tool trim tool T favia #nd gy
2

Linc. Arc 981 Circle & wm 1 frz 754 €
T & wrh F fawhea W wEd §)

(Erases pant of a line, arc or circle, or splits
1t into two lines or arcs)

TRE W %W 3 lines & connection W
‘l?:_r_mmfcr (a angled line connection) &1
TF &

(Creates a chamfer at the intersection of two
lines)

« D Chamfer T set &3 #1

P g0 polyline ST chamfer e &I
D Sets chamfer distances

P Chamfers an entire polyline

Fillet

mﬁimﬂ%immmgcmmw
g T #1

(A fillet or round connects two objects with
a tangent arc in 2D or creates a rounded
transition between the adjacent faces of a
3D solid. An inside comer called the fillet
and outside comer is called a round. you can
create both using fillet command. Constructs
an arc of specified radius between two lines,

+ PF WM 4 vertices TG polyline
fillet € =TI

* R &1 e ¥ fillet Radius F setting
F 9 TEH 21 Default value I T
? 31t 319 FF value specify T& w0
ﬁ’ﬁ?ﬁ'ﬁ:ﬁ‘«’ﬁva}ucﬁﬁ‘ml’-ﬁ
radius T TF set TEM T T 3 ]
change & H

e

ol

faplode
v

arcs, circles, or will creae arcs of the
specified radius at the vertices of 4 polyline
Radius of the arc to be constructed may be scf
to 0, which will make o sharp comer)

ke block, dimension 7 ek pattern 7
FHE constituent entities B 57 7 1y 4
m polyline # 77# straight lines 8 explode
fFm = &

(This command separates a block, dimension
or hatch pattem into its constituent enlities or

explodes a polyline into a series of straight
lines)

Hatch

73

Enclose Area W1 fRT select object %1 v
hatch pattern, solid ill A1 geadient fill %
T W B

(Fills an encloscd area or selected objects

with a hatch pattem, solid fill, or gradient
fill.)

EEr 9]

—
* PFillets an enure Polyline ot the vertices

* RAllows setting of the fillet radius. The
default value is zero

—
—_—

<Pattem Name> library file & hatch pattem
name use T ¢ Famd 7R areq F
pseudo block hatch enuty 37 fill 711 =
TEA AW TR explode FTF individual
line M points B reduce fFm = w1 71
(<paticrn-name> uses hatch pattern name
from library file to fill designated area
with a pseudo block hatch entity and can
be reduced 10 individual lines and points
by Expleding it.)

Pedit

TEE] FEEA H AN TR | T € polylines
I edit T B

(Allows editing of polylines which are
already drawn. The PEDIT command edits
polylines, objects to be joined to polyline and
related objects. Common uses of PEDIT are
joining 2D polylines and converting polylines
into curves that approximate B-splines
{Spline fit polyline))

+ C ¥ 27 open polyline 7% & = 81
* D curve FTH & @ control frame F
connected Witk T 71 g F faw
TF spline curve 2@ &1
+ E 8T vertices F1 edit f&m1 amm #1
+ F % T polyline & f TF fit curve
T curve F €9 & & 1 I5F ventices
R frt THem
T UF line W Arc T &4 polyline
TF open polyline & Jrgan &1
L line type generation to toggle =Tal %
Dash 1 0% fRm® pah:m,E-‘l\cm'ces
ﬁﬁmw%,mﬁmnemﬁﬁ
R E T VAT vertex W W4T ¥
21 (= ? ¥ toggle 7 1T A states
& ne faafem & & 91 5 ¥R fam

g € ON & OFF, OFF & ON #f2)




0 % & T polyline npmm

S splinc curve IR FEYY Poly line
vertices 1 TN F@A §) A T EX
3R variable spline type Zm Frvify
fEm ST R

C Closes an open polyline

D curves, o retums a Spline curve 1

its control frame or series of connecteq
straight lines

E Edit vertices

F Fits curve to a polyline and makes 5
senies of straight lines into a curve which
will pass through the vertices

J Joins a line or arc or another polyline
to an open polyline

L Toggles line type gencration to be
either a continuous pattern of dashes
passing through the vertices, ora paltern
which starts and ends at each vertex
(Note that the meaning to toggle is
a switching between two states, for
example, 2 CAPS lock switch is a toggle
switch because you can switch between
lowercase and uppercase by pressing this
switch).

O Opens a closed polyline

S Uses the polyline vertices as a frame
for a Spline Curve i.e. type of Spline
Curve is set by the Variable Spline type)

Osnap

Existing objects ¥ reference points W [ CEN Centre of arc or circle
points @1 precisely locate T & o | END Endpoint of arc or line closest
OSNAP F1 Running Mode Fe1 9T 21 51| INS  Insertion point of Text or Block

None & %2 ¥ T T cursor menu & A
Interrupt Mode OSNAP Method & 4 W14

MID Midpoint of line. arc. rectangle side,

or polygon side

@ selection mode F1 TR run 14 ¥ | NEA Nearest point selected by aperture on

set FA1 Bl

line, polyline, arc, or circle

OSNAP Method 3 combination 3 commas | INT Intersection of line, arc, or circle
SR FAW fFT M option F TF series & | NOD Node or Point

A T TR M W w1 e | NON None

% faw afz 3 lines F1 end point locate | PER  Perpendicular point to line, arc or

4 5 T end points @ intersection points

circle

pick T =TEA € 1 A 5 command use | QUI Quick mode

&1l OSNAP < RET > END, INT < RET>

QUA Quadrant point of arc or circle

Ortho

wFz 93

(The ohject snaps (osnaps) command are
drawing aids used in conjunction with other
commands to help you draw accurately, Iy
allows you 1o snap onto a specific ]nca'tmn
when you are picking a point. Enables points
to be precisely located on reference points
of cxisting objects. This is the so-called
“Running Mode™ of OSNAP. which sets
sclection method to run continuously until
st to NONE (none) or until overndden by
selecting another “Interrupt Mode” OSNAP
method from the cursor menu. Combinations
of OSNAP methods can be used by selecting

a series of options separated by commas)

39 command F FEEW B drawing 1
constraints f&a1 I & AfF grid ¥ =
wiHa lines W o T TR A4
Horizontal 31 vertical lines ¥&(® AfC
cross hairs &7 snap, rotate command F{#3
F WA § qE 9 €, 9 = EE
crosshairs U@ F T4 parallel ¥4 & fag
constraint () & W &1 IHF point R
snapping FT& 41 end points F AT exact
co-ordinates enter T constraint Fl TH
N wFA &

(Constrains drawing so that only lines aligned
with the grid can be drawn. usually means
only horizontal or vertical lines, however.
if the crosshairs are rotated through the
Snap. Rotate command sequence. the lines
drawn are constrained to being parallel
with the crosshair rotation. Constraint can
be overridden by snapping to a point or by
entering exact coordinates for endpoints.
Ortho mode is used when you specify an
angle or distance by means of two points
using a pointing device. Inortho mode. cursor
movement is constrained to the horizontal or
vertical direction relative to the UCS.)

-4

the user.

T selected line, polyline, arc T circle F
g frfi sfard W point (T optionally
blocks ) TR Tl 21 Interval 1 distance
user ¥ g0 A k]

Places points (or. optionally, Blocks) at
intervals along & selected line, palyline, arc
ot circle. The interval distance is given by

B Specify T & % TF defined block 71 {
TF point F T99 TF marker 9 F
svam fem 5w &

B specifics that a defined Block is to be
used as a marker instead of a point.
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Scale

¥ AT ST
7€ existing object F HE
1

(Alters or scales the size of existing objects)

A oftaf F

qifed size T style ¥ text characters draw
FA .
(Used for drawing text characters of specificd
size and selected styles)

—
« R % BN Reference size & Ty 0bj:,

H AFEN TS T TEHA R

* R Resizes the object with reg

2 Pect to 5
reference size

]
« Precision Drawing A text B

HEeqel 81 3T objects T TE line
drawing ¥ text ! TF object B ¢,
T scale, move 3 ernse 3y cditing
commands % I open B
AutoCAD 319 2 option ¥ )
Single line

Multiline

Text is also very important in precision
drawings. It is also considered as an
object, just like other objects such as line
or circle. This is open to same editing
commands like scale, move and erase.

AutoCAD gives you two options i.e.
single line, multiline

ks 95

—

(Draws aline or series of lines with an arrow
head called leader, to point 10 an object to
notate it. This command will also prompt
you for the note at the end of the leader
line, allowing only one line of text. Hence,
you can draw leaders between the object to
be notated and text that you create with the
DTEXT command).

Lincar Di

1

aT 1 @ ¥ di
draw FT@1 31
(Draws the dimension of a line linearly)

ion ) lincarly

Line, Polyline, Arc T circle ! specified
number ¥ TR Wi A fawfem st 1
(Places points along a line, polyline, arc, or
circle, dividing it into the specified number of
equal partsi.e. you specify that in how many
parts you want to equally divide the object
and the points will be placed at the desired
position so as to equally divide the object.)

« Object H select H

« AutoCAD 3T parts 41 number of
divison specify FTA H FR T enter
| AYH T object Th FAfd= F&
¥ segements & T B &1

* Select the object.

* Then specify the number of divisi.ons
or parts, the object will be divided into
specified number of segments.

Text
4
Divide
Leader

f&t object F notate FH ¥ Y TF arrow
head fo SR T T “leader” F21 ST 2,
¥y TF line Al series of line WiEM a7
command FMFN leader line ¥ 37 ¥ note
F fom % 3, 9 T oxt R Faw
line F ﬂiﬂfd m T command % ITE
T F WG useful method Faet notated
object % F leaders F draw T 3 text
ﬁﬂmDTEXTcommand%m?ﬁﬁ%I

Aligned Dimension

A\’

¥4 command 1 FEEAM B selected
dimension origin points % WA lincar
dimension draw f& 3 Taa }1 77 SR
T angled line % A1 dimension align F13
M & S 3 @ facgd Horizonwl €7 & 7
A verticall s

(Draws a linear dimension with the dimension
line parallel to the selected dimension origin
points. Hence, you can align a dimension
angularly with the desired line that is not
either exactly horizontal or vertical)

Angular

A

T command F WA | Arc draw T
TR %, QA non-parallel lines Fdg angle F1
O L FHA & 90 text 3R arrowheads 11
draw ¥ §Fd 21 Arrowhead 39 defined
Arrowblocks o #X standard AutoCAD
filled fireror 81 #1

(Draws an arc and calculates the angle
between two non-parallel lines, and draws
the text and arrowheads. Arrowheads are
the standard AutoCAD filled triangles,
regardless of your defined Arrow Block
i.e. the arrowheads draw will be standard
AutoCAD and Arrowheads.)

Base line dimension

h..

39 command ¥ FEr & fIoeR @1 selected
Dimension #1 Base line ¥ linear dimension
I RN T FEdR 8

(It continues a linear dimension from
the baseline of the previous or selected
dimension).
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Centre

®

Current layer T circle 3 Arc #F centre W
Jines draw T Fa 1

(Draws crossed lines at the center of acircle
or arc on the current layer)

Radius

@

T Arc A circle F radius dimension A
centre & T8 g 0 draw ¥ § 961 9
F arc T T 9

(Draws the radius dimension of an arc or

circle from the center to the point on its locus
where the arc or circle was selected.)

Diameter

©

78 command F1 TE@A & selected circle
Arc 1 Diameter measure & =1 T4 §1
(Draws a dimension through the center of 2
circle or arc, calculating the diameter)

Function and Accelerator Keys

KEY OR KEY COMBINATION DESCRIPTION

Fl Online Help

P Osnap ON/OFF

Fé Coords On/Off

F7 Grid On/Off

F8 Ortho On/Off

F9 Snap On/Off

F11 Object Snap Tracking ON/OFF
Press CTRL + A Select all
Press CTRL + C i COPYCLIP
Press CTRL + V PASTE CLIP
Press CTRL + G Turn GRID on/off
Press CTRL + N Create a NEW drawing
Press CTRL + O OPEN an existing drawing.
Piess CTRL + P PLOT a drawing
Press CTRL +§ Save a drawing.
Press CTRL + X Cut to Clipboard.
Press CTRL +Z UNDO

AutoCAD 8hort Cuts
DRAWING COMMANDS

COMMAND SHORT CUT
Line L
Muliiline ml
Poly line pl
3D Poly line 3d poly
Polygon pol
Rectangle Rec
Arc a
Circle ¢
Donut do
Spline spl
Ellipse El
Block
Text T
Dimension Dim
Write block w
Insert 1
Hatch H
EDITING COMMANDS (modifying)
COMMAND SHORT CUT
Change properties ch
Erase E
Copy c
Mirror Mi
Offset o
Array
Rotate Ro
Move M
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li COMMAND SHORT CUT
— e =
| Streteh S s
I . Lengthen Len
Trim Te
Extend Iix
Break Br
Chamfer Cha
Fillet P
Explode X
Layer LA
Units UN
Zoom 7
Regen Re

(h ARC = ..
i) Z00M =,
(iil) STRETCH =.
(iv) ERASE

(v) CIRCLE
(vi) FILLET

(Vi) MTEXT ~

) Ctrl+0
(i) Ctrl +2
(v) Cirl +4
(vih) Cirl+ 6

(i) Close the block editor

() Create a leader and Jeader annotation
(Iv) Control properties of exlsting objects

(v) Create a 2P polyline
(VD) Check spelling in a drawing

(vil) Create a line of Infinite length

QUESTIONS

1. Write the one key Shortcuts for the following commands:

2. What will the following commands do;

1) Crl + 1
(v) Ctrl +3
(v Cirl+ 5§

3. Write the Hotkeys for the following:
(1) Calculate the area of an object

B
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8PECIAL FEATURES:
LAYERS:

Autocnd drawing 41 v o tuyeon ¥ o0 s B0 Layer v paper 70 e iz 41 me
A & forreil denwing objectn T S0 TR 1 sammeona; faedt et 42 plans ) drawing 7 04 layers 71
une {7 N T B1 A 1 Dyer &Y occopy AR T wally” wer w B, weark s frrefent
fort fayer YO REE S, WY (o 000 fem o 7w B, suft Deawing W) woy @ wifea w03 wond
il vt gt P fa o v 8

AUtoCAD STTAY T defanlt layer WeR ATl & 3001 A0 0 (zer0) 81 10 other layer @1 309%
v sl ¥ feaw wEnan o ofen, vl s U g % P wE 3w layers assign 91 WA
{1 0 layer i Y & 16 71 Fe) objects hotd w2 10 81 BT ayer 01 0 s A g v

Layers Wi U 570 & A0 lie wxd) & T4 move 7 fam w wrm #)

Layer 1 visible 41 invisible @t 31 T # 3t 70 colour M line type assign fm =1 7w {4
Wi layer T draw W1 1§ T object U wpecific colour 4T line type 7 €1

- line % 01 w1 IV Line W) thicknews w1 fear & fery fam e 81 an o 5 A
printer/plotter device 0 3 monachrome i 3wt w7 &, T Layers 91 colour assign T 474 arer
o T

An AutoCAD drawing can be constructed over several layers, A layer is like transparent sheet of
paper which holds drawing objects, For example, a drawing of plans of house could be constructed as
follows, The wally would occupy layer called Walls, the doors and windows would be placed on layer
called “yitting”, ete. When a drawing Iy structured in this way you have control over various works.
Autocad supplies you with one default layer named as 0 (Zero) layer, Any other layers must be created
by, the user, although you can assign as many layers as you like to a drawing. A layer (s not limited in
number of objects it can hold, Each layer should have a distinct name. Layers always lie directly vnder
each other and cannot be moved. By using appropriate commands layers can be made visible or invisible,
and can be assigned colour or line type so that each object drawn on the layer will be in specified colour
and line type, The colour of line type can be used to indicate the thickness of a line, Even if the printer
[you use 1y of monochrome type, assigning colours to layers can be very important and helpful and makes
lllu- drawing more understandable.

Setting up n New Layer (a1 layer setup w0 —7el £7 Walls 31 Fitings ¥ %1 2 layers %1
st up )

% 1§ layer 7Y % forg, Ty %A layer command ) fssue F

¢ Command line: Layer

¢ Menu: Format -» Layer

® Layer properties manager dialog box H new T click H
W Inyers el lise 7 wafckn 7 o &1 T drawing i ferg @ layers setup ®1 AW T

® Walls 84 3 layer type U A1 enter press Y YAR wall THF layer I B WAM TR
properties W ¥ % e, show details T click F

¢ W W Fittings T W} UH New layer %A1
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Setting Up New Layer: o
Set up two layers catied Walls and Fittings. To create anew layer, fistissve the layer COmmany
e Command line: Layer
* Menu: Format— Layer
o In the layer properties manager dialog bov, click on new.
« Typeinalayer named Walls and press enter. The Walls layer, will thus be created, click oq S

details to see its properties.
o Create a new layer called “Fittings™ in the same mannet.

Assigning Colour to Layer (Layer &t Colour assign 0
el layer 1 colour TTR T F W 58 layer ¥ draw F T 4T T I8 colour } § w3
« Colour column & colour box W check FE
o Select colour dialog box ¥ Walls layer ¥ ffT Wit 11 W click S
» Fittings la_\trﬁ gmenco\ourmgnﬁl '

Assigning Colour to Layer:

After assigning a colour to a layer, everything drawn on that layer will take on the same assigns!
colour. To assign a colour to a layer. 5

« Click on colour box in the colour column.

» Click on the colour red for the Walls layer in the Select Colour dialog box. (you many asig
whetever colour you want)

+ Similarly. assign the green colour to the Fitting Layer.
Making a Layer Current (Layer H Current TR & m:
5 layer R draw T § V68 ¥ current 3 ST £1 Walls T layer 1 current ¥ §
o= steps T follow TR—
* Layer Properties Manager dialog box ¥ layer name W click %%, fft current botton ® clickst
* Drawing editor W retum ¥4 ¥ fT OK W click 51 :
* Screen  top W Object Properties tool bar, current layer T 9% 10 =1 7 feamem
Making a Layer Current:

e By current layer. we mean the layer on which we are current! y working on. The current layer select
the selected layer as the current layer on the viewport.

A layer must be current before you can draw on it.

To make the layer Walls current

. 1 e =
Ch_d‘ on the layer name in the Layer Properties Manager dialog box. then click on current W&
¢ Click Ok 10 retumn to the Drawing editor ) ¥

* The Object Propert r
and its <J:olour_ s 100l bars at the top of the screen, will show the name of the current Iy

|iwm wrd: @ owwR Fittings layer #1 current layer @
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Making Layer Visible or Invisible (Layer % W IKF TA:

AutoCAD 3T#1 layer F switch OFF T switch ON 33 ¥ ¥ 2@ # saig 39 layer F
‘OFF" (invisible) T "ON" (visible) F1 TR ¥ I Complex drawing cluttred ( F57a(=7) falkr il
& fir cditing T drawing 3 0 object F1 select 77 T 7w 1 7tz 579 fadd = &
jayer T FT T TR & A T layer F invicible T clutter 71 ¥ fFW 71 75T t ¥
layer invisible Q M ¢ M IV W draw €3 T objects screen ¥ T (disappear) T A ¢, T
2 drawing 1 feem o T H= layer invisible f&m =/ E: 14 print & 7@ g 21 ST T
@ ¥ i fumishing ¥ interested 78 €, 3 TF interior designer 3 drawing T place 57 £ 1
7 9 furnishing layer 1 invisible 0 drawing 1 builder (T Frfan) ¥ 7 ploc 37 ¥4 €1 7%
AEeaE @ W T layer F invisible TR T FA &

Visibility 1 show &3 ¥ foT T glowing light bulb &1 icon a1 # T invisibility 1 dull light
bulb ¥ Z0 show fFa = &1

Making Layers Visible or Invisible:

Autocad allows you to switch a layer “off” (invisible) or “on™ (visible). Complex drawing may become
cluttered, (379 complicated) which can make it difficult to select objects for editing or drawing. This
clutter may be reduced by making a layer invisible, if you are not working on it. When a layer is made
invisible, the objects drawn on it disappear from the screen. but they still exist and part of the drawing
means that being invisible does not means that you have removed that object. it only mean that it is not
being shown on the screen for the time being. Layer w hich are invisible are not printed. So. you can print
selected layer of the drawing. For example. suppose a builder of tower may not be interested in furnishing
which an interior designer has placed on the drawing. The furnishing layer can be made invisible and the
drawing is then plotted for builder.

Several layers can be made invisible if required. The icons for visible is a glowing light bulb.
Invisibility is shown by a dull light bulb.

. |
Important to Note: When a layer is ON, it is visible and available for Plotting. When a layer is off. |

itis invisible and not plotted even if plot is ON. ‘

]

Linetype (ST§E¥Q):

AutoCAD ¥ Default linetype continuous £1 TF dotted a1 dashed (T other) linetype T line draw
T ¥ AU 9 libraries ¥ supply ¥ % linetypes ¥ F selection ST &I

How to access a line type (STFFETEY BT access FTT): Linerype T use T & o 7 steps —
mﬂaﬁ‘mﬂ Linetype library & AutoCAD ¥ load ¥ WTET. SR T current stams ¥ ¥ ¥ set

e

How to use a line type: (S5 T§T F Use & =Y)
T W AtoCAD 3 line type load 813 3 T2 39 T “current’ T 77ag STWM T wwA ;
* W layer N assign TE—TN Fard F By layer method $T Ll
© T TF block M assign TE—T method N by block method & &1
* W TF object migna:@s—-ima-ﬁ ¥ fom S line type F current TR 3R draw 1
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How to load line type (emgT TRY F load HR):
o Object properties toolbar ¥ line type W click FX 3R command line W Arrow 3
¥ 7 line type, type F
o Other ™ check X1 ST line type manager S fRar ST B
o Load W click ®
o 75 g 6
list ¥ select F
o T line T click #t F1 39 load T TEA &1
o Linetype 3% loaded 2 3 linetype manager dialouge box 1 list & add &)

C(,nlm &

acadisolin T box ¥ A AR & T € A Al w check Y st
us: 1

LINETYPES:

The default line type in AutoCAD is continuous. To draw with any other line type

in the libraries of line types supplied. youhareo

How to Access a Line Type:
To access a line type, the line type must be loaded in AutoCAD from library, and set as currenisa

How to Use a Line Type:

Once a. line type is loaded into AutoCAD, you have to make it current
* Assigning it to layer (By layer method) .
* Assignit to a block (By block method)

* Assign it to an object (make the line type current and draw)

How to Load Line Type:

« H .

; CE:::;:?—;, l:n;pemcs Panel = Line type drop down list = Find
. ine type manager is di

+ Click on loud, ger is displayed.

* Make sure acadiso.lin is in {hi i
(Note that LIN 2 p:il:n lhl:box. If.it is not then click on file and select it from pibrary
rary files or simply a collection of Linetype definitionsin ASCIE®
setting ACADISO. LIN j . .

* Click on the line :;::1: ::1:? ?mOCAD drawing i started with metric settings)

* The line type is now 0 load and click OK.
. loaded and ad, iz

use the line type in your drawing nod:d to the list in the line type manager dialog box.

Dimension Tools

&

‘ T scale |
. : . draw &
B, a; tedt feafy 3 Annotation ) "

angles # sh
Sy

) o

% precise drawing desired information & & fm i

;‘?Jectsaﬁ length A objects & e # Lk A
imensioning 9 Annotation #1 drawing ¥ it

| n
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Dimension features 31 T ¥ 1Y T3 terms 31 I Aa7T® € 9 770 AW use FF2 i #

Dimension line—%g UF line €1 2 f¥ end & arrow 1 {7 ¥ ¢ A 7% 2 T4 dimension
1 @ 3 represent FA 2

Arrows—Dimension line % end WU &l TWHd F1 arrow F21 WA 21

AutoCAD ¥ feature # g ¥ flexible # 1 f BT arow block F ticks, dots 3% L
replace FTA 1 ST 2 & IR AHT vary & = 8—

Extension lines—3T¥dI T dimension 1 measured object @ @121 g1 draw fFa a1 %1 Measured
dimensions 1 T ¥9 & Ff¥e w11 & fag 2 § 1@y object & perpendicular draw = 9 2,
f572 extension lines % &9 ¥ A1 S #1

Dimension text—7% TT text I actual measurement F specify FT 81

Leader—# % dimension text ¥ ITIH T W move FTN FAES & T & FF 7T
object ¥ T fFz T T #) T cases #, end & Arrow TTeRl TF pointer line objects T text F s
ETEE B 2, R leader F71 TR ?

Dimension Tools

In certain applications, a precise drawing plotted to a scale is not sufficient to give the desired
information. Hence an annotation must be added showing the lengths of objects or the distance or the
angles between objects. Dimensioning is the process of adding this annoration to the drawing.

Dimension line: Dimension line is a line with arrows at the end. It represents the extent of given
dimension. ’

Arrows: The symbol at the end of the dimension line is called arrow. AutoCAD allows arrow block
to be replaced with ticks, dots etc. the size of which can be varied.

Extension lines: In practice, dimensions are drawn a certain distance away from measured objects.
In order to specify the extent of measured dimensions. Clearly, two straight lines are drawn from the
object perpendicular to the dimension line, which line are known as extension lines.

Dimension text: Dimension text is the text that specifies the actual measurement.

Leader: In some cases, the dimension text may be moved a suitable place as it does not fit near the
object. Hence, a pointer line with an arrow at the end is necessary between the objects and the 1ext,
which is known as a leader.

A% (Blocks):

T& block objects F1 FIE (collection) T 2 f99 @& single name object & ¥9 ¥ combine f&m
I 1 378 § FO sAF objects, objects F e representation B %, T symbols T & 3R I
A TF D-size drdwing F T Architectural title 5 B 21 AutoCAD ¥ ‘=&’ w1 | IRM A
repeatable items 1 o T ¥ forg F e @ R 39 TR g A T@d @, - @ symbol
s e &

AutoCAD drawing & blocks &1 I T F FE o §—Tee Y speed & 374 TF I/ I 7
TF symbol draw T & A T-T T draw FTH F S € EA THA S fle size 2, “blocks’
H TR HQ A 3T drawing sheet T file F1 AFR (size) TTH FF B SCW
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% ® Create TN (Creating the Block)
o =iF ¥ A objects create R
o Block command 3 JE Xl
o Block ¥ T name enter
o IW object 7 7T T Frd o1 =ilF F fog TN W
o Block insertion fag # faffe
o Convert to Block I seiect ®I
o Ok click Ht1

% # Save A (Saving the Block)
¢ Command bar & block type #%
o Block 9 T& T ¥
« T location ¥ &l 39 block ! save HTH TR 2
* Ok ™ click ®I

Block ® Insert T (Inserting Block )
¢ Command bar W I type ®
e Block % ¥ ¥ save %1 T fill A locate T
o Insertion point 3 fifd= =X
o Ok W click ®I
Ablock (also called symbol) is a collection of objects that are combined into a single named object.

- Some of these blocks are realistic representations of objects, some of them are symbols, and one of them

is an architectural title block for a D-size drawing. The term Blocks is used in AutoCAD to describe
repeatable items that you place in your drawings. Blocks are used in our AutoCAD drawings. To enhance
.fpeed as once we draw a symbol, we will never have to draw it again. We have to select it and drop it
into our drawing. Using blocks grearly reduces the file size of saved drawing sheet.

Creating Block:
¢ Create the objects for the block.
* Start the BLOCK command.
* Enter a name for the block
» Select the objects that you created for the block
* Specify the block insertion poins.
* Choose Convert to block.
* Click OK. Hence, the block will get created.

Saving the Block:
* Type block in the command bar.
* Give aname to the block. (You can name it wh

useful)

atever you like but meaningfiel names always P s
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o Click on browse and choose a location where you want to save the block.
o Click OK, hence the block will get saved.

Inserting Block:
o Typelonihe command bar.
o Locate the file that you saved as a block.
o Specify the insertion point
o Ciick OK, Hence the block will get Inserted,

Dynamic Blocks:

Dynamic Blocks & £/, parameters 3z 3R € a1afq 387 ¥ insert 7 911 W block reference
¥ appearance (¥T&T) FI T5eM ¥ Y dynamic block ¥ rules @1 parameters €1 €1 T =ii®
¥ Wy =M F¢ static block WRAWN F1 TER F AT TF YA =AF €A T4 € A shape. size A
configuration ® TEH Fehdl &1 I F fAU, fafe= AR F FF interior door HF T F T
MY TF resizable door block &1 T Bl

One of the most powerful feature of AutoCAD is dynamic block. Dynamic blocks contain rules, or
parameters, and they describe how to change the appearance of the block reference when it is inserted in
the drawing. With dynamic blocks you can insert one block that can change shape, size, or configuration
instead of inserting one of many static block definitions. For example, instead of creating multiple interior
door blocks of different sizes, you can create one resizable door block.

TRfamedts W
() UNDO g Shortcut
(a) CTRL+Z (b) CTRL+Y
(¢) CTRL +X (d) CTRL+W
(i) PASTE ®g Shortcut
(a) CTRL +Y () CTRL+X
(c) CTRL + W (d) CTRL+V
(iii) Online help 8] Shortcut
(a) F4 (b) F3
(c) F2 (@ F1
(iv) GRID ON/OFF &g Shortcut
@) F7 (b) F6
(c) F5 ) F4
() Crtho ON/OFF ¢ Shortcut
@) F7 (b) F8
(c) F9 (d) F10
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WG WEA-1 (Experiment-1)

IRV (Object):
(i) AuteCAD ¥ flmash 1 s15397 T (To study the features of AutoCAD)!
(i) Computer ¥ input @ output devices 1 VST FT (To study computer input and output
devices)! '
JAYEFE WHM (Requirements):

o Software: AutoCAD Software

* Operating System: Intel Pentium 1V, or Compatible

® Microsoft Windows XP (Professional, Home Edition, or Tablet PC Edition), Windows 2000

Professional SP4

e Memory: 512 MB RAM (minimum); 750 MB free disk space

¢ Display: 1024 x 768 VGA with true color (minimum)

o Input device: Mouse or other pointing device

¢ CD-ROM drive

* Microsoft Internet Explorer
@it (Theory):

AutoCAD software Autodesk BR1 launch 1 T software 21 AutoCAD software 1 Fewal
drawings A | draw T90 interpret foa =1 @ él 3‘&\'@ ‘f-f k| Drawingsiﬁ mini drafter %t
TEER A T T @R FF time consuming T SIS WERA ot A drawings ¥ O FA R 5gd
TfeFs A I =@ AutoCAD software # = commands # 7T ¥ drawings 1 A1 T modify
FTH FTH FEA 8 T E FEH TRO AutoCAD F SR T T frm e 1

Advantages of AutoCAD (AutoCAD & @)
o AutoCAD fESTgTT &1 Productivity ® agm 21
(AutoCAD improves the productivity of the designer to visualize the product and its component,
parts and reduces the time required in synthesizing, analyzing and documenting the design).
o AutoCAD @ FTE &1 fayeiqur wieral | aan MeAaT @ fman n v 1
(AutoCAD system permits a more detailed engineering analysis and a larger number of design
alternatives can be investigated).
o AutoCAD % Wi & drawings ¥gaT ¥ €, ST WASHIETW G §, I9T AR documentation
v gan & e qfea ot wwogf
(The use of AutoCAD system provides better engineering drawings, more standardization i.n_tlxe
drawings and better documentation of the design as well as few drawing errors and [egl’blllt)‘)-'
« fafT=1 components 3 design T ¥ AutoCAD &1 U& Engineering Drafting tool ¥ ¥ ¥

wErgqul st §1

o T TR Keyboard F key FI press ¥31 & & T

\ o IR FPET Keyboards QWERTY Keyboards
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3D Max, Maya, ¥ 3 design Automation tools & H17 use 7 w=wa {1

(AuroCAD's enable its users to plan our architectural s

: iy paces, map them out and b
simultaneously with 3D Max. Maya and other design/animation 7:)0[: when the :::d :n"‘::d
AutoCAD supports the use of DW_G and DXF files which can be exported from its interface 0
those of other advanced CAD applications 1o aid animation projects) ‘

AutoCAD vs Manual Drawings
o AT % M (AutoCAD is easier to understand and is user- friendly)!

o Wi, 3 FH time consuming (much faster than manual draw ings. So. its less time consuming)!

o ¥ accuratey & errors (It is more accurate, so, errors are reduced)! i

o Back up FFI AU SR § WR w1 1= (Creating backups easier, hence no problem of
storage)!

o E-transmit option ST drawing %1 fava & et s %14 & 5 #3191 599 (E-transmit option in
AutoCAD, enables the user to transfer the document easily to the client in any part of the world)!

o Drawing Tl update @9 modify FTT GH (Updation and modification is much easier)l

e gﬁb‘ﬁ (Input Devices) :

| T W 3 Input T ¥ NG I Input I e 1 ol Inpur 3 P 3—
_ > Keyboard:

' 7 TEIIR F a@ A 2 (97 1.4))

electronic signal ST STl S bit pattern (1 7% 0
51 99%) ¥ convert € S B
* o Keyboards # ASCII (America Standard Code for
Information Interchange) = 431 f&al STl 21
* Keyboards & <8, Sicwrafese a B F1
& il keys Bft 21

fax 2.67—=1-2E a1 WRE

B & o 8-bit FT code T 256 Tt F1 I
T e ) g7 WY R AR Keys B Sl #1 F9 “QWERTY™ 81 €1

* Set of typewriter—like keys that enables you to enter data into a computer and other devices.

. * Standard tayout of letters, numbers, and punctuation is known as a QWERTY keyboard because the

first six keys on the top row of letters spell OWERTY.
* | Keys typically found on computer keyboards are:
¢ Alph ric keys: The letters and numbers on the keyboard.

(AutoCAD is an engineering drafting tool used for designing various comp ts, while minimizing

human errors).

o AutoCAD %} fasrearsii % =TT01 AT designs FY plan FT TFA &, map BT W §

* Punctuation keys: The comma, period. semicolon. and similiar keys.

. * Special keys: This includes the function keys. control keys, arrow keys, caps lock kev, and so on.

Iv
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» Mouse: 8

o WEE T e feanq R (f 1.4) T Screen % Pointer ® control F B

o TT & palm size device 31 (T wEER ¥ AEs F TR)

o T Ball ¥ g7 o1 &1

o 75 S A e ET S W ¢ T A 727 a9 G Seroll wheel Bt 81

T Mouse 3 FF THE T move i ST # A Ball Roll % & fraW Pointer W screen W move
a1 3 options F sclect fF ST wF R

ST F select 3 2 single click, T F select T open FH ¥Y double click A% Window
move FTA %Y drag operation 1 q {1 N L4

o Optical mouse LED light ¥ % %@ & af® Laser mouse Laser T41% 1 T CIcA]

o A pointing device that detects two-dimensional motion relative to a surface.

Motion is translated into the motion of a pointer on a display, which allows a smooth control of the
graphical user interface.

Controls the motion of a pointer in two dimensions in a graphical user interface (GUI).

Turns movements of the hand backward and forward, left and right into equivalent electronic signais
that in turn are used to move the pointer.

Relative movements of the mouse on the surface are applied to the position of the pointer on the
screen, which signals the point where actions of the user take place, so that the hand moverments are
replicated by the pointer.

.

Controls the movement of the cursor or pointer on a display screen.
A small object you can roll along a hard, flat surface.

Name derived from its shape, which looks a bit like a mouse, its connecting wire-can b‘e imagined to
be the mouse's tail.

As the mouse is moved , the pointer on the display screen moves in the same direction.

Mechanical: Has a rubber or metal ball on its underside that can roll in all directions. Mechanical
sensors within the mouse detect the direction the ball is rolling and move the screen pointer accordingly.

Optomechanical: Same as a mechanical mouse, but uses optical sensors to detect motion of the ball.

Optical: Uses a laser 10 detect the mouse’s movement,have no mechanical moving parts, respond
more quickly and precisely but they are more expensive.

» Touch Screen:
o 7% T M ¥ H Screen T 2 < = % W 3TN (Touch sensitive) et 21

e T Screen W Option Select 1 ¥ It foban et 2

o Touch Screen, ATM, Mobilephone, restaurents St % 351 2l &1
o A computer display screen that is also an input device.

{"'s Screens are sensitive to pressure; a user interacts with the computer by touching pictures or words

on the screen. -
* Aninput device normally layered on the top of an electronic visual display of an information processing
" system.
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o Touchscreen lz’f_h"ﬂ"'g)' makes it possible to interact with a computer system using direct 1ouch of
the electronic display instead of using a traditional keyboard and mouse.
o Typesof touch screen technology are: Resistive: coated with a thin metallic electrically conductive
and resistive layer that causes a change in the electrical current which is registered as a touch event
and sent to the controller for processing. Surface wave: uses ultrasonic waves that pass over the touch

screen panel. Capacitive: coated with a material that stores electrical charges.

Wgﬁﬁﬂ (Output Devices) :
Tﬂ@ﬂﬁé%ﬁﬁfwmmmmm?mélfaﬁamw
e o—

Output Devices
— Monitor
Non
Impact Laser Printer
[—= Printer Printers
Inkjet Printer
—= Plotters 2
Impact Printers
Dot Mairix Printer
L——s Speakers

» widfex:
« T VDU (Video Display Unit) 9t %21 <1 &1
o THF TEAA A results F screen T 3G < T 1
o Monitors &1 size 3% diagonal (Frvl) 1 specify fFl S § &9 21 inch screen ¥ diagonal
21 inch ST F1 gAMI
o Screen %1 Resolutions screen T pixels It ¥& g1 i &t ?1 Wiz 71 o= @l dots &
foer 1 @ 2, 9 dots picture elements 1 pixels FEed &
. ;)iSplay 7 CRT (Cathode Ray Tube) screen 3 LCD (Liquid Crystal Display ) screen wEm = ==\
|
>fifet
et Tz g firedt document 1 printout &1 R wam e S 21 Printout 3 document ¥ hard
copy & T 21 Printer & ¥&T ¥ 819 §—Impact printers ¥ non-impact printers. Jmpact printers
. Paper W print XY AT paper F WY ST & wafF non-impact printer, ¥R FI touch & FTA1 Dot
Matrix printers (DMP) Daisy whee! printers 3 Character printers impact printer %1 i & o & w=te
- inkjet 7 Jaser printers non-impact printers ¥ 471 % am &
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wre fiizd (Laser Printors) :

o fro Anfimd (static electricity) ¥ fagra w2 sy

o Laser @ WEmm R YW W positive charge TR fm Imn &, aen (61 paper AT (toner A1 ink
powden W1 spray fkm B ok At wd) fawwdl & S positive charge B R

o TT7 T A Apa e Wi (R @ wivem O & ), I resolution (600-1200 dpi)

o % TR T welting ¥ WD A 7WH

o WEM, carbon copies IR T W W wHd

o Aprinter ( fa7 1.8) is a device that accepts text and graphic output from a computer and transfers
the information to paper, usually to standard size sheets of paper.

fam 2.68-fie

Anexternal device that communicate s with another digital device to print what a user sees on a screen.
Use small pixels to transfer an image from the system to another surface,

A peripheral which makes a persistent human readable representation of graphics or text on paper
or similar physical media.

Laser printer rapidly produces high quality text and graphics.
Laser printers employ a xerographic printing process
Inkjet printers operate by propelling variably sized dropleis of liquid ink onto almost any sized page.

They are the most common rype of computer printer used by consumers. printer is a piece of hardware
for a computer.

*

o Allows the user to print items on paper, such as lett, rs and pictures.

» T (Plotters) :

o e o T yEm ¥ faed ¥R & 9 353 T 9 drawings, images T graphics # hard copy
IR T ¥ WA 9

o 7% fied T T B W w2

o Plotters % W& ¥ TR §—30 et (78 YW @ rotating drum W mount fa s §), we ¥
TR (¥ IR F horizontal surface W fix a1 i 1), vef)

Aavz 111
CAD workstation: A CAD workstation, in ity simplest from, consists of a ¢ omputer with a keyboard,
Mouse and monitor and loaded with CAD software. The beyboard am

itor Is arenl time I mouse are essential input devices
montic
whereas 1

; output device, Al the three are Integral pans of computer and are always
cannected 10 central processing unit. For CAD applications, o ¢ omputer with reasonably good processing
unit 18 recommended.
Rosult:

studying of Auto CAD, its application and its advantages is done,

Wi ¥N-2 (Experiment-2)
practico Exorcises on AutoCAD Software

RV (Objoct):
AutoCAD ) commands F study 391 practice 1 (To study and practice basic draw commands
of Auto CAD)!

: sryas @l (Requiremonts):

o Auto CAD Software e Computer Hardware

| Commands:

o Line ¢ Polyline
¢ Rectangle ® Arc
¢ Circle

ot (Theory):

Line Command:

] Contiguous linc segment ¥ATY iﬂ ¥H command FT use fHTT FAT §1 TS segment TF line
| object BYar & RvEmY sepurately edit i w1 W #1
|
[

Create a series of contiguous line segments. Each segment is a line object that can be edited
| separately.

fax 2.69—Line Tool

* Commang: L.

|
|
|
‘ * o0 Wae wned
I * Specify first point: Pick any point
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® Specify next point: 8

(Give Direction then specity distance)

o Specify next point or {Undo]: 3

o Specify next point or [Close/Undo]: 8

o Specify next point or [Close/Undo}: 6

o Specify next point or [Close/Undo]: 2

o Specify next point or [Close/Undo]: 4
Specify next point or [Close/Undo]: 6
Specify next point or [Close/Undo): 6
Specify next point or [Close/Undo}: 8
Specify next point or [Close/Undo]: 6
Specify next point or [Close/Undo): 5
Specify next point or [Close/Undo}: 3
Specify next point or [Close/Undo}: 3
Specify next point or [Close/Undo]: 2

&% 2.70—Line drawing

PLINE:

PLINE 314 Polyline command line command F TE O & Ty wai TER aen g end
point B specify T AT {1 TT TH object ¥rft & feg TO different segments B THA &
Polyline ¥ YT segment F FBA width & 1 WS 9 polyline % start q end ¥ FET-
e width R & 0 wER

Command Pline means polyline and created in the same way as line created b

ut this command
requires first and second endpoints. It is an object but may have different segments. In polyline, each
segment can be given required width and can be also given different width to the start and end of the
polyline.

&

 Ribbon: Home Tab » Draw Pancl » Pline (Polyline)
o command: PL

L ]
alze View' Manage - Outpust
L Trin!‘ v f

“BFilet ~ .

St.lle ::A"ay ja &

1 -, B svech . )
Ly . Moddy v.

Poly[\ne

e 2.71—Pline Tool Icon

o Specify first point: 3, 3

« PLINE Specify next point or [Arc Halfwidth Length Undo Width]: 6.6

« PLINE Specify next point or [Arc Halfwidth Length Undo Width]: 6
(give right side direction then enter value)

o PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 3
(give down side direction then enter valuc)

o PLINE Specify next point or {Arc Close Halfwidth Length Undo Widthl: 6
(give right side direction then enter value)

o PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: @6 <45

o PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 9
(give up side direction then enter value)

¢ PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 3
(give left side direction then enter value)

s PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 3
(give up side direction then enter value)

* PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: 9
(give left side direction then enter value)

* PLINE Specify next point or [Arc Close Halfwidth Length Undo Widthl: 4.2
(give down side direction then enter value)

* PLINE Specify next point ar [Arc Close Halfwidth Length Undo Width]: 7.8
(give left side direction then enter value)

* PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]: €
(C for close line)

AAFT 113
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fiax 2.72—Pline drawing

CIRCLE:
¥ command BRI circle 39 o wmm &)
1t iy w command by which we can make a cirele, There are many ways o create Circle, One is by
specitying the radius and second by specifying Diameter, Besides this 2 point, 3 point, and tan tan radius,
¢ Ribbon: Home Tab » Draw Panel » Circle
o Commund: C

* Specify center point for circle or [3P/2P/Tir (tan tan radius)): Pick a point
o Specify radius of circle or [Diameter]: 15

Cenler point

Contor W circlo
y T g
\ %) g W e

N\

faw 2.73—Drawing Circle by Specifying Radlus

Circle Dlameter
o Command: C
o Specily center point for circle or [3P/ 2P/ Ttr (tan tan radius)]: Specify a point
o Specify radius of circle or [Diameter]: D
o Specify diameter of circle: 25

=

athEz 115

~.
@

faz 2.74—Drawing Circle by Specifying Diameter

3p (Threo polnt)

Draws a circle based on three points on the circumference 447 g F 7% 4 fa=; fafrea =75
circle draw HT

¢ Command: C

o Specify center point for circle or [3P/2P/Tir (t4n tan radius)): 3P

o Specify first point on circle: Specify a point (1)

o Specify second point on circle: Specify a point (2)

o Specify third point on circle: Specify a point (3)

First ~ P1
point
Second
point ‘i‘,
P2
. Therd
P3 pont

e 2.75—Drawing Circle by 3 Point Method

2P (Two Polnt)
T4 % end points F1 specify FIF circle draw FT (Draws a circle based on two endpoints on
the diameter)!
® Command: C
® Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2P
® Specify first end point of circle's diameter specify a point:
® Specify sccond end point of circle's diameter Specify a point:

P1
.I P2

9% 2.76—Draying a Circle by Specifying the End Points of the Diameter
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TTR (Tangent, Tangent, Radius)

QA objects A radius tangent specify T circle draw FT (Draws a circle with a specified radius
tangent to two objects)!

e Command: C

o Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: T

o Specify point on object for first tangent of circle: Select a line

o Specify point on object for second tangent of circle: Select a Iine

o Specify radius of circle < current >: Enter radius

P1

fa% 2.77—Drawing circle by specifying ttr

ARC Command:

T command 3T are (IT) I F SR #1 Arc 3 point T 2 point B WA &1 3 point Arc #
angle, endpoint, start point, combination of centres, chord length, direction values 9 radius FI specify
fom o g R

s Ribbon: Home Tab » Draw Panel » Arc

e Command: A

Visualize ~ View Manage. - Output Add

e Biir, <3l — 1 b
PN
:

ﬁ?—g’wz EEJTOTY T se—— s o
? STETE R A W s g e

lnsen Annotate . Parametiic = 3D Tools |

-~ Lo Move - O Rotate .

- o - % Copy' K Mimor @ Fillet + o¥ - e
Line Potyline - Circle o & <oy ‘h b ‘ i 'l Text Dimension -
; 4 A B Stlttch Bl % v Amay - {5 e
Draw ¥ Mod:fy v Annotation ¥
arc tool
fa 2.78—The Arc Tool
Or 2

o Specify start point of arc or [Center}: Pick 1 point
* Specify second point of arc or [Center/End): Pick 2 point
« Specify end point of arc: Pick 3 point a q

fa 2.79—Drawing an Are

yarlous Ty

pes of Arc (Arc % fafim wam)

TR 2.80—Arc Types (Note that eleven types of area are available)

RECTANGLE:
¥4 command ZT rectangle I0 fAd TR 81

Itis a command by which we can make a rectan gle.

¢ Ribbon: Home Tab » Draw Panel > Rectangle
¢ Command: REC

Schematic

Pro:iect

/v_:) @ /‘Eﬂ?].g.wve

Line Polyline Circle Arc 3
D;;[; ed OPo}ygon

fax 2.81—Rectangle Tool

ez 117
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* Specify first comer point o1 [Chamfer/ElcvalioaniIlclfl‘hickness/Width]: Pick 1 point
e Specify other comer point or |Area/Dimensions/Rotation]: Pick 2 Point

1,

T fag

rd

n2

o 2.82Rectangle

Line: The LINE commands is used to draw a line between two specified points. First enter the LINE
command or shortcut L in the command area. Mouse Cross hair displays to specify the first point of
the line and next point of the line or enter the distance of the line. Press ESC key at the end of the line.

Polyline: POLYLINE commands is used to draw a series of lines continuously at a time. PL or PLINE
is the keyboard shortcut for poiyline.

Rectangle: RECTANGLE command is used to draw a rectangular geometry in the drawings. RECT
is the keyboard shortcut for rectangle. First enter the REC command in the command area. A cross hair
will be displays to specify the first corner, point of the rectangle and input the dimensions of the rectangle
as other corner point.

Circle: Circles are created with the CIRCLE command. There are several different says you can
define u circle. Those are defining center point and radius or diameter of the circle. In the 2Point method
define the circle with points on either end of the circle diameter. In the 3Point method define the circle
with 3 non-collinear points. In the Tangent, Tangent and Radius method define the circie by specifying
two other objects that are rangent to the circle and the radius of the circle.

Arc: ARC command is used draw partial circle in the Auto CAD drawings. There are seven methods
available to draw an arc in the Auto CAD.
Result: Studying and practicing of same basic draw commands is done in the AutoCAD.

Wi we-3

3ILFT (Object):

To draw Plan, Section and Elevation of a single storeyed building they AutoCAD. (AutoCAD Ft
Terrd ¥ fore UF HAen WaT F Plan, Elevation d Section )|

Fravas At (Requirements):
® AutoCAD Software
e Computer Hardware

Commands:
* Rectangle
e Line
s Copy
e Move

stz 119
« Hatch
o Text
o Dim linear
o Trim
o Offset

s (Theory): >

The detailed drawings of a building (may be residential, public building like schools, colleges. hostels,
offices, hospitals, factory building, buildings meant for business) basically consists of:

(a) Plan (<)

(a) Section along given vertical plane (vertical plane % along section) and

(a) Elevation (I#awA)

(a) Plan (®9)—@F & @ 2 Building ¥ top ¥ @A W fe@r I TN horizontal section
3raf plan of building represents, a horizontal section of building at given height seen from
top. For buildings, it is a general convention to imagine that the building has been cut down by
ahorizontal plane at the sill level of the windows and is seen from the top after removal of the
50 cut part.

(®) Sectional Elevation (HETet {eftavA)—& =1 O vertical section & # 4 78 Few
FF F building F vertically T line F along cut fFa1 I 1 left § 39 building 3 view
@ M, T view sectional elevation FEwd & a1, while drawing section. it is imagined
that a finished building is cut vertically along a line so that the building is separated into two
portions along the imagined vertical plane right from top of the building to the lowe.sl part of
the foundation. This view that can be seen while travelling along this imaginary vertical plane
when looking towards left is drawn to the same scale as that adopted for the plan and this view
is called a sectional elevation, cross section or section.

(¢) Elevation (}¢R&¥M): Elevation complete building # cutward view (F&&t # side ¥ 3@ W)
? Elevation is the outward view of a completed building along any side of the building.

When a building is seen by standing in front of it. is known as front elevation. In the same way,

from any side of it which is known as side elevation.

Procedure (to Draw PLAN): ) .
Set the units and drawing limits for the drawing in the format option as desired.

Pian Procedure;

** Rectangle Finf 1 7M bedrooms, toilet, bathroom, drawing room F kitchen F represent FT%

FUM: 3.5%x8m, 13mx09m2mx12m 35x7.1 mTA 35x25m dimensions T

. T8 draw ¥ Draw the rooms using RECTANGLE command with 3.5mx $ m, 1.3 mx 09 m,

2mx 12 m, 3.5 m x 7.1 mand 3.5 x 2.5 m dimensions to represent bed room, toilets, bathroom,
Wing room, and kitchen respectively. .

2 all rooms in desired position using MGVE command with reference to the given line

Jiagram, fiy A line diagram & reference # move command F T } W rooms H required

Position Wt =rafierg (arrange) 1
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o Draw the wall thickness rectangle using OFFSET command with space 0.23 m width. (Ofr,.|
command B TITE § 023 m S77 31 wall thickness rectangle draw F7)1 |

© Draw the rectangles for windoras with 1.1 m > 125 m at desired position and for door with 11),!
%2018 20d 075 m > 2 m demasions and place them ia required positon using MOVE comme,
(windows command 7 uwse 375 3 T2 preition T windows 77 1.1 m x 1.25 m dimension 7
tectangle draw 37 TF daw T 7T 997 MOVE command 571 T3 position T move T

* Open at door position using TRIM command and dras type of the door (tnm command 51 =
1 AT door position T opea )

o Draw the sunshades of (1.6 m projection with a bearing of 0.15 m all-zround the windows

o Draw two steps in front of the door with rzise 150 mm and tread 300 mm using RECTANGL2
command (Pectzngle command 31 wse 7% doors = 2 150 mm raise 721 300 mm treed 3
3 sieps draw )

Procedure (to Draw Section and Elevation):

o Dram rectanzies of dimensions 09 mx03m.06mx06m 04mx06mand 025 m x 3z
wsing RECTANGLE command 1o represent CC bed. foting. basement and height of buildny
respectively. (Rectangle command 3771 building % CC Bed, footing. basement 7 height ¥
reprewernt T3 7109 203 m. 06m 2 06m. 04 mx 06 m. 77 025 mx 3m F recungle ¥
draw %3 )1 il — =

o Arrange all of them in desired position using MOVE ¢ d (Move ¢ d 3 use 773 7|
TFE TFA position T AR 7))

o Drawm 2 rectanzle with depth of 120 mm to represent skab of the building (Slab represem 777 7

120 mrm 7T T r=cungle draw )1

Dras the parzoet (035 m Height 2nd 150 mm thick), sunshades, doors, windows and lizte! R
(150 man thick 2o | § mm beznings) in the section using LINE or RECTANGLE command (Sec5® —z 2
3 fine T rectangle command Z77 parzpet (0.45 m heizght 775 150 mum thick), sunshades. 6o = K
windows, lintels (150) rmm thick 20d 15 mm bearings) B draw %7 )

o Draw the fonring over C.C of 100 mm thick using LINE command (Line commznd #1 use 7
CC & =% 100) mm thick flooning daw 7)1 )

o Haich the section wsing HATCH comerand in desired portions of the drzwing (Drawing ¥ 137
portion W hack command B we FE section T haach )1 )

By projecting lines from plan znd section draw the elevation of the building with panelled door 2| EEE

windaw with 1274 in front of docr. Plan the section @ lines 21 project 7% building &1 elevan®] |
draw 1 %_
nes : b
Drningp{m.wuimzﬂekvzjmdasingjcwreycdmildingi;dfuu\ingmcwlr\wc“‘ e &
F PR B single sreyed building B plan, ection 77 elevation draw fzm ma) ; = — T Lo
4#f7F5 ZvmA (Practical Exercise) i _
mnnwrhn.dummmrmunmmmmwngmm@amﬁyﬂ' i fa 2
residential building T7 plan, elevation 7 section draw %7 )1
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(i) U e st Yo wafei &1 sugerr dur w1y w0 plan, AA WU 1y,
Ay gva wite @it dan 200 m'lﬁcht',‘ﬂ!!?ﬁﬂﬁﬂiﬂm 1000 mm t,nﬁmnﬁwnﬁtm
3000 mm &, Reia @ Samd 450 mm #1

e

Kitchen + .
Dining ;
6m x 4m

Bedroom
Am x 4m

Bodroom
3m = 5m

S = 1

Hall
5m x 5m

Office
4m x 3m

' 3mx4m

Portico !
3m * 2m

Front A’ —

fa=x 2.84
HyATaeit

AutoCAD 1 27 38 =1 19 &7

AutoCAD % ¥&a 1 wam fafad

AutoCAD software faferet Zsiifad & 13 firg woR Iw@n &2
AutoCAD &t F¥¢ e FHAFgH 9 S H1d Farzal

AutoCAD %! GgraeT & f&Ht Building & Plan, elevation 9 section draw i1
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AT (STAAD PRO)

THINK ABOUT IT

One way to kcgp momentum going is to have commnrf_r] greater goals
—Michael Korda

§ 3.1. STAAD Pro

STAAD A1 STAAD Pro U% HTSHTeTS oo™l (Structural analysis) iR festet 3 fon e saqe
9 H 3T A w9 aren Sieam 2 S Ry TS ®9 | 1997 # Research Engineers International E11

famfaa fn man am 2005 % i@ § Research engineers international %1 Bentley system gRT @1 T

mlﬁmﬂﬁﬁ%mwﬁﬂm%w%l ARY A F T program = WG F prior
knowledge 3Ta¥g% T&i &I

e STAAD Pro @ structural design oriented program %, 9% user interactive interface 1 QeI
T user ITH TG AEH ¥ FH I TEFA

o 3HSI faf= structures W& structural configuration Ft modelling, designing 9 analysis 29 use
foran s e 21

e STAAD Pro %l §&a favivary T—Model generation, Model verification, Secondary analysis,
Seismic/Dynamic Analysis, 7<)
STAAD Pro Software & Advantages
e Manual calculation i 3TE¥aHl &l
Tt gl | Heiftm fesmefm g S99 (concrete, steel, aluminium ERC 1]

Results accurate ¥4 &, Shear Force, Bending Moment 3% 3 T structures 3 |4t beams
T columns g F1 A TFHat 2l

Structure H X =T H9a| .

o & Al YFW F load TG designing H9a 197 Dead load, Live load, Wind load, Snow load,
Area load, Floor load #f2I AutoCAD # STAAD # design import FX T |

HiE # e B € A9 beam A TR AR ST T design T faverawr faren s w3
123
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124 T weifaftn R R gt
AAD Pro Softwaire (STAAD Pro

e & ) STAAD by ‘
Basics of ST, g

o STAAD Pro Grophical user nterfuee ‘{:‘lﬂ);mm? “i:]ug:m A % fﬁq N
ﬁ?.mwﬁs“AADclxgul\cmm ‘-g%@ﬁa;m‘ﬁ mﬁm 3‘?1{‘3%
Wn‘ﬁ&mommwﬁnuﬁw@ﬁmw i mmﬁl

ey s A 7T REIR Rt S W e, s,

) ST‘{E;ADE‘ m e ¥ - TR §T (General Purpose Caleulition Engim)i

o FE JAE (lnput Generator)— I T input file % T} STAAD . w‘;
communicate T 1 Input file TH text file Ot & TR command T TF series g A
sequentially (R ) exccuted 70 S | -

« TEEAT F W (Typesof Structure)—FEH H T F T (assemblage) ¥ Ty ¥ “ﬁ\nﬁa
S < T e, a structure is an ussembly of elements. STAAD ¥4, R 3i 4 i
0 e <o e 1 et ofe FeEE TR A W (capable) #1 ‘

« gfe fem (Unit System)—l 3 MKS. S1 31 FPS S 1, 70 commonly iy
2 T T TR nits system H input data siR output request M AR #)

|
What is STAAD Pro? [

« STAAD Prois a structural design ariented program with auser interactive interface which allgy
for the user working en it extremely easy.

o It can be used for modelling. designing and analyzing various structures and structurgl l
configurations.

« STAAD Pro programming is broadly wtilized as a part of the structural analysis and designing
structures i.c. towers, buildings. bridges, transportation facilities, wtility and industrial structres,
Designs can include building structures incarporating culverts, petrochemical plants, bridges,
ninnels, piles: and construction materials such as timber, steel, concrete, aluminium and cold-
formed steel.

 The software is very extremelv useful for buildings and other such structures insignificant of their
uses varying from residential ta commercial to hospitals to offices.

« Also useful for bridges, foundation design and analysis. Shear wall is another feature incorporated
into it for design facilitation.
o Steel buildingsand ¢
images.

can also be designed and rendered to view the real life resembling

« STAAD Pro software lielps structural engineers to automate their undertakings by getting ridd
the repetitive and lengthy manual procedures.

» Anstructural analysis scfware that accompanies an adaptable modeling environment, advonct

Jeatures, and smooth data collaboration.

¢ Enables structural engineers to dissect and outline for all intents and purposes any sort of structirt

A.;i“hm specialists, divisions in development organizations, administrators, and Govemne®
ofjices eic.

Maln Foatures:

w=red 125

Model Generallqn: Inlcr;@cliun _hfm:d menu-driven model creation with concurrent 3D display
2D and 3D graphics creation utilizing rectangular or polar coordinate frameworks

Modal Varification: 0." sereen 3D/2D drawings and in Full 3D shapes for outlines. components
Isometric or any rotations for a full 3D view.

Socondalfy Analysis: Limited component capacities, concrete design, steel design and timber
design. Displacements and forces at portions between nodes. ’

static Analysis: The 2D or 3D analysis in view of state-of-the-art Matrix strategy to deal
with a substantial degree of the job.

Selsmic/Dynamic Analysis: Mass modeling, extraction of recurence and mode shapes
Response spectrum, time history examination etc,

Advantage of using STAAD Pro Software:

Faster designing the structure.
Manual calculations not involved.

Suitable for almost all types material for designing i.e. Concrete, Steel, Alurinium etc.

Shows accuracy in results i.e. Shear Force, Bending moment diagram for each and every beam
and column of the structure.

Shows result for Number of reinforcement used longitudinal, Shear reinforcement.
Improvements in structure, section, dimensions can be made easily.

You can design structure for any type of load i. e. Dead load, Live load, Wind load, Floor load
Snow load, Area load etc.

Any to element like simple beam to sky scraper can be designed and analysed.
Designs from AutoCAD to STAAD.
Easy to learn.

Limitations:

Not for brick masonary work.

Does not show the amount of material used.
Not for costing and estimating.

Require proper skill for typical designs.

Benefits of STAAD Pro:

Isometric and point of view perspectives and 3D shapes.

Design concrete structures like columns/beams/slabs/footings according to the international codes.
Generate text/graphics input.

Execute flexible zoom and numerous views.

Perform code check, member selection and optimized part selection comprising of design/analysis
cycles.

Utilize built-in coramand file editor and straightforward command language.
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o Fimish complete object-oniented instinctive 3D/2D graphic model ereation.
e Do effective algonthm that imits disk space prerequisites
o Unlize pull down menus, dnifting toolbars. tool up help.

The STAAD Pro software consists:

e Graphical User Interface (GUIY: GUI is used to generate the model, which can then be analyzeq
using the STAAD cngine. After analysis and design is completed. the GUI can also be useq to
show the results graphically.

® Analysis and Design engine: A general purpose calculation engine for structural analysis ang
integrated steel, concrete, timber and aluminium design.

* Input Generator: The user communicates with this software through an input file, which is a
text file consisting of a senies of commands which are executed sequentially.

e Typesof Structures: A structure is as an assemblage of elements. STAAD is capable of anal yzing
and designing structures consisting of both frame. plate/shell and solid elements.

e Unit Systems: The user can input data and request output in desired engineering unit systems ie.
MSK. SI, and FPS.

v wta st fviw § (Structure Geometry and Co-ordinate System)

Structure T FTE1 ST WTF) (individual components) F1 TF assembly & 3% Beams, columns,

plates. slabs 312: STAAD & %% 71 (Frame elements) 341 @2 @i (plate elements) 1 IU4M T
uEs F o fem = mw R

e Structure Geometry and Coordinate Systems: A structure is an assembly of individual
components such as beams. columns, slabs, plates etc. In STAAD Pro, frame elements and plate
elements may be used to model the structural components. The modelling of the structure geometry
consists of two steps: (i) Identification of description of Joints or nodes, and (ii) Modelling of
member or elements through specification of connectivity between joints.

¢ Global Coordinate System: TT=1 SfAfd F (specification) faf¥sm ¥ fou faefafay
co-ordinate systern TIH>T “{—

* Conventional Cartesian Coordinate System
¢ Cylindncal Coordinate System Reverse
¢ Cylindrical Coordinate System.

o Local Coordinate System . Local coordinate S)Swmm member (W23) F Y 3@ E’q‘ 2t
4}

* Global Coordinate System: The coordinate systems available for specification of the Structure
geometry are—
* Conventional Cartesian Coordinate System.
¢ Cylhindrical Coordinate System Reverse
¢ Cylindrical Coordinate System
¢ Local Coordinate system: A local coordinate system is associated with each member.

. ﬁml; Element Information: Staad TIR2d5T AT plate/sheel 91 solid finite element & kcal
]

pember Properties Specifications Available jn STAAD:

=z w127

" TwF A= oA Eg section library (built-in section ibrary) & standard

properties. specifications A7 user Z71 2773 ge0) tables (Tapered Sect
Member/Element Release: STAAD member
T

Truss/tension/compression: STAAD H member tension 71 member compression command
mmmloaddirecuonnmﬁam%ﬁnm?:mifzﬁmrm.emhmwr,

w2

Tgnsionh‘ompl"i“hﬂ'ﬂﬂl! ?P.rinﬁ: STAAD 7 spring tension ™ spring compression F9Z 37
mmﬁmmﬁtﬁamszfmmmi,hﬁwngmmmﬁ

Cable Member: Cable members 31 member cable 307z 57 795m 375 5z (specify) 5w
 wa

Member Offsets: T F FZ 7777 Incident joints T concurrent 3 717 3

_ T IO offsert 77
74 &1 T offset distance global T local co-ordinate system 1 TITA B specify f5m 7 3

Finite Element Information: STAAD is equipped with a stateof-the art plate/shell and solid
finite element.
Member Properties Available in STAAD: Prismatic property specifications, Standard steel

shapes from built-in section library, User created steel tzbles—Tapered sections through assign
command.

o Member/El t Rel.

steel shapes, prismatic
ion)!

clements 7 F 77 Releases 3 ]

: STAAD allows releases for both members and elements.

Truss/Tension/Compression: This command may be used to designate certain members as

tension only or compression only members. Tension only members are truss/cables that are

capable of carrying tensile forces only. Hence. they are automatically inactivated for load cases

that create compression in them. The opposite happens in compression only members. The Member

compression or member compression command can be used to limit the Joad direction the member

may carry.

Tension/Compression-only Springs: In STAAD. the spring tension or spring compression

command can be used to limit the load direction the support spring may carry.

Cable Members: Cable members may be specified by using the member cable command.

Member Offsets: Some members of a structure may not be concurrent with the incident joints

thereby creating offsets. This offset distance is specified in terms of global or local coordinate

system.

Material Constants: Material constant 1= —

O Modulus of elasticity (E)

O Weight Density (DEN)

O Poisson's Ratio (POISS)

O Co-efficient of thermal expansion (ALPHA)

O Composite damping Ratio @91 i1 F171 (BETA) ) . A

* Support: STAAD supports ¥ faf#2¥l (specifications) 1 341 a1 & 3 Global axes ¥ 7
A inclined 81 &1

*

*
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o Master/Slave Joints—Master/Slave f#ea il A TR SR W rigid link T model
T} Tym FA % Ry v fe

o Loads—UF TR R €Y e (Joint Load), §5E g (member loady, ATHH g (temperature
Joad) 3R fixed end member load ¥ wu R fffe (specify) fm o wEM t

o Losd Generator—Structure W moving load (generate) FE w01 ¥ STAAD ¥ 7 & (in-

built algorithm) Algorithm B 1
o Material Constants:

The material constants are:
o Modutus of elasticity (E)
o Weight density (DEN)
o Poisson’s mtwo (POISSY,
o Co-eflicient of thermal expansion (ALPHA).
* Composite Damping Ratio, and beta angle (BETA) or coordinates for any reference (REF) point.
o E value for members must be provided o the analysis will not be performed.
o Weightdensity (DEN)isvsed only when selfweight of the structure is to be taken into consideration,
Puisson’s ratio (POISS) is used to calculate the shear modulus (G) by the formula,
G =0.5-EAL + POLISS)
If Poisson’s ratio is not provided, STAAD will assume a value for this quantity based on the value
of E.

Cocficient of thermal expansion (ALPHA) is used to calculate the expansion of the members if

temperature loads are applied. The temperature unit for temperature load and ALPHA has to be
the same.

« Composite damping ratio is used to compute the damping ratio for each mode in a dynamic
solution. This is helpful if there are many materials with different damping ratios.

« Supports: STAAD allows specifications of supports that are parallel and inclined to the global
axes.

o Master/Slave Joints: The master/slave option is given to allow the user to model rigid links in
the structural system.

 Loads: Loads in a structure can be specified as joint load, member load, temperature load and
fixed end member load.

o Load Generator: STAAD has built-in algorithms 1o generate moving loads and lateral seismic
loads on any structure.

Analysis Facilities

frfafEa Perform Analysis Ffa¥md STAAD # Ivei=t —

o Stiffness Analysis

o Linear Static Analysis

¢ Dynamic Analysis

Member End Forces—Structure % Load apply ¥R W member end forces T8I moments I
% %1 7% forces local member co-ondinate system ¥ B %1

. wEW 129
Multiple Analyses— ST T mﬁﬂmﬁﬂkunﬁﬂﬁy@mﬁ i

41 STAAD Wl B Input T3t #) oty 2
f & anfz fored 7 OF @ ar § a9 e sgﬁmz;j :":: member properties, support

oncrete/Timber Design

condiﬁun

steliC . e o o
« STAAD 7 =9, llmhevr it ¥ feg extensive design AHAN T7eRg 8
. Footing Design—STAAD H I7AEA specified supports ¥ ey

individual footi
FO § T TF T FET Hfam 3w idual footings e
o Printing facilities—7 input 3R output data F1 STAAD # wems it comma 2
3 A d #F1 27Em
& (print) Fie 3 w1 7 € p n

o Miscellaneous Facilities—STAAD ®&N FHIIR (Problem solution) % fefa fifafam fafam
gﬁ‘mi WA &I 2—
o Perform Rotation Geometry—Geometry ¥ specify & 9 % a1 28 command 7 =P

4 structure shape F fFR W angle w am fd) o global axis ¥ about ATAT ( FAM Rotate
firn) <1 W 2

o Substitute—Joint 39 member numbers 1 STAAD Pro % SUBSTITUTE command & TPl
Q redefined (TTORwfa) foFm <1 v &1

. Cen“‘%“[ Gravity @ TURI—Staad 3} T ¥ structure 1 centre of gravity F1 0T =t
wFl

Analysis Facilities available in STAAD:
o Stiffness analysis / Linear static analysis second order static analysis
o Dynamic Analysis
o Member End Forces
¢ Member End Forces—Member end forces and moments in the member result from loads applied
to the structure. These forces are in the local member coordinate system.

Multiple Analyses—In some cases, structural analysis and design may require multiple analyses
in the same run. STAAD allows the user to change input such as member properties. support
conditions etc. in an input file to allow multiple analyses in the same run.

Steel/Concrete/Timber Design—Various design capabilities are available in STAAD for steel.
concrete, timber sections etc.

Footing Design— A footing design facility to design individual footings for user specified supports
is available,

Printing Facilities—Input data and output results may be printed using PRINT command available
in STAAD.

Miscellaneous Facilities—STAAD offers the following miscellaneous facilities for problem
solution:

Perform rotation: After the geometry has been specified. this command can be used to rotate the
Structure shape through any desired angle about any global axis. Substitute: Joint and member numbers
may be redefined in STAAD through the use of the SUBSTITUTE command. Calculation of Centre
of Gravity: STAAD is capable of calculating the centre of gravity of the structure.
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Structure ® model, analyse ¥ design ®X & WIW T (The basic steps Involved |,
modeling, analyzing and designing a structure are:)—
o WIW WO FA (Starting the program)
o T |TEA ITH FEA (Creating a new structure)
o Joints 99T members I FTA (Creating joints and members)
Member properties specify ST (Specifying member properties)
Material constants specify I (Specifying material constants)
Member offsets specify FTT (Specifying member offsets)
Member 3 F=AN print F (Printing member information)
Supports H specify T (Specifying supports)
Supports T specify TN (Specifying loads)
Analysis % YR 1 specify FT (Specifying the analysis type)

Post-Analysis sTafd fawereor & 98T print command specify FT (Specifying post-analysis print
command)

Steel design ¥ Parameters specify T (Specifying steel design parameters)

Design T8 Analysis perform 31 (Performing analysis and design)

Output file T G (Viewing the output file)

Screen W result T graphically ¥ numerically Ff9d FT (Verifying results on screen
graphically and numerically.)

STAAD Pro screen & & elements—

 Menu bar: ¥ menu screen ¥ top T 8t # 91 1 Werdw ¥ STAAD H Tt Hfrwmd wma

B &1 (Located at the top of the screen, the Menu bar gives access to all the facilities of STAAD

Pro)

* Toolbar: Tool bar ER1 3% use M T A commands T IFTEFN ¥ TEAN < THa B (The
dockable Tool bar gives access to the most frequently used commands)!

 Main Window: I% screen % centre W ¥ 9%1 Area BIdl € &l model 4l results %1 display
fFm o1 T (Largest area at the centre of the screen, where the model and the results can be
displayed)!

Page Control: T% tabs 1 WY €A1 & I main window ¥ left & B1 & (A set of tabs that appear
1o the left of the Main Window)!

Data Area: T% screen & right ¥ 81 & W user TR fFA 1Y I operations F MR W dialog
box, list box, tables 3 8 ¥ (The right part of the screen is called the Data Area, where different
dialog boxes, tables, list boxes, etc. appear depending on the type of operation)!

STAAD Pro & F% modes of operation B § 3% mode menu &R menubar  acess fFd 1 TR

% (STAAD Pro offers several Modes of operation. These modes may be reached through the Mode menu
from the Menu bar. The tabbed items in the Page Control area change depending on the current Mark.
A check marked besides the menu item indicates that the specific menu item is selected)!

wr
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M.nubﬂ’
L b?&- Ple /403 Vo Lioth | Mot G| Comnarts, Mo Vi hedon: pig
Q‘g}}ﬂlﬁﬂ = N R Ry Y NG
JJ@ g @ Fi) @ @6y Mo o 4% Nt Vom0 iy
I S YR g 2 gy o - —

[ 1700
firz 3.4

« Modeling: Modcling mode & A= model ) geometry generate
specify £y 7 & (In the modeling (Pre-processing) mede, the user
gpecifics loads, supports ctc)!

o Post Processing: ¥ mode & analysis % & fromy 1 U, query, Regem geretation #%%
fo T & (The Post Processing mode allows the user to perfotm poat-anatysis result verifie stiens
query, report generation, etc.)!

o Interactive Design: ¥ mode # STAAD pro % graphical environrment 3 structural contigrmwed ¥
design foFan s # (The Interactive Design mode allows the user to perform structural commgrmert
design in the STAAD.Pro graphical environment)!

o Piping: Graphical environment % ADLPIPE Geometry % T4-T07 structural Gernnatry 29
¥ 7% mode use feFar S 2 (The Piping mode allows the user ta view ADLVIVE, geraresry
along with structure gcometry in the STAAD.Pro graphical environment)!

o Page Control: 8 option # user page control tab F1 ON 71 OFF 4% wygle %7 wim b
(The Page Control option allows the user to toggle the Page Control tabs on and off)1

37 (Object):
&3 T Truss &1 faYEI90 T (To analyse the given truss (Howe Roof Truse)s
o5

aiN kN _l
\ T

\

1) A ) am berael 7 sugremt
gene mes tha fredie] gromis try.

Wi Tom-4

120 |

fa3 3.2—Howe Roof Truss
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fafa (Procedure)
« STAAD Pro ¥ f#F F(Click on STAAD Pro)!

o New Dialog box T FFT New file T 7% FU (Click on new file in the “New™ dialog boy),
o 78 A% 1, units meter 37 kN select FU (Click on “Truss™ Check the units in Meter 3

Kilo Newton)
o Next T 3% F77% F11 (Click on Next)

[
@ e P Prsarsion

B o 1 ‘

=0 C= =0

fax 33— wraetT At
 Structure Wizard 1 select ®t (Select Open Structure Wizard)!

Where do youwant togo ?

[ Add Sokd
[ Open STAAD Editor
[ Ede Job Information

BE Ry ¥

Boce b ] : — -
nz‘m,qudzdma. . &

fot trusses.

fa® 3.4—Open Structure Wizard Select FTTT

, Truss model T select FL (Select Truss model);

F. re3 :., =3 _m

peEk fvP LT o
,-—y-.l'0~‘: '.'.'-:T

@ Pomma ot O S Uvm Mases

o 1o DTN -
[ = ]
| atoms o T o Bie
|

(i) =N [N
| e To i bt

ot 352w wieet 3 fdee &

ymftet fadee & (To select parameter)
« Howe roof T f&& FX (Click on Howe roof)!l

DeQL + -8 ® = 5
[ToB =008 corsboc Qaane

O Pttpeticdde  C SavadUse Hoown

Moce Trom: [Tam Meden

St T

i
]
{
i
i
&
PO TN

| - Selection /
\ : of Howe I /-
5 Roof Truss | -

C=] =]
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\‘ L
f"? 3-;‘—Selming Howe Roof Truss. Howe Roof Truss is a truss having upper and lower horizontal members
between which are vertical and diagonal members, the vertical members take tension, and the diagonal members

ire under compression.
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e STAAD Pro # model merge 1 (Merge model with STAAD Pro)i

o 37— ofed fag = W wiew

» RIS model H paste FX (Paste prototype model)!
x=0,y=0,z=00k

B Structure! - Whole Structare

fax 3. 3—tféeT HEemn

4z view & (View from + 7)1
L]

=z 135

fa= 3.9—Viewing from + z

materlal Constants Specify ST (To Specify Material Constants)
o Click on General > Material in Side Menu
ent Method > Assign To View > Yes
PR, \iprocesuna] | Concrete Denign] Foumdatian Desian ] kAN Comecuen boye ete]

AT [CR Dsner 1) 5 Gy 1| 4 &
[ W st | b= 00 & 0o | 8= ey | 57 (] HAPopory

7 [ UT

Select Steel > Assignm

O Structurel < Whete Structure .

sign

GX; = Sracsser, - futecists
STAAD Pro Y8i (SELICTsevies 4)

.

faR 3.10-Specifying Material Constants
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Properties T Support Load Specify 771 (To Specify The Properties, Supports, Loads)
+ Selsct General » Property » Section Datsbase » Stzel > Indian

s |
nH
Qs
it
al=f
Halt
i
i3
I
$53
i
szl
?ik
Tal3
-
-
>4
i |

57 2.11—Specifving Properties and Support Load

(1) Top Chord Members 2 [sa 75 x 75 x 10 mm. Bottom Chord Members 2 Isa 80 x 80 x 10 mm
Using 10 mn Thick Gusset Plate

(1) Intzrmedizze Tension Member Isa 55 x 55 x 5 mm, Intermediate Compression Member
I245x 45 xSmm

« Tross =7 properties assizn ToF (Assizn the propenties to the truss)!

-
Trss B propertes IR . =
sIn T X =
- m o= B m “m
- L = = =
| 3=
37 3.12—Assigning Properties to the Truss

. Aot =W 137
ification specifly FTT (To assign the specification, Gegera! . . .
. :P_:Cdd 3 Assign the truss to whole structurc) seneral > Specification » Beam » Truss

et 3.13—Specifying Specifications

« To Assign Support General » Support » Select Pinncd & Fixed But » Add » Assign the support
{0 truss.

To Apply the Given Loads. General > Load & Definition > Load Case Details » Add > Primary
Loading ’
o Select Load Case | > Add > Self Weight =-1 Add

« Nodal Loads > Specify l.oad Values » Add. Assign for Required Nodal Points

o Close

fa7 3.4

Structure ' Analyse ST (To Analyse the Structure)
« Click On Commands > Analysis > Perform Analysis » No Print > Ok

TW W F5gT wON (TO DESIGN STEEL TRUSS)
* Click on Design > Steel design
o Select IS 800 from “current code list” at the top of the data
* Click on Select Parameters
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o Clear all Selected parameters by clicking ok Select Fyld, Ratio, Track to the Selected Parametery
by clicking ok
e Click on Define Parameters > Specify values for selected parameters » Add > Assign the defineg
Parameters to the Truss Members
 Click on Commands > Check code > Take off > Add > Assign
* Close

fagefea oftomd ® WA (TO VIEW ANALYSIS RESULTS)

* Click on Mode > Go to Post Processing Mode » Done Select the required load cases » Apply
7 Ok

¢ Results: View Value > Beam Results > Axial » Ends

PRACTICAL EXERCISE:

For the structure shown in Fig. 3.15, members AD, DC, and ABC are assumed to be solid rigid
members; member ED is a cable. For this structure, determine the reaction at A, the tension on
cable ED, and the force in member DC.

150 kN 700 kN

1. STAAD Pro software ¥ €7 T5% T @ &2
2. STAAD Pro screen % T4 clements BH-®1 | 21 €2
3. STAAD Pro software #1 q& fafmasii =1 aviz Fifad

(AUTODESK REVIT)

THINK ABOUT IT =)

y’.’l ot can dream it, you can do it, i

—WaKDisneyJ

§ 4. BIM T uftad (Introduction to BiM)

Building information modelling T intelligent 3D-model based 57551 £ =1 £ Architectare,
Engmeenng'qa construction (AEC) professionals 1 insight tools 32 =75 § feest semmr 5 =2
buildings ¥ infrastructure F1 (e TEGES plan, designs construct 27 manase 57 =53 51

Building information modelling is an intelligent 3D model based process tha 2+ ;
engineering and construction (AEC) professionals the insighs ard 100l 10 rore oL
manage and construct buildings and infrastructure.

BIM U% <ieel Aeeithe Wiedl € S1 P SEA F aees e (i
mﬁmmmmwﬁtﬁ—rq——xsﬁm—{:.
 (input) TTIE Fehgl =Tal i:l,BD Wiwdl 1 S£¥9 WRE (29ES SeE
F e | Wﬂmﬁmmﬂ%@ ST ARE Rew
(modification) ®1 FETIA H4M 98 T =ga & wiaawrel (powerful) ool £ |
FH R O, W F T90 9 G € AR A Toe ww & = a6

2 =

®Ieiifss BIM ST SYI architectural professionals 27 = = == 0 T BM = ===
¥4 3R @ | construction industry & pmfesnona]s F @EE § Building = 3D Representation

TEH (roads) 3R wtilities H & TTEM fr Sw1 $1 BIM 27 779 55 (desien decision making).
I VeI et FEI0 (high quality construction), SIS SEIET (document production). R =T
(constrr-=tion planning), iR o 3137{!?1 (cost estimates) = ¥ fou sve= Lul,duu = = ===
(reliable) representation Tal &1 ST € T& BIM 1 S94r1 551 (properny)  Taws1 (owpers) 0 5
T 1 e 21 o R Fomion Wi v € S AR WEEES
T O % U SaE S e W S € P e Seh Sew 5,
Sty (space), ST (light), iiifrs SR (geographic information). T (quandties) Erd-echore

= FE IEEEE

(geometry).
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7 1 v 1 #1 BIM #1 T fr dh wfry TR B EEm A m@wmmzdm
life cycle) 1 wifin =3 F fAw frm 3 7 21 BIM application procc“’i? 3"7’17"1 T A ey
@ﬁ?ﬁm(imqmcddﬁign)%mmﬁ T A T2 AT T AR ATE Gy
feam ¥ 2 frm @ R

70 WA F =z fafe=3 3F2M (contractors) ¥ 41 TaoN (pmblemw':I frETe Ty
(coordination) T #7 T fAEiM TR B T FR ¥ fAm A BM AN R I AR A phygicy
pnxcss%mmﬁ T IFA B W AT ideal T 2 T3 TF A 0T T T trade execute T 72 7
# W T3 schedules TEF (mmprc“cdﬁfﬂ #1 BIM ¥ ¥ s 2 aom 7w I fro oz
fFm I 2—

o ATIFA (Architecture)

o [TEAT (Structures)

e MEP (Mechanical. electrical and plumbing works))

o fF3M T (Construction Management)

o ITATAA (Utilities)

o TZF T8 (Road Construction)

o Srzfm (Scheduling)

o TR WHTA (Property management)

AW TR TF WAFFA (sandardized) BIM TEA frEfaa w1 F1 Ffem R ® A T
fafe= wam F1 wtefem Fet F1 UEFA (integrate) FAF e fFn i wR T BRI @ A
& e feam fufo woem 4w @ 9o i wEn ) gfan wEE w2 T fen IR
CAD ¥ 4 UF & Data Center #1 FAF 21 9% a2 @ Data fordd 8 Take-offs, Analysis, co-
ordination 31 Tﬁﬁ‘{‘ﬂ project milestone F TR A :61 use fF1 < = 21 77 o whEm A

w1 4 B HeE FAM 3 UF A e Fom fIEE STEW Bidding process ¥ SF R 1 @A
? afF oeft T A fewfd g A o W

What is BIM?

Building Information Modeling (BIM) is a process of creating and managing 3D building data
at the time of its development. BIM is a complex multiphase process that gathers input from team
members to model the components and tools that will be used during the construction process to create
a unique perspective of the building process. The object of 3D process is to achieve, savings through
collaborarion and visualization of building components into an early design process that will decide
changes and modifications 10 the actual construction process. Hence, BIM is a very powerful tool that
when used properly can save money. time and simplify the construction process. Although industry has
commercialized BIM towards architectural related professionals, but the real advantages of BIM relate
to all construction industry professionals. The 3D representation of the building can be used in roads and
utilities too and is moving to help towards all construction professionals. BIM makes possible a reliable
dizital representation of the building available for design decision making, high-quality construction
document production, construction planning, performance predictions and cost estimates. Also, BIM
can also be used by the property owners, once the construction process has ended, to carefully monitor
how the building is performing and to complete repairs efficiently.
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§ 4.2. AUTODESK REVIT

Auntodesk Revit TZ Building Information VadeSiny (EIV) whtwirs 3 22 bniiding indormation
architecture, engineering T3 comstroction industry ¥ dosign procens 5 5% 70 11 Rt T ome
%73 @ architecture desizn, dralting 77 swrefling TR %0 257 & 7794 5% 57 [F 41

Astodesk Revit, Autndesk T 5557 27 aritcen oy witvem wrumird copmer
MEP engineers designers 97 contraions (53777 7 777 nluraten weiny =227 11 =
A % 3D B building 7 stnucturs 78 TF =E % 277 50 % A2 27 ¢ D datung
T T A F annotats TT E P builling maseh b E by 3 TR0 B A
T8 31 Revit 4D BIM 2, ¥ 7755 2 T il T F 25 5 S TN W ruk T
T o (R 47 7 & a5 § o 31 57 TR Gl B TEw W S
Newton, Massachusetts B Lionid Pziz 7 Rrais 37 5% 7= %, T PIC = proEagoesy S 22—
%mm?mdzfcwa % IT where T 252 375 3 T0% % 0 F boldng
industry ¥ parametric modelling 3 7737 1 7757 fom T == )

Building design 77  f27e= 75 # Revit 70 7757 377 Toors =ran 2o (oofizhoranon
‘tool) F = F fFm T T3 1 Revit work emvirorment ?"77 ST P il B I
assemblies F1 T FA7 3D shapes F1 manipslae 7 T37 71 57 Models :
objects I imported geometrical models FTr e T T2 ?"—’_‘ Revit NURBS D’ffk" "
#am object T individual polyzons (T3 specific obje=t ypes == = roof. slabs, terrzin T752) 3
-manipulation F1 A% TE TET ) .

Note—NURBS 1 @774 Nonuniform Rational B-splines Z #) Aworad F NURBS suwrjace = 3D

I RSICRur 8 pusnrss (ressiomy @ tiege

¢ Sk (. om T d

radet tirc ey o G

spline x 9 G trer 7 7 TFA '; fz:;é,’ﬁrpoinzt o ¢ ?’F;F’éﬂ! M T e

= o foee BT = =T 71 =% TE-SF
7} manipulate 7 1 TFA # 74 surface F G T H AT 0E 5

FTT

- 5 T us 77 surface 3T precizion
AwtoCAD %1 3D surfaces T fit points F1 777~ 5777 demsities Fwse 7% SaTJCE. 5 PYEKERGS

aﬂdfkn’e %1 4 control FT TFT #
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Objects ® T categories WAl & FR) Revit 7 90 A families F21 3 2—

o System families ¥4 f¥ @, v, va vemfz SF project F AT T AR #)

o Loadable families SfF primitives w0 7w wd € A e:urusions. sweeps 772 an

T project ¥ SEM TAW A # YA AATTFA T W project F AT load FFW w0 3,
o In-place familes f7 project & In-sity A S & (319 AR A WFfaF feafa &
A1 %) A T9 Joadable components 3 A ool sct use fFA @ 21

Building Information Modeling (BIM) is poised to be a major innovation in the architecture industry
in the 21st century and Revit supplies oxygen to this wonderful innovation.

Revit, BIM software. has become a household word in the AEC community since 2002. It has changeq
the architecture design. drafting and modeling processes. There are a great number of BIM software
vendors. Autodesk’s Revit suite has the highest market share in the BIM software industry, indicating it
acceptance and popularity among the global fratemity of architects.

The advantages of Revit BIM software are:

o Preview the Future Home in 3D BIM Modeling: Revit parametric modeling is a significant tool

Jor conceptual design. With Revit software, architectural designers can quickly sketch a rough
layout of a floor plan, or make changes 1o the standard set of building designs, and at the same
time, let their customers preview their future homes. 3D design views allow designers to try out
different design ideas and guide their design decisions at an early stage.

® Quick Changes to Design, No Repetitive Tasks: During the design phase, the building structure

and floor plans nced to be modified frequently. With Revit BIM software, architectural design
and drafting become much fast and accurate.

Ina Revit architecture model, all building components such as plans, sections, and elevations
are intelligently connected to each another. Hence, when a change is made to the model, the
software automatically updates every related component, affecting the whole building model.

 Vast Library of Parametric Building Components: Revit comes with a full set of parametric

building design components. It also allows quick changes to the existing components. It stores
the newly created or customized parametric objects, which can be reused in other projects. The

architectural designer can use the stored parametric building objects for quick references-to -

prospective clients while designing a new project.

¢ High Quality Construction Documents: The 3D modeling capacity of Revit architecture enables
designers and drafers to easily identify the clashes and areas of congestion, and resolve them
early in the process. It results in error-free and high-quality construction documentations.

¢ Accurate Estimation of Quantities and Cost: This software provides facility for the automatic
generation of bill of quantities (BOQ) and helps contractors and owners determine whether the
project sticks to budgets.

o Improved Coordination: Revit unifies design, drafting, construction and facility management

Pprocesses in single envir , allowing all stakeholders to remain updated and aware of their
responsibilities, thus improving overall coordination.

* High Level of Flexibility: Unlike AutoCAD, Revit allows all project data to be stored in single
project file. It allows multiple users to work on the same project file and merge their changes with
every save. Also, Revit exports and imports DWG, DXF, DGN, PDF, and JPEG files.
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o The list of BIM adrmga conn‘ngm The BIM approach has proven 1o be “significantly more
ient” than the traditional drafting-based approach. A large mumber of architecture design
and {rafting companies are implementing BIM sofrware.
Aull?d”k Revit is buildin‘g MIOMWH modeling sofrware Jor archutects. landscape archizects,
al engineers. MEP engineers. designers and contractors developed by Autodesk. Users con desisn
building and structure and its ‘WW’ in 3D, annotate the model with 2D drafing elemen:s. and
z os3 building information from the building model’s database using Ravir. Revit is 4D BIM capable
:!‘h tools to plan and track various stages in the building’s lifecycle, from concept to construction and
later maintenance and/or demolition.
The Revit work environmen allows users to menipulate whole buildings or assemblies in the project
F or individual 3D shapes in the family editor environmens. Modeling tools can be used with
.made solid objects or imported geometric models. B, Revit is not a NURES modeller and also
lacks the ability 1o manipulate an object’s individual polygons except on some specific object npes suck
as roofs, slabs and terrain or in the massing environmens.
There are many categories of objects called families, which divide inzo cerain groups:
o System Families such as walls. floors. roofs and ceilings which are buils inside a project
o Loadable Families or Components, which are built with primizives (extrusions. sweeps. e1c.)
separately from the project and loaded into a project for use.
o In-Place Families, which are built in-situ within a project with the same toolset as loadable
components.

Revit:

Autodesk’s Revit is a Building Information Modelling (BIM) product. It encdles archizecrural design.
MEP and structural design, detailing, and engineering design. Revis provides an open-source grtz,—-h:k'al
programming interface designed for BIM workflows. performance mi:.’_’mz ch SQ visuclizarions Jor
designs. The program supports mid-process analysis to enable iferarive a'd)fu-w ‘..Lh can inform and
refine models and designs. Revir also supports worksharing for cross-ream collaborarion.

BT
| SR
R (Object): . . ‘

Revit software ¥ 3 g7 W Ufefen 79 51 437 T (To Srudy Basic Drawing and Editing
Tools of Revit Software)

* Move Elements with Move Tools N )
Move tool, Dragging 3 AT /M S(al & T T€ option bor W FITH FIHA ¥ Tt
R 3w W (precise) Wiz 3 A T & N
Move tool ¥ W19 move element F orERE ¥4 § fae— -
* Move Y ¥ fTu element ®1 ¥ FX R modify T click T <Flement> tab » Madify
Panel > (move) N
® Modify tab > Modify Panel » move W click T, move T ¥ AT element 1 997 § R

Enter Zam)
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Option bar WU desired option T click Lol :
Constrain: Vector & 19 element % motion #1 9fFala (Restrict) WZ‘ & {0 consteain m
chick ®E I clement & AER (perpendicular) awT (collinear) e i
Disjoin - Move #31 3 W I (selection) 30T 31 @ (other elements) & A a4,
(Association) 1 Break H % 10 disjoin W click F21 7% option 3¢ =0 3P 1 gy 4,
TRV, WA A U 7 A (wall) @ move F T # St gud Aam A H B oam g,
clement ) 3% AATF host B 0% New Host F move % A0 W Disjoin fawe F1 390m 25
A $1 T M UE window 1 UF wall A At wall T move 3 e Tl {1 feature
T T STE AT AT £ W@ AN constrain option 1 clear T F )
Move  fA10 0% want point 73 &0 F fom OF A0 click F T clement F U preview
image display #1071 31 3T cursor F 3 direction it move w1 direction W am
element 1 move FEA FFA #1 T cursor, Anap points FEIY snap ¥ IO Aq dimension,
puides F ¥ 0 wE2 7w
Move B complete F73 ¥ fon TF AR R A click R, 3R 39 A precision wea €, 3
distance type T3 F T2 enter T click F

The Move tool works in the same way as dragging. Moreover, it offers many additional functions
on the Options Rar and can allow more precise placement.

To move clements with the Move tool:

(i) Select the elements 1o move, and then click Modify | <Element> tabModify panel (Move).

(i) Cli-k Modify b » Modifv panel » (Move), select the elements to move. and then press Enter.
(iii) On the Options Bar. click the desired options:

Constrain: Click Constrain to restrict the movement of the element along vectors that run
perpendicular or collinear 10 the element,

Disjoin: Click Disjoin 10 break the association between the selection and other elements before
moving. This option proves useful in some cases, for example, when you want 1o move a wall that is
Jjoined to another wall. You can also use the Disjoin option to move a hosted element from its current
host 10 a new host. For example, vou can move a window from one wall to another wall. This feature
works at its best if you clear the Constrain option.

(iv) Click once to enter a start point for moving, a preview image of the element displays.

(v) Move the cursor in the direction that you want the element 10 move. The cursor snaps to snap
points and the dimensions appear as guides.

(vi) Click again to complete the move, or, for more precision, type a value for the distance to move
the element, and press Enter.

ﬁ’l 4.1=Using the Move Command

Atttz 145
pign ElT w0 7 W A
ool F use T ™ HTE elements F1 FEH selected elements 7 Al oo
A"g“il £ tool T T A Walls, - s L) e

.Bcamx, Lines 3 277 elements 71 Align f2m 51 5 4
4 74 tool F T @ wall F surface patiern 1 TR element @ align f5 71 wam 31

DY ts TF @ YA % W e X9
i maﬁﬂﬁclcmcn“@“ ( W-WW FRTFAL &M clements %1 plan
lw 4D view 1 elevation view ¥ align F a#a #
EWs <

& Fee: &4 Align ool F1 IV O T f—

s Sclect beam, line @ wall % @9 wall 1 beam ¥ ends (faf) 1 align 73 #7)

+ Selected beam, line 71 wall & WY walls 7 beam ¥ cenwe # align #7413

o Selected line 1 wall F T window F T 7 align 711 43

o frdl selected line ¥ selected end points 1 align 333 £4(

Align 100l can be used to align one or more elements with a selected element, This 100! is widely
wed1o align walls, beams, and lines, but it can also be used with other types of elements. For example,

in 3D views you can align surfuce patterns of walls with other elements. The elements 10 align can be of

the same type, or they can also be from different families. You can align elements in a plan view (2D),
3D view, or elevation on 2D view.

The Align tool can be used to:

c

o Align the ends of walls or beams with a selected beam, line, or wall (This action extends the
lengths of the aligned walls or beams)

o Align the centers of walls or beams with a selected beam, line, or wall (This action moves the
aligned walls or beams) ]

o Align the heights of windows with a selected line or wall.
o Join selected endpoints with a selected line. A
To Align Elements
o Click Modify tab e Modify Panel > B (Align).
The cursor displays with the align symbol E.
« On the Options Bar, select the desired options (Option Bar T afod fawes &1 @ B):
® Select Multiple Alignment to align multiple elements with a selected element (Selected element
& multiple elements F1 align FTt § muliple alignment F1 %7 FX) (You can do the same
if you press Ctrl while selecting multiple elements to align.)
& When aligning walls, use the Prefer option to indicate how selected walls will be aligned: using
Wall Faces, Wall Centerlines, Faces of Core, or Center of Core (Walls =1 Align w4 T
Prefer option T use X Fred 78 WA =t A {5 walls &3 Align &)1
/ ® Select the reference element (Reference element F¥ select R
* Select one or more elements to align with the reference element (Ref 1
¥ W A element F select F!

1 @ align FH
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o Before selecting. move the cursor over the element until the part of the element to align wiy, the

reference element is highlighted. Then click it (Selection & & cursor F I element ¥ Eo]
move T I TF reference element A align fFA 1 1A clement F A highlight 7 § ),
afe 319 9% TR ¢ fF selected element reference element k| align AR alignment R lock T
% iU padiock W circle FX1 T padlock symbol display & 81t 2 A modify W click FY e
Refercnce element 1 select T ARF symbol f A display B ¥ (If you want the selected
clements to stay aligned with the reference element, click the padlock to lock the alignmeny. 1

the padlock symbol does not display, click Modify and select the reference element to make the
symbeol redisplay)l

7 alignment ® start FTX ¥ Escape F TF R press HX (To start a new alignment, press Ese
once)l

(viii) Align tool T exit FTA ¥ Esc M A TR press F (To exit the Align tool, press Esc twice)|

Move Elements with Offset Tool

Offset tool * TETa A 7 selected element A 7% model line, detail line wall A beam %)

IR T F T O Feifa G0 W copy I move B 1 W 1 39 T tool B TF singe

clement T TF & TR F ¢ elements T T W apply FT THA ¢1 3T selected element T
drag ¥ Freifm g8 w wgw wwa & o frolfe T 9 ype FTF D enter FTFHA £ Offset too]
F @ 7E ¢ F &9 lines. beams, A braces F 9% 3T work plane T & offset F THA &1 3y
in-plane families ¥ 1 ¥ T walls 91 offset T8 T TFA TN elements F IT% move plane ¥
perpendicular view ¥ W offset T FX WHA
Use the Offset tool to copy or move a selected elements, such as a model line, detail line, wall, or
beam, a specified distance perpendicular 1o its length. You can apply the tool to single elements or you
can also use this tool 1o move a chain of elements belonging to the same family. You can specify the offset
distance by dragging the selected elements or by entering a desired value. ;
Restrictions of Offset Tool:
® You can offset lines, beams, or braces in their own work planes only.
® You cannot offset walls created as in-place families.

 You cannot offset elements in a view perpendicular to their move plane. For example, you cannot
offset a wall in an elevation view.

(i) Click Modify Tab > Modify Panel > fTl= (Offset).

(ii) Option bar W WTH select FX f 3T offset distance fFT Y specify FA =& &1 4R M
selected element F1 copies F1 IT FIF offset FC TEA T A option bar W copy I select
FX (On the Options Bar, select hows you want to specify the offset distance. If you want to create
and offset copies of the selected element, select Copy on the Options Bar )|

(iii) Offset FTA %ﬂ element 3 chain I select F1 AT 3TN offset distance numerical option &1
specify &1 2 A highlighted element ¥ 3 € 8 T T preview line display B ST (Select
the element or chain to offset. If you specified an offset distance using the Numerical option, 2

preview line displays at that distance from the highlighted elements on the side where the cursor
is positioned)!

) Aikos Y, 147
preview line 1 =2 offset position 77 display F3 17 cursor 71 71 :
qm T position U chain W clement T move T3 % oy m 3 4y fimg s "“f::
; s R 4 ZEi 7
move element T cllfk U 77 3 graphical option 71 w13 37y § 7 highlighted el 2
dlick FTh select &, AT position T drag 71 anm e

7 4 cliek 71 dra 33
Jistening dimension display %1 3, fomd zm offset distance 11 specify 74 £ (Move the cursor

g8 necessary to display the preview line at the desired offset position, and then click 1.

element or chain to that pos'ilion or to place a copy there, Or, Also, it; you selected a}z)("::;;i“j
option, click to select the highlighted element, and then drag it o the desired distance and chccak
again. After you start the drag, a listening dimension displays, and you can now enter a specific
offset distance as desired)!

(V)

Copy Elements with Copy Tool

. Copy tool T TEHN A 2T TF 7 AT selected elements F1
sl g ¥ <l =8 T place F TF ¢
. The Copy tool copies one or more selected elements and allows you to place copies in the drawing
immediately.
The student must note that the copy tool is different than the Copy 1o Clipboard tool. The Copy 0ol
is used when you want to copy a selected element and place ir immediately (for example, in the'samz

view). On the other hand, the Copy to Clipboard 100l is used, when you need o switch views before
placing the copies.

copy F1 T ¥ 39 54 copies H1

" (i). Do one of the following:

' Select the elements to copy, and then click Modify | <Element> > Tab Modify Panel 93(Copy).

J _ o Click Modify Tab » Modify Panel > c’Q(Copy). select the elements to copy, and then prass
"~ Enter.

(ii) Multiple copies place FTX g option bar T multiple select F{ (To place multiple copies, on
the Options Bar, select Multiple)!

(iii) Elements ¥ move T copy F14 2q drawing area (I &9) 1 TF IR f7=% FX (Click once
in the drawing area to begin moving and copying the elements)!

(iv) 7 elements & cursor ! 3 & F R move F{ T&l 3 copy F place FT T2 € (Move
the cursor away from the original elements and toward the area where you want to place a copy)!

(V) Copy I place FXA ¥F click F{ T listening dimension ¥ IR value enter F (Click to
Place the copy or enter a value for the listening dimension)!

() T ST elements B place FTH A T copy tools  exit FT & ESC #1 press F (Continue
placing more elements, or press Esc to exit the Copy tool)!

Mirror Elements

Mirror tool, select 2l T element # position ) TF line # mirror axis A1 T Reverse ¥
W #M mirror axis WY pick T T # 1 9 temporory axis F1 draw W FTH 21 Mirror tool
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21 selected element 3 flip Rl 1 T & 1 R copy TTH TF & step I position )
reverse f&a1 W gl t
The Mirror tool reverses the position (i.e. creates a mirror image about the specified axis) ofq
selected model element, using an specified line as the mirror axis. You can pick the mirror axis or dray
a temporary axis. Use the Mirror tool to flip a selected element, or to make a copy of an elemeny angd
reverse its position in one step. For example, if you mirror a wall across a reference plane, the wal| flips
opposite the original one.
(i) =1 ¥ T TF option follow FX (Do any one of the following):
e Select the element to mirror. and on the Modify | <Element> Tab > Modify Panel, click
eitherPK] (Mirror - Pick Axis) or [ig-(Mirror - Draw Axis).
o Click Modify Tab » Modify Panel, and click either Pl (Mirror - Pick Axis) or Pig-(Mirror -
Draw Axis). Then select the element to mirror, and press Enter. You can also select inserts, such
as doors and windows. without their hosts (Miror axis Y represent T3 e line select Fw}
% T pick mirror axis F select X A R draw mirror axis 1 select F1& TF temporary
line draw T (To select the line that represents the mirror axis, select Pick Mirror Axis. Or o
sketch a temporary mirror axis line, select Draw Mirror Axis)!
(i) To move the selected item (rather than making a copy of it), cléar Copy on the Options Bar.
Use the CTRL key to clear Copy on the Options Bar.
(iii) Select or draw the line to use as a mirror axis. 3
Y ¥ TF line A reference plane select F THA & FTGH! 1 cursor snap X THI Selected
element S move copy HIdl ¥ TG selected axis ¥ around IHH position W reverse HT M 4
(You can pick only a line or a reference plane that the cursor can snap to. You cannot mirror an element
around empty space. Revit moves or copies the selected element and reverses its position opposite the
selected axis)!

4% 42—Mirrored (and Copied) Door
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ysing Rotate Took:

Rotte 100! 7 geram A elements F 5 axis F wha rouae Frm T @5 1 Floor plan,
ation T Section views H elements JH view ¥ perpendicular axis ¥ around rotate 373 ¥ 725
Ele i A axis, view % workplane -2;; perpendicular T 1 A% elements axis % around rotate TH
2 A TIEC: Elevation yiews ¥ walls rotate = %7, 30t wrm Fr walls 7 windows rotate
o <

w0, TRl
il ou can use the Rotate 1001 10 rotate elements around an axis. In foor plan, reflected ceiling plan,
dpvatiom, and section views, elements rotate around an axis perpendicular to the view. In 3D views, the

isis P"pendicular to the work plane. of the view. Note that all elements cannot be rotate around any
:;;, For example, walls do not rotate in elevation views. Windows cannot rotate without their walls.
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fa® 4.3—Use of Rotation Tool

Torotate elements;
' (i) Follow any one of the following methods:
o Select the elements to rotate, and then click Modify | <Element> tab > Modify pancl > O
; (Rotate).
4 Click Modify tab > Modify panel > O (Rotate), select the elements to rotate, and then press
Enter.

Wity
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element

(@ I you want. you cao relocate the ceseer of rotation by:

® dngzging the coetol © 2 pew bocaticn.

o ciickmg the control aad cBeking 1 2 pew kocaton

e pressimg Spacchor aad chclory w0 a2 ew kcasion.

n‘emm—uumci%%mmmmmrqﬁnﬁm\mﬁﬁhzﬁmm
cumsniﬁ#i'ﬁ,ﬁ&mrh1f¥¢{9i%&‘§xnﬁn@?ﬁ“nmmm
i?'aﬁ‘!iéztphxmr.ﬁnitﬁ?ﬁEﬁnﬂﬁmm*:iﬁﬁkqtmmu
dalog 5 T defioe 2 e centre of recanon command T modfy FX TR cootrol TR poi
e (35 75 walls T imersection of walls 2od Enes) T 59 3 sop B 531 W N open e &
ﬁmﬁ*@l’fﬂi‘_\mm&Rmmas!xml‘ey(lu\:ﬂi\mﬂrﬂuqﬁm
Kmnuumnmxmmnmmmm&:mmmk
mmmmummnmummmﬂyumm.m
mamwhmwmmg.\m-mmmmmmn
pmmdhnsdmmﬂsstﬂsnﬂt&knmﬁudtﬂkmiﬁnm\'wmdmm‘n
outo open space. if you wish)i
(@) Option bar % 5 5 5 = T selext =X (On the Optioas Bar, select any of the followizex

. mmsﬁ%gﬁmmwmamﬁmmzﬁ%ga@
S selet 30 W BN T I 63 § = o 50 TS wall S oo S SS
== T wall 3 T2 ¢ ¥ (Select Disjoin o break the commection between the selection
mmmmmmmmmhm‘mm‘n
to rotate coe wall tat is joined t0 2nother wallit

* Copy: 3% 3 selection S copy = rotaze ST ¥ € 79 ocigiml W S T
Wiammﬁ(&u%nm.maumm«@mmm
case, remains i place)!

* Angle: Anzle of roation 3 specify 3X 33 enter press S Revit 3 T anghe W rotse 5
TR1 (Specify the 2ngle of rotation. 2nd press Enter. Revit performs the rotation at the specified
angle. Skip the remaiving seeps)l

(iv) Click to specify the start ray of rotation.
8ﬁmmﬁéﬁﬁmmémw‘iﬁmmmmwm
mm%a@mmm%mmﬁaiﬁwmmémiﬁiﬁ
qugksmmaziﬁmhmysmmm:ﬁmny_ﬁ&mm
whi]espeafymgdr&nny,dtﬂ@ﬁncrmmﬂﬂtpﬂiwbuxmdsmpbmgbm

:!zscmennhﬂepiacingmcsecuﬂny)l .

. bhvelbemrsormph:elhemimyufmx'xn_

(¥) 37 Estening dimension ¥ wse T05 4 rotate T FE3 $1 99 @ AW stare cay of rotation 3
click ¥ specify 371 ¢ 43 @ angular dimension bold ¥ display ¥ TR 1 3T keybourd

RS Y i T ¥ (i | T T 95 R O o IS I R click S R
|| %2 comen)

@ wEw R valve BT TR ¥ (Another ine displays toing;
jon displays as you rotate, and a preview image shows the selection rotati
an ,mm using l_nsxcmnl; dimensions. After you click mfpecif mﬂl i e
“" angular dimension displays in bold. Enter a valye using the key hmid kg rosce;
= Cick to place the end ray and finish rotating the selection. -
The selection rotates hetween the start and end rays.

m"‘d Extend Elements
Trim ¥ extend tool T FETA A TF T 3 elements 3

ﬁmwutmdfiﬂlilmtl mnmmrﬂlelelmmuﬁcxlmdm#mﬂmfm
ﬁmﬁ“mmmtﬁmmmwﬂmhﬁmmm R IR T
'lwﬁsdeufﬂ'aiﬁnmwsiﬁonckmcm%mmﬁm%ﬁm T TR
5% R tools T walls. beams, braces lines, MEP fabration pipe work @ ductwork 372 & trim @
exiend T B use T IR A
Ywmmcd)c]’rimand‘F.xt:ndloolstonimurex:endoneu-nmelmnmoatxmnda:ydcﬁmd
by the same element type. \puanalsocxlcndnon-paxulclckmms to form a comer, or also trim
wmmamwnfdrymtmWhenywselecnnclemqnmbeu-immed.drnmpostim
inficates the part of the element to retain. You can use these tools with elements such as walls, lines,
heams, braces. MEP fabrication pipe work and duct work etc.
__Touim of extend elements, Do any one of the following:

T8 element type 71 defined boundary

T2 WY AR Steps (Actions to be Taken)

R selected elements S comer | TR 3T fFH element ) tim FTF comer T T3 § & TN seleat

or extend two selected elements | retsin TTN § I TR @A R
Click Modify tsb » Modify panel » B (Trim/Extend to Corner).
Select each of the elements.

While selecting an element that needs to be trimmed to form the corner, make
sure you click the part of the element to be retzined.

8 element =Y 37T clement 2T | B

dary ¥ ¥4 ¥ use $ ¥F AT reference T select N ITF R wim

define A T boundary TF trim
F extend S Y (trim or extend

e clement 10 & boundary defined
by another element)

¥ P

q extend R S T element 1 select T TR element boundary T
projection 3 cross 1 # & ¥ T T revain W FW T WA
N click FFa #1 Boundary ¥ &0 ¥R ¥ WM rim § FRM

(Click Madify tab > Modify panel > =\Tﬁm'ﬁvmd Single Element).
Sckcuhcmfemmmuseasatumda.w.m-n gkmﬂ_relummk\uimer
extend. If this tlemcmcmstsxlrl\\mdn}'«:mm\nthemm)@
dickiswillrcmainthdrasiLTbepmunlerktsx&oﬁhﬂtundarymﬂ
get rimmed.
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aifa gRom
(Desired Result)
fe 7 element T define | Click Modify tab > Modify panel > = (Trim/Extend Muliple Elemeny,)
¥ TR boundary T multiple | Select the reference 1o use as a boundary. Select the clements 0 trim or exteng,
elements 3 trim A extend A | 8 Click to select each element to trim or extend.
%ﬁ (trim or extend multiple [® Draw a selection box around the Jements 1o trim or extend.
elements to a boundary defined Right & left F 3T box draw Y WY TE AT T ¢ R element
By s trienn select {73 T Y box ¥ @ e &1 LeN A right 3 3 draw 77 oy
¢ AvaF ¢ Fr Box ¥ AR A clements ¥ sclect B AR elemen
boundary cross F@ & @ element F1 Fad T8 WM AR T d oty
retained TEA1 & 8 W 3T click & 1 Selection box ® draw T3 wyy
boundary 3 T side T elements T& | I sclection T YFA 7 4
i mainedamﬁﬁ & #1 Boundary ¥ T&R side T M trim & W #
When drawing a selection box from right to left, the elements do not have
10 be contained inside the box to be selected. When drawing from left to righ,
only elements fully contained inside the box are selected. For any elements
that cross the boundary, the part of an element that you click is retained. When
drawing a selection box, the parts of the elements on the same side of the

boundary as where you click to begin the selection, are retained (i.e., remain
intact) The part or parts on the other side of the boundary are trimmed.

fisd oM AT Steps (Actions to be Taken)

1 fag3i ¥ 99 element R trim | Option bar ITF delete inner segment 1 select HY, FfEA boundaries 3
FTA ¥ (trim an element between | define T Y A points W click F| T inner segment A delete B TRM
two points) AFA TR W retained 39T T8 ® W@

(click Modify tab > Modify panel > [Bal (Split Element). On the Options
Bar, select Delete Inner Segment. Click two points on the element to define

the desired boundaries. The inner segment will get deleted, and the remaining
picces are retained).

r

o To exit the tool, press Esc.
Arrays

Armay ¥ Elements T line follow ¥ Wl & f linear array %% <1 @ 01 T arc @1 70
follow 3 W% &, T radial array %1 W &1 Array F I T T9T aray F elements & 99
F 0 D TIR Y specify T FHA —

o TEA T W element % F W T specify T T 79 I 1 TN elements F &9 4 7@
A g @ R

o V& q A element ¥F 99 TR specify FF a1 39 feafs F 9 F TR elements T G
W 2
The elements of an array can follow in a line called a linear array, or they can follow an arc called

a radial array. When creating an array, you specify the distance between elements using either of the
following methods:

di between the first and e i 153

cify the distance rstand second elements, (Use '

. iIPI‘sugscquem elements use the same specified spacing e Maks
gpecify the distance between the first and last elements,

[

(Use the Move To | i
. 1] Ast option.
lements are evenly spaced between them means the distance betweer, mm" n ‘), :\‘l:

To second option.)

maining € L
:Tcmcmb‘ will be same in this case also.

splitting Elemens ..

splt ool 2 TeEd 4 elements a mamum A divide frm @ wEm 41 2
4  segments T T S T 0 D walls ¥ 9 4 defined gaps 1 377 fom 1 e By
o 100l & @ & QA Lic %—Sp}n element 3t split with gap. 319 split tool 1 walls, lines,
pilings. columns, Beams, Braces, generic MEP elements 918 5 duct pipe. cable trays 3 condut,
S € use foa 1 A

Use a Split tool to divide elements into two separate parts, remove segments between two points or
ecreate @ defined gap between two walls,

There are two ways to use Splittools:, i.e. split element and splitwith gap. You can split walls, fines,
railings (Split Element only), columns (Split Element only), beams (Split Element only), braces (Sphe
Element only), generic MEP elements such as duct, pipe, cable trays, and conduit etc.

points &

PIN Tool

Pin Tool 7 TETEA ¥ modelling elements # TF T W lock &1 91 w#a1 & a1 75% a2 39
clement F1 move & fFA1 A1 GHall I 2 pinned element F1 delete F14 F1 T3 F74 & A Revit
ATH waming 31 & % 7% element pinned 21 32 M T component F pin FA 2 A W T
feaft 3 A move T THA &, AT T AW-TH & elements F AT move FH # ser fF7 T

Use the Pin tool to lock a modeling element in place. When you pin a modeling element, it cannot
be moved. If you try to delete a pinned element, Revit warns you that the element is pinned. If you pin
acomponent, it can still move if it is set to move with nearby elements or if the level where it is placed
moves up or down.

To pin an element:

o Select the elements to be pinned, and then click Modify | <Element> tab > Modify panel > {3

(Pin).
* Click Modify tab > Modify panel > 4 (Pin), sclect the elements to be pinned, and then press
Enter.

Revit displays a pushpin control near the element to indicate that it is pinn;d in place. Tp move or
delete the element, you must first unlock it by clicking the pushpin control. Click the pushpin again to
lock the element.

Resizing and Scaling Elements
T tool 3} e & oy Frel element & size ) adjust F FHA 2 2 scale T TFA 1 Resizing
W scaling graphically a1 scale factor SR F1 3 Tad 81 Scale tool lines, walls. images. links, DWJ
DXF Imports, Reference a7 Planes S 87 STeed o &1 element 2D 'G'I\JD views 3
Resize %7 7o ) o2 T i Pinned element Resize 71 3 1 ¥ 379 Resize 374 q e IR
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unpin W STIEEE B 1 Element ®! Resize T ¥ forg 3wl UF origin 3tata ym firg Py
w0 v ¢ D % T fix point B0 2w wEl A clements equally resize B IR tiw m W
T W R ¥ Resize R A WA /W clements parallel plane A fran ¥R erm aq v i
T seloct T TR walls W base level ) wT @0 wfew) 9@ 3 fR wall ) Resize 0§ 5 i
Inserts SRy doors W1 windows wall % mid point A fix distance W @ W ¥ W W W T
T STETE € % Resizing dimension 3 position B change %7 & 3 5 353 value #)

You can adjust the size and scale of elements graphically or by entering a scale factor. You can rey %
multiple elements simultaneously. The Scale tool is available for lines, walls, images, links, DWG and
DXF imports, reference planes, and the position of dimensions.

Importance to Note:

* You can resize elements in 2D views and 3D views,

© You cannot resize pinned elements. Hence, unpin elements before resizing them.

o To resize elements, you have to define an origin, which is a fixed point from which the el

MS Tiee

(MS PROJECT)

@ .. i THINK ABOUT IT
}'?iﬁn[ that the hardes 1 work, the more fiuck I seem to hiave.®

equally resize.
® All selected elements should lic in parallel planes. All walls in the selection must have the same
hase level.

® When you resize a wall, inserts such as doors and windows remain at a fixed distance from the
wall's midpoint.
Delete Elements
Delete tool 1 HEA R selected elements drawing ¥ € TR § 19 delete B w2
The Delete 100l removes selected elements from the drawing.

o Sclect the elements to delete, and then click Modify | <Element> tab » Modify panel > X (Delete).
@ Click Modify tab » Modify panel > X (Delete), select the elements to delete, and then press Enter.

WyTEE
1. BIM® 3 w1 wwwa §7
2. Autodesk Revit 31 §2 ¥a fadteard, o e arpwim
3. Autodesk Revit & FB B 1ools 1 qUi Fifadl

|

§54. wtae iAwie divedaad (Project Management Softwares)

mﬂmmfmme@ﬁmﬁmﬂwﬁwmﬁm%ﬁlmmﬁmma manage
FT  help 10 & (A Project Management Software is a software specially designed to help plan.
organize and manage project works)!

NS Project &1 &2 (What is MS Project?):
MS Project management &g 43R a1 a1 software # S project 31 planning, trackine 3 conmrolting
A FeEa w1 # (MS Project has been especially developed for project management and is a useful
software application for planning, tracking and controlling a project)!
MS Project 3MT% {2 @ w1 waHaT #7 (What can MS Project do for yoa?):
¢ Project managers B support Tl 2 (A tool which supports project managers)!
o FEA 790 59 F terms ¥ AR HT (Can do calculations in terms of durations o costs accurately)l
e TAF TR F GoETe) 1 A F63 (Allows *what if scenarios?", to make changes to the
| project and see the effects to those changes before finalising your plan and commitring it to work)!
:, :’ wt ma?( Y track FA (Track all the information you collect about the work, duration, costs
| ‘ _. and resource requirements for your project so that you can make adjustments in order to keep on
L farget)l
® Reports T8 views 1 create I print FT (Helps you to creaze and print various predefined
¢ ... eports and views quickly)!

MS Project also has a very useful Help facility with its own set of online tutorials that you can do l
2 any time,
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MS Project @ Hurd (Limitations of MS Project)
o Cannot create the tasks for you
o Cannot create the logical relationships between the tasks
o Cannot possibly know what resources you have to apply to the tasks
o Docs not know the duration of tasks
PRIMAVERA:
Primavera UF standard software management tool & 3 project ¥ planning @ management #7 yy,
fem v &
Oracles, Primavera (P6) s a very powerful, robust, casy to use management software for prioritizing,

planning, managing, and executing projects, programs and portfolios. The difference between MS projey
and Primavera are shown below:

AFAFT—MS Project T Primavera if 3fat

MS Project " Primavera
o T AW M FH T AEA o faga ag afem
o VBA language ¥1 e A Macros ¥ ford | e Macros 7o wfem 93 71 w0 wway
T W
o T A= (1) o i Iwem
o T TER 9 T 7m 3 g o ¥ yriwa R o 7 N W wwh b
o 9 cost o F cost

wiwe f&R w5 &7 (What is a Project?):

fR unique product 71 A #A 71 I F0 F 14 FEM 91 70 T Project FHAM # (Project
is a temporary effort undertaken to create a unique product or a new service. It might take one week or
many years but must have some finish date)!

Points You Must Remember:
o Project manager F1 project #1 specifications #1 i 913 €1 93 (Project Manager must have
complete knowledge of Product to be developed before defining the scope of the project)!
* TF T project manger project 1 fHifta 7wy W ¥ i, budget F1 e # a7 FTA
%1 7l #fz %1 oI F T g project complete T # (A good Project Manager is one who
completes the project within specified time, within budget and as per customer satisfaction)!

MS Project 71 Use %7 (Why to Use MS Project?) *

MS Project ¥ Project ¥ 3273, 1a, farffta wua faf, resources Af% track 7704 # Wz 77 £
(MS project helps to track the information about Project goals, cost, deadlines, and resources)

M ahe 187

s project gtart ¥ W7 (How to Btart M8 Progecy (8tandard Version)

on the Windows task bar, click the §tan bt
: o e start mentt, point 1 Al programs, elick Miceon

i
o 5007 {or whatever version In available) Nhice and then ¢lick Micromft (ffice

roject Plan # 277 %17 (4o
"“'m:w:fn Ie‘ menu, Click New, ( b Project Pin rom:s
 nthe New Project task Pane, under Template, Click o Computer,
o Inthe Templates dialog box, click the Project Templates Tab,
+ Click the template you want, and then click (k.

Templata?)

view # &@ wif? (How 1o switch 1o a different view?)

MS pmjcdﬁ vi_cwm werh working place 8 8, %7t am project plan 41 474 1 engey, edit, disghay
) analyse 7 A ¥ (A viewisa working place in M8 Project where yons can enter, edit, display and
snalyze information of the project plan)l

e Onthe View menu, click the name of view you want,

o [fthe view is not listed, click More Views, in the more views dialeng bork, click the name of view
you want, and click Apply.

Mé Project # ZUT¥I Views (Views Avallable In MS Project)

» Gantt Chart View: 2 %1 71 % defuult view # £48 vasks, 700 wmots, waring % fimishing
dates, 7 task T AT resources 71 FPIA 14 4 (Gantt Chart View is 2 default view which
gives information about tasks, duration of each task, sunting and finishing dates and resomrces
allocated 1o that specific task)!

o Resource Sheet view (0T W1z ) elaborates all available sesources allocated ws project in
asheet format. It doesn’t tell which tasks are assigned  which rescurce, frird 72 73 T =
arifza i fodrida ) oz =t ° zoi )

o Resource Usage view groups the tasks against each resource 477 frifm 73 = fofe=y 23
%) frird & argen g T

o Task Usage view shows details about each task that which task is assigned to whom and working
schedule of each resource 441 AT% TH3 7 ¥E E MfpA A h

o Calendar view: Tasks bars appear on the days they are schedaled to stant 777 o ad
F W 7 Fl H v dn £ 9w o o g fedfa

o Network diagram view takes % B9 relationship 2774 # 7@ 7771 frdrzs %1 & 27id #
(Network Diagram view shows relationship among tasks and also the dependencies)

Print Preview Window H Report @t Z&rdl
(How 10 view a report in the Print Preview Window?)
* On the Report menu, click Reports
® Click a report rategory, or to see all reports, click Custum. and then click Select.

¢ Select the report you want, and then click Select or Preview.
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MS Project ¥ visual report ¥aIT WA (How to create a visual report In MS Projoct?)

e On the Report menu, Click Visual Reports.

e Click a Visual Report tab, and then click the visual report you want.

o Click View.

Stz A (Project Plan): SR @ T model B & 3 areferd MR F T T8 aspecr 3y
£ A, g1 3 F 3 R smIf @ # (A project plan is a model which is constructed baseq
on various aspects of real project, i.c, time. cost end resources.)

Project ¥ YEHM 1 project #39 A fret 71 e ¥ @A AR (While starting a new projecy,

Project Manager must have answers to the following important questions in mind to produce positive
outcomes of the project):

o T A task fF A #2 (What tasks must be performed?)

o What will be the sequence of the execution of these tasks Hafq 31 fifv= < =1 =1

e Task %1 §9% T §7 (When should each task be performed? (schedule))|

e Task ¥ FM? (Who will complete a specific task? (resource assignment))!

T & 73 w3 =97 I? (How much will it cost? (Cost Calculation/budget))!

o A2 31 rask Frifa waets TwamEfa § qof 7@ @ W @ S fowed T €2 (What if some
task will not be completed as scheduled? (Tracking & Managing tasks))!

e Project i 37% safeadi &1 MR 3 S FQ £ 914 (What is the best way to communicate
the project details to those who have interest in the project?) (Views, Reports & Graphs)!

WH—How to create a new project plan and set its start date? j
¢ On the File menu, click New.
© In the New Project task pane, click Blank Project
¢ On the Project menu, Click Project Information

o In the Start Date box, type or select project start date you want
* Click Ok

¢ On standard toolbar, click save button.

* Save As dialog box will appear, give relevant name to your project
o Click Save to save the project

F¥—How to set working and non-working time?
® On the Tools menu, click Change Working Time.
® In the For Calendar box, select the base calendar you plan to edit (normally it is Staudard)
e In the Name field on Exception tab, enter a descriptive name for the non, working time.
¢ In the Start and Finish fields, type or select the start and finish

dates for the non, working time.
® Active Work Weeks tab and then click Details button to change the default non-working days
and timing 5 ;
¢ Click OK

MS e 159
set P.-operﬁes about a Project Plan?

_—How 10 ) ;
ile menu, Click Properties
iy On the Fi

") In the propertes dialog box, click Summary tab, and enter the information you want fike:
0 o Title of the Project

o Manager of the Pro?'cc(

o Company Information

‘" Any other useful information in comments

W’Ms Project o Milestones @ =1 Al §? !

Milestones arc significant (important) events that are either reached in the project or imposed
1 the project. Because the milestone normally does not include any work, so presented as task with
OZERO'duralion.

gF—MS Project # default working hours fFe7 21 §2

Fai—Default working Hours are 8 hrs/day, 5 days a week and 20 days per month. l

; Y weE- r1.

WS Project Start WA AT ITH! THWW F FAT FT (Starting MS Project and
Studying It workspace)

f!ﬁL (Procedure):

w11® Programs > MSOffice > MS Project ZRT MS pmjmﬁ et

Aite ‘A'screen appears which is called workspace of MS project (& screen &2 it fawa! T&a
MS project %1 workspace @1 STl )]

I v S——
1§ s pt b i

34!

oLael 134

AR

0ty

A 5.1—Starting MS Project
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Gantt Bar Chant
bars show B &
RN F TAF task
+ wHaEfy ®

scale

FEUR TR

fa&¥ 5.2—MS Project workspace details

Screen H1 FTIFM &F (Working Area of the Screen)
Screen F1 FEFR &% 2 Wil & fawfom @ & i entry table (ST 3MR) T Gantt chant

(TR 3it) 1 v 2 fF Gantt chart §1 T US engineer HL Gantt % 5 W @I T ? (The working
area of the screen is split in two main parts: the Entry table on the left and the Gantt chart on the right,

separated by a divider bar)!

Entry Table
Entry table # project ¥q 3@ &4 task list fFd R & o 9% farer weffa fed ST € (The

entry table will contain a listing of every task required by the project and will show calculated details
for each task)!

Gantt Chart

Gantt chart ¥ bars B & 9t 6 5% chart ¥ duration T calender timescale % ¥4 ¥ <9fd #1
(The Ganit chart will show bars drawn to represent the duration of each task against a calendar timescale.)
The name of the active view appears on the left edge of the view.

T¥A—Tasks &1 € £7

TAT—Tasks Project ¥ basic works units €13 & A1 project ®1 d, THAGM, resource requirements
¥ ®9 & aftls #1A ¥ (Tasks are the basic work units of a project and describe project work i
terms of sequence, duration, and resource requirements)!

-

o MST#Rz 161
oot 1 : =

0 . “. e

i Object): MS Project 1 M HTE (Using MS project)—
m‘ 71 W A (Creating a new project)!

(
U art data scl FTh project calender set F7 (Sett
) Projeet start data s T (Setting the project start date and adjusting

the prnjccl calendar)!
adjust F (Adjusting the time scale format)!

y Time scale format
\ 1 T @ roll ups enter FT (Enter task Names and task roll ups)1
i W plhases o =raftad FTA (Organising tasks into phases)!

(il
(i\-) Tas!
(v) Tas

i (Procedure): '

PR 04 A T project plan F (Hat computer T T enter 74 T T3H) (Before you
can put any information into the complfler. you have to plan the project in some detail )1

+ Work breakdown structure T (Produce a work breakdown structure with a task list)!

o T GO & @ (Produce a time schedule) (sequencing and linking of tasks)i

o Resource Plan A (Produce a resource plan (people. materials. budget required))t

o Tasks 3 resources assign F{ (Assign resources to tasks)|

pmjgctﬁ?t start date ¥ 3T 4 end date & backwards schedule F#aT =1 TFa1 21 Project information
pane ¥ startend date 91 schedule form set &1 Dialog box #1 access #4 ¥9 main menu bar T I
project T FRTH X T4 project information delete 1 (Projects can be scheduled from the start date or
backwards from the end date. Set the start/end date as well as the schedule form in the Project Informaton
Pane; to access this dialog box click on Project in the main menu bar and select *Project Information ...")

Standard calender % working times change main menu bar R ST#X FH T wols W 5% w3
change working times X it X (For changing the working times of the Standard Calender click on
Tools in the main menu bar and select ‘Change Working Times ...")!

Time Scale Format Adjust ®YATI (Adjusting the time scale format):

Gantt chart % time scale 3 format ¥ change X3 ¥q main menu bar W S format F select
T T Timescale WX f® =X (In order to change the format of the time scale for the Ganu-Chart
select Format in the main menu bar and click on Timescale ...)!

Enter Task Names and Task Roll Ups

s Task &1 9 d Roll up enter T (If the task table is not already displayed then click °T
on the toolbar)|

* Task Name column heading % 9 a1t cell W 1% X (Click the cell directly below the Task
Name column heading)

* Task name type S T enter key press FX (Type in the task name and press ENTER)!

¢ YF task T 1D number T SIAM TS TR A change A gFA F (Each task gets an

ID number. Each task has a unique 1D number, but it does not necessarily represent the order in

Which the tasks occur)!

asks’
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MY Wi e 163
| tnge Yiews AlLthe tonls you need |, N )
o Duratiom 1 e fanlt one dday 1010 # curd faee aten) i st u @ v ne estimated (g, i The “’\(h * WOl g filew wre meensible fram one
q L iy, r ,
i) 500 ML A o hape @0 0nA FOEnd el ITRY dength WE Gant chang wy ”." mnﬂ“l'w Viewt 1t i antomatically displayed atoyg ),
# 00y defant task sttt posject stant date Aot A &Y o Wil otiee that the \e
e fant iy :

el 1 Views, diwin,
nhn,nlm.‘ o hedule, ¥ the iverview of (he

: jre M ,
e fanlis o 1 aday with agoestion mark which “;"“, ullr\ “:;“ “‘““ I‘: cl:: l‘l;ﬂ‘ll»;\h :: ‘I;"'m“" Yoy, p m Planner (MSI Professtonal Onty),; 1 has been atdef ¢ \
Y SOt . | aldedd 1y o
Change bater A conveapuanding tavk acot o day s dengthappears in the Camt chan ny, ""'lml. cl|“ mnembhers are pertorming and where there 1 Over allinatyeg BV @ greater clarity of furw (he
§ S an late v et L]
e sk stant date fs the same as the pragectstan date)t ll’:’““‘:‘ Task (MSU rofesstonal Only)! Yo cun Make o lask gy \
| CAL wlive and sl

Organising Tashs Into Phases: L] HEpresent them

jn the project
o Summary ek 1R op TR Galtaks WA tA oy tash, o a b ug, congy

N
imber ot sk T e Gantt Chanca swmmmay Gk i indicated by e samny |, 2

wyare)
LN

| Manigement Softwares 4490 013 LERECIOR (T [
o 82 Q) PO, e v sepeig fufiga,

and the sumnany task e appean an bokd fetters)l
2 . x Pwjec

o 1 sk 9 commany Gk Y allocate 403 *Y‘\ MUY ok 1Y fadent @44 gl *l LU ! 18 Phoject
Y aelont T AN ool har 0 AL dent oF outdent feon S0 1A Q0 wad, M : h"‘ Project o iimavers LU GRIERIELT]
A indent M anident 14 URA R (Lo allocate an individual task W a MY Tash you gy, 3 M
indent the tavkh Lo can mdent o outdent a task By selecting e sk amd elicking on fhe
o outdent o m the wnl bhanl

o Duration tield 1 0ea fas o aerd ae idicare 90 &0 duation W estinae ) Tank w)
duration 1 & Froan g # yaaad fam ae wn ) i s e QUeroy
ik an the duratnon Belbindicates that the duration s an extimate, The dovation of o sk i the
AT OE e Vo e et ke to complete e Tk, The dueations can vnge fom Wiley
e months, but hoves day s, and weeky ae generally usedit

o I sk ) At e cnner A0 W blue bar U Black diamond W9 i @ av v,
date S am el #1 aE palestone Srenm R, W Project RN M ok e aetion polut gyl
B Q0 vou enter O 1o the duration of o sk, the blue bar beeomes a Blach diamomd with e
Which i catled a Miteatone and denotes an tmportant decision ov action point b a project)|

Displaying the project summary task

MS Prject # Projectsinumaty penerate %006 1 fais T display W8 HRA1 (MY Mrjewt
antomatically penerates the project summary task but doesn®t display 1t by detawlol

Main meimber %3062 ol W RAS 907 aption Y (Click on Tools I the nwdn wew
bar ad xelect Optionsdl

[ .
by

o View pane A3 aelect 38 (Select the View ane)!

Outtine uption lrom | ML \how Moject summary task seloct X (Under Outline optiony lw
oo Melectthe Show project simmary task chieck box, and then click ORI
MS Project Gamit chart view 8 39U project stmary taks display 2R (MS Project displays
the project simmary task at the top ol the Gantt chiart view)!
Features of MSP

o MSE helps to baild schedutes with tashs and resources,

o Fluentinterfuce (RIbbon): Commands are organteed in logleal roups that me collected opethia

wnder tabw The menus and toolbars have heen replaced with the rilbon, to flnd the connmanh
quichly
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THINK ABOUT IT

The only thing that stands feneeen you and your dream is the will to try and the belief thay i
is actually possible. |

. — Joel Brown

§ 6.1. 9f=q (Introduction) : /

TF spreadsheet TF software program il ‘é il @ Dana £ organize (=gafeem) fem Enk
Data W calculations fF W1 751 @ T T T graph F F9 X W display fFa s v 1 Eleclnmi;
spreadsheet A rows 791 columns TR £ f58R user fafvm T6R & FmEmal A iy R T4 Mg
TS UF fARTE Wi €, S mieTE T S0 qm wE w1 § 9 S 8 S Sies)
faredo & forw T I (Tool) ¥ @ faweiver 01 e § 98 won & fog e ol SvRw fam
1 o S 91 wem F favem, faid au swafem $0 9 sTavEEa 3 2, A 9 Sredie 5w
FW

Tredie TEiEE 3 A (Row) F F W ¢, A9 F A A 7 I B e o A = wp
2, 9 99 F IR | N9 I@ 21 A aW AW T intersecting point ﬂﬂ%ﬁmﬁmWstomge
unit 21 Excel # ¥ ¥ Numbering ¥ Sl &1 7 < A BT & 5= 991 column N 37&R VA indentified
fom w1 @1 A Sredi | 9% VS wA € i e, TR @ W wre iR s v @) wite
TR A & T W SRA MO FA € A IR B W @R 1 MS Excel ¥ fawd ¥ $9 meeq
SER e —
(i) THNIR UF Sievie Fi wid 0 & el 39 A H cells F enter FW & N fF rows & columns
F ¥Y 8§ arranged T #1 SF worksheet ¥ 65536 rows ¥ 256 columns B ¥ Rows | ¥
65.536 7% numbered B & WafE columns A A Z. fRt AA ¥ AZ ft BA ¥ BZ, 7a 3¢
%9 7 [V T numbered ¥4 €1 Sheets F1 numbering 1 Q255 7% Bl €1 Worksheets F1 6
workbook FEe &1

(ii) MS Excel #1 start 34 ¥4 Start - All programs — Microsoft Office — MS Office Excel
select FU

(ifi) Trevie § W AF F1 UF T USH O €, S 36 A H location T #1 ¥ GRH It F Few
&R (column letter) 3T A T (row number) 1 combination §1 S—C3, N6, H22 Tl
164

) . MSTFER 165
{ am Ffam F A (cell) M1 g iy

wat .
qﬂmﬁuﬁ AR T B AT B o s VAT (address) T § 7

; S 7 (appear) 711 7, 3terg il
Nmmtnwwmmmwﬁm;,wW =3 8 w7 o
o fﬁmmm,mnmmmme * WO T ay wfes

Ny AM vy o i s )
1 R S 4] F 0T tom 41 ey
") 7 work book T FA T File - New workbook select 57 7 Blank workbook sel
= x
( gacel R leters, numbers, special characters 31 combination e s 8 select 77
.- ¢ 7 textenter fFm m wEa 2 Fi Worksheet &
) ; wrEe TR A 8 W T 2 R e e 7
i ! _ =
i fya f UF A A (l;rlnul.n F I F8 5 1z o npy e I S —
ﬁmm -l@‘l‘ﬂ % i azﬁ3‘(\""mkb(l)kb?T’}’!‘1'&1‘;’!{1::3-'?;1-;:——;:,:‘
hA® F TN 90 T e ey
wFA X ) | AR TE R RA T v 4
‘W B F T T—
o 28 1-2-3 * Quatrpro
o VPP ® MS-Excel 77031
(vil) Mathematical cxprcsfi()n Bl f()rflu}l.’n kx| Tﬂm 2 F3 cells T Ty s 5 "
(viii) Dota 1 worksheet ¥ enter FT 2 cell F select FTH T2 # 971 double click T =
4 fae @ cell ¥ Data enter 771 =1 =g &1
) T R F & Delete key F1 use 7 9 541 2 7 cell 1 overwnte FI ATER Y
(x) Workbook  save FA ¥ shorteut (Curl + S). open T3 7 (Crl + O) command. close 73

R (Alt + F4) short cut F1 use 1 31 TF70 21 Excel # exit 73 73 File menu & T exit
) select A I & A R Al + F4 use i =m 2

numhc

s
A 4n P 5
BAD T mw AR ot

(xi) Cells F WY (continuous) range FTH ¥ range T upper left cell 7 cell pointer F1 T4 mouse
R diagonally lower right cell &% drag 1 31 /1 71 F ranges (Muluple ranges) ¥ select ¥7%
¥ Ctrl button F hold FF ranges T selected {731 1 T2 1 T worksheet 7 select 3 73
Ctl+A command 1 use 1 1 T 21 750 cell T range 1 9577 573 ¥ 79 cell T range
R select FE TS € 9 FFR Name box F Name drop down list T click F75 Name type 373
T ® ¥R enter press & Tgdl 21 Name change FT7 ¥F Insert — Name — Define command
use FTR T R
(xii) Row and column 1 intersection cell FEaI 21 Cell ¥ refer FT9 T column and row =
_ number cell address Feeldl § IEIUE: Al, B3, C2 321 F& Data enter fFasa =
spreadsheet worksheet FEe €1 Worksheet F1 group work book FEE 21 Cells W
contiguous T noncontiguous block Range FEE 21 Data §1 TF 571 enter 74 T3 Auto-
fill ¥ use TN WA 1 MS Excel 31 Auto-complete feature IR active cell = Dty ?
automatically input 1 T FFa ® (AR T repeatad entry ) i ""': TN
S Formula shortcut 1 use f&Fan s el 21 MS Excel F =T Readymade formulas ¥ function

A #1 Constant T8 T 2141 § 3 Formula 3 9 enter AT fomw T3 &R
& B

1

Bt



166 &= parsem 2 =wyw s

T

f=afer Ty W o -

(2} rajoeeh ppt b) ravikant xbs (¢) shweta.doc

FETEZ (Workdheet) T Sheet clevtronac spread sheet program (38 65 Excel) Zm g file &
smpic page B ¥ TT B TF Eaced file FIT8 TF T WIF worksheets T TFEA 2 Workbook 77 5
# Workdod ¥ specad shert § FE T :

® A mowlsheer or th-r U d smple paxe m g file creared with an clectronic lrn'adnh.«.,,.,,,‘,m'

sk @3 Ercel or Gewrgle Spreadhects
® A wowihovd 11 the mame grven o an Excel file and comtains one or more worksheets.
® The term speead hevs G ofon wsed 3o refer to a workbook. when, as mentioned. it Ptore corre, ly

refers to the compater program itself

S, srrctly speaking. when vou open an electronic spreadsheer program it loads an empty warkbogg
file crevass, of ome or mory blard worksherts for vou 10 use

Worksheet Detads —A worksheet is wsed 1o store. manipulate, and display data

The bavec woruge wnit for daza i a worksheet are the rectangular-shaped cells arranged in agnd
pettern m cvery werksheet.

fadridas ceils of data arr idemitfied and organized using the vertical column letters and horizonta
rom mumbers of @ worksheet wichn creaie a cell reference - such as Al, DIS, or Z467.

Worksheet —in Excvi worksheet (s a single spreadsheet that contains cells organized by rows ang
columas. A worksheet begins wich row number one and column A. Each cell can contain a number, tex;
or formula A cell can also reference another cell in the same worksheet, the same workbook or o
differemt workbook. In Excel 2010, the maximum size of a worksheet is 1,048,576 rows by 16,384
columms.

Workbook—A workbook is an Excel file that contains one or more worksheets. By default, a new
Excel workbook will contain three worksheets. You can switch between worksheets by clicking on the
worksheet tab on the bostom of the Excel window.

Benefits of Multiple Worksheets—The ability 1o have multiple worksheets in an Excel workbook
allows you 16 organize your data. Each worksheet can conrain a different set of data.

Adding and Renaming Worksheets—To add a new worksheet, click on the plus sign next to the
last worksheet 1ah. A new blank worksheet will be created. Alternatively, you can click on “Sheet"
under “Insert” or the «wp menu bar of Excel. To change the name of a worksheet right click on a
worksheet tab. select “rename ™ and rvpe in a new name followed by the Enter key.

Printing Worksheets and Workbooks—Lxcel gives you the option of printing a single worksheet or
the entire warkbook To print a single worksheet select “Print” in the File menu then click the radio
button next 1 “Active Worksheet™ under the heading “Print What.” To print the entire workbook,
choose the radio button next 1o ~Entire Workbook.™

o Worlsheet or sheet is a single page in a file created with an electronic spreadsheet program such

as Excel or Google Spreadsheets.

o Workbook ts the name given to an Excel file and contains one or more worksheets.

o Spreadsheer often used 1o refer 10 a workbook, when, as mentioned, it more correctly refers 10

the computer program itself.
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o - et is used 10 store. manipulate, and display dasg,
o ¥ e unit for data in a worksheet are the rec, ;
£ i:’# in r:!fy worksheet. ngular-shaped cels arranged in a grid

G heet is a single spreadsheet that e ontain, cells o

; works ! rganized by row
prfl 1 begins with row number one and column A ¥ rows and columns. A

.y cell can contain a number, text or formula. A cell can
. worksheet. the same workbook or a different workho
{3 worksheet is 1.O48.576 rows by 16,3584 columns.

a

o

e kbook s an Excel file that comains one or more workheets

’ i / ksheets i L
iple worksheets in an E ;
% ity 10 have multip i X f‘.l workbook allow s You to organize your data.
b a new worksheet. click on the plus Sign next to the last worksheet 1ab

also reference anather cell in the
In Excel 2010, the maximum size

P " A new blank
a» T heet will be created. Alternatively, you can click on “Sheet” under "Iruerr," on the 1op
- i bar of Excel. To change the name of a worksheer right click on a worksheet tab, select
g . » and type in a new name followed by the Lnter key.

;'Eﬂ" gives you the option of printing a single worksheet or the entire workbook. To print a

i single worksheet select “I’r4mI “n: fhe File ment l/u:‘n click the radio button rext 10 ~Active
* Worksheet” under the heading “Print What.” To print the entire workbook. choose the radio
3 putton next 10 “Entire Workbook.”

" Selecta Worksheet—When you open Excel, Excel automatically selects Sheet! for you. The name
oihe worksheet appears on its sheet tab at the bottom of the document window.
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MS-Excel Sercen 3% O WT—Excel @1 Interface =1 sl A fawifem @ 8

Title bar—2T5ed TR Document 1 title et &1 3 Title bar ¥ Drag F% T My
¢
Y

T B

T iee 8y ;
Menu bar-—Menu bar screen A R TR TR ¥ 3l Exeel & fafi@ Commang Ier

Formula bar—Formula bar Active cell ¥ Contents & FA-T Cell Address Re, ‘

Y I“Mc;
T Tl

Standard Toolbar—Stand
T T A A R fEm W T

Formatting Toolbar—Formatting teolbar # Formatting CU"""“:"““ & o s, Buiton 3
# foma TR SO A9 Cell F1 ST Je-Foo WM FT Fehd &

Task Pane—Excel # aR-3R 52 51 a1 F1 & fTT Task Pane TF 3wdnf Hfaw 2 T fy
options A FE T | T F el

Cell Pointer—Cell Pointer Active Cell F1 brelcicific 715131 A1 WA G (Colour Border) %,
Type #7d §5G {98 Cell ® Text 91 Numbers fear 31 € 98 Active cell 8 81

Worksheet Window—Worksheet window T8 Window % gl 39 Excel & grafyg TR 7
& 1 7 Window § Columns @ Row ¥ &1 775 fre & Cell 1 1 Worksheet %1 fam Wi
fe 3 9 Cells # Data Input Fd 2l

Mouse Pointer—Worksheet window & 37 T@1 W Mouse Pointer Hollow Plus fa= ¥ 3 3
21 3T Mouse Pointer F&AE Cell Select &, Data f&@, Menu Commands §=ﬁ Ik Buttons
Click 3 ¥ forg = 74 21

Column Heading—¥™% Column ¥ ¥R f&@m 37 9 18R Column Heading Feem #)

Row Heading—¥ei® Row ¥ arfi 3R @ 2 91 % ¥9e9 Row Heading Feem #

Sheet Tabs—Excel & Y% Document & Workbook H TF 91 TF ¥ ST Worksheets T &

Status Bar—Status bar Document &1 SH&R 9T €1

ard wolbar W Basic Excel Command F Buiton 7R § i a
ik

§ 6.2. MS Excel % U& Spread Sheet &1 7@ Al Functions T ST &% (To
create a Spread Sheet using MS Excel and Study the Built in Functions of MS
Excel) :

. A _s(;areadshec: is a computer equivalent of a paper ledger sheet spreadsheet. The values are arranged

,I : gnd made from co-lumns and rows. These values can take many forms such as text, dates and tim¢

an| numbe.rs. The main 1dea about using computer and spreadsheet is that you can experiment wilh

numbers without having 10 redo all the calculations again and again
'Slschnd ina com!'nulcr into which you put your data it is referred to as a worksheet.
o ;!:;l Cé"hm“’f"'"]"f’e spreadshects. It is uscd in budgeting, making inventory, invoices, Stuisic
{"h;w ier‘ "."b- prmlm’g labels, creating graphs, what if analysis and calculations etc.
: orksheet is the working area of the spreadsheet and js arranged as follows:

r
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e LA Yer et Format Jooh Dets Yindow Help  Adogepr ' e
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b [ 0 ¥ i = -

- e

26, . O ——
fiv v n\Sheet1/ Ste=2 / cheer3 /

Ready e e

fax 6.2—Spreadsheet

devic & fafws YRt (Parts of the Spreadsheet)

Nearly every part of the spreadsheet has its own term and it is quite useful to know your spreadsheet
vocabulary to make using Excel much easier. There are three basic parts of an Excel Spreadsheet.

» @M (Columns)
iR $THe” columns FEad Tl

Each vertical segment of the spreadsheet is referred to as a column.
MS Excel uses letters (i.e. A, B, C ... Z. AA, ..., AZ ... elc.) to represent columns.

ATl E B me C i

Column A

faa 6.3—MS Excel Columns
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s el Start T (Starting MS Excel)

» Rows ’

= ¥

Sy tedrE pows EEEN Y o
S AR N To start Excel,

ot run feit - aght are refered o as oy
K Start > All Programs > Microsoft Office > Mi, rosoft Office Excel

SRTACDN thawt

e b > 1 ote) to label mows , Clic
B
2
31
‘ i
5
T 6.4 MY Exeel Rows
> & (v .
Codams ¥ Row ¥ antersectton ocll FFaR |
Wi 3 oo and @ row tenact they form el The very finst cell. where colyy, Aang
L imterad & referrd o @ Al The column label always comes first and then row Number, = F A Al () Mcrosoh:
B O I G | [ e stort Ny, W
i programs selo 3
11 |
-] o vt o

(1ii) All programs | Microsoft
Office select F%

& 6.6—Starting Microsoft Excel

o Start

R es—Cell

The eres formad by antensecnion of a column and a row is known as cell. The cell is the smully
et i 2 workaheet that s esad 1o store data. A particular cell is referred to using the column ey
fallowad By the row number. Cell B2 is the cell where column B intersects row 2. Each cell in i
wocksheet has 2 umque address.

An actie cell is outhned 1 black and the location appears in the name box.

=) W

_qs%ammﬁsoimwi, SW R/ 408 WA W}, T WA T Erm

THAE T W (Worksheet and Workbook)
m“\.-\ \\n\!\h'n: 1 like 3 spreadsheet where You can enter your data in cells arranged into horizont!
rows ':w‘ i-m;.xl mlim_u‘\s Esch worksheet contains 65,536 rows and 256 columns. The rows &
i .“:\l 1003330 and the columas are numbered from A-Z for the first 26 columns and el
e umas AA 1o .—\Z“r:-:. Heace. you can see that the 256 column number will be 1V (as 256+
—_— \T:;ﬂ“::: 2 :‘m.\mJ:r “nd 9™ leticr is Land 20™ letter is V). You may change the name !
hoct that you want. bt they are nembered automaticatly, from sheet 1 to sheet 253, The worksh 3

%

The following screen appears with sheetl and A1 cell active.

RIS may comain vp to 32 charae s M
Workbook 1 3 :““‘-‘- j-“?dﬂ\ and does not contain any of these characters £\ %55 % B i
A &tion of one or more orksheets. You should store related worksheet int E: T sheet sz steed .l e marrall -
and cell A1 active)

same woarkbook to l\ﬂ‘p them together.
MS Exce! organizes w orkshe R 6.7—MS Excel Opening Screen (with Sheet 1

"2 i workbook Si + require more than O -~

workeheot for any given projec on the basis that you may require I S ], 5 Excel ® Click =¥
) PIORCL A pew o : 1 default B K i . programs — MS Word — MS Exce <

you may add worksheets upj;n a mal::n:::?(;j‘; You open contains three worksheets by défd FE—MS Excel H1 start F0 ¥q Start = brograms — Ho

= |
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a7 6.8—MS Excel Window & fafs g
Title bar at the top displays the title/name of the current worksheet.

BT Microsoft Excel - Book1

a3 6.9—Title Bar (zTgeet aw)

Menu bar contains menu and sub-menus.

[Worksheet Mena Bar

Isart | Foirat © Jook ; Data | Window . Help  Adobe PDF 7] Type a question tor help

. B X

e 6,10—Menu Bar(aq'm
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ar contains buttons, providing shortcuts for the commands such as New. Open.
te. There are also buttons to sort data in ascending and descending order, to add up
Iso to produce a map from the data.

b
dilfd l()()|
leajn Redoc
roduce graphs and a
Print

E-mail prevrew
° Research

Format
painter

Auto Sort

Copy Redo sum  descending

savt

ey G L | Y T
GO RITRINDBA: 19008 -5

i - - - ~ - - —- -

Sort  Chartwizard Microsoft Excel
Spelling Cut Paste  Undo ey

Insert @ "0 Zoom

hyperfink
fa 6.11—¥= Toolbar

Formatting toolbar contain icons from tasks, such as Font. Font size. aligning text etc. It enables
formatted. The appearance of the data in cells can also be altered. Using this toolbar you

open Permission

peceN 2 I give the worksheet greater impact and to put tp the data in an
may also use borders and colours to give the worksheet greater impact and to put up the B
efficient manner.
Currency Decrease
Italic Left align style Co decmal s .

I Center align

Decrease Font
) tyle i asenndeﬂt color
i Bold Underline  Merge an Incre
Font See center decimal

a7 6.12— ST Toolbar

Status bar displays messages.

Formula bar is used to type formula in the cell.
i 6.14— T Bar

The values are automatically put in the active cell.
> New Workbook Task Pane

MS Excel creates a new workbook w
ind Sheet 3. This task pane consists of options. such
>

o3 6.13—Status Bar

N
ith the name Book 1w ith three worksheets-Sheet 1. Sheet 2
as Blank workbook, from exising w orkbook.
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3 Templates on Office Onie
] on my computer....
(sl Onmy Web stes...

fa3 6.15—New Workbook Task Pane

Click on New button on standard toolbar, or use Ctrl + N.

Tt aHgH IWT BT (Creating a New Workbook) :
To create a new workbook select File > New and New task pane appears.
Choose Blank workbook.

» T advile ITT FTE (Creating a New Worksheet)

At the bottom of your worksheet you will see, Sheet 1, Sheet 2, and Sheet 3. To select a new sheet
click sheet number, this opens a new worksheet for you.

» T &3 (Name Box)

It is on the left side of formula bar. It consists of cell address of active cell.
To go to a cell you can directly type its cell address in the name box.

7 Row Heading
It consists of row numbers 1,2, 3, 4, 5 ... etc.
» Column Heading
It consists of column name A, B,C, D, E ... et to IV
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4.Data @ aa ¥ Put f&an s & & (Data which can be put into a Cell) :
§6.4

y Text
el € fize as a number, date, ime o formula as text 277
Eﬁu 221 @ number, data, time " formula F ¥ 7 T mr=mm, 0 a4 e 1w o B Data
pacel ists of letter is text. Text includes a combination of letters, number and

onsists

that €

Atexten
ul
{he formuld
" Jap the adjace

onsiders any data that it does not recog

special characters,
try can contain up to 32,767 chgructcr (only 1024 will display in the cell but all will show
a bar). I the text you enter will not fit in the particular width of your cell. Excel lets i
nt cell unless that cell already contains an entry.

(,\‘crlﬂp

7 N VO B B BN O ]
b B LA g B s S

R PR ) e EhT

s

i) File Edt Yiew [nset Fgmmllooh Em Window Help
;i‘JtJH.é.JIJ_lI’ﬁj}, M T
92951

o+ 5

R

foF 6.16—Column Width % FT

Column T =gl 41 T & 2@ IGH boundary W cursor F1 F T ‘41'51 cursor T{i »_dmfhlf
headed arrow TTE vertical l.ine 1 qftafia & ST 3/ 39 mouse i drag FIF column F1 W13E F
TR wRERh = w8 A N

To widen the column. move the cursor to the letter of the column. Itis column A in this case, click
it, it will change to a cross and the colymn will be highligAhxedi As you move the cu\{.\or l:; u:e h:;
separating the two columns it changes to a vertical line with double hcadcd :.um\\ .‘.lo\\. 1:: )“( -r
mouse to the right until you get the required width. Same method applies to make a column narrower.

> T/ (Number) .
You may enter number or text into a worksheet. MS Excel
numeric data. Numbers consists of 0-9.

is mainly used for manipulation of

* Decimal point (a period) is used a separator for decimal numbers.

* Comma is used as a separator of thousands. >
* Numbers can start with dollar sign (§) or with other currency Symbots
* You may use a built in numeric format.
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o When an unformatted pumbe
o When a formatted number docs not fitinace
2 number as a date only if itisen

o Fxcel mterprets

vy month date-year and 1

A nuemenc cell entry can maint

Excel converts it to seientific not
as 12345678001 234500, and displayed as 1.23457E16. In soi

correctly in the cell, the cell is not w e enc

Care should be taken while entering a 16-dig (el !
rine the number to prevent the last digit being turned into a zero,

cell as Text before entel

¢ does not fitin a cell. it is displayed in scientific Notation
11, number signs (# # # #) arc displayeq, ;
tered in American data format such 5 -
wot in Indian format is dd-mm-yy. N-dg.

ain precision up o 15 digits. If you enter a number thyy j o]
ou type 12345678901234567, it wiy| bhe \[ung‘
me cases, although the numbey ;Inr‘(-d
wgh to display it properly. Storg
it (or more) credit card or account number,

ation. For example. if

Tmat the

I T

T&F Excel Worksheet B 7 39 colls ¥ FEaq 3 save H—
Al =22, A2 = 33, A3 =49, B1 =49, B2 = 9111, B3 =20

» WIEN (Formula)

Formula is mathematical expression. To perform addition data iq the cells A2, B3 and C4 ang y
display the result in cell E5. so the formula will be = A2 + B3 + C4 in cell DS5. Here, the = sign needs
to be typed first, in order to distinguish between text and formula.

» & F q& FTA (Moving the Cursor)
You can move the cursor using several options on the keyboard:

Alt+ PgUp and Alt + PgDn
Home + End

End + arrow key

Keys/Combination Details
(F 7 wiEftIvE) (fen)
Tabkey Moves one cell to the right (row wise)
Shift + Tab keys Moves ane cell to the left (row wise)
Enter key Moves one cell down (column wise)
Shuft + Enter keys Moves one cell up (column wise)
Cursor keys (armow keys) Moves one cell in direction of arrow on key
Home key Moves the active cell to column A in the current row
Cul + Home Selects cell Al in the current worksheet
Cul +-> Moves the active cell to the last cx;iumn
Curl 4 <- Moves the active cell to first column
PgUp 2nd PgDn Move the active cell up and down one screen worth of rows respectively

Move the active cell left and right one screens worth of columns respectively
Move the active cell to the last cell in the worksheet that contains data

Moves the active cell to the first cell in that direction that contains data and is next
an empty cell

You may activate the cell by clicking on the cell. It can also be done by writing the cell address it

the Name box.

A

MsTFR |77
sitatzd (Mathematical Operators)
4 # memﬂﬁ“‘l operators are given in the following table:
al
Operator Function 1
4
addition (M) ‘]l

subtraction ( ATZ75 )

multiplicauon (7)) |

division (¥m)

percentge (TFA7A)

There is 2 predefined order of doing calculations. If a calculation involves only addition and
ptraction, it does not matter in which order the operations are done. Again, if a calcu'ation involves
sul mplicﬂ‘i"“' division, brackets then, the order does matter. Brackets are solved first then multiplication
g:ision followed by addition or subtraction.
Example:
Opecation Symbol Constant Data | Referenced data Answer |
Multiplication * =8%*6 =A2*B3 43
Division ! L S =A82 4
‘Addition + =6+16 =B3+A3 2
Subtraction = =6-2 A3-B4 4
Percentage % 50% =A3% 8 |
Exponent " 2% =Al"B3 i o4 |
Negative ‘ - = =A2 =3 4}
A q91
frr &1 39T W ERn—
M 16/4= (i) 15/3 (iii) 20% 3=
(iv) 2% 5= v) 5% 2=

Heviz 7 gEvitiz ¥ AT (Difference between a Spreadsheet and Worksheet) :

“A'spreadsheet is a software program allowing the user to make use of all the special features that

help handle the data on the grid. i i
A worksheet is a single grid into which the user enter data. When the user finishes entering data and

formulae the work is saved as a worksheet.

Worksheet

Spreadsheet

v mw software program ¥ @t weral A user
grid F1 data handle F37 3 TV features 1 use
T wE R

o TE TE single grid & Y user data enter FTA L4
- Data enter F71 F T work worksheet ERSR]
save § W@ ?
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371 @t advie ¥ Enter A (Entering Data into a Worksheet) ;

Select the cell where you want to enter data. Now double click in a cell after selecyjy,
cleC!

double cli¢k in it. Now you can type into the cel
y 0 m()d"y 1
Ahﬂllﬂ'dy. select the cell and type data in the formula bar. You may als

present.

2 or dif@cuy

When you enter data. i
'8 cC | o |
IWheﬁEmﬁdia.iW&s;enhwi

E | F

E‘EJHIIJ

nler 3 3
byl

e . — It

&% 6.17—Formula Bar # 321

» Tefadl W W FT (How to Correct Mistakes?)
If you make a mistake and enter wrong data into a cell, it can be corrected in many ways:
(i) You can delete the content of cell (text, number of formula) by selecting it and then press
Delete key (Delete key %1 Herdl q)
(ii) You can type over what is already written there (over write FTF)
(iii) You may double click in the cell and erase the characters using backspace or delete key
(backspace key BRI)
The two small buttons on the left of formula bar become acti ve, as soon as you start typing in acell

The button is the cancel button and it is used to cancel the data entry without pressing the Delete
key.

The button if pressed is equivalent to Enter button.

g S AT H (Saving a Workbook) ;

* Savea workbook sclect File > Save. If you are saving a file for the first time in Excel it displys
a Save As dialog box,

,

MS TR

he file and also select a drive or folder to save the file at the desired location.

me 1
i Save button.

o Press the

se Cirl +5:

A9 T

Exeel TE T T Il fraeq 22 Fill :1—

Al=5 Az=53,A3=22,A4=92,Bl=23
=9

! ¥ frEqg o9 &—
A1=6,A2=92,A3=32,A4=23,B1=24

&l A Drive Ul Folder faetae &Y
el e File 1 Save F &1

Ji opto corrections
& Sunita rattan engg

FE File FT 7 29 F st B =,
N Cutes TN

Camputer
E % Fepame: [ ggpgorakhpur ] [
Poces | Save as fype: [mcrosoft Office Excel Workbook M [ oma
R S R R SR ————— ———;a

o=t 6.18—Save As ST TF

g% B 30U FET (Opening a Workbook) :

® To open an existing workbook select File > Open.
* Select the drive or folder and then select the file to open.

179

& vis deepak File save F4 & faT
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Stop 1 Fiomonu A T

1
|
|
| & Sunt refian engy i
Step3 T daogbox wemmm || I | LT Step 4: T8 A drive A folder
dspiay T . i fadw w1
I
e Step 5: File name Eeloct .
{ W A % VAW TE @ open T
|~m-n- \
{ Q Megme {5 ] : o -
Sy Networt e T —
Races | Flesof oe: 'l oot Offce Exc Flcs .

3 6.19— File Menu 1 open Tamea Sramif arew
&g @ Close & (Closing a Workbook) : ; 7

After you finish all the work in the workbook and you need to close the workbook 10 start workin

a new workbook, select File > Close.

Ensure that all the workbooks are closed before closing Excel application. Close option of File

menu closes one workbook at a time.

Use Alt + F4.
[Foe [ Tot | View frsent Fa
3| New.. CurleN
3] Open.. Ctd+0
_ Glose File close HTY %ﬂ
] sove CtrieS L e
Save As..
Save as Web Page...
'2 File Search...
Permession »
3§ WebPagepreview |

T3 6.20—Close Option of File Menu

MsTFE 181

file butkeep Excel open or you c ;

can close your You can close your file alo, J

;”:ur file follow these steps: ng with Excel. To only
c o !

s Click the Jower of the two X's displayed in the top right.

[

o 1f you have made any changes (o your file you will be asked whether to save before you quit
(using 2 message box).

Toclose poth your file and MS Excel, follow these steps: -,
+ Click the upper X that appears in the top right. You see that this X rests on a raised gray square.

o If.you-have made any changes to your file you wHl be asked whether to save before you quit.

Exit &I (Exiting Excel) :
To exit Excel follow the steps select File > Exir.

[ Use Alr + F4 to exit.
| P ’

[Fe | Edit View Insent " i

Dq New... CtleN |
74 Open... Ctil+0 |
Close
Save
Save As...
Save as Web Page...
File Search...

CtreS

Permission »
Page Setyp...

Print Area »
] Print Preview )
Print... Ctrl+P
Send To »
Exit

TR YExit H (A TR )

R 7]

7 6.21—File Menu 1 Exit faseq
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(i) I \ ‘ ’ -
. . T & Do you want to save the chap, 5
wdviz ) ag AR T IR g , ngen ‘
No“clickﬁﬁﬂTIWWWWDamﬂﬁaﬂ.mmm%? am%

(ii) File 3 close FTX T Excel | Exit .a;ﬁ o w41 AT 2
(iii) Workbook @& worksheet ¥ T T f?

¢

§ 6.5. AW HT T4 HIA (Selecting Cells) :

Cell worksheet 1 % W 912 ¥aré & Fad copy, delete T edit e <1 s 3,

A cell is a smallest part of a worksheet that can be copied, deleted or edited.

Cells ¥ regular block (contiguous 31 non contiguous) range m 21 Ran 2e q amy e
TF 9 1 X WA 81 9 5 formatting cells, entering data, naming a range ¥wufE))

A range is a block of contiguous cells or non-contiguous regular blocks of cells.

Range allows you to work with a number of cells at once. For example, formaning cells or epye;
data. You may also name ranges so that you may identify them and move them easily. You c.

range in formulac. The name box, left to the formula bar displays the name of the curren
range.

an alsoyg
tly selegy
To select a contiguous range of cells:
o Click in the upper left cell of the range.
¢ Hold down shift key and click in the lower right cell of the range.
a
Place the cell pointer at any corner of upper left cell of range to be selected.
Drag the mouse diagonally opposite to the lower right cell of the range.
q

Click the upper left cell of the range.

Hold down shift key and using arrow keys move to the lower right cell of the range.
Release the Shift key.

> % Ranges 3 @& W fadez w0 (Selecting Multiple Ranges Simu'tancously)
To select multiple range of cells:
® Select the first range of cells,

* Hold down Ctrl key and select the next range.

¢ Continue holding down the Crl

key and select another range of cells. When you finish, relesé
Ctrl key.

> Out of View Range &1 Select HT (To Select a Range that is Out of View)
When the range of cells to be

ccd
selected i ; the range®
be difficult task. In such a case: edis very large, then dragging the mouse through

® Click in the upper left cell of the range and Press F§
* The status bar will show Extend indicator .

MSTF= 183

Click in the lower left cell of the range. If you want to turm off the Extend function, press F§
: again or Es key. -

‘Iﬂ Row ! Select HTAT (Selecting a Complete Row)
b4
o selecta complete row,
o Click the row heading number at the left edge of the worksheet.
a
o Press Shift + Spacebar

To select several adjacent rows (&% TErR rows = N — .
'n Drag the mouse over the row headers.

To select non-adjacent rows )

o Press Ctrl key as you click each row header.

» \ft Column @ Select FIA (Selecting a Complete Column)
To select a complete column,

« Click the column heading letter at the top edge of the worksheet.

g svoxrouT]

{ Use Ctrl + spacebar.

» T whvite @ Select FIAT (Selecting the Entire Worksheet)
- To select the entire worksheet:
o Click the Select All button.

|
Lldnva :
AH T
0 = & = frd—
(a) Ctrl + A = ..
(c) Shift + =,
(¢) Ctrl + S = . .
(@ T Tt advite mr&, T IWH Rows 1/ 10 Umlunlns.-\ﬁl?mwmﬁﬁmﬁl
o e
(@ R column B FY select T
®) Tt row W 3 @t select I
(©) 'ﬁ columns B & D &t TE W select w1 )
@) TR rows W 3,5 T 6 W T WA select T
© T8 wdvfic wt ww T select K

(b) Ctrl + Spacebar
(@) Win + M = v
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I o O & (Naming A Range)
To name a cellor d range:
o Sclect the cell or range-

o Click the Name drop down list of the Name box.

Monthly expenditure

fa 6.22—Name Box

he range. The name can be upto 255 characters with no blanj;
anky

e Provide the name for ¢
n underscore.

begin with a letter. a backslash or ai
o Press Enter.

and Mg

faar w1

Cell 1 Name &%, range of cell %t name & TG0 Excel file F name Each e
b

» Range & ¥ @ a9 &0 (Change Range Names)

To change or delcte a range name:

+ Select the cell or range.
« Select Inserr > Name > Define. Define Name dialog box appears.

You will find the names of currently named ranges in Names in Workbook list,
« Now, you may add. change or delete the range name.

0 Type a new name for the range in Name in workbook text box. Click Add.

D Select the range name in the Name in Workbook list and click Delere.

After you finish making the necessary changes click the OK button.
e W
@) ‘:ij m li: cells A2, A3, A4, B2, B3, B4 & C3, C4, C5 &t TS WIT select Ht 7
(i) 9 Range &1 T Anju ¥ T Chaandni T
§ 6.6, Edit ] W (Edit Menu Cemmands) :
Undo—38 Command 1 ¥ar S a1 %1 Cancel F3 ¥ fog e < 21

Redo (Repeat)—38 Command 1 %M Undo F1 T firam i i @ %01 % mﬁ‘ﬂ?ﬁ"*'

Cut—Zq Command &1 58m C :
R ¢ll contents &1 Cut 3 & foag FAFTA
{1 S W Paste & T § nts ¥ Cut F3 ¥ forg e ey & o Cut ¥

Copy—%d Command %1 Wi Cel| § ;
5 ) i Cell & contents F1 T i forg fepan S 3 il
@ I Duplicate matter 57H % fFT Paste F1 2; k4] L % e

Paste— ~
% Command %1 58 Cut, Copy T4 3 1% & Paste % & ferg farm o €
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Clear—%1 Command 1 m Select Cell contents F1 Clear #73 i frw )

I)EI(’IE'W Command 1 MM Scl?c( Cell contents 1 Delete T"-“(T f‘-mhfm — 7'14
pelete Sheet—54 Command 1 W Sheet 1 Delete F73 5 fem f;ﬁ-,n ) r’j Bl ]
Move Copy Sheet—%1 Command I WA Sheer Duphcate \lll:'ﬂ 'I?T:ﬁi ‘fl?n fam

e Command 1 ST FRR w1 (Word) #1773 (s i Y
|—50 (Word) "0 723 (Search) % fm fam mm )

Find .
s SONSISLS ¢ ious comnu
= Editdrop down consists of various commands that can be used to make
; make changes in cell contents

» Undo
” and reverses the last acti .
Undo commanc ast action performed. MS Excel :
5 supports multiple levels of
undo

. n action is undone the pruvious action will be dis, ay e; . oplic E
will be di [Y]. ed next 10
the Undo ption i
y n Edit

Menth
| UseCrrl +:Z.
» kedo

Redo command repeats the last action performed. It gets acti
T » g tivaled ‘ou havi -
othenvise it will show Can’t Repeat. after you have undone an entry

Grrl + Yor F4.

» Cell & Contents Delete FIT (Deleting Contents of a Cell)
To delete the contents of cell:
o Select the cell or range of cells whose data you want to delete.
o Select Edit > Clear > Contents.

= &y v LT -
0 P28 P P 1 S e
P i o
M wivis ~“wats comsen
00 3
n n
a ”
s "
Somtenty  Odt
anf | j:-,-- 400
n
e 5w\ gheet) / shet L Shectd / 1 »
. = L

firt 6.23—Edit Menu & Clear faeq
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o The sub-menu is displayed. select contents.
o The data in the selected cell or cells is deleted.
You may usc Delete key after selecting the cell or cells.

famme weA

Iudrw Toid T a3 T can’t undo (Ctrl + Z) option dim == 7

> Cell Contents & Copy Paste &1 (Copying and Pasting Cell Contents)
There are two methods for this purpose:
e Copy und paste
* Drag and drop

e 1

fax 6.24—Edit Menu &T Copy faeq

In copy and paste method:

¢ Select the range of cells to be copied.

e Select £dir > Copy.

¢ Click the cell where you wish to paste the cells
* Select Edir > Paste,

[
A C

I

i
ki i
‘JA 3 Paste Specist ¥
ﬁ 8 g 1
{5 j Cleat ¥ i
%T | pelete. ':
3 i
i :
] i
. s
it
1

5 H
1 H
2L nees (shee2 /Shess / T e s d
Ready S 1300 el {

fa% 6.25—Edit Menu &1 paste fa&eT

The data copied will be pasted to a new location.

Press Ctrl + C'to copy and Ctrl + V to paste.
OR

"ght'f:liqk to choose the options from Shortcut/Context menu.

In drag and drop method:
o Select the range of cells to be copied.
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¥ 6.26—Mouse pointer H1 TaMA &1 & lower border T position HTIT

® Position the mouse pointer at the lower border of.the selected range of cells.
e Hold down Ctrl key and the shape pointer changes to plus sign.

e Drag the border to the target location. .

The cells are pasted at desired location.

2
¢ s o) Sheet] S Sw2 / 7 m
Peey 2

Fe==i

ot 6.27—wr1 = mifew R W paste FTA

-
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nts A Move BT (Moving Cell Contents) :

Conte
Cc“ two ways for this purpose;

There 4rC
, cutand Paste
» prag and Drop
For cut and paste method:

« Select the range of cells.
Select Edit > Cut.

. .
1 the cell where you wish 1o paste the cells.

o Selcc

o Select Edit > Paste.

The cells will be pasted to the desired location.
For Drag and-Drop method:
o Select the range of cells.

fa7 6.28—Standard Toolbar

» Place the mouse pointer to the border of cells. The shape is plus sign of the mouse pointer. Click
and drag the selected cells to the desired location.
» Cells have moved to the desired location. Release the mouse button.

E trl+ X to cut and Ctrl + V to paste.
E

OR

Ciit and Paste buttons on the Standard toolbar.
OR

¥eh il
ght click to choose the options from Shortcut/Context menu.

T W

(W frmen w1 T W
TR e s W website Gicht & 3T 39T T text select
LRE R operation T FT Whd-
(1) Copy and paste
1(b), Copy, paste and undo.
(c) Cut and paste
(d) Ctrl + C and Ctrl + V.

Fran ¥ T S text W
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§ 6.7. Insert Menu 1 WanT (Using the Insert Menu) : , Choose he desired option from the Delete dialog box.
e nserting Rows and Columns) : " press the OK button.

Row @ Columns Insert e (I "

To insert a row:

e Click the row headef

o Select Insert > Rows. =z o A
The selected row shifts down and a new row is inserted in its place. §6.8- . . '

o Thess 2 Height &% @M (Changing Row Height) :

To insert a column: oo

o Click the column nam

o Select Insert > Column. N
o The selected column shifts towards right and a new column is inserted. .
L[]
Rows & Column &t Delete & (Deleting Rows and Columns) ; 3

L
To change row height only for one row then click on the bottom of border of row heading and the

¢ to select the row, where you want the new row to be inserteq paste T Paste special ¥ T 3fT 2

mat Menu T ITA (Using the Format Menu) :

i i i ight of cells:’
e to select the column, where you wish to insert a new columy, For changing row.helgh

o Select the row by dragging through the row header.
Select Format > Row > Height.

Row Height dialog box appears.

Enter the new height and press the OK button.

I Watch that the row height changed for selected rows.
To delete row or columns:

o Select the row or column you want to delete. hape of mouse pointer changes to double headed arrow and parallel lines in between. Drag up or down
o Select Edit > Delete. urect o achieve the appropriate height.
The rows or columns are deleted and the remaining row(s} or colurn(s) are shifted to fill th £
left. s A
You may right click any selected part and choose Delete option of shortcut menu. o Hlide W@ Unhide ¥ 7 3R §7
Cells = Insert T Delete &1 (Inserting or Deleting Cells) : Column #t ©¥gT8 &S FIA (Changing Column Width) :
If you want to insert cell or block of cells instead inserting the entire row or column. For changing column width for several columns,
o Select the range of cells that you want to insert. o Select the columns by dragging the column headings.
o Select Insert > Cells. o Select Format > Column > Width.
o The Insert dialog box is displayed. ¢ The Column Width dialog box appears.

¢ Enter the column width and click OK button.

e Hence, the column width changes.

To change the column width of one column click on the border of column heading and drag it to left
orright until required width is achieved:

¢ Choose the appropriate option from Insert dialog box. Select the option Shift cells down.
e Press OK button to insert cells.

Right click the cell where you wish to insert a block of cells and choose Insert option from shortcut
menu.

faar ¥

> ¥ T Delete F (Deletin
g Cells)
; T Excel Worksheet & column width @ row height # AW & Jfawaw f6aa 1@ w&H1
?

lJloc:ou can delete a cell in block of cells and also fill gap by moving cells right or below the deleted

o Select the range of cells you want t
0 delete. e "~
e Select Edit > Delete, . o
You can also right click in the ran,
¢ The Delete dialog box appears,

. MSExcel 1 Autofill feature predefined series of dita (S % text 1 numbers enter T #1 Ffaw
ge of cells and select the Delete option from Shortcuf ment- W T




frin 9w T \

192 fafa | | B
£ MS Excel lets you enter a predefined series of data, such g - | )
Auto Fill feature o‘, e ) | i
o example, oo S e |
Forexin? 1.3.5.7.9 ; gt i
A.B.C.D.E. .. e o foren
Sunday. Monday, Tuesday. . A . Aumml
he tist of Auto Fill options, click the Auto Fill Options button. The lismfopl_ X o g N
To display the nis ulas, numbers, months of the year, days o, . ' o
according to the e of data: text and form gty o du‘:\ : ﬁ. : %
etc. The available options re: \ ;
o Copy Cells (d)m:{ﬁ o m;mqa
o Fill Series | 5 e

o e
Fame | Teds | Rwa _ Youdow
g iy - SID ok

Fill Formatting Only
Fill Without Formatting
Fill Days

o Fill Weekdays . P — e
e Fill Months 7] 9 ey
o Fill Years . o [ — 4 iy
The above eight options are also included on the shortcut menu th.at appears when yoy right 5 i iy m.
and drag the fill handle to adjacent cells. The Auto Fill Options button is not displayed while using thig (] 1 52 oot
method. o :g‘ foctober =2
To create a numeric series are: it 35 s B
s . | 62 -
o Enter the first two values of data in adjacent cell. The first two values decide the incremeny 4] 5
value. h el i
The first two numbers are entered into consecutive cells with the starting value of 38 andis 1. L ~
increments by 2. (0]~ i
o Select two cells. : I S S - o - . oy
o A small black square in the lower right corner of selected cells is the fill handle. Drag the hande = ar
to the cell where you want to fill the number with series.
o Release the mouse button. The cells in grey area will be filled with the series of required numes. T 6.29—Series sl Weckdays
You can also generate a predefined series of weekdays, months, dates etc. §$6.10. FEH e Create HEA (Creating Custom Lists) :
* Type the first value in series. For example, January i ; 1
o Select the cell, TR Excel ¥ 3¢ Built-in-Lists 76T & fFT 39 379 TSOIER 9 lists T w1 § ot
£ Cl{ck Auto Fill handle and drag it to complete the series. » custom list 3T I 21 T Custom lists F1 39 built-in-lists N o cells ¥ il FEH T
o Release mouse button, Although many built-in-lists are available in MS-Excel, you can create your own lists also, and

these are known as custom lists.

Preparing customized lists in MS Excel is a way to create your list of names or text. After you have
Created a custom list you can use it to fill the range of cells to sort or fill in a user-defined order. MS

acustom list when sorting data, it is also saved with the WOrRE™ EXCCI provides day-of-the-week and month-of-the year built-in lists, but you can also create your own
) Ustom list,

zou will find the series of months of the year filled in the grey area. '
nce you create a custom list, it is added ’s regi e
other workbooks as well. If you use o aries

to be used on other computets,

Je forust
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BUILTAN LISTS "¢ ‘ ‘ e L " 4 (Charts):
Sun, Mon, Tue, Wed, Thu, Fn. Sat i T E ]
Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday A pIREAS ;q A T—;’m H&:ﬂaiqmz :?: fon < 31 =@ T T:!:'ﬁ ¥ 9= a7 iz
Jan, Fab, Mar, Apr, May, Jun, Jul, Aug, Sep. Oct, Nov. Dec . 321 enter W £ EXCEl :GFF" 3 'm IR T ¢ aW F A @ HFT use F & am
Janual r : ‘Mard\ May, June, July, August, ber, October, November, Dege, mmaréaﬂdocumemﬁmm place T =d &1

ry, February, , April, May, L July, P h g mbar Chartis 8 graphical representation of data. It is easy to understand.

For creating 3 chart, when you enter your data in a worksheet, Excel needs the information you

To create a custom list are: s and the type of chart you want to create and whe; ish i i
o Select Tools > Options. want to use a0 re you wish to place this chart in your
e The Oprions dialog box is displayed. document.

e Select Custom Lists tab. MS Excel § sueren fafes W& & Charts :

Column chart FFft T3 STt # 8 a1t Data ¥ WRard 1 <t & o0 frt fafvet items 1 o0

o Select NEW LIST in custom lists box.
81 (Changes ofver a period of time or comparison among items)

e Click List entries box and type the items you require in your list. For example, rainbow colour,

e Click the Add button. It includes the list in custom lists box. Pass
percentage

[cor v 3 | Swe | EvorCheonyp Searty 190% o 2
[“vew ] cactaton | Est ] Generd [ Tarmton | Qstomisn [ curt w 8%

i Liet rives:

NEW LIST -
| S M, Tue, wed, TP €| o i = | 60 |

Sunday, Monday, Tussday, Wer | | Be
| 320, Feb, Mar, Ar, May, 1, ) | |Green

January, February, March, Aprl Yedow ‘ . 40 —

|Badminton, l?ooa 0, Bc Orange
| Violet. Indoo. Bee Green. Yo |Red .
{ | 20
|
| 0 I Year

» v 2014 2015 2016
faw 631
L [ tgpart ] o Bar chart faf =W items 1 g1 7@ & (Compares individual items)
Subject
L
[ ]
Science
fa 6.30—Custom Lists Box
*  Click the OK button.
Maths J

A q9T

T& FRA list g daw s3i— English :l

Delhi, Ghaziabad, Hapur, Garh Mukteshwar, Gajraula, Amroha, Moradabad, RamP"’

Barelly, Shahjahanpur, Hardoi, Valamau, Lucknow Marks obtained

86 8991
2632
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+ Line chart T 3 & ¥ WA Data TR F Tt # (Shows trends iy tiag
Q('u

intervals)
Renu

1003 Ravi
80 Gunjan
60 8
40
20 -

0 T T

tst Test lind Test ird Test

fax 633

e Pie chart f&&t Data ot A TRF items F sum total A I F TWiAT 1

Rent (40%)

Item Cost (]
144°
Travel 1000 1000 3500 =720
5000
2000
Rent 2000 2000, 3600 = 144°
- 5000 © ,
y 2000
o = 144°
. Food 2000 ety

fax 634

o XY Chart—Shows relationship among numeric values in several or plots two groups of numbe®
as one series of xy coordinates 14l HEATEF HA F WeA ey far 21
Area chart ¥ ¥Ha ¥ T € T wRad @ g @ )
Doughnut charts pie charts % T 2 ¥ fifg TF A 34T data series FI include F Skl
Radar charts data series %! S&3l #) aggregate values Tt gorl #d 2 _
o ;urface charts 99 394 23 € 59 s W F a9 % HeA best combination s =
|

Ms TFTA 197

?

Bubble chart.xy chart 3 T o & £ 77 3-values F1 compare FTF 3-D WA F 7 frre
o 1 A R

A9 AT Table T T Chant create
jﬁhmuﬁﬁmmmil

DRI

fa 6.36—Creating Chart
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ﬁﬂwtﬂseﬁrtﬁmﬁ?ﬂ*lﬁscricsm,}m§

g udry B R R e ® e, o F e *ﬂrwmm

e g ¢ 3w A industry : ﬁ“mhﬁ .

*ﬁmﬂﬁmwﬁﬂﬁﬂmcxplninamryﬂﬁ%ﬂmlcWuﬁnmmmh y

Charts need at least one data series. A data serizs is known as a set of numberg for

Chant &

a 5
category. N"'(ul;,

Types of Charts:
.Tsumcmn:wswmiﬁmmwﬂﬁmﬁchmgcsmﬁaﬁ%:}ammw

9 ® wREd, TERI A line chart shows the trends in data at equal intervaly, Alin

typically used to show changes over time. @ chan,
QI T
frafafaa data 3 Excel sheet ¥ feed T T ¥ Line Chart ¥ R—
Item * Expenditure
Travel 5000
Food 6000
Accomodation 3000

2. Area chart: Q@ % s line chart Hﬁmiﬁféﬁfﬁmm line %‘ﬂ%;‘]ﬁﬂﬂmm

Area chart is identical to a line chart except that an area chart has shading underneath of eah

line to its value. Area chart mainly shows the relative contribution of values over 3 period of ip,
or other category.

JqEH T
frafafed Data & Excel sheet § W% & & FHST Area chart THA—
Item Expenditure (Rs.)
Travel 8000
Food 6000
Expenditure 4000

3. Column chart: e =T 1 WeTaa § M9 &1 41 3IUF items F1 GorA T T 1 Using column
_chan. you can compare two or more items column. Ckart is useful when the height of any
individual point is more important than the trend among the point in series.

JEq qvT

MS Excel sheet ¥ 5 @meafia 221 W @ 39S column chart TR

4. Bar chart: Bar chart 9t 2 values %1 qoi1 %3 1 ¥4 Fa1 81 Values F1 horizontal bars 70
it S &

Bar chart is mostly used for comparing two or more values. The values are shown b)’f':
length of horizontal bars. For example, a bar chart may contain of five different bars, 1t whie

each bar can represent a different items and the lengths of the each bar can represent profiles
made from each item.

MS Excel

h a8

MSTFA 199
aFura TR
§ Excel sheet ¥ 38 FEAE 2 WY q ITFT Bar chart T
" ple chart: Bubble chart values % @ sets 1 N F FEA 21 T XY W scatter chan F
B & = XY chart 2 T 1 71 18 § % Bubble = % 11 574 1 v e

U pBubbles chart can compare three scts of values. These are like XY (Scatter) chart, where X
d Y represent twp of the values, but the bubbles of the chart’s size is determined by the third
an

value.

5

AR ¥ ¢
ofiz ¥ wreaf® ¥ W T IAH Bubble W TAHI
4. XY Scatter chart: XY chart QA values F qoT FTA &1

XY chart is used to compare pair of value depicting them as sets of X and Y co-ordinates.
Scatter charts are used to show the results of many trials in an experiment.
3 HAE 9T
MS Excel § T 1At 321 9 7 IAHT XY scatter W &

7. Pie chart: Pie chart circle ¥ sectors % &Y H I & a quantity F sector ¥ IV 3H
quantity 1 # relative part IR 2 -

Pie chart is limited to a single data series. It cannot display more complex series of data. The
value of each item in the data series is assigned to a slice of the pie and all the slices add up to the
total of the data series. These are visually appealing and simple to understand.

Each data series in a chart has a unique colour or pattern and is represented in the chart legend. Pie

charts have only one data series.

I T
MS Excel ¥tz # %0 Fteaf® 321 WIET WS n-chart |

> Creating Charts

You can easily create different chart types for various data. Excel’s chart wizard offers you the

Ruidance for creating charts from your data.

Tocreate a chart, follow these steps:
® Select the range of data for which you want to create a chart.
* Click the Chart Wizard button on the standard toolbar or select Insert > Chart.
The Chart Wizard dialog box appears.
e ‘I:ﬂhal:lte Chart Type list box, click the type of chart you want. The default chart type is column
type.
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faF 6.37—Chart Type Dialog Box

o In the chart sub-tylpe group, click the specific variety of the chart you want to use.
e If you want to view the range of cells from which each row or column of data is taken, click the

Series tab.
« Now, click the Next button to proceed. It will bring you the next chart wizard dialog box called
Chart Options.
Chart Options/Tabs ., Details a3
- (w farwed) (ferercam)
Tides ° F W
Axes X-Y 318 ¥ scales F1 94T
Gridlines fire am =fed @ =& =fed?
Legend #1 A colours TR
Daa 1 data labels T SR 82
Data Table Data 1 table display e ¢ (fords ferdl chart draw &0 )

ms vFE 201

«t button, to display the chart location.

Ctick the Ne . i
Y k the Finish button. The chart will be created and displayed.
o Clic!
ne Chart Toolbar ‘ ' .
Se 4 arc working on chart and you need to modify the chart after creating it. To display the
\Vh‘?]f:’:'f select, View > Toolbars > Charts. The chart toolbar will appear.
chan‘!;““’cha;‘ 1olbar have the following buttons:
3
; s
Avu"“l’]“ Buttons Details
)| (ferarrom)

To select the part of your chart such as the legend of category axis. w ithout chicking on

< objects list h
chans £ these (Chart % parts select FTH €q)

To change the colours and borders of your chart plot area (Chart plot area  colours &

rmat plot arca x oa
fo Border change &TH &Q)
Legend loggle To show or hide the chart legend by clicking the toggle button (Charts legends =
show 71 hide %4 ¥7)
Data table view Displays the data used to create the chart ( Chart 375 FT ¥ W 24 F e FA
)
W Display the data by row or column (Data 1 row wise I column wise display Tl’j
i

Angle text downward Changes the appearance of X-axis and Y-axis labels to appear downward (X-Y labels U

appearance downward FA )

Changes the appearance of X-axis and Y-axis labels to appear upward (X-Y labels &1
appearance upwards %01 ¥9)

Angle textupward

O WEYUl YYHINT (Some Important Question Answers)

TF—MS Excel 31 81T 87

FMW—MS Excel is a very powerful and easy to use spreadsheet package included in MS Office
suite. It works very well with numbers and their complex calculations. It helps prepare your data in an
Nxm_izzd. orderly and meaningful fashion. It is used for creating reports and performing calculations
by using formulas. It is best suited for scientific and statistical analysis. It can also be used to prepare
Profit and Loss accounts, Balance sheet and other Tax statements. It can be used for both simple and
;:zg:ict‘fned numbers. It can be used for prep{u'ing analytical reports including statistical analysis.
price ap:l%c::id rEg_ressmn analysis. In short, it is very useful software for accounting in specific and

ons in general.

-
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¥¥9—What are title bar, menu bar and standard toolbar in MS Excel?

FAC—Title Bar—Title bar shows the name of the document and is situated in the top of
window application. *

Menu Bar—Menu bar contains various commands under various topics to perform some g
tasks. it is located below the title bar.

Standard Toolbar—Toolbar is the shortcuts of different Menu options to execute or perform the
menu options in the easier, efficient and faster way. Standard toolbar contains icons for the Excel’s
most frequently used commands.

W¥T—Excel ¥ 3uera fafWs operators F WaivEwAr T 114

Pecia)

IAT—
Precedence (STafirsam) Operator (F14) - Details (T
1 : Range of cells
2 Space Intersection of cells
3 Union of cells
4 w Negation
5 Percentage
6 & L Exponentiation
7 & Multiplication
7 / Division
8 + Addition
8 - Subtraction
9 & Concatenation
10 = Equal to
10 < Lesser than
10 > Greater than
10 <= Lesser than or equal to
10 >= Greater than or equal to
10 > Not equal to J

Note than in above table, some of the operators have the same priority like multiplication and
division, addition and*subtraction, and various comparison operators.

Y¥i—Excel ¥ 7 & M7 | dUEd €7

(a) Goal seek (b) Scenario (c) Filtering

39— (a) Goal Seek—Goal seek faftr wrfem gRT e result ) W@ He3 3 Aifod T F T
T &1 fal7 €1 Goal seek is a method for finding the input value that a formula requires [0 retum 2
given result. For this purpose, MS Excel varies the value in a cell that you specify until a formula that's
dependent on that cell returns the result you want we can use the Goal Seek command when you want
to find a specific value for a particular cell by adjusting the value of only one other cell.
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() Scenario ¢ )39 values 71 e & & T8 Excel save F71 291 2931 worksheet
; substitute T e ? (7.'@ THA ©)1 A scenario is a set of values that Microsoft Excel saves
il substitute automatically in your worlkshcct. You can use scenarios to forecast the outcome of a
andcan + model. You can create and save different groups of values on a worksheet and then switch to
wm‘:(hﬁlccqc new scenarios to view different results,
A (g)FIl(cring—lﬂ’?fa‘?“"?a?'aé1 list ¥ St A FE GoA 9 F & A fherd F use oA 5
Jocale any information qqickly in an extensive list Microsoft Excel provides Filter list option.
This option enables lhel user to display a subset of the mf.ormgrion selected according to some options.
This is known as filtering. The two commands for filtering lists are:

» AutoFilter, which includes filter by selection, for simple criteria.

2 To

» Advanced Filter, used for more complex criteria.

259 ﬂﬂﬁ'llﬂf ﬁr-g (Some Important Points)

MS Excel T WG T8 W & 4w R 1 H 91 spreadsheet package &1 7€ €21 W
et &0 % e FO N A HEmall W F § e vers § fien sem 793, formula
1 use T calculation {3, IR T it faveraui #, profit and loss accounts @ &, Balance
sheets T B, Tax statements F ¥, Excel 1 3789 4fiF 21 98 object linking 41 ernbedding 1
+# support FTA 2 1giq MS Office % M Programs (S8 MS Word) ¥ 221 Fi Excel ¥ put 91 fo
foan <1 wHA 2 9 Excel ¥ ST <ft < 9ehal §1 Excel S start S0 g taskbar ¥ start bution R click
& programs option HI select X AT FAA MS Office W STE MS Excel F1 select FX TF TG
Excel Window & & W& ¥—Title bar, Menu bar, Standard toolbar, Formating bar, Status bar.
Formula bar, Cells, Rows, Columns, Name box, Help assistant, Scroll bars 41 Worksheet.

MS Excel % fafas @zt &1 +1d (Work of Various Component of MS Excel)

¢ Title bar—Window application % top W &rdt 1 5 Fd document ¥ 7T F1 TSR w1 o4 R
Title bar % ¥ Menu bar 211 €1 Menu bar ! menus ¥ fafi commands ¥ § &1 a9 ¥oR &
¥ % €1 Standard toolbar ¥ ffiT icons € € 1 W fRT® %% Menu options HI 3TEHA ¥
3T R R S FA 2 37 6 FE G4 § FF standard toolbar menu options T T ¥q shortcuts
F T8 A 81 Formatting toolbar ¥ document & formatting ¥ Weiferd faf@ shorcut icons &
# Status bar cursor =3 feafd (positioning)  keyboard 1 F© HeUl keys 1 status show FTl
2178 5 mouse R toolbar button T point T & A TF TR T message Ve T 1
3 user menu option F select @ TAH SR point FT@ & F FE menu option F TV message
display a1

* Formula bar Cell & i formula 1 show Far § 31afq af fEh cell  formula stored ¥ 1 &t
lick Y R formula bar % TER Waiftrd formula Fef & &1 €1 T &f W& (horizontal line)
IR cells TYE row et &1 Excel work book ® worksheet ¥ Sif4shaq 65536 rows &1
& & i Y (vertical line) ® I T+t cells 1 WE column Feara 21 T Excel workbook
bk worksheet ¥ iftRam 256 Fei B0 &1 TRIF row I HieW & TR (intersection) cell

A
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FEAM 1 MS Excel 221 791 cells 7 store £ 3001 21 Excel workbook 3 weir WOrksheg, 4
256 % 65536 = 16777216 cells €14 #1 Name box T TR cell (currently active coy), 3;' !
W2 FT@ #1 Office Assistant 3TTF F7 FT4 7T online FEPT UA real time tips PIOVide
#1 Horizontal 9T vertical scroll bars #1 WePTM A 3 worksheet ¥ 57 26 -7, i 3
TR FT TH4 21 Excel # worksheet 3T9F F1 =70 1 781 3 F1 F 74 21 Workbook % y;"
worksheet F1 1w 3@m TEE A & Ao SORF worksheet W/ J9F (separate) #r 3
workbook ¥ AT 255 worksheets T £1 »

Menus in MS Excel (MS Excel ¥ 3uee ﬂ'«'{ﬁ)

MS Excel # 3717 faftd menus &—File Menu, Edit Menu, View Menu. Format Menu, Tools Me,
Data Menu, Window Menu @91 Help Menu. '

File Menu

o TF T4 workbook open Eac ‘E-'ﬂ File Menu ¥ 918X New option sclect & 9 Ctrl + N shortcy Bl
use F T New THF Window open &t fomdl T @1 a6gs ¥ &7 878 OK button 1 click
F1 MS-Excel 31791 374 73 ¥ T T4 workbook IT1 1 M R Vel whiie smva wiy
W fzzar T3 =R am == Al cell active B workbook 1 save FX ¥ File menu B IR
Save option select F1 1 Standard toolbar W STF Save button W click FX A1 Ctrl + S shortey
1 ue F1 7fZ 39 T werkbook F1 TEel a1 save FTTE T A Save As dialog box T Workbook
save ¥ {71 T W #1 A=M S W M9 39 workbook F Y folder ¥ save FCN A &
7 Deskiop W save FI1 TEA & 11 Save in combo box H 39F computer W IYeTe T fagrey
fewars <7 912l 7 workbook save F1 T Hadll €1 319 I4GRH folder 1 T File Name text box ¥ ¥
A file name type FX 37: file T4 & 9I IV TEeh TR save F THY IGH! T G 33
@ F vEA € S 5 Taem fory) T fFm @ 21 File Name type 3 % 941 Save button W
fTF F1 79 FFR workbook FfE T (I M @l #) F sifed T (folder) W save & Wi
T Hfaw B 3 T Wiew 3@ 9Fd § a0 76 Editing X HHA §1 ©IH W@ fF 99 99 vge
file F1 save F7d € 1 Save a1 Save as option ¥ % HTat 2, 319q document Y save FTdt (4
¥ T commands & 37 9% € fF Save As command Y T ¥&F aR Save As dialog box ¥ g
T WAF 9N AT file F1 GH TWH W T AL T W save T THA ¢ eTclin 98 AE T4 # g
Save option ¥ Save As dialog box Fad Ugell IR @ ¥ 2N (4 AW file F GEA TR Save &
T2 T) 3R 9R Save command 3 W ad A I changes # €, 98 save €M1 File 1 location
9 name TE T 3:, TF R file F save & 9T & YA eR a1 Save command 2 W ¢ dialog
box show &l €M1 Y Save As EIACHT 4T+ &1 Tools drop down list T click &% 3741 WaTE
(password) i set F1 TFd 21 T General option window R fos FT1 W & 2Trm a9
méhﬁmﬁ mﬁ'ﬂfﬁﬁiﬁoplionsselmm%—

(i) Password to Open—3fc 4 8 fa®e set FU1 @ F1 SAMTFA user T8 workbook F "‘ﬁ
e TEM O T & password characters 1 TF unspaced sequence & foradl Terdd ¥
computer FZ Al &M T 7 5 S user computer 8 access T @1 9 ARAfaF user &
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o, [mssword wF T A A A A A ? h"ﬂ‘l Az 77 user computer F1 access 3'7 A
3 password to open f’f’FW set FT4 & a2 93 A Tré 7% 78 workbook F1 TR i
s FM @ MS-Excel T3 7 workbook F1 password T2 F77 5% 77781 password A3
a2, #a: 7% password FaA ﬂm‘lwm.’mfm a1 TIf, AR, A3 A A AT
st % F T workbook F1 T T M ‘
.y password to Modify—Password to modify 7% decide FM % 31 workbook & 712 717
Uk -hange ¥q APrga # M A Az f7 7AfF 71 password to open A T # %] password
:o modify 7 T/ AT FF T workbook 1 TETET Wp A WEA ¢ 77 778 AT change
) F A _ _ .
iii) Always Create Backup—7f2 A 27 frF=1 %1 574 2 91 9 717 34 workbook F1 save F771
e 7 - w0 o6t 7 71
& Saved Workbook ! WIEMT (Opening an Already Saved Workbook)—fF#! .exisung
okl @ 24 File menu § ST Open option ’fl.selecl_ #1 71 Standard toolbar # Open
100l W foFTH & 71 Cntrl + O '{m keys F1 I F11 773 Open dialog box 7 EcpiREC]
folder # ST workbook saved 2, 371 T Look in combo box @ select F71 3 43 27 folder
a1 7 sclect T G T folder H save fA T 7 folders 7 files F T ATH1 window 3 frard
1 @i @ A A 4 File window ¥ @ifZ file F1 select #2 71 f77 File name combo —box "? Eled
file ¥ 7 type F| THF A open button T click %1 41 Enter press F1 798 ATTH1 7124 file
open & =Tt

sel

+ GTE® T S T (Closing a File)—fFH 775 F1 close 11 7 File menu % F57 Close

option W select T A1 IHE Window F1 right comer W Close 724 W fF% F1|

o 4a %91 % ®q A €T BT (Save as a Web Page)—Save as a Web page option 3 Excel workbook

Web page format & save €l S html format & save 27 @ T filename extension .xls F

T9/@ htm S 37 34 FGET web browser T T@ TFA €1 fFHl 95aF F1 Web page F F9 F save

0 ¥ File menu # ST Save as Web page option F1 select FU 773 TF T m T

/I A 98 g@T 9 R m{ﬁwnrkbook 1 web page F 9 H save 1 Erat g o f

ier 9T @Y (Entire Workbook or Selection)! 395 & v faged 1 1 Title change Eas]

7 Change Title button W fer® F{1 A2 M T save FA =24 # @ Save 723 W 7% L

791 3% 3T TR Publish FT 91EF & A Publish button W A T wH 2 f% file 71 save F74
4 publish ¥ & Iz 37T B0 © £ file F save FT W himl format T F file save T € AT
FEA F publish T T FA file F WMA-Tg 97 TR objecrs I 3 file & insent 71 ¥ (3TETIMR;

sound, picture, graphics 3fS) # save ¥ %1 3fz 39 Publish button W click 74 € 51 TH dialog
Dox appear B 21 39 T = % Choose combo box # JIFT 3T 3 item F1 T3 T4 & fam=1
3 9T (publish) FTAT =9Ed &1 AfZ 39 publishing file F1 path change FT1 =24 € A browse
button R firetr. FX1 37@ Publish button W f&FT® F1 ATH F3 ITGF ©Iest T save & S
W 3@ ¥ A9 file F Windows Explorer ¥ Ge#t @ ¥F4 ¥ File menu ¥ Web page
Preview faeg gra oy fiFe file F1 web page F ¥ H save FTH @ publish FH 4 74 72 T@ 933
tfe JM9H file web browser # Fd fa@

e ——,
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o wh W T T (Saving Workspace)—Workspace flle create TN 31 v % -
¥ group (|E) @ TR el Workspace file ot open workbooks QA Wﬁm “V“'\h.l\‘
location, windows size, screen position afe) M save ®A R aft amy Open @ ;
workspace file ) open FA T W MS Excel workspace N saved o Workbook A
{1 51F workspace file ¥ 3 W workbook T8 TR, : 72 3y ) Workbo 4 I;;: wi
FQA ¢ A A T save W o Wik TR A Y I workbooks 7 m\m., \‘lm,\h
MY group A open TN TEd ¥ Workbook windows kol position T size s af 7 3 *R? ¢
Wiy B (T 39 T3 workbooks W use ) W ¥ 3@ File menu & W Sy ol

. Ve Wy,
option W chek U TEA Save workspace dialog box P Eieu <] workspace W ‘;rksp%
1 A 2, File name box A type L 720 8 WEst ¥ 39 W save F0 Wy m

G n

celect T, fAR Save button F click FX T workspace oA WwS ¥ wifgg ?mq% \:::ZI,;““

o U ¥Z-IT (Puge Sct-up)—Page setup option W HEEA A user AW work ¥ nc.m‘
() page layout set T N &1 6% FA File menu ¥ ST T Page set up opyion ;:"""K
U @ Page setup dialog box T SIAM I F orientation set FX (Portrait = l.x\ndsc:lkk
s worksheet R reduce (size F FT) T enlarge (size TF FTM) T ¥ Adjust 1o sm::m
option T set FXI FH 13 Adjust to check box FI check FX T % normal size box & pcmmm“g
(SRY) set T 76 ST TR 10 T reduce T 400% T enlarge T T &1 T G gy
box option 1 it & ford ame 7x fofa ¥ 3T selected work B FF pages ¥ fit FA W
21 T35 7 Fit to check box #1 select Y, {7 pages ¥ 39 work =1 select FT TN ¢ 2 g
select X A9 tall box X W& enter F1 Paper size select FX1 TH window F Margin tab #
margins F set F TE W TR Page setup dialog box AT F6F Top, Bottom, Lem, Righ,
Header @ Footer options ® I8 T W 1 fF fed aram & MS Word % i s mg

o GI§e T2 &I (File Print Option)—fi am=e Sl Rﬂ File menu ¥ ST 99 Print option select
X T Ctrl + P F1 use T I Standard toolbar ¥ Print button T use F1 37 Print dialog box
M T NEVEF entries fill FX T OK H click FH fiiet ¥ B a2 @ M)

o Excel ¥ 231 3 Entry 9T Editing & (Data Entry and Editing in MS Excel)—7% @ 38
IR € €M £ Excel ¥ 20 cells ¥ enter fva s #1 fireh w wva § 8 T cell highlighted T
? foa currently active cell (TR ¥ fiva §91) w0 S 1 T currently active cell F addrs
Name box & f@ré 2w &1 Name box screen ¥ upper left corner ¥ €1 & (Column letter A Fd
FR)I 3N worksheet & TFER W cell # data enter I FFA 21 THH A cell pointer H I
WA IR W VLA enter FT T TN 3 cell T select FTA 37 mouse left button click®
arrow keys ¥ use T TH 1 T W, 7R SR cells F group () F select m.t?h moust
pointer T I/ cell WA WA W1 A 78 continuous range start TRt #1 3 cell ¥ click X F o
pointer F1 diagonally fawdd comer 1 3iR drag T T | 9, 9 5 Sifd range select ?
A mouse pointer T release ¥ 21 AV /A FF T range % @ cells highlight & select ¥

+ T ATIH (Range Operations)—Fra THR MS-Word # Block operations 1 e N —‘;E:m
A single operations 1 14 3HH =1 31 # I FFR Excel A  afg 73 an single cells

~—
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& B A single cell % TAA range operation IUF ATAF A o T I 21 Range
ncllo“l s 49 Excel A group of cells F, fFEh row 1, fFR column T = A THME F1 select FH
opt‘;;‘:‘ e 81 T 3 cells  FRR 9 ) fadz w00 ed & A range F T §A T pointer
2-@ 7 left mouse button ) click & drag B U diagonally opposite corner @ A m A
o i ifisd range select T 8 SN O 3= fafir e } iR cursor & Wﬁ.cell o™ (Gﬁ-'ﬂ am
election TS FT <med ¥) @ Shift + arrow keys 1 press A T3 range % last cell T T
m T row A select T G row numh_er (29fq 1, 2,3,4,5 3nf2) W mouse poin-(er Eal poin}
L a1 TF AR lelt mouse button 1 click FT 2| 7@ ¥FR fF@ TF column F select ?rT:‘
3 mouse pointer %1 column name (39| A, B, C, D, E 31f¢) W T@ T left mouse button 1
o U@ W foRTR %1 0 i A TR F14 ¥ mouse pointer F1 rows number 3 column
pame 3 common point (SN 1 FFRAA F left § Tl T8 §) W T 9 Had T AN left mouse
putton T click X %, THA 70 T fadae & s

Edit Menu use & (Using the Edit Menu)

» Undo T4T Redo Commands—FH command # reverse T3 ¥4 undo F1 T reverse F M
command 3 50 H reverse FT ¥ redo command FT use 31 I 21 Undo 791 redo commands
Edit menu ¥ ST Bt 1 Standard toolbar 7 shortcuts (FF7: Ctrl + Z T4 Ctrl + Y) F1 use
0% W actions 1 Undo A1 Redo a1 =1 a2

« w2 T T (Cut and Paste)—Cut and Paste operations B &t cell F1 A cell range Ed
contents T et TR cell A cell range H TEAR I THA €1 Excel ¥ cut and paste XGra1 98
@ 0 2, et 6 frod srwa ¥ MS Word W ==t 33 wwa aff #it 7 4t (Edit — Cut, Edit
—» Paste &1 Ctrl + X and Ctrl + V &0 Standard toolbar &1 use &{&h)!

o Hift T8 T (Copy and Paste)—3E R i MS-Word #} @& Edit menu, Shortcuts (Ctrl + C
and Ctrl + V), Standard toolbar J1 Content menu 1 use FH T o TFA 2l

o Find, Replace and go to Options—MS Excel #t Edit menu ¥ 3t Find, Replace & go to options
B ¥ 99 T S} MS Word 1 Wil text 1 €29, Replace HT 1 fif@ particular location ¥ w&=
7 use fFar < 1

+ SXARET (Autofill 31afq Numbers &t Series (XU, Date 31 FRY Item T Fill FTM)—Range
F VR cell T select FX T series F starting value enter FX1 313 ITA next cell M select FX T
Nextitem enter FX1 (T &4 & 7= I increment AAFK Excrl 3MYH A series 541 M 4 W
® 3 AP (Arithmetic Progression) ¥ €I ¥, ¢ AU a + d T A Al series I 1 <1 ¥t T 3 afz
a=5,a+d=8 @ series TN 5, 8, 11, 14, 17, ... 301 37 starting T cells B select T 7 fill
handle % =i 9% drag FX T 7% ST Autofill FN T T Increasing order ® fill ¥ ¥ f
F @ righ 7 sl drag FX ST decreasing order ¥ fill 3 F fo TR @ left N 3 drag T

Step value box ¥ % value WX fHF 3T series F ST member ¥ TG TRA ¥ Linear series
& value add B S 7o Growth series ¥ T 4R 7€ value O multiply Bt TRA (39l linear

A;
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H AP T TE series AT FAF growth R GP F @ series TM) 3w e —_—
Type ¥ 33 T (linear TT growth). Step value box ¥ I value W i :
w7 9Ed € (series & last member = value W)
3 2 £ selection F comer § TF small black square B 1 5= am oy i
#7 & A pointer TF black cross # T ST #1 37 adjacent cells (TEA ey ﬁe T
e %F_‘ a1 ceries F fill F %'j (data 30 ). fill handle Eal drag & Fip “Plion\;(:.‘*m
menu F display 3 ¥4 fill handle F1 drag FW T right mouse button = huld' sk
¥ type F1 specify F ¥ range ¥ FW filt handle  drag FT TWT right e b ) iy
¢ a9 shortcut ﬂ’j } IYLF senies TFI g command ffa (issue) FU Series Trm 3:’; iy
1 manually F25 FT3 3] Series command T use FX AD1 series F il F1y 1 I\" iy
wEm F= Yboarg 5
o fireraT W (Clear Command)—3fe fF& cell F1 contents format A comments Frermt s
2 clear command 1 use {21 ST 21 Contents clear T H A ¢ 5 Faq COnlen;s 3’?%
format @A T2, format menu # setting T& M Format clear 1 14 # fif cel) 5 co‘kax [}
) w1 T4 T2, contents clear T& €Nl Fa format clear M Comments clear mmn%c;;k
¥ attached comments (reference ¥G) clear 2 S& Clear All command cell @ range & o
format. contents & comments 9 TS o FT M i
o feefiz (Delete)—Edit menu = Delete command & imia MTH TR e Suee 4 i
(i) Cell @ delete HX T right cell T deleted cell & T TT shift F1 IEm;

[744 [ 2 | » E ]
25 @ cell delete fFa1 A—
W | » [ » [ 4 ]

(ii) Cell 31 delete X T left cell T deleted cell F M W IR Y ITEm:

IERE [ 2 [ & \
3@ oz 25 AT cell delete T SA—
‘ v [ w4 E E
(iii) q@ row ® delete FX
(iv) ‘{‘t column & delete FX1 4
afz ¥ 9 Wi (i T99R TEAE) F delete FO A € Delete sheet command F 1
?ﬂmﬁwmmﬁmméﬁ%qmm recover T FFE T §1 37 T O
F1 A WEATAEF use FA A g
o Thie N g W ED TEI—die 7 T Thw @ gEd T A copy T m""’”ﬁé?@m
menu # ST Move or Copy sheet option 1 use Tl 35 9aTq Move or Copy dialog b

Ny
T ser, h':

Doy
U g,
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k list box # =% workbook select 1 Tl AT current worksheet F1 move FTA AEA

10 Wlm Jestination workbook for the current worksheet) 5@ Before sheet faF=1 i ST#1
1€ %0 £ 7 sheet T 3 THIF B FE 72 F T Ze A # gmem: Az 2T Preeti
k # worksheet 2 @ workshect 3 9 current THIZ F1 = TEA £ 7 To book
o , a1 Before sheet % sheet 3 fedrrz 541 Afz A g T W S sheet T BEA
§ 7 7 BT qu 3aF T @ =Mz 2, @ 74 dialog box F Create a copy option #1 check
ard .qﬁm:ﬁzaﬁuﬁﬁmﬂqﬂﬁwﬁmmi?ﬁCrtawacopyuplinn(check

Ecid
pat) # uncheck =l

o Ment FT use & (Using the View Menu)
" | 4 workbook 1 < TR # view f#n (Z@n) 31 #EA #—Normal view 771 Print layout
U E'xﬂ' Normal view # 7@t worksheet T 2@ 2 A pagination A1 print area specified = 7
;';Viﬁz 4 A, Page FE A YE W WA 2, T8F Zod Normal view H Tﬂml Print
Wm,ew.-mﬁ;;aésmﬁﬁm%, A 7 Frar & fF worksheet 31 72 T3 W FH |
iﬂﬁmﬁqqml 37, 39 view %1 TEHAI F 1T print area 3 page breaks F1 3= H adjust
FTH ¢ T view # a9 page % background W page number F1 T oF4 £, 571 72 page
qumber printout # fr@r T M (Not visible in hard copy)! 39% #AfaitF TF Full screen view <1
m%ﬁg&é‘@ﬁ%{m #T9 View menu ¥ ST Full screen option F1 select FX TFA 81 THH ATTH
worksheet 1{( desktop F cover F AT qLAl IGF I EE) ft feard & &m m FTTFT worksheet
T screen 31 cover HIM, bars fa@r & T
+ Views & Zoom AT (Zooming the Views)—Display ¥ size ¥ Standard toolbar % Zoom box
71 @@ A View menu o IF Toolbar command T Zoom box BT T2 91 9gTl =1 T
# Zoom percentage 10% @1 400% % WeA ¥ 7 1 WA €1
+ TR (Toolbar)—ZFMAN e FATE T daal & issue F{3 1 UF W& WAH & F1H 39 burtton
Tt T click & 8 FAFE step B IR & FH click W € dialog boxes T I & a1 menu
% 9RY ST T IR options select FT TR €, TWH_ 79 dialog boxes TF TEA €1 Excel 7 14
Joolbars T & R [ by default ¥ & T (RTE TEER 9 Formatting toolbars) &
fert O &1 v o 1 feT MY T991 F FW B1 View menu H ST Toolbar option select
W, 79 3 g M e FON 9 €, I I Ah Wieh A A S GIA (hide FA) TEd
t, 3% am 4= W T T
¢t 2T (Headers and Footers)—¥ei% U1 &I top margin W S T text header =
bottom margin W ST AT text footer FEAI €1 MS Excel F1 working worksheets ¥ header a&1
;’“"“ display 7€ €1 ¥, ¥aa printouts ¥ e &4 ¥ (=7 ¥ 5 MS Word # document ¥ 37et
ki fﬂ@g 22 €)1 Headers @41 footers create FTX %ﬂ View menu % Header and footer option
:r(e:[j:]f:;z; :l)el:(:)eur“ﬂm 7‘gusfom foo;er buttons W click FIF TVTTAR headers & footers
N on &I click & <l
appm;ﬁ(f;:o; ::’;;vgs)ﬁ—%ustom views BRI workbooks, worksheets, objects & 37t fagm =1
) change & <1 TF@ }1 3T FETR settings T print settings =

A—
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7 fram A define T T views 5w A save TUHRY #1w g WEI )

; ; ; se
Tl & HY Window size, Column widih, Display options, Frozen panes 7y Wind"my\ ® |
. Ow 10
sheats A view ¥ create TRV T selected cells 1 foafa, hidden rows, hitl(lcwmlu\' ’\u)
, n ¢
seftings. filter settings aufar v 2 f% custom views "{ﬁ workbook Tt B “:ntnh."m‘ p,l"
F T w n

f vitz wher) gt i senings 39 W ot e Lauill ”m"m\“
TN view W create #73 ] View menu W I ad Custom views W click A

Name box 1 view 1 name 3 s T e ¢, type FU Include in view | ﬁn:li:'l Click 5,
A select F fFH custom view ) frrd T T view menu W WA custom "1 Ay ',m"“‘
34 View box 8 37 view # Am 9 click 1 f am am ﬂT(ﬁ ﬁ Hr“?mq N
319 T @ view F1 2@ FFA 1 Custom view ) print F ¥ View — ¢
Show — Print W I Custom views F delete F 8 A Views — Custom
Views bax 1 View % 7 click F @ Delete T click F

Views W fye
show ik ':'J
Ustom Vle“‘ ¥

Viewy w 1;
i

MS Excel  Elements @1 Insert FT (Inserting Elements in MS Excel)

Worksheet 3 cells (3 group of cells insert FT3 87 39 ccll W click X @ cells F o
F1 WK AW AW cell (A cells F group) insert F e 1 e 9% v W e hﬁg““pﬁclul
ST select 777 £, 30 @ T cell A cells insert TAI 37 Insert menu ¥ Ccllupliuﬁclalﬁ ly
) Insert window M, T A shift cells right, shift cells down faFed 3 4 aifyq ﬁ;;w
4 3 OK button T click F T TFR 3T columns A rows W insert T TFY #1 g fml ¥
menu B I Columns J1 rows oplions F select FI e
o & 7t adviz insert HTA &Y Insert menu # TH Worksheet option ) select = 2
g vF A AP worksheet insert F argd & @ FR key F1 hold T 74 3 g ‘T!ch;l
=t faaf 2\ 39 insent FTA Ed &1 o € fF o T RIS slanmmmmmﬁ
wom #z 7 9FA ¢ 5 fFH already created workbook # 3R o Afafier Wem 9 s
wzdt # & @M Insert — Worksheet command &0 7 worksheet T T 2

G (Formula)

o TN UF mathematical expression (ot i) e & fIER AT worksheet data WM
#7 7 #1 Formulas mathematical operations ¥ T¥-814 el HTH A text T join 7 41
WETF € 21 Formulas 34 worksheet & cells 9T, IH workbook 1 & worksheets % cells W
M 7 workbooks &) worksheet ¥ cell T apply 3 51 o #1 SerRTvm: A7 4 coll nunke
A6 8 20 add FCE T (C6 + D6 + E6 + F6 + G6) & divide FT e & 71 formula M = (Abe
20/SUM(C6 : G6) i 579 &7 % formula ERVN equal sign (=) ¥ Y@ B &1 7 A6el
reference €, + addition operator 2, 20 numeric constant £, /division operator 2, SUM( ) workshed
function % am C6 : G6 range reference 21 Excel % formulas fruffa fram & fF 7€ equals?
@ 7F ¥, AW TF AR operands ¥ (FA W TEAE R A #) @ 9% operands calculat?
operators L] separated M) wIF operand TF numeric constant, uF cell re
reference 71 label @ T A excel function # 4 F@ M- T wHA #1 Excel left

ference T rangt
4 right 7%

e E—
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#xm & (order of precedence S9fq_operators ¥ W ¥t fadifta & aem I== A AT

o’ M)%M'mwm:ﬂﬁb-#B‘xi?ﬂ'XZ?.almul!iply 2 f#T add #A3: result
n"g.:;'?“m pnrcmhcsis 1 use T order change F7 TF @A (6 + 3) * 8 F result 72 rm
.10‘ | 3 formula ¥ ZmR cells B M refer fF1 51 7 21 fa cell # formula 2 ¢ 9 zan f5
[P 1 A refer FFT 2 4t formula TN cell dependent cell Feemt & Fife 03 value T cells
(‘ﬂﬂ:’; &1 9 A referred cell 3 value ¥ change 0, A Jependent cell F1 value %1 change

:aﬁrm gro: A& D2 ¥ €2+ B2 stored # @ C2 M B2 W change T T D2 # ¥ change

Eoull

cell a1 Range

o Reference itz R FER cell A cell F range F identify (TEEA FHTAT) HIA £ = Excel F1 42
—— WﬁusemwmﬁmvalueaﬁiﬁﬁmﬁlRefercnce?ﬁmﬁ

mwmﬁm%fﬁfﬁ A H entered 221 F use F TFA £ A TF cell T value TH
ﬁﬂmﬂuscmm%l o I FEGF 51 WiTE F -1 formula T T THH
71 g@ S 21 Wt use F G 21 GHQ THIF F cells F1 reference FTA external reference
sy & R GER SR F B A refer FN remote reference FEEHA 21 Reference & fafs=
styles £ Al reference style 791 RICI reference style.

o Bydefault, MS Excel Al reference style T use &Il 2 el columns (A ¥ IV TF el 256) T4l rows
(1 8 65536 T) FI number feran w1 ¢ ISETE: AS, B6, C2 and E8, M17 $efEl Range of cells
2 refer FC ¥ 91 range % upper left corner 1 cell F1 fdh=d, f& colon (:), T lower right
comer A cell F reference for@n s 21

References (Cell and Range References)

fauS! refer T ¢ T use &L
CS cell . cs
c53CI10 F1 C5:C10
C5, DS, ES, F5, GS 319iq. C5 ¥ G5 a% C5: G5
Cs, DS, ES, C6, D6, E6, C7, D7, E7 199 C5 ? D7 a% C5:D7
T row 6 6:6
column M

‘lg:w 56,7 J\: ]7\/l
Column B, C, D B D

¢ Rl f
. WCslaﬁ‘ﬂﬁ style ¥ rows o columns S F reference a1 ST &1 T reference style macros ¥
o lmlumns # position calculate FTY 3G ST €1 41 T6H R ¥ 31 row number 79 C
column number feran S 31 FEEE: T row F ST column w1 R M R6 C8

T aege fretw (Relative and Absolute Reference)

* M Excel # relat
ve reference 1 use T Hahd & I fF formula 1 positi
T absolute reference 1 ' oo A el Bz
use T THFA T W THM TF A cell T i e
refer T ¥ I<EAUW: afe
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B6=12.C6 = 13. B7 =&, C7=9 1 afgd D6 # = B6 + C6 stored ? A relative reference % MR
D6 T W B6 + Co Hakq 12+ 13 = 25 Zm #1a 3fe relative reference * IR ™M W‘iﬂl "ﬂ
D7 # copy fm T % A T D7 W egervn & fom mamc?w%amm&mamqﬁ,,z
§ +9 =17 @ %= 3P 3z formula absolute reference F 3MUR T I3 AW 2 [ gftomm iy
f 124+ 13225 T T AR row F letter A column & number & 9B dollar sign e
reference ahsolute & Ta afy 58 w0 # & reference relative ¥1 T T W & relatiy,
reference F1 copy FA T automatic adjustment ST % & absolute reference # m ;];
adjustment & TN
Relative reference @ Absolute reference & e switch S 89 F4 key & use fm sy t
% 50 T8 cell B select T F5@H formula @ &, formula bar ¥ 37 reference 3 selegq En
o A9 change FT =EA € 791 F4 key ® press XU A1 & reference 2 $D $2 (Absolute column,
Absolute row). Press F4. #8 reference & ST D$2 (relative column, absolute row), Press F4, 5])2.
(absolute column. relative row), Press F4, D2 (relative column, relative row), Press Fd, again j
becomes SD S2 and <o on.
e 791 I (Labels and Names)—3T columns T rows & A1 &1 3 columns A rows ¥ cell
k2l reference 73 §7 use T T €1 ILEOM: Amount. Quantity. Marks SEEI W€ T labels F
examples ©
Functions @ use &% (Using Functions)—%=¥4 predefined (38 WR=If%d) formulas 3@ &
it =0 favifa &0 0 o o (arguments) W TUATY T & ISR SUM () function &WT cells
T range of cells F contents &1 add f&a1 =1 Te €, SR

Functions 9 &4 91 /€ arguments Fear % @41 98 numbers, text, logical values (TRUE 41
FALSE), arrays, error values, cell references. formulas, constants. other functions afe FEITA
T &1 IfF waE WA F 9 arguments 94 Fiia 8 €, o1: ST valid value € RIS H
2 9 =fed

GEYH H HIEA (Structure of Function)—F M %M function name ¥ T& & g,

opening parenthesis (brackets), f&% arguments separated by commas, 3R f closing parenthesis
(bracket)l A function FFE1 BT F1 start FTA & T HTE F1 start F@ E A GawA & AW Y T
equal sign (=) 2139 F| Al HY %1g U1 formula type & @ % fowil frd! Sav &7 use © @ Excel
%1 Formula Palctte 399! 28 FMI

A1 § a9 399 S (Inserting a Function in a Cell)—Cell & Her T8¢ &1 &g difod
cell W f&1& F7, Insert menu # T function 99 Hi 94, 394 Paste function dialog box T
SFmI Aifza FEE F g3 9 OK 929 W s #1 A Ses $E W syntax TIH & A1 S0
function wizard & 1 # SEvEET 6 €, A9 FH cell § T AH e T e for@ w4 €1
Cells T 9 7@ (Naming Cells)—3T cells, ranges of cells, formulas @1 constants R affE FA
'E'.ﬂ m;qy@tmmam ﬁmmélmmmcellmccllrangeaﬁscleclai.ﬁwi
menu 3 30 3R W 4, TowET FavE ® e 7, T 39 adgd box H Wt TR T
Eica] 'a" = 3t 72 W fooe F 3w A W A 1 29 cell range F reference ¥ Fel o use
&1 qHd
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e gr@d & (Inserting Comments)—

mﬂccnﬁa:ﬁfeswémm Excel 91 1z faen wa 2 fF 39 cell B 203 7 21 #1 =
= mww%muﬁ'mwlmmvﬁzaﬁméﬁ?ﬁwaﬁﬁ S F fF cell &
gz',-(mwi:mé? gty wfaw # i e fed v w1 e T A mwm%mm
$gaﬂmif-m 1 A AT YA TEA € A IH comment B A i, Excel st e faen ?"TII Cell
H comment insert F g c_ull Eﬁ‘selctl Ead InscrlA menu ¥ TR comment option \Fl::l ol ?’1
@ W comment textbox @AM FAH comment type F71 31T comment type FT =, @ \\:mdnw ‘—1
@ il (Textbox 3 AR) S click FI A 2T fF mouse pointer F1 commented cell F ?W‘?'T
o T T comment STE] TR A T Comment F edit 7 delete T 7 cell T select HX T
right click T context menu § SFL edit comment 7 delete comment select wU

, o F@é & (Inserting Chart)—

ﬁrwmaﬁwm%améywmmmm mm#ﬁ!vﬁ’i?ﬁcmulcwm
21 worksheet T embedded object F1 ¥ WA create FT FHG £1 I TA9 T o A2 qiE=@
) §1 = T ¥ ae WA S enter B R data 1 select F7 A7 AR wizard F use
0 Excel # 3901 faeedl & AIf=r @11 Chart wizard chan 911 F1 Fa9 5EH o= T fam 2=
Y5 R 91 A € 4 fadiEe FU Insert menu T Chart option select 11 Chart wizard—(Step
1) S T 3 FE Chart type list box # A (column, bar. line, pie. XY (scatter) 37{Z) faer =
Chart 1 preview @7 &¢ Press and hold to view sample' @7 F1 Press 79T hold 1 3fe <1 Eeea]
choice % STTRR &l € @ custom types tab W click 1 Chart type #1 select ¥ Next button H
click & (Step 2) Chart source data dialog box qﬁ’l‘ll fg 79 2 I select HET Y& ™ % a1 change
% 9% © @ 9@l data range combo box % 3T click T data range select T4 €1 Series tab
W click F1 TeT 39 Add or remove button W click & series list box F series (34919 columns)
21 add @ remove FX e §1 fR F Next buton W f&TF U (Step 3) Chart option dialog box
FaAM Chart =1 title, X-axis F1 heading & Z-axis I heading fill 7| 3% legend tab W 914, Legend
dialog box et Legends show FT1 &g Show legend check box T & U1 Placement position
select X1 Data labels tab T3 T X1 8 TR & labels 39 W W g =ed €, 39 T4 Next
button T click F1_(Step 4) Chart location dialog box I & F1 destination (miq e o ®
19ig new sheet T A1 current sheet ) I 3/ Finish 91 T foeT® 21 Chart 391 WE W &S
ST TG WHR chart wizard 1 FETaA § 39 four-step process (SR-931 T ShF) |/ 9 SR W
*ﬁmﬁwmﬂﬁmﬁcremeﬁmil
Format Menu § &w &GN (Working with the Format Menu)
Format menu 1 WEdl @ cell, row. column &1 worksheet I format FF 3T TH 741 look fg@n s
T v o fevet SRR N FEIA FRA S T R
Cells B Format T (Formatting Cells)—&e8 #1 WIoien o waR § 1 & 7+a1 & $W—

(i) Cell AT cell range a,"a-ﬁg fa?e number format 3M—3F & range 1 select F,
Format menu & cell option 1 T4, number format (F& number, currency, percentage,
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fraction, date 1 time 3112) F1 . decimal places adjust R, 7T SCUINgS selecy o

frame ¥ preview ¥t 79 ¥3 §9 &% F T W OK button Ft — éll Ex) S‘Mpk
(11} Cells F alignment @ format FET—35% 2 cell range select F3, format

option T3, Alignment tab sclect Tt Horizontal T4 vertical alignmeng el n;nu o o

orientation select T (307, 45° 3) selected cell T text 3T foll s ﬂn e

(rotates upwards)! TFF wrap text chec}\ bov #1 cheek F79 W text 7 5 car e ‘: 5

F wrap W 7@ cell F AR T T A I T wrapping 5 & oy gy 0
fit FT9 €3 € A tet control ¥ shrink to fit check box 1 check 3, 3o tent T cell
T (fEe W) w9 cell § fit 1 SEW G T HTF cells F merge 573 _ﬁ_‘;hnnu
select F% @@ merge cell check box =1 check FT €1 ITI® TN settings =7 cells 33

FTF uz

button 7 check ¥ 21 * ¥ ok

(iii) Text ® formatting ! change S—Cells F X fTF text F format (s
sule. font size T2) § T TRET S 7 39 cells &Y select &YX, s ‘6“0:; f?
formattine F7=1 =74 21 Format menu T I cell option select FXI Font tab ?:T. 3R
=% F 7 options ¥1 TSR setting T § OK &7 W foeis & ¥)

(iv) Border settings &1 format FT—Cells S border ﬁi format F ¥ 57 cells T seloqp w2
fe=%1 379 formaning 77 976d ! Format menu.ﬁ & Cell option Fl select 5 Burd;
wh R == X1 57 border F border styles F1 select X 991 OK button W click 573,
9 WK border F1 settings 395 $VIIER & FF

(v) Cell & pattern change SAT—Cells S pattern change T TG ST cells F select &
=1 pattern 3T < F =g €1 Format menu ¥ SR cell option S ¥ I Pattern b
= select &I Cells F1 colour & pattern TWSTIAR set ¢ 9 samples T&A T, W colour &
pattern 39S THT &4, T select T OK 77 W click % {1 Selected cells F colour 3

pattern YS! $SSTIAR change & ST

select 53

Rows @@ Columns &T Size Change &1 (Resizing the Row and Column Size)
o ¥ foiFd § text T 379K rows T columns F size change FA & ETaEA Ygdl Bl Cell 7
row ¥ S (height) change T 3 cursor &t 3 cell W &I Row heading & 4t awi
boundary T 7 % drag FY W 7% row B height FH FHHAR T & T T
faft 72 2 f5 format menu T ST91 row option select F¢ T@ 9% 3fR Gell submenu # height
option select 1 7 Row height box ¥ 31T ifod row height 1 fill X 791 OK a7 W ==
EaaH|

e Format menu 1 row option & ¥ 3= faweq W ITweT §— 5
(i) Fit the contents—Row F1 height F1 contents ¥ AR F13 & ford (3raiq feed contents
ST row F1 height %: adjust 81 1), row heading % 59 ¥ boundary ™ =@ feew

Eadl 5

(ii) Hide and unhide the rows—=f et feafit & 2795 ol row a1 rows & hide w0 (ﬁ!‘-‘ﬂ"':
Eﬁmﬂgﬁléﬁﬁm“‘sﬁseleaﬁﬁ%m hidemm%l maﬁ}'ﬂﬂ“’

v—-—'
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qu § ST row option F1 select F A THF T sub-main  hide option F1 select FI
;;'icdc 21 click 7 ¥ T8 % rows o S (frmré & =2 @ SE) | 3 rows ¥ unhide
=a &g (T #7 %7) " A 27 rows F1 select F d Format — Rows — Unhide

option select FTH T rows #1 unhide F FF T

drg¥ & Change FT (Resizing Column Width)
ding & right side &TER boundary &1 7@ A& drag &1 5a d% Bt column &t
idth Ef Gn'l?l TH ?Tﬁ fafa 7z ¢ f= Eﬂﬁﬂ column F1 select &, quat
menu & FH Column option FT select '4" Column sub-menu J ‘—VTB" \\:idlh T click &1, 'dfil
jumn width box 1 =ifza width enter & a7 OK @24 W fa=ia %71 383 column width 391
FeOTEN set B S
.Co,mupﬁgnézaiaﬁagmmfamﬁmiéﬁ— o
() Fit the Contents—Column width F1 78 TF1 73 F a7 fo@d contents T fit & TﬂT’i
column heading % right side @il boundary W W& double click 1| Worksheet < HHI
columns :{9[ & width F4 % f& select all button W click =< a41 f&5 TF column heading
% right side a1l M (boundary) T double click F1I
Copy a Width—3f< 39 T column F width T copy T TE W apply FCT =Ied €, A
column ¥ 1 cell 3 select FX, Standard toolbar T Copy button 1 f5oT% ¢ T target
column (7 T 319 T width apply FT =ed €) F select T Edit menu ¥ ST Paste
special option W click F @41 fFt Column widths option W click I

FZVATE WIAET (Conditional Formatting)
Conditional formatting &1 &= condition % ST¥R W cell FI format a1 I &1 T4 7 Faa
19 spreadsheet awesome ﬁwﬁ%aﬁm@@mmwaﬁmhmél

mEHTe W 269 (Microsoft Excel Tools) T
« T WF (Goal Seek)—Goal seek T TTH IW 3G WA I find F4 ¥ 8, &R formula
TifE result return S IETW: T formula = A3 * 5+ 6/2 § 3 43 return FC T €
A3 F1 9 8 €1 e Goal seeking ¥ MS Excel referenced cell #1 value et @l &l &
3 9% formula (S ¥ referenced cell W dependent &) F€ WU result TE1 & W & 39 =red
%1 Goal seek command 1 use & T4 ST & W 379 530 cell ¥ el T8 cell F1 value F adjust
T\%E‘ﬁ value =T&d &1 7M1 fF cell B2 # 50 entered £ q& C2 H value unknown (37| A e
?) firg U= Ta & (a0 M R £) 5 B2+ C2 F value S0 § A1 39 C2 & value YAl FTA
&) & & Goal seeking ¥ D2 # wrfel = B2 + C2 feid1 Cursor F1 cell D2 & @1 Tools menu
HIAR Goal seek W s H¢1 399 Goal seek dialog box eI FTH set cell box ¥ S/ cell &
reference <10 ol W BHfE § RAEF 3T resolve TN TEA € (e fore wROm o wan
I W SV F 9 cell D2 &, 3: setcell § D2 W ) To value box # 39 S value 3tafq
WO ed ¥ qx e (i $9 ST F AR $0 TR By changing cell box I cell i
Teference 31, Fga value 3T adjust ST I8 € (G 9 cell F unknown value § 3/ cell

Column =
, Column hea

(i)

el
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W reference) ek TR TTEE A AqE () wed aw v R fw oy hanging ooy
cell ¥ reference MUY ¥R £ E ool set ool T by N eference e wy _‘1‘ e
referred B WA (TREIT WE Y seroell DY MR A D2 N G 1:-." "
coll B reterenve PER T (el (TR O @) wetevne: WUAW | ST TN ¢ ~‘N“q‘;m‘|h Wy,
T 20 3 E Gaal seck status hoy W el g M W W el v o “"\ ML :,\:
click %3 2 S Canerl Rutton WIRTE $ 21 3 resalt €2 N asi v e Ny, Y
Gatus oy X OK w7 TR A v @ M Gy
o TR (Soenariod Scenare WA KT EGE (et of valnes) WO R W fiy M bae
WEW ¢ W ot adeiiz W OR: substitute (put) BT WEE RE A9 (cenaggg {‘\q“" N
workaheet moded ®1 outoome (ST farecast (TER R W0 W10, St e a“m“" v
1S9 TR WOART S group valuey ST save WORE ¥ amn fa g N |t1 g
sernano W awitch $XH (M) THA Wy WA W SRemd WA w8 ¥ Seenuia .m.:\:“ Wy
Took menn R WHEL Seenarias option W ¥ WU AR Seenario Manager boy wdm “:;N \
optron W chek ¥ 39 Add Seenario hov JEFNLTER Seenarlo name box N e, v%« W\M
(5% WEY ) type TR W Changing eells box N 39 cells W reterences add w (.3 Anl o ®
w7 AR £ TR bov § Protection T Hide check by MR &, STTRIRIHR 8 che v, b
WU SR OK button 8 prevs 3138 Seenario values dialog box open By oy \‘In;mgm:::
?’1 values tpe * Scenano TR FA ¥ OK @7 W e W afe ann o \\‘n‘mnm; 3&1\
w0 e W Add WIS T S0 A0 W teps WGROAT epetition) 82 wa ay g
soenanios create TR W OK WI3 W IRTH W00 ITE T Scenario manager dialog o ¥
Close button W f¥TF F1F Scenario Manager M close W1 AR 39 changing celly % e
(onginal values) T preserve () w00 wred & N 9 W A seenario WO W wiging o
values T use FIA W, TQA TR seenarios TR, foAd values change W% B und &
sl ¥ ferd (wefim) T Y Tools menu N IR Scenarlos option T RRTE W1 30 Scenrh
Manager box TR, TR 31 scenario ¥ T W AT w RIQ 3 w1 wred &, 18 Show b
W fRI® ¥ TR scenario display € S wTE ¥ R IR 91w fRER scenario W display (%)
T ¥ W TN scenario ¥ 3T ¥ T A saved cells F 7T oMy wE T ww R

¥ 4] o W HTAN (Working with the Data Menu)
32 menu ¥ W fafw SRR T apply I A WER commands Iuerer wrd & H fh Son, Fle

Form, Subtotals, Validation, Table, Text to columns, Consolidate, i)

o 21 W BRAT (Sorting the Data)— Data B sont ¥ H1 awwd R data W FE condition ¥ wym
ascending T descending onder 3 STAfem WTN (U MR A1 ST 7 o wfz &) %‘ ot
T ] 39 columns B select T TR 3T sort T T $1 321 menn A IR _s""""'"'m“
select T TR sort dialog box WA MAM T columns M el W select m.f\ ¥ my“
w00 wed € (afz 3T W select A fFY W ST PO change TN wigd ¥ ) I \:‘ﬁ“‘l\';?““
ascending T descending fawed § A TF W select W Afe wble i W header 1owW ¢ ',’m
has header row option ¥ check F1 378 OK W23 W ferw WY A1 oy 247 f& colum &
set W % options & STA set ¥ M &

me v 217

i et (Pt L) freee wt yfiqe svd @ wrra . msh Qtﬁ feufn z;mﬂ
g el gt )ttt condition (vrd) % snure ey g wEw A

g el Miter Dist optlon duer@y #1 g0 option W NEREEL A aver T oophions m

s M:\l‘.;.“‘n‘"l QUL A1 sabset () frae) wem o main I U part (ST

condit lints #1 1 commands 2RI e

T RLE R e fon aerdt &1 Miciosolt aeel filiening
. o e I criteria (vl A SN NE filedng A1 andl #i

Py @l2er val comples critena) B e T pliening nd &
1A B ft i W

( Aute filter,
{h Advanced Oiter " K el Borai e
b option ZRE AT worksheet 1 AEE U Tist W ap L
l“.'l\;::“:::":l-lfl:“ﬂlll‘a A Al M u cell At 3 e T Data meno Nt mt«;
aption T bt Al qu g Antofilter 1 click A g AR 3 pows W frea wrn “;'11 8
e M apecitic vatue ladn e e e & @ A column T click WY AT data ® ‘",'
i fae) e e 1 afe o fel ot st e smeatra w1 AR condition apply FT T
) i a3 e R drad
Advaneed Crlterbn & omurt wt iz WY Fllter WO (Flitering o List using :\xlvuur.ﬂl
Crltorin — 4% (i Sne) worksheet 1A S orel i @ i @ pows blank (riefl) et
wled fIEd € rows uY crltern range B wse A1 S A List F colomn I.‘lvlrI\ ot st
(Compulsorily) A AR Advanee critera apply 33 Rq B columns T values B35 filer 00
ared &, 3% column abels W seloct BT WM Copy option M FEFE 30 Criterin runge 2 weeft
Blank row T IR W paste option T {AEEE B Crltertn labels % A el rows T ag
criterti type WU S 309 matech waen wgd 1 ome ylaa w6 crieria values W1 It # dra
WA w U Dok row (AT row) BED SalE Lise ¥ G0 0 cell 90 click WU Data menu 7
W Fllter option W point Y W submenu N Advaneed flter W ET w0 afg 3T I rows
W hide W (Rowrr) vigd & W s criterin A A% A wER A Filter the list frwen W frers
WA 9 I pows WY, W O criteria A match 6T ¥, copy TO% worksheet & 58 353 arca
N e wied ¥, @ Copy to another locatlon AT %Y qY; (61 Copy (o box W f¥Ts w1 am
el o B vows ™Y paste WL YIEd ¥, 38 mea ¥ upper left comer W click U Criterin range
box W criterin range W1 relerence W criterin labels enter w3 A& 3 criteria range %14 WA 1o
B R Advanced filter dinlog box oY BT ¥ied @ Collapse Dialog W s 72)
W AN filtered ows WY GE O copy WA ¥ D I specify WAFA § (6 copy ¥ wda-wly
A column specify WY 1
Subtotnl—~MS ixcel ST Tl list W1 subtotal caleulate W W) [l s s wen @) gk fon
TR column name T 1ist WY sort WY, RRIE) rows WO subtotal W RN R1 List % 5 cell
by pointer W N WA Data menu N I subtotal option seleet WU At each change in box W KT
k3l column ¥t P W forgil w8 groups (1) @ AL 3T subtotal wET ngd 1 ag wEl column
W R snm) g W sort B A3 use function box B W 30 function T click WY
frm) amg subtotal caleulate W 3‘1 use TN e ¥1 o Add subtotal to box R 7E column select
T 3T subtotal TR wEN W B1 W OK button W s w1 “

L
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5 Ay i'm iE3 NS Excel ¥ powerful W wrwsmten (Allrounder) spre
ammammmmm\mw\u\m%aﬁfsmﬂw\mm

Adsheet Package 4
Spreads| B

T TR TR QTR el W % R w19 practice ) swrvawm ¢ mhﬁwhm g

Y Tarm resular proctice T8 F T8 T T S0 habie ¥ T 30 e Sy
ST MS Excel 9 regular practice T, T T AR AN R W Wiy

PRACTICAL EXERCISE

Use SRS TR S :
St an spread sheet for the Civil Engineering problems given below:

EARTUWORK

Y embankment of formation width 10m is 1o be built with side slope ot 1V ;

' honzontal in the direction transverse to the centre line. Length of embankment is 1201y
of the embankment at 20m intervals are given s 1.7m, 3.2m. 3.8m, 4_3m, 3.5m,2
the volune of carth work. ) V_

Km, Lom, Ca

Speed T m
M

2. The Groung ;,
\, the centre heighy
leulage

—

Hint:
DATA
Total length of embankment 150 m
Common distance L 25 m
Formation width B 10 m
Side slope N 2
SOLUTION
no. | Dimneem) | PR Seed
1 0 1.7 A
5 20 32 A,
3 40 3.8 Ay
4 60 43 Ay
5 80 35 \J A
6 100 28 Ag
7 120 1.6 A,
Volume of earth work
v
'r 1 I Prismoidal Rule LA + A+ A+ A+ AJ+2 (A +AJ)] mj
LICA, + A+ A, + A+ A+ A +A ] L

l 9 ’ Trapezoidal Rule

Fo

1

EN
s

““[ll.v\ UsED
Nsmnhlﬂl Rule
‘rﬂ]‘t‘mhlnl Rule

MS TFT

T0 CALCULATE VOLUME .
SDSSA(DLI +D17) +4°(DI2+ D14+ DI6)+ 2%(D13+D1S)

SDSH* DI +DITY)+DI2+ D13+ D14+ D15+ D16)

Wyt

w1 Ol &2 Civil Engineering N T 3w 2

2 Cells T TR &2 T numbering & R A 2
Waorksheet and work book N WA :;_a ;

fxcel ¥ i work book 4 @ . ; \

) Edit menn @ FIE commands WATEA?

lv"“":lil-’l display 0 ¥ T Excel WA-WA | charts present 0
Data Y

spreadsheet
MS ewel T
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araan WyIH

(VIVA VOCE,

T
o PRTTRTN.Y — o
THINK ABOUT IT '
W i whove the mark 1o his the mark ..:uu,hwamﬁmul
—)

yr1 | fufam pofratm wm ) yoftfrafin fed wed 10

FAT— Lapimeenng 1 the term applied to the professson in which a knowledpe of the mathemanyy
and natwral sciences gainad By ctud . expenence and practice in wpphied 1o the efficem pe
of the matenals and forces of nature ¥ engineening W7 wrrry § T v vy
e S L et m-m:&.mumhm'mnwﬁnﬁ

% vod w owr @) oemphe wEm wrE rg fEmoam b Owil enpincening s ihe devps
wrd comstruction of public works such @ dama. bndpes roads, canals. harbours wall e, 1e
A il engineenng e, the apphication of planning. designing, Mamtaining incanting and
operating infrastructures while protecting the public and environmental health and improving
eanting infrastrctures,

vra 1 fofam poffrafn € YO0 U PG Sofwares & T wERY
T AwaCAD Rivet. STAAD Pro, MS Excel, MS Project 821

73 ) AuteCAD w0 £7

I AwoCAD TS BTRITE computer-aided 50T s TRT software application 1
Atodesk T trwfam st forgf (marketed) S R, AwtoCAD TERR W femar 1980 2
s ‘T U0 % wu § wyedtas sefrs wiewR fTOed (Internal graphics controllers)
¥ W pucro computer WA T @)

AutoCAD 1 fTE Wrmemsn % WEw (drafung) S T (Documentation) ¥

190 Autodesh B faatan faw mp § www ® e w1l Stuctoral design consultances
(areA, fears woRew ) st W R TR Wwaw @ Ivam fem W owem f AuweCAD
3D version 3D modeling & 10 9 availuble #1
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§7 6. MS Project 370 §7
WT— MS project T progect management 1] 507 07 22 wttume § ¥ g 2 sty
o tracking ¥ management f FITT WTW & S prosent o VISP 5 5 geemect :

; software for project managens so Bt ey can control nd plam Do prowects. seegs ks
manage resources, make reports o)

¥A 7. Primavera &1 §?

W— Primavera UF  standard project susagement et sl |8 9006 wecnes ®0 %
~ construction, ol and gas. manufateneg. oxrgy. TV TIME [T o infematen ©chmgy
A q use f¥m 77w ’Iflulmm‘ $ ¥ 8 pownt panmng T? menageeew 8
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nagement software (IR L] project man,

i i j lio ma
Primavera T enterprise project portfol .
collaboration. control capabilities ¥ ¥, s 3= GO H-Eﬁ!ﬁ!u M fr

SAP's ERP system % Ta THgA O il

Rcml'n(

oracle s

¥¥F 8. MS Excel T §?

FIT—Microsoft Excel, microsoft & fasfaa spreadsheet 21 3l caleulation, graphin,

L

. STTF macro programming language 1 TN P élx”l::

@ ¥gF M AN spreadsheet §, TR m

. fogarmmn o P B ST Sprea g
*mﬁmam%mm%,hmfmmc

athematically manipulate F1 1 aey 3

pivol tables A9 visual basi

A values ¥ tables 1 rows U column
9 complex arithmetic operations T function 8RT m
W 9. How to create a new project plan and set its start date in MS Project?
I— o On the File menu. click New.
In the New Project task pane, click Blank Project
On the Project menu, Click Project Information
In the Start Date box, type or select project start date you want
Click Ok
On standard toolbar, click save button.
Save As dialog box will appear, give relevant name to your project

Click Save to save the project

How to set properties about a Project Plan in MS Project?
On the File menu, Click the Properties

In the properties dialog box, click the Summary tab, and then enter the information you want
like: *

o Title of the Project

» Manager of the Project

e Company Information

e Any other useful information in comments

¥¥T 11. Right tasks define 11 1 &1 -IAvaHA 87
3W— Defining the right tasks to create the right deliverables (product) is must. Tasks listed in 2
project should describe all of the work required to complete the project successfully.
o Inatask view, such as Gantt Chart view, In the first cell directly below the Task Name column
heading, type task name “Feasibility Study™ and then press “ENTER”
e Enter some of the relevant tasks
e Each task will be assigned a unique ID
o This ID does not reflect the sequence of the execution of the task
o Inatask view, such as Gantt Chart view, click a cell in duration column
e Type the task duration and press “ENTER”
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Fat— Milestones arc significant (impoy y
on the project, Because the mil
task with ZERO duration,

rant) eveny
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¢ et
Cstone m"m“”y her rea

does pot incl

fom i

YS a week 3

f&a mm

ched in the Project or impered
; ude any work, 5o presented ag
o 14 MS Project H default Working hourg

ga—Default working Hours are g hrs/day, 5 4
, a

7 15. AutoCAD T6e& g1 fomfiry

gat—Autodesk Inc. EI

¥7 16. AutoCAD %9% aR &g release fira 1
Fat—December 1982 | i

nd 20 days per month,

¥97 17. AutoCAD ¥ foad workspace avajlaje Lol o)

w—3 '

7 18. AutoCAD drawing file % TG 21 extension g )
n

F—DWG extension i

FA—REC command mmand use §Tdt §?

WA 20. Circle create %1% & M0 #1 @ commang N ITE fE a2
FH—C command )
¥ 21. What does AutoCAD stands for?

F—Autodesk’ Computer Aided Design

¥ 22. AutoCAD ¥ properties palette %}
w §?

FR—Control+2

T 23. AutoCAD ¥ frat- units &1 IwaT frar smr &2

T—s5

WA 24, 90° straight line T} % fTT & & mode & wse fEar ImT 32
fM—O0rtho mode

obwinm%fﬁiﬁ?ﬁkﬂ'ﬁlwm- I
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concentric circles af p

arallel curves obtain w0 ¥ fog fay commng
W¥A 25, Parallel lines,
1 use fa @@ £7

FH—Ot st
u¥a 26. STAAD Pro software = [
rification,

fayraand, FATEL o
IFT— Model Generation, Model Vel Secondary Analysis. Static Analysis, Seismic Analyis
— Model (e 3
3f Dynamic Analysis.
%3 27. STAAD Pro software &
T—Structure A A1 designing F
Aluminium 3f)1

w @ v wge

——————

o R F v # design F AU ITLH (Concrete, Steel,

PEE]
(MULTIPLE CHoOICE QUESTIONS)

1. Which sofiware is used for drafting
(@ AutoCAD
© STAAD Pro
5, Bl software W (Which o
(2) AutoCAD (b) MS Excel
(c) STAAD Pro (d) PRIMAVERA
3, Construction, planning and scheduling software B
(2) PRIMAVERA (b) MS Project
(¢) Both (a) and (b) (d) NOTA
4. Building information modelling 3§ T software:
(a) AutoCAD (b) PRIMAVERA
(c) STAAD Pro (d) REVIT Structure
5, Arc GIS software frafad use o <mr —
(a) Surveying (b) Modelling
(c) Spread sheet (d) Drafting i
6. 3DS Max software {8 use frmr w1 23—
(a) Surveying (b) Modelling

Purposes (Draftin
(b) MS Exce|
(d) PRIMAVERA

re of these is 5 spreadsheet)?

L ¥ TIR software T = 27)

(c) Spread sheet (d) Drafting
7. Excel window % bottom W &1 W#e ¥ &2
(a) Title bar (b) Formula bar
(c) Worksheet tabs (d) Name box
8. Civil engineering ¥ WqT software:
(2) AutoCAD (b) STAAD Pro
(¢) Revit Structure (d) ST i

9. Basic rectangular building blocks of a spread sheet are called:
(a) Cells (b) Molecules
(¢) Atoms (d) Nucleus

225
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10.

12.

13.

14.

15.

16.

17.

18.

. @ ya @ fem g 09

a3 W
A v feE (b) Address

(d) Label
3 R it (void ratio of soil is 0.9, ji Poroi

Celis
(a) Name
(¢) E-mail

will be)—

(a) 054 ) 0.74

(c) 0.57 (d) 0.75- . . .

The volume of voids to the total volume of soil is known as (Ffr T 7 s

F7 T @ ST FEEH -

(a) Void Ratio (Rl 3739)

(c) Mass (¥=RM) gy
i s void ratio of 0.5 and its porosity Wi

(a) 3% (b) 66%

(c) 100% (d) 40%

The ratio of liquid limit to plasticity index for a soil mass is (Cail:ol-cuc i foe =5

d s s qEEE § AT FE €)—

(@) Liquidity index (531 q#(®)  (b) T HH

(c) Consistency index (¥Td TFFF) (d) None of the above (S ¥ & # 7))

Uniformity coefficient of a soils is (&1 1 THFRN TH ?—

(a) Always less than 1 (¥ 1 q )

(b) Always equal to 1 (T 1 F FTM)

(c) Equal to or generates than 1

(d} NOTA

The law used is permeability test is (FRTAT e # WM R R 9 AR R e

@ #)—

(a) Stoke's law (TrF T7H) (b) Pascal’s law (WT&Fa F1 fram)

(¢) Newton's law (23 F1 F@8)  (d) Darcy’s law (SR &1 fram)

A soil has an average particle size of 0.2 mm. It is predominantly (fret 7a1 1 e Fu

FFR 0.2 mm. ¥ T TM)—

(b) Saturation (Hgwdn)

(d) Porosity (TR=)

approximately (T §31 T
amy—

(a) Sand (S1]) (b) Gravel (s=1t)
(c) Silt (mr fawe) (d) Clay (gft)
Unit of coefficient of consolidation (VSFA TUI% & THE)—

(b) cm¥sec (FHUAFTT)
(d) g-cm/sec (IR AFTT)

(a) cm¥g (Fii*ram)
(c) glem¥sec (A 2 AEvE)

i
|

|

i

i;

20.

21,

22

25.

26.

arfrEin g 227
fg,; :;:[::‘gr;;:rcnil)fjr all soils 1s generally (Ffa% wmmn 51 o3 A W = o F
(ay 0.5 (hy 20
(c) 1.0 (d) 25
The fire demand of a city may be worked out by (F9% 3m #m 71 w7 fzorz (o
sravaEay) frRe T R ) —
(2) Kuiching's formula (F=fam =1 777)
(b Freeman formula (¥ =1 )
(¢) Under Writers formula (521 T321 %1 77)
(d) All of above (3w =)
For a number of column constructed in a row, the type of foundation provided (V% T+ 3
fiffa s wWO * o F mh fa)—
(a) Strip (g1 (b) Raft (t%2)
(c) Strap (TgH) (d) Footing (T2)
The total water demand can be taken as (@ #1 F@ =M o o TEA 2)—
(a) 195 I/P/d (b) 135 UP/d
(c) 210 I/P/d (d) 270 IrP/d

. Which of the following values of pH represents a stronger acid? (== 7 ¥ F13-T0 pH

stronger acid represent Fdl 2)—
(a) 10 M5
© 2 (@ 8

For water supply to a medium town, what is the approximeate daily variation factor? (9% a1 X

amr W fame ¥ fau sffea @it e = oA dm 82—
(a) 05 (b) 09
(c) 0.8 @ 15

The percentage of chlorine in fresh bleaching powder is about (FT M WS A FRA

F1 W@ B 2, T —
(a) 30-35% () 10-20%
(c) 70-80% () 40 ¥ 50%

The process of de-chlorination is followed by (FEEEET W e fFEw @ ®OSE
B)—

(a) Pre-chlorination (‘{-f FARAIHT)

(b) Super-chlorination (JR-FAGHH)
(c) Post-chlorination (T¥d TR
(d) Double-chlorination (g~ AT
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; 7 fafre KRRy
cific gravity of sewage? aitea (72 il R W

27. What is the spe
(a) Zero (1)
(by Slightly less than 1 (1 & ag W)
(¢) Slightly greater than 1 (1 3 gy HF)

(d) NOTA .
e € A) N W F W uy g
28. The sohd content of sewage is generally ( : : ua
H—
(@) 99% () 70%
(c) 15% @ 0.1%
29. SR g W wEA g TE E— )
1-snB ® 14sin@
(@ T5ang 1-sin®
1+tan®
1+cot® ST
ot N ()
(c) 1—col0 1-tan®
30. g1 F YT proportional B #— :
@ Dy () Dm3
" /
© DI (@ Dif
JAHA
L@ 20 3@ 4@ S@ &6 .0 3@
9. @ 1. IL@ 2@ 1B@ Mo 150 16 @
17. @) 18 (0 19 () 20.(d) 2L (@ 22.() 23() 24 (d)
25. (a) 26. (b) 27.(c) 28.(d) 29.(a) 30. (b)
e

ERECIep R

ST (MULTIPLE CHOICE QUESTIONS)

—

1. Which software is used for drafting purposes (Drafting ¥ FJ#1 software 357 T 7,
(a) AutoCAD (b) MS Excel
(c) STAAD Pro (d) PRIMAVERA
2, dgwiiz software F T $2 (Which are of these 15 a spreadsheet)?
(a) AutoCAD (b) MS Excel
(c) STAAD Pro (d) PRIMAVERA
3. Construction, planning and scheduling software 2—
(a) PRIMAVERA (b) MS Project
(c) Both (a) and (b) (d) NOTA
4. Building information modelling 3] ¥ software:
(a) AutoCAD (b) PRIMAVERA
(c) STAAD Pro (d) REVIT Structure
5, Arc GIS software fFafad use fFm smm 2—
(a) Surveying (b) Modelling
(c) Spread sheet (d) Drafting
6. 3DS Max software fFafedl use fFa1 w1 §—
(a) Surveying (b) Modelling
(c) Spread sheet (d) Drafting
7. Excel window ¥ bottom T T Y&z T &2

(a) Title bar (b) Formula bar

(c) Worksheet tabs (d) Name box
8. Civil engineering ¥ WIF software:

(a) AutoCAD (b) STAAD Pro

(¢) Revit Structure (d) SR |

9. Basic rectangular building blocks of a spread sheet are cailed:
(a) Cells (b) Molecules
(c) Atoms (d) Nucleus

225
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10.

12.

14

15.

16.

17,

18.

. A soil sample has void ratio of

e g———— R R
(a) Name (b) Address

(©) E-mail (d) Label N .
L@ ym @ faam SR 09 3. oA T i (void ratio of soil is 0.9, i Porosiyy
will be)—
() 0.54 (b 0.74
() 0.57 (d) 0.75

f soil is known as (ffaad & smom g ™y

The volume of voids to the total volume o

TE WA w SR wEe 6)—

(a) Void Ratio (&@ 3¥g@) (b) Saturation (|
(d) Porosity (FT@D)

(¢) Mass (F5991)

0.5 and its porosity will be approximately (U6 a1 T 5
fifem (SEE) U@ 0.5 3R wEe WA (TR F T WA @) —
(b) 66%

(@) 33%
(d) 40%

(c) 100%
The ratio of liquid limit to plasticity index for a soil
Fo s T g S oA e §)—
(a) Liquidity index (@@ qo®i®) (b) T EFw

(¢) Consistency index (Ffi gawi®) (d) None of the above (3w ¥ | I )
Uniformity coefficient of a soils is (321 1 HHEA 'ﬂ“ﬂ'w"' %)'—‘

(a) Always less than 1 (531 1 | FH)

(b) Always equal to 1 (FR1 1 & R)

(¢) Equal to or generates than 1

(d} NOTA

The law used is permeablity test is (SOl wew # wEm fer s 9@ frE F o
S| #)—

(2) Stoke's law (== T1a9) (b) Pascal's law (Whed H )

(c) Newton's law (3 &1 F@H)  (d) Darcy's law (sl w1 frm)

A soil has an average particle size of 0.2 mm. It is predominantly (foret w1 &1 dirm F9
MR 0.2 mm. €1 TE T)—

(a) Sand (&) (b) Gravel (F=i)

(c) Silt (V= fgee) (d) Clay (i)

Unit of coefficient of consolidation (FE7 1% & T&1E)—

(a) emfg (FH/zm) (b) emsec (T /AFTE)

(€) gemfsec (MUEH.AFTT) (d) g-cm/sec (AN AFTZ)

mass is (FFE @1 S59H & fau o

|
|
|
|

arfam=im w227

19. The critical gradient for all soils is gencrally (FifaF yavm #1 5@ T4 TER F O§A| T
fau, ammeR: @ #)—
(a) 05 (b) 2.0
(c) 1.0 (d) 25
The fire demand of a city may be worked out by (9% 3F1 T F wrm fzmz (==
sravea) FIERER S wE f)—
() Kuiching's formula (F=fem #1 939)
(by Freeman formula (WA R 77)
(¢) Under Writers formula (227 227 1 73)
(d) All of above (3w A1)
For a number of column constructed in a row, the type of foundation provided (U% 3 3
fafifa oM @l & fau a9 i AE)—
(a) Strip (TE) (b) Raft (¥12)
(c) Strap (9gH) (d) Footing (UZ)
22. The total water demand can be taken as (Fc 1 Fel M & = TFA )—
(a) 195 I/PId (b) 135 i/PHd
(c) 210 l/Pid (d) 270 I/Pd
23. Which of the following values.‘of pH represents a stronger acid? (FF=faf@s § 3 =5-7 pH
stronger acid represent Tl €2)—
(a) 10 (b) 5
(c) 2 (d) 8
24. For water supply to a medium town, what is the approximate daily variation factor? (W&l &
T s faan & fau sfafed | o @ oA g €2 —
(@ 05 (b) 0.9
(c) 0.8 (d) L5
25. The percentage of chlorine in fresh bleaching powder is about (T =™ Wss? F TARA
F WA A €, ST —

20.

2

(a) 30-35% (b) 10-20%
(c) 70-80% (d) 40 ¥ 50%

26. The process of de-chlorination is followed by (3EENHIET H1 ¥ f&us =7 =1 W=
)—

(a) Pre-chlorination (Jd FeRiiaoT)

(b) Super-chlorination (G- FARIAIHTI)
(c) Post-chlorination (Y¥=l FTQIHTOT)
(d) Double-chlorination (JH-FARIEHI)
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27. What is the specific gravity of sewage

(b) Slightly less than | (1 & 9igl %H)
(¢) Slightly greater than 1 (1 8 9rg1 31f4H)

(d) NOTA
28,
—
(a) 99% (b) 70%
(©) 15% (d) 0.1%
29. S W W WiFg 94y g Tolih—
1 -sin0 1+sinB
@) 1+sinB ®) 1-sin6
14 cot@ |+ tan©
30. T H UETEAT proportional Bl —
(a) Dy, (b) Djy
(c) D72 () Dig

1. (a) 2. (b) 3. (¢)
9. (a) 10. (b) 11. (c¢)
17. (a) 18. (b) 19. (c)
25. (a) 26. (b) 27. (c)

SAHTEAT

4. (d) 5. (a)
12. d) 13. (a)
20. (d) 21. (a)
28. (d) 29. (a)

6. (b) 7. (c)
14. (b) 15. (c)
22. (b) 23.(c)
30. (b)

) (g (1 TE) R TEE # A gy

The solid content of sewage is generally (HTHTAC: et () B 3 A A e

8. (d)
16. (d)
24. (d)



